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COPYRIGHT & CREDITS 
 
 
The contents of this book are Copyright © Koroush Ghazi and protected under US, Australian and 
International Copyright laws. No unauthorized reproduction, alteration or distribution of the book, in part 
or in whole, in any language, is permitted. All Trademarks used in this publication are the property of their 
respective owners. 
 
HOSTING, DISTRIBUTION AND TRANSLATIONS OF THIS BOOK 
 
Reproducing, altering, hosting, or mass distributing this book in any way is not permitted. The latest version 
is always available from TweakGuides.com. 
 
Translations of this book are not permitted, as I have absolutely no way to determine the quality and 
accuracy of any translations, particularly given the somewhat complex and often delicate procedures in this 
book. Professional translations of this 115,000 word book into the multiple languages required would cost a 
great deal, and amateur translations are unacceptably shoddy. 
 
If you wish to spread the word regarding the book, please link to the TweakGuides Tweaking Companion 
download page. 
 
I've invested a huge amount of time and effort into creating this book, and I also provide a free version of 
this book which is easily accessible so that the widest possible audience can benefit from its contents. There 
is no reason for anyone to publicly reproduce or distribute this book when the latest version is always 
available for free from my site. People who host this book or portions of it are usually doing so to generate 
easy traffic, income or credit for themselves using my hard work, which is not acceptable. Appropriate 
action will be taken against any such individuals who do not respect the concept of author rights. 
 
For those who do not understand the strictness of these conditions, please see the TweakGuides FAQ. 
 
CREDITS 
 
This book is a reference compilation borne out of a great deal of testing, research, reading and personal 
experience. I give full credit to any websites and authors linked in this book, as well as all the software 
developers whose excellent tools I recommend in this book, especially those who provide their software for 
free. It is amazing that they invest so much time and effort into developing and testing their software and 
then provide it free to all PC users. I encourage you to support their work with donations and purchases 
where relevant, because giving is a two way street. 
 
Thank you to my readers who, since TweakGuides began in April 2004, have provided a great deal of 
support. From those who support the site by linking to it on various websites and forums, to those who take 
the time to write to me with thoughtful and constructive contributions, and in particular to those who 
donate to the site or purchase the Deluxe Edition of the TGTC - I truly appreciate it. The only thing which 
motivates me to keep writing guides is the fact that I know there are intelligent people out there who are 
patient enough to take the time to read them, and to use the material in the spirit in which it is intended: to 
learn more about their PCs, and to think for themselves and resolve their own problems. 
 
A special thanks goes to Larry Kuhn for preparing several pages of very detailed and highly valuable 
feedback which was immensely helpful in earlier revisions of this guide. 
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INTRODUCTION 
 
 
Windows XP was first released in October 2001, and has subsequently 
received several significant updates in the form of three Service Packs in 
September 2002 (SP1), August 2004 (SP2) and April 2008 (SP3). To date it 
is one of Microsoft's most popular, and certainly the longest-running 
operating system, with the majority of Windows users still running 
Windows XP as of mid-2010. 
 
While Windows XP may not contain all the latest conveniences and 
safeguards built into newer operating systems like Windows Vista and 
Windows 7, it also doesn't contain what some people may consider 
annoyances or unnecessary features introduced in these OSes either. It is 
highly customizable and a good light-weight solution for systems with 
limited resources such as basic home PCs and notebooks. Although 
Windows XP is quite mature now and will no longer receive any feature 
updates, Microsoft will continue to support XP with security updates 
until April 2014, so it is far from being dead. 
 
The first version of this book was called the Windows XP Tweaking Companion (XPTC) and came out in 
December 2004. Since then it has proven to be extremely popular, and has been continually refined through 
a great deal of user feedback, experimentation and new discoveries. However just like Windows XP itself, 
this book is now quite mature and will no longer receive major changes. For the most part we now know all 
we need to know about tweaking Windows XP, and this book contains the bulk of such information. 
 
The length of this book will no doubt frustrate people who are looking for a handful of tweaks or quick fixes 
to 'make XP faster'. Clearly that is not its sole aim; the main purpose is to try to explain how things work in 
simple but sufficient detail so that readers can customize and optimize their machines appropriately while 
learning more about them. Computers have become integral to almost every aspect of our way of life, and it 
is no longer possible to simply ignore them or pretend that it's not important to know how they work. Now 
more than ever it has become extremely important that you understand how your PC and Windows are 
working. Thus the book is long because I try to ensure that you are given enough details to understand the 
logic behind my recommendations, rather than being treated like a small child who is simply told to change 
settings without a second thought. 
 
I promise you that if you patiently work your way through this book over the course of a few days, that you 
will come out at the other end with not only a better performing, more stable and better customized PC, you 
will also be much more comfortable with using Windows on a daily basis; the mystery will disappear. More 
importantly, you will also be able to better diagnose, indeed prevent, any problems on your PC in the future.  
 
In closing, I hope you find the book useful, and I thank you for purchasing the Deluxe Edition - your 
generous support will allow me to continue releasing a basic free version of this book to a wider audience, 
and to also continue creating new works in the future. 
 
 
Cheers, 
 
Koroush Ghazi 
Owner/Author In honor of 2,500 years of Persian Culture  

TweakGuides.com Dedicated to the noble ideals of Cyrus the Great 

http://www.iranchamber.com/history/cyrus/cyrus_charter.php�
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BEFORE USING THIS BOOK 
 
 
Please read the following information before attempting to make any changes using this book. 
 

BASIC REQUIREMENTS 

There are several important requirements you must meet before using this book: 
 
 You should have prepared backups of all your important information prior to undertaking any of the 

changes detailed in this book. Follow the instructions in the Backup & Recovery chapter. 
 You will need Administrator level access to Windows XP to make the majority of the changes in this 

guide. See User Accounts under the Control Panel chapter for more details. 
 You should have your original Windows XP installation CD readily available - do not undertake the 

tweaks in this book if you don't have an original Windows XP installation CD. 
 
Unless you meet at least the first two requirements above, I do not recommend proceeding with the book as 
you may be unable to successfully undertake the tweaks in this guide, or may run into problems. 
 

DIFFERENT VERSIONS OF WINDOWS 

This book is designed equally to suit Windows XP Professional and Windows XP Home. There are no major 
content or performance differences between XP Pro and XP Home. The main differences between XP Pro 
and Home are covered in this article. Furthermore, there are no content differences between the various 
versions of Windows XP such as the OEM Edition, Academic Edition, and Upgrade Edition. These are all 
identical in terms of performance and content to the Full Version of Windows XP. The only difference 
between these editions is that certain purchasing conditions are attached to them: the OEM (Original 
Equipment Manufacturer) Edition can only be provided with the purchase of a new computer; the Upgrade 
Edition requires that you own an earlier version of Windows to install it; and the Academic Edition requires 
that you be a student or qualified educator to purchase it. However the tweaks and tips in this book apply to 
all these versions equally. 
 
This book does not apply to older versions of Windows such as Windows95/98/SE/ME - these are based on a 
different architecture to Windows XP, so many of the descriptions of Windows functionality in this book are 
not correct for other versions of Windows. Windows 2000/NT/2003/x64 are based on the same underlying 
architecture as XP, so most if not all of the general tips, descriptions and tools should work for those 
versions, however I cannot specify which do not work. I have only tested the tweaks and settings in this 
book on Windows XP 32-bit, and cannot provide recommendations for other Windows versions. 
Importantly, there are separate TweakGuides Tweaking Companions available for Windows Vista and Windows 
7 from the main TweakGuides Tweaking Companion page - these are also recommended for XP users who 
want to learn more about the features of these newer operating systems. 
 

WHY IS THE BOOK SO LONG? 

This book is intended primarily as an educational and reference source. It is not intended for people seeking 
quick fixes. I provide explanations for a wide range of features and procedures for a relatively broad 
audience so that anyone can gain a good understanding of what they're doing, and make up their own mind, 
rather than just taking my word for it. I firmly believe in the old saying: Give a man a fish and he will eat for a 
day; Teach a man to fish and he will eat for a lifetime. To find information on any topic in the book at any time, 
you can use the Table of Contents or press CTRL+F to bring up the PDF search functionality. I will not be 
releasing a cut-down version of this book; there are no '10 best tweaks' or a handful of changes which 
magically speed up or fix Windows XP. It is a complex interrelationship of hardware and software settings 

http://www.winsupersite.com/showcase/windowsxp_home_pro.asp�
http://www.tweakguides.com/TGTC.html�
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which determine how fast and how stable your PC runs, and it requires understanding and thought to 
correctly optimize and customize a system. 
 

RECOMMENDED SOFTWARE 

Listed throughout this book is a range of software which I recommend to enable you to carry out some of the 
procedures in the book or to provide additional functionality in Windows. If you do not feel comfortable in 
downloading or installing this software for whatever reason, you should ignore those procedures which rely 
upon it, as none of them are critical to the functioning of Windows XP. Furthermore, at no point do you have 
to purchase any software. I am not paid or sponsored by any software or hardware company, so I generally 
recommend the best free software available to do the job. In a few cases the software may require purchase, 
but usually the trial version of it retains enough functionality to complete the job for which I have 
recommended it. Of course if you do find any of the software useful I encourage you to purchase it or donate 
to the software's author. Not everything on the Internet is free, nor should it be. 
 

PROBLEMS WITH THE BOOK 

While I have made every effort to ensure that this book is as clear and accurate as it can be, I hope you can 
appreciate the fact that I cannot possibly test the information and recommendations in this book on every 
potential combination of PC hardware and software available. If there is anything in the book which you 
believe is genuinely inaccurate or misleading, or if you just want to report a broken link, please Email Me 
with specific details and if appropriate I will rectify it in the next version of the book. You can also email me 
if you wish to share any general feedback or thoughts you have about the book. 
 
However I must stress that the book is provided 'as is', and I cannot provide technical support of any kind. It 
simply isn't viable or appropriate for me to do so, so under no circumstances will I provide personalized 
optimization, customization or purchasing advice/feedback, or any other form of technical support related to 
the information in this book. The whole reason for writing this book is to give each and every reader a 
thorough rundown on all the steps necessary to customize and optimize their system. As such, there are 
sufficient resources and links in this book to help anyone learn more about their system and solve most any 
problem when combined with additional research and thought. 
 

YOUR RESPONSIBILITIES 

The basic theme throughout this book is that as long as you read and consider the advice given carefully and 
use common sense when applying any changes, you will remain problem-free. I have made every reasonable 
effort to ensure that the contents of this book are completely accurate to the best of my knowledge, and that 
the sites and utilities linked to in the book are free from any malware or deceptive practices at the time of 
writing. In all respects the book is safe to use if followed correctly, with careful consideration and taking 
appropriate precautions. However for legal reasons I cannot take any responsibility for any damage or loss 
incurred through the use of this book. It is a condition of use for this book that you agree to take full 
responsibility for any of your actions resulting from reading this book. If you do not wish to take full 
responsibility for using this book and any resulting impacts, then do not proceed any further - close the book 
immediately. 
 

mailto:koroush@tweakguides.com?subject=TweakGuides%20Tweaking%20Companion%20for%20Windows%20XP%20-%20Correction�
http://www.tweakguides.com/FAQ.html#Q11�
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BASIC PC TERMINOLOGY 
 
 
This chapter explains in layman's terms commonly used technical terminology. All of the major hardware 
components found in a modern PC are also covered. While advanced users may want to skip this chapter, 
everyone should read the Bits & Bytes section below to clarify a common point of confusion. 
 
 

BITS & BYTES 

You will often see the terms Bits, Bytes, Kilobytes, Megabytes and Gigabytes (or their abbreviations) being 
thrown around. Understanding these is very important to learning more about PC usage. To start with, a Bit 
(Binary Digit) is the lowest form of computer information, and can take the value 0 or 1 (i.e. Off or On). All 
computer functionality is derived from the behavior of bits. For the purposes of this book, the most common 
units of measurement are: 
 
8 bits (b) = 1 Byte (B) 
1,024 Bytes = 1 Kilobyte (KB) 
1,024 Kilobytes = 1 Megabyte (MB) 
1,024 Megabytes = 1 Gigabyte (GB) 
 
Note that bits are shown as a small 'b', and Bytes are shown as a capital B - this is an important distinction. 
For example 512kbps is 512 kilobits per second, which converts to 64KB/s (Kilobytes per second). 
 
For most users, knowing the above conversion factors is sufficient for understanding the terminology used 
in this book and around the Internet, as well as for general PC usage. However strictly speaking, the values 
shown above are not correct, as explained in this article. The discrepancy stems from the fact that the 
commonly used metric prefixes Kilo, Mega, Giga and so forth are based on the decimal (base ten) system, 
while as noted, computers are based on the behavior of bits, which is a binary (two digit) system. Therefore 
while 8 bits still equals 1 Byte under either system, the correct prefixes to use in other cases are: 
 
1,024 Bytes = 1 Kibibyte (KiB) 1,000 Bytes = 1 Kilobyte (KB) 
1,024 Kibibytes = 1 Mebibyte (MiB) 1,000 Kilobytes = 1 Megabyte (MB) 
1,024 Mebibytes = 1 Gibibyte (GiB) 1,000 Megabytes = 1 Gigabyte (GB) 
 
What's the difference? Well one Kilobyte (KB) actually equals 1,000 bytes, since 'kilo' is a decimal prefix 
meaning 'thousand'. Yet one Kilobyte as interpreted by a computer is actually 1,024 bytes, so 'kilo' is not the 
appropriate prefix to use, Kibibyte (KiB) is the correct term referring to multiples of 1,024 bytes. This 
discrepancy may seem minor at first - only 24 bytes difference between 1KB and 1KiB - but as the values 
grow, it becomes more significant, so it is important to understand the difference. This is particularly true 
because hardware and software manufacturers often use these prefixes differently, causing PC users a great 
deal of confusion. 
 
The best practical example of this discrepancy is drive capacity. A drive advertised as having 150GB of 
storage space is a technically correct use of the term Gigabyte, because it holds 150,000,000,000 Bytes of 
storage. However purchasers of the drive soon become confused when they see that Windows typically 
reports the drive as having only 139GB of usable space. This is because 150,000,000,000 Bytes translates to 
139GiB in the binary system the computer uses, as opposed to 150GB in the decimal system, but Windows 
incorrectly shows GB instead of GiB. This results in many users feeling ripped off because their usable drive 
space does not match the advertised storage capacity. As drive capacities grow, the discrepancy between 
advertised and reported space becomes much larger, causing even greater concern among consumers. 

http://en.wikipedia.org/wiki/Bit�
http://www.iec.ch/zone/si/si_bytes.htm�
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In any case, to avoid further confusion, throughout this book I will continue to refer to values based on the 
accepted (but technically inaccurate) common usage, i.e. the way in which hardware manufacturers report 
them, and the way in which Windows reports them, despite the discrepancy. Eventually however 
widespread adoption of the correct terms will be necessary to prevent growing consumer confusion. 
 

DATA 

In the context of PCs and technology, Data is a general term referring to any amount or type of information 
which is stored and used by a computer. 
 

PC 

 
 
A Personal Computer (PC), also referred to as a System, Machine, Rig or Box, is a collection of hardware 
(electronic components) which function as a unified system through the use of software (programmed 
instructions). 
 

CPU 

 
 
The Central Processing Unit (CPU), also referred to as the Processor, is the single most important component 
of a PC. The CPU chip is typically a small thin square chip which is seated firmly on your Motherboard, and 
usually covered by a large metal heatsink and fan to cool it. The CPU controls and co-ordinates the actions of 
the entire PC under instruction from software. It has the role of determining which hardware component 
does what, assigning tasks and undertaking complex calculations which are then fed through the various 
relevant components and back. 
  

http://en.wikipedia.org/wiki/Data�
http://en.wikipedia.org/wiki/Personal_computer�
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MOTHERBOARD 

 
 
The Motherboard, also called a Mainboard or Mobo, is the large rectangular Printed Circuit Board (PCB) into 
which all of the electronic components are connected in a PC. The motherboard is typically firmly attached 
to the inside of a PC Case. The motherboard provides a network of pathways for the CPU to communicate 
with the various hardware components, and a range of ports for standard peripherals and other devices to 
plug into the PC. 
 

MEMORY 

 
 
A PC uses several different types of Computer Memory to store data, whether temporarily or permanently, 
for the purposes of speeding up processing performance. Memory chips are fast because unlike other forms 
of data storage, such as physical Hard Drives or Optical Drives, they have no moving parts. The main types 
of PC memory are covered below: 
 
Random Access Memory (RAM), also called System RAM or simply just Memory, is the most common form 
of hardware used by a PC. RAM usually comes in the form of a long thin PCB stick (a DIMM) that plugs into 
the motherboard and through it provides a place for the CPU and other components to temporarily store 
any data which the system needs to rapidly access. RAM only holds data while it has a source of power; if a 
PC is rebooted or switched off, any data in RAM is instantly lost. For this reason, this type of memory is 
referred to as Volatile Memory. 
 
Read Only Memory (ROM) is a more permanent form of memory, and works similar to RAM, however 
unlike RAM it can only be read from and not written to under normal circumstances. Furthermore it will not 
clear when it has no source of power; that is, when the system is rebooted or switched off it does not lose its 
contents. For this reason, this type of memory is referred to as Non-Volatile Memory. ROM is primarily used 
to hold smaller amounts of important data, such as the Basic Input Output System (BIOS) - the program 
which tells the computer how to function when it is first switched on - stored on the ROM chip in the 
motherboard. Certain ROMs can be written to by use of a process called Flashing, such as when the BIOS is 
flashed with a newer version of its programming. 
 
The CPU and other hardware such as hard drives often have small memory chips of their own called Caches 
to temporarily hold data. This memory is typically a smaller RAM chip and is used as another point of 
temporary storage to further speed up data transfers. 
  

http://en.wikipedia.org/wiki/Motherboard�
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STORAGE DRIVES 

As noted under Memory above, RAM is only a temporary form of storage, and while able to store data 
permanently in the absence of power, ROM has typically been too small to store large volumes of data, and 
is also not designed for being frequently written to. Therefore modern computers employ one or more of 
several forms of storage drives designed to permanently hold data in large quantities and with varying 
degrees of portability. Storage drives plug into one of four main types of drive controllers found on the 
motherboard, listed from slowest to fastest below: 
 
 Floppy Disk Controller (FDC); 
 Integrated Drive Electronics (IDE) / Parallel ATA (PATA);  
 Serial ATA (SATA); or 
 Small Computer System Interface (SCSI), including Serial Attached SCSI (SAS). 
 
The controller available for any particular drive to use depends on both the drive type and the motherboard 
type. Some storage drives can also plug into the Universal Serial Bus (USB) port of a PC, however this is a 
multi-purpose port and not a dedicated drive controller, so it is not listed above. 
 
The various types of drive hardware are covered below: 
 

 
 
A Hard Disk Drive (HDD) is a magnetic storage device that acts like Memory, except it is semi-permanent, 
slower and far larger in capacity. The hard drive is a rectangular metallic box inside which is a stack of 
round platters and a read/write head. Whenever the PC requires data, it must first be read from the hard 
drive, usually into RAM, from where it is then accessed by the CPU and other devices. Data written to the 
hard drive will remain on the drive regardless of whether the system is rebooted or switched off. Because a 
hard drive has moving physical components, such as the read/write head and a spinning disk, it can never 
be as fast as memory chips - which have no moving parts - in providing data. As a result, a system may slow 
down or stutter while waiting for more data to be loaded up from or written to a hard drive. The amount of 
data stored on the hard drive itself usually has no significant impact on its performance, however if the data 
on the drive becomes fragmented, this will reduce performance. 
 

 
 
A Solid State Drive (SSD) is a memory-based storage device which combines the advantages of the speed of 
computer memory with the more permanent nature and larger capacities of hard disk drives. By using a 
type of Non-Volatile memory called Flash Memory, which is similar to ROM as covered under the Memory 
section above, an SSD can store data even when the PC is rebooted or switched off. Unlike a hard drive, an 
SSD has no mechanical moving parts, and as such is much faster in accessing its stored data. As SSDs 

http://en.wikipedia.org/wiki/Floppy_disk_controller�
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http://en.wikipedia.org/wiki/Serial_Attached_SCSI�
http://en.wikipedia.org/wiki/Universal_Serial_Bus�
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become cheaper, faster and more reliable, they are steadily replacing hard disk drives for consumer PC 
usage. 
 

 
 
An Optical Disc Drive is a disc-based data storage device that reads from and sometimes writes data onto 
CD, DVD or Blu-Ray discs via laser or other light-based methods, hence the use of the term 'optical'. These 
portable discs permanently hold this data until overwritten or deleted. Optical drives usually come in plastic 
rectangular boxes with a loading slot or extendable tray in the front. While much slower than hard drives or 
SSDs due to physical limitations, the main advantage of optical drives is the portability and relatively low 
cost of their media, along with the fact that such media can also be played on a variety of non-PC devices, 
such as standalone DVD or Blu-Ray players. Note that the term disk usually refers to magnetic media, like a 
floppy disk, while the term disc refers to optical media, such as a DVD disc. 
 

 
 
A Floppy Disk Drive (FDD) is a magnetic storage device which reads and writes data on thin plastic 3.5" 
Floppy Disks. The floppy drive comes in a rectangular plastic box with a loading slot at the front and a 
manual ejection button. Floppy drives are extremely slow compared to any other form of drive, and also 
hold very little data (around 1.44MB), and hence are a legacy device no longer used on most modern PCs. 
Some PC users retain a floppy drive for Windows recovery purposes, or to flash the BIOS, however this is no 
longer necessary as most modern PCs now fully support the use of optical discs or USB drives for these 
purposes instead. In fact the only major advantage of floppy drives - the relative portability of their 3.5" disk 
media - has been completely superseded by USB drives which are much smaller, faster, sturdier and more 
reliable, and can hold several GB of data as opposed to just 1.44MB. 
 

 
 
A USB Flash Drive is extremely similar to an SSD, in that it also uses Non-Volatile Flash memory to store 
data. However USB drives are typically much smaller in capacity and physical size, and offer much slower 
performance and reliability than an SSD. Their main advantage is that of low cost and portability due to 
their very small size, which is why they are also known as thumb or key drives. They plug into a standard 
external USB port on a PC, making them much easier to use for connecting to and transferring data between 
different PCs, since unlike a standard drive they do not need to be connected to a motherboard drive 
controller found inside a PC. 
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GRAPHICS CARD 

 
 
The Graphics Card, also called the Video Card, GPU, Graphics Adapter or VGA Adapter, is a miniature 
computer of its own dedicated solely to processing complex graphics-related data. It is a thin rectangular 
plastic PCB with a Graphics Processing Unit (GPU), also known as the Core, and Video RAM (VRAM), also 
known as Video Memory. The GPU and VRAM are the graphics-specific equivalents of the CPU and System 
RAM on a PC, and the graphics card itself has Pipelines for transferring data internally, similar to the data 
pathways on a motherboard. The graphics card plugs into the motherboard through one of the following 
interfaces, sorted from slowest to fastest: 
 
 Peripheral Component Interconnect (PCI); 
 Accelerated Graphics Port (AGP); or 
 Peripheral Component Interconnect Express (PCI-E).  
 
Graphics cards typically come with some form of cooling enclosure built around them, to ensure that the 
GPU and the VRAM remain cool enough to operate correctly. The graphics card undertakes the majority of 
2D and 3D graphics calculations under Windows, and also sends data directly to a Display Device. Some 
motherboards have built-in graphics functionality that works in much the same way as a plug-in graphics 
card, but is referred to as Onboard or Integrated Graphics. PCs with such graphics functionality typically 
process graphics-related data far less quickly than those with plug-in graphics cards. 
 

DISPLAY DEVICE 

 
 
A Display Device, more commonly referred to as the Monitor, is the device through which the PC's data 
output is displayed graphically. This graphical data typically comes directly from the graphics card, and a 
display device must be plugged into the graphics card to facilitate this. Some computers still have a 
traditional Cathode Ray Tube (CRT) monitor as their primary display device, however most modern PC 
monitors now utilize Liquid Crystal Display (LCD) technology. Furthermore a modern PC can also be 
plugged into a television set of any type, such as CRT, LCD, Plasma, Rear or Front Projector, and other 
similar technology sets if the user desires, or even a combination of multiple displays at once if the graphics 
card supports such functionality. 
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Display devices have the ability to display graphics at various Display Resolutions, typically expressed in 
number of Pixels wide by number of Pixels high (e.g. 1920 x 1200). A Pixel is the smallest component of a 
digital image, thus the higher the resolution, the more pixels are displayed on the display device and the 
clearer the image. At each resolution a display device can also redraw the image a number of times per 
second, referred to as the Refresh Rate which is expressed in hertz (Hz). Refresh rate is not to be confused 
with Frame Rate, which is expressed in Frames Per Second (FPS). Refresh rate is a physical limitation of a 
display device in refreshing the image on the screen a certain number of times per second. Frame rate on the 
other hand is the number of times per second that the software and graphics device can provide a whole 
new frame of imagery. 
 

SOUND CARD 

 
 
The Sound Card, also called the Audio Card or Audio Device, is a thin PCB that acts as a dedicated CPU for 
calculation of audio data. It typically plugs into the motherboard, and usually has no form of cooling 
enclosure around it. Some motherboards have built-in audio functionality that works in much the same way 
as a sound card, but is referred to as Onboard or Integrated Sound. PCs with such audio functionality may 
process audio-related data less quickly or with less additional functionality than those using plug-in sound 
cards. 
 

SPEAKERS 

 
 
A PC usually comes with some form of sound output device, typically a built-in PC speaker to provide 
audible warnings in the form of beeps or tones. Users with a Sound Card or Integrated Sound can attach 
more functional sound output devices, such as Speakers or Headphones, directly into the sound card or 
integrated sound device through the back of the PC. The addition of speakers or headphones allows the user 
to experience higher quality sound and also a potentially higher number of discrete Audio Channels which 
can increase the realism of sound reproduction. 
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POWER SUPPLY UNIT 

 
 
The Power Supply Unit (PSU) is a square metal box which is connected to mains power from the back of the 
PC, and inside the PC is cabled to several major components, as well as to the motherboard which regulates 
this power to the remaining components. Thus the PSU is the primary source of power which allows the PC 
to function; if the PSU cannot provide sufficient stable power to the hardware components of a PC, it can 
cause erratic behavior or even a failure to start up. 
 

COOLING DEVICES 

Electronic components can generate a great deal of heat, especially when under heavy load. The hardware 
components in a PC most susceptible to heat buildup, such as the CPU and GPU, come with cooling 
solutions designed to dissipate the heat into the surrounding air. The two most common types of PC Cooling 
solutions used are: 

 
 
A Heatsink is a square or rectangular solid metal object typically with a perfectly flat surface on one side, 
and multiple spines, fins or rods on the other side(s). The role of a heatsink is to sit on top of the component 
to be cooled, and draw out the heat from the component through conduction. This heat then travels along 
the heatsink until cooler air and a large surface area help in accelerating the dissipation of the heat.  
 

 
 
A Fan is designed to draw in cold air or expel hot air. Fans can either be employed on their own, such as case 
fans which simply suck in or blow out air from a PC case; or they can be mounted on or near heatsinks to 
assist in more rapidly removing the heat drawn out from hardware components. The larger the fan and/or 
the faster it rotates, the greater the volume of air it can move, hence the greater the potential cooling, at the 
cost of additional noise. 
 
Other forms of cooling, such as Watercooling, are much less common due to their additional cost, risk and 
complexity.  
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CASE 

 
 
The PC Case is a hardened structure, usually made of thin but strong metal and/or plastic, which encloses all 
the PC components and onto which the motherboard is firmly attached. The case provides the basic 
framework required for holding together and protecting all the components of a modern PC. However a case 
also increases the potential for heat buildup around components, and can also trap dust which can cause 
hardware to overheat and malfunction if not cleaned out regularly. 
 

PERIPHERAL 

 
 
Peripheral is a general term referring to any device attached or used externally to a PC, such as a mouse, 
keyboard or printer for example. The term specifically indicates that the device tends to lie on the periphery 
- that is, the outside - of the PC case. The only thing peripherals have in common with each other is that they 
provide additional input and output capabilities to a PC. 
 

OPERATING SYSTEM AND SOFTWARE 

 
 

 
The Operating System (OS), such as Windows XP, is a vital piece of software - a compilation of instructions 
that tells all the hardware and software components in a PC how to function to achieve particular outcomes 
in a unified manner. An OS is a necessity on all modern PCs since without an overarching program to 
provide core functionality, all the computer components would not be able to function as a single machine. 
The OS also provides the main interface for users to interact with the PC hardware and software.  
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Software is a more general term, referring to a collection of programmed instructions which through 
interaction with hardware provide various functionality on a PC. While the OS itself is part of the software 
on a PC, and provides a great deal of functionality, additionally installed software provides further 
functionality to perform more specialized tasks, such as word processing or gaming. 
 
 
Hopefully the information in this chapter has helped you to better understand common technical 
terminology used throughout this book. I encourage you to research further about any particular concept or 
component which may confuse or intrigue you, as it is important to have a solid grounding in the basic 
concepts and terms before moving on to more advanced material. The better you understand the basics, the 
more readily you will grasp the more complex topics covered in this book. 
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SYSTEM SPECIFICATIONS 
 
 
The first step in optimizing your PC is to find out precisely what hardware components you have, and what 
their various capabilities are. This is known as your System Specifications, and to find out the specific details 
of your hardware you require an appropriate set of tools. Information about your system specifications is 
vital both for using this book, and for general PC usage and maintenance. For example you must know the 
model and chipset type of your motherboard before you can upgrade your BIOS or install the correct 
motherboard drivers; you must know the full capabilities of your graphics card if you want to know if it can 
run certain games or to update its drivers; or you may have a complex problem which you wish to resolve 
yourself or provide details of to a Technical Support person. This chapter covers the tools you need and the 
methods you can use to obtain all the relevant system information. 
 
 
 SYSTEM INFORMATION TOOLS 

There are several good free system information utilities to choose from, including some comprehensive ones 
built into Windows XP. A combination of these programs will tell you everything you need to know about 
your system specifications and capabilities: 
 

WINDOWS SYSTEM INFORMATION TOOL 

 
 
You can access the Windows System Information Tool by going to Start>Programs>Accessories>System 
Tools>System Information, or go to Start>Run, type msinfo32.exe and press Enter. Note that for this utility to 
work, you will need to have the 'Help and Support' service enabled - see the Services chapter for more 
details. 
 
The System Information Tool presents a range of basic information about your system. Unfortunately much 
of it can be a little difficult to comprehend or may not be quite what you're looking for. Some of the more 
useful pieces of information include the IRQ allocations under Hardware Resources>IRQs; the listing of your 
hardware components by type under the Components section; and a listing of all the system drivers loaded 
up and their status under Software Environment>System Drivers. In general the System Information Tool is 
best used by medium to advanced users who can comprehend the interface and the information much easier 
than a beginning user. Its major advantage is that it is a free and built-in utility that anyone can easily access. 
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DEVICE MANAGER 

 
 
You can access the Windows Device Manager under the Control Panel>System>Hardware tab, or by going 
to Start>Run, typing devmgmt.msc and then pressing Enter. As a built-in Windows utility you can gain a 
great deal of useful information from this tool. Your major devices are displayed under various categories, 
and you can even choose to update individual device drivers or uninstall a device altogether should you 
wish. The device manager has several important roles and is covered in more detail under the Control Panel 
chapter. 
 

DIRECTX DIAGNOSTICS 

 
 
You can access the DirectX Diagnostic Utility (DXDiag) by going to Start>Run, typing dxdiag and pressing 
Enter. DXDiag is another built-in Windows Diagnostic/System Information tool that is part of the DirectX 
API. When DXDiag starts up you don't need to worry about WHQL (Windows Hardware Quality Labs) 
certificate checking as WHQL certification is not necessarily a solid indication of a driver's stability or 
functionality - see the Driver Installation chapter for more details. 
 
The main tab of DXDiag, called System, shows basic information about your system such as CPU type and 
speed, amount of physical RAM and the total pagefile (Virtual Memory) usage among other things. Under 
the Display, Sound and Input tabs you can find more information about the particular hardware you are 
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running for each of these functions, and also conduct some basic tests to ensure they are working to their full 
extent under DirectX. In particular you should ensure that all the DirectX Features listed are Enabled and 
that any Acceleration options are at maximum (slider to the far right). If you are experiencing problems with 
your hardware you can try the DirectX troubleshooting procedures under the 'More Help' tab. 
 
The most useful function of DXDiag for our purposes is its ability to create a text file with all your major 
system information, including your main hardware specifications, driver files, and environmental settings. 
To generate this text file click the 'Save All Information' button found at the bottom of the DXDiag screen. 
You will be prompted to save this report somewhere, and the default of the Windows Desktop is just fine. 
This DXDiag.txt file can now be attached to an email you can send to a Technical Support person, or its 
contents can be posted on an online forum to allow others to help you with any problems you may be 
experiencing. Don't worry - it doesn't contain any private information such as serial numbers or passwords. 
 

SIW 

 
 
SIW is the System Information for Windows tool which can be downloaded from the SIW Website. Once 
you've downloaded the standalone version of the program, you can simply run it from the file - there's no 
need to install anything. The interface is intuitive; click items in the left pane to see more details about them. 
For example, to find out more about your motherboard, click the Motherboard item under the Hardware 
section, and the details will be shown in the right pane. Alternatively, you can access each item by going to 
the Software or Hardware menus at the top of the screen. Note that SIW also has a range of other tools built 
into it, but I don't recommending changing anything using them - the best use for this utility is simply for 
viewing system information. 
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3DMARK 

 
 
You can download the 3DMark from the Futuremark Website and you can read more about its main 
functionality under the Benchmarking & Stress Testing chapter. 3DMark is primarily designed as a graphics 
benchmarking utility, however it has a nice system information section that gives you plenty of important 
info. Start 3DMark and on the main screen, click the Details button under the System section. A browser 
screen will open with a vast array of information about your system. Everything from your CPU's clock 
speed and L1 & L2 Cache sizes, to your drive capacities and interface type. Note that only 3DMark 06 or 
older will run on XP; the newer versions of 3DMark are for Windows Vista and 7 only. 
 

SANDRA 

 
 
Sandra stands for System ANalyser, Diagnostic and Reporting Assistant. You can download Sandra from the 
SiSoftware Website - the Lite version is free, and once installed, you will see a wide selection of information 
and benchmarking modules to choose from. Note that during installation of Sandra, you can disable the 
Remote Network Services, Price Engines and Rank Engines as they are not critical, however the Rank 
Engines option does allow Sandra to display a comparison of your score with others who have run the 
benchmark, which can be useful. If you've enabled the Rank Engine, after installation you can customize it 
so that your results aren't made public for example. 
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Sandra Lite has many inactive (grayed out) modules, however the main ones we need have sufficient 
functionality for our purposes. For example, if you want to know more about your system, double-click the 
Hardware icon (or select the Hardware tab) and then double-click on the Computer Overview module. It 
will display a range of useful information about your system, such as the CPU speed and type, your 
motherboard Chipset, and your Memory Module brand and speed. If you then want to know more about 
your motherboard in particular for example, open the Mainboard module, and it will display more detailed 
information. 
 
Sandra has several very useful benchmarking and stress testing features that are covered in more detail in 
the Benchmarking & Stress Testing chapter. Note that Sandra installs a new Service for itself called the 
'SiSoftware Deployment Agent Service' which you should leave at its default. 
 

CPU-Z 

 
 
A highly recommended tool, you can download CPU-Z from the CPU-Z Website. Run the program and it 
will provide you with all the major information you require about your hardware. It has highly detailed 
information about your processor under the CPU and Caches tabs, such as the CPU brand, socket type, 
speeds and voltage, and the various cache sizes. It also provides key motherboard details under the 
Mainboard tab, and your RAM's complete details under the Memory and SPD tabs, although note that for 
information to appear under the SPD tab you must first select the slot(s) on the motherboard that your RAM 
stick(s) occupy. CPU-Z even provides details about your graphics card under the Graphics tab, as well as 
PCI-E link speeds under the Graphics Interface section of the Mainboard tab. 
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GPU-Z 

 
 
Another highly recommended tool, you can download GPU-Z from the GPU-Z Website. Note that GPU-Z is 
distinct from the CPU-Z utility covered above; it relates to your GPU (Graphics Processing Unit), which is 
typically your graphics card. Run the GPU-Z.exe file, and much like CPU-Z, it will provide you with all the 
information you need to know about your graphics card. Under the main Graphics Card tab you will see all 
the specifications for your graphics hardware, including the amount and type of Video RAM, the level of 
Direct X support, the BIOS version and the clock speeds. Under the Sensors tab you will find your current 
clock speeds, temperatures, fan speed and so forth. Finally, note that the Validation tab is there only if you 
want to submit your specs to the GPU-Z Statistics Database, which is not essential. 
 

HD TUNE 

 
 
HD Tune is a tool for quickly gaining an insight into your drive details and current capabilities. The free 
(non-Pro) version has sufficient functionality to provide important drive details including a list of supported 
features, the drive standard, firmware version, serial number, as well as the current temperature of the drive 
and the health of the drive. It even includes a benchmark, which is covered under the Benchmarking & 
Stress Testing chapter. 
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There are many other system information tools which are available, some of which are not free. However a 
combination of the tools in this section should be more than enough to give you all the details you need for 
every aspect of the hardware that is in your PC. I strongly encourage you to make sure that you are fully 
aware of your hardware specifications and capabilities, as incorrect knowledge can cause major problems 
when you try to install drivers or make changes in software or the BIOS for example. Also make sure you are 
familiar with the contents of the Basic PC Terminology chapter in this book. 
 
 PROVIDING SYSTEM SPECIFICATIONS 

If you ever require technical assistance for a computer-related problem, you will inevitably have to provide 
your system specifications. Whether to a qualified technical support person, or for computer enthusiasts on 
an online forum, you should provide your specifications in an appropriate format. Simply copying the entire 
contents of a DXDiag text file for example might be quick and easy, but few people have the patience to 
wade through it, so I recommend using the format shown below unless instructed otherwise. 
 
Also bear in mind that no-one can magically solve a problem simply by looking at your system 
specifications, no matter how detailed. There is no real substitute for becoming extremely familiar with your 
own system, for a range of reasons beyond simply troubleshooting problems. 
 
Use several of the system information tools covered above to fill in the appropriate details in the categories 
shown below. The more detail you can provide, the better - the bare minimum is the brand and model 
number of your major components, but you should add in details like whether any of the components are 
overclocked or physically modified in any way. I have filled in some sample information from my own 
system in italics: 
 

CPU:  Intel Core i7 920 CPU @ 2.66GHz, stock speed, stock cooling 
Motherboard:     Asus P6T Deluxe X58 

Graphics card: Leadtek Nvidia GeForce GTX 285 1GB, stock speed 
Monitor: 24" Samsung 2443BW LCD 

Sound Card:     Onboard ADI AD2000B HD Audio Chipset 
RAM:      6GB (3 x 2GB) G.Skill 1333MHz DDR3 

Storage Drive(s):     Western Digital 150GB VelociRaptor SATA2 
Western Digital 74GB Raptor SATA 

Optical Drive(s):     Pioneer DVD-RW 216BK SATA 
Power Supply:      Seasonic 700W M12 

Operating System: Windows XP SP3, including latest Windows Updates 
Other Details: 257.21 Nvidia Forceware graphics driver 

6.10.0002.6585 SoundMax HD Audio sound driver 
System not overclocked, not physically modified 

 
You can also provide details of your other hardware, such as the keyboard, mouse, speakers/headphones 
and case, however these are usually not critical to solving most PC problems, at least not in the first instance. 
 
 
I must stress again that it is an extremely important element of PC optimization and customization that you 
have more than just a passing acquaintance with your hardware components. Becoming familiar with 
hardware specifications and what they mean not only allows you to discover areas of potential optimization 
on your system and assist with troubleshooting problems, it also gives you the ability to make better 
purchasing decisions when buying a system or upgrading any hardware components in the future. 
 
You should also become familiar with the Windows Errors and Benchmark & Stress Testing chapters of this 
book, as they provide important details on how you can go about resolving many common problems on 
your own PC. 
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BACKUP & RECOVERY 
 
 
Computers can store a great deal of valuable information. Over time your PC may come to hold a lot of 
important, private, irreplaceable data such as digital photographs, home movies, financial documents, 
emails, bookmarks and login details. It is of critical importance that you establish an appropriate method for 
regularly backing up this information, so that if your PC is stolen, damaged, or its data is corrupted or 
accidentally overwritten, that you do not lose all this valuable data permanently. Hence backing up is a vital 
and unavoidable part of sensible computing. 
 
This chapter not only covers various backup strategies and tools, it also details a range of useful data 
recovery methods you can use to regain valuable information which has been lost through forgetting 
passwords, accidental deletion of files, data corruption or damage to your Windows installation. You should 
have at least one backup copy of all your important and irreplaceable data proceeding any further with this 
book. If you already have a recent backup of all your important data, you can skip this chapter and return to 
it at a later point. 
 
 
 MANUAL BACKUP 

The most basic and reliable method of backing up your system is to do things manually. There are methods 
that can be used to create automated backups of your system which are covered further below, however I 
personally use the manual method regularly to ensure I have a 'clean' backup copy of all my important files, 
especially if I am going to do a reinstallation of Windows. Any automated backup utility you use may 
inevitably backup the problematic or sub-optimal settings you were trying to escape in the first place, so a 
clean manual backup of your data is strongly recommended, especially if you are experiencing problems. 
 
How precisely you do a manual backup is up to you; below are my tips for preparing data and manually 
backing up your important files regularly: 
 
Logical Directory Structure: Create a logical directory structure under your 'My Documents' folder, with 
appropriately-named sub-folders, e.g. Music, Videos, Pictures, Patches, Downloaded Programs, Drivers, 
Personal Documents, Tax - as many as necessary.  Note that you can rename the default directories such as 
'My Pictures' or 'My Music' to Pictures or Music - right click on each folder and rename it. Now sort all your 
relevant documents into these directories. You might also want to keep copies of downloaded programs, a 
copy of all the latest patches and drivers and so forth for quick usage during Windows reinstallation, but 
these are optional. Alternatively, if you have a separate data partition or drive, store your files there in 
appropriately named folders. Having a logical file structure makes storing and finding files easier, but 
importantly it also makes regular manual backups much easier to perform. 
 
Internet Bookmarks: In Internet Explorer you can create a backup file of your Favorites by going to File 
menu>Import and Export>Export Favorites. Follow the prompts to export your Favorites to a suitable 
location under the default name Bookmark.htm. Back this file up, and to import your Favorites back into 
Internet Explorer at any time go back to the Import and Export function and choose 'Import Favorites'. If you 
use a browser like Mozilla Firefox, you can backup your bookmarks by going to the Bookmarks menu, 
selecting 'Organize Bookmarks', then clicking the 'Import and Backup' button and choosing either the 
Backup or 'Export HTML' options. 
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Program Directories: Don't attempt to backup an entire program or game directory, as you cannot 
restore/reinstall a game or program in this manner - these will not run properly if they are copied back onto 
another installation of XP due to the lack of appropriate registry entries and files spread throughout various 
other directories. You must use the original installation files/discs to reinstall a program or game correctly. 
 
Saved Games: If you want to backup any saved games or game configuration files, these are typically held 
under the game's main directory, in a \Saves, \Savegames, or \[profilename] directory, or held under 
\Documents and Settings\[username]\ in the \My Documents, \My Games or \[gamename] directory. If you are 
having problems with a game, backing up its saved games should still be fine, but I don't recommend 
backing up any of the game's configuration files as it may just pass the problem onto your new install.  
 
Usernames/Passwords: You can store all your usernames and passwords securely electronically - see the 
Backing Up & Restoring System Passwords section further below. If you have no interest in electronic 
storage systems then compile a written list/printout of the major usernames and passwords on your system. 
However you must then store this list safely in a physically secure place like a safe, and keep in mind that 
any time you write down or store your passwords in unencrypted format in any location you are facing a 
security risk if it falls into the wrong hands, particularly if you share your PC with other users. 
 
Backup to Disk or Drive: Once you have determined the files to backup, you should regularly backup your 
important files/programs to another medium, such as another hard drive, a USB flash drive, or to DVDs. I 
certainly don't recommend backing up your files to another partition on your main system drive. I 
recommend rewriteable DVDs or a USB flash drive in particular simply because aside from ease of storage, it 
is easier to transfer data to any other PC via these mediums. When selecting which files to regularly back up, 
give top priority to files that are genuinely irreplaceable, such as digital photos and financial documents. 
Anything that has a high sentimental or monetary value should be backed up often, ideally to more than one 
location. Data which changes frequently should also be backed up more often. 
 
 AUTOMATIC BACKUP 

If you want a more comprehensive method of backing up your data that will take up more space but is 
automated, and hence may be more foolproof, then you can use an automated backup tool. Note that if you 
are having any sort of general system problems or quirky behavior, I recommend against using this method 
to backup your data and settings. Any automated tool may capture and transfer the same problems you 
experienced before onto your new install of Windows XP, defeating the entire purpose of doing a fresh 
install of Windows. Only use these methods if you genuinely aren't experiencing any problems and have 
generally trouble-free performance. 
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WINDOWS BACKUP UTILITY 

 
 
You can access the Windows Backup Utility by going to Start>All Programs>Accessories>System 
Tools>Backup, or by going to Start>Run and typing ntbackup and pressing Enter. Windows XP Home users 
will not have access to the Backup utility by default, but it can be manually installed from the Windows XP 
Home CD by following the instructions in this Microsoft Article. Basically it involves inserting the Windows 
XP CD into your drive, opening Windows Explorer, going to the \VALUEADD\MSFT\NTBACKUP\ 
directory on the Windows CD and double-clicking on the Ntbackup.msi file to start installation of it. 
 
The Backup Utility has several methods of usage, which are detailed in this Microsoft Article, but essentially 
it involves the following steps: 
 
1. Run the Backup Utility and click the 'Advanced Mode' link to switch to a more customizable method of 

backing up. 
2. Go to the Backup tab, and put a tick in the boxes next to the directories that you want to back up. 
3. Select the 'System State' box if you want to ensure all the additional system settings relating to your 

setup are backed up as well (i.e. your registry settings etc.). Alternatively, if you don't want to save these 
as well (i.e. you want to restore your backups onto a clean install of Windows), then don't tick the 
'System State' box. 

4. Click the Browse button at the bottom, and select the destination for the backup. This is usually another 
hard drive given the amount of data involved; the Backup utility cannot backup to CDs/DVDs. 

5. Click the 'Start Backup' button to commence backing up. The process may take quite some time 
depending on how many directories you chose to back up, and the type of medium to which they are 
being transferred. 

6. To restore this backup in the future, run the Backup utility again, but this time under 'Advanced Mode' 
click the 'Restore Wizard' button and follow the prompts. 

 
The Windows Backup utility has many more options and methods for backing up, so go through the options 
for configuring the utility under the Tools>Options menu in Backup. 
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THIRD PARTY DRIVE IMAGING SOFTWARE 

There are third party programs available which can provide features similar to the Windows Backup utility. 
The two major software packages for imaging drives quickly and easily are Norton Ghost and Acronis 
TrueImage. However neither is free, so they will not be covered here in any detail - refer to the relevant 
Norton Ghost Manual or the Acronis TrueImage User Guide for more details. The main benefit of these third 
party imaging utilities is that they provide a wider choice of options, and take a full image snapshot of your 
entire Windows installation which can then be restored in full whenever you wish. 
 

ONLINE BACKUP 

Online backup services allow you to back up data to a secure location, typically a remote data center. This 
ensures that your data is encrypted and stored safely, but this not a free service, so it is only recommended if 
you genuinely need that level of protection against data loss or theft. This form of backup is not absolutely 
necessary for the average user, but it provides additional security and peace of mind, particularly in the 
event of fire or theft, whereby your PC and your onsite backups may all be destroyed or stolen, leaving you 
with nothing to rely on for restoring your data. For the average user however there are several ways of using 
free online services to provide added security against such data loss: 
 
ISP Storage: Many Internet Service Providers (ISPs) provide their customers with a basic web space to which 
you can upload personal data. This is a relatively secure and typically free method of storing your data 
offsite - check your ISP's website or contact them directly for further details. Even if a small fee is involved in 
obtaining such a facility, it can be worthwhile given the added protection it provides you as another location 
to store your backups. 
 
Email Storage: Free email services such as Gmail provide extremely large amounts of storage space - in the 
order of several Gigabytes. While I do not recommend uploading/emailing any sensitive data to these 
locations, as they are not completely secure, they do serve as good holding spots for additional backups of 
digital photos and other important irreplaceable files. In fact you can use free utilities such as GSpace or 
Gmail Drive to make storage of data on a Gmail account much easier to manage, though bear in mind that 
Gmail and other free email providers may take steps to prevent this practice if it becomes widespread. 
 
Photo Storage: There are a range of free photo album providers which will allow you to upload and keep a 
large library of digital photos, which is extremely useful as yet another place to store photos which are 
otherwise irreplaceable in case your originals are ever lost. The most popular free photo gallery providers 
are Flickr, Photobucket and Picasa. Make sure to read the instructions for the gallery and enable all the 
privacy features so that members of the public cannot view your gallery contents without your permission. 
Regardless of such features, a direct link to a particular photo can often be publicly discovered, so I do not 
recommend uploading sensitive photos to such galleries. 
 
Ultimately, if you believe your data is worth preserving against all eventualities, or you need to store it with 
maximum security, it is necessary that you consider a professional remote data storage service to hold your 
backups. The free options while convenient do not provide sufficient security against unauthorized access. 
Of course most Windows users do not require this level of protection; regularly taking manual backups and  
keeping a copy of them in a fireproof safe for example is sufficient protection. 
  

http://www.symantec.com/norton/ghost�
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 SYSTEM RESTORE 

 
 
Once the initial backing up of your data and programs is done, and if you are not going to reformat and 
reinstall Windows XP, you need to create a new System Restore point as an additional safeguard before 
doing any tweaking. Using System Restore means that even if you make a large number of system changes 
you can 'undo' these changes if you run into any problems. More details of the System Restore functionality 
can be found in this Microsoft Article. It is strongly recommended that you create a new Restore Point prior 
to implementing any major tweak or system change by following these steps: 
 
1. Go to Start>Programs>Accessories>System Tools and launch System Restore, or open MSConfig 

(Start>Run>MSConfig), and click the 'Launch System Restore' button. 
2. In the System Restore Wizard, click 'Create a Restore Point' and follow the prompts to save your system 

state in a new restore point. 
3. At any time, if you wish to return your computer to the state it was in when you created a particular 

Restore Point, follow step 1 above to get to the System Restore Wizard. Then click 'Restore my computer 
to an earlier time', and select the date on which you created the restore point you wish to return to. 

 
Note that if System Restore is enabled, Windows automatically makes restore points under certain 
circumstances, such as during the installation of new drivers, or prior to the installation of certain 
applications. This gives you additional protection against potentially catastrophic system-intrusive changes 
on your system. However a restore point is not a guarantee that you can just go back to the way things were 
if something goes wrong. In some cases trying to undo a change by going back to a recent restore point 
won't resolve a problem, so only use System Restore as an additional layer of protection - you should always 
make backups of your important data often, regardless of whether you use System Restore or not. System 
Restore does not backup personal files or folders, it is only a tool to capture the current state of important 
system files and settings, so it is not a general backup utility. 
 
If your system is currently stable and problem-free, and you have made a recent restore point, you can clean 
out all older restore points except for the latest one by using the Disk Cleanup utility, thus freeing up a great 
deal of drive space - see the Cleaning Windows chapter. Finally, note that System Restore will not function if 
you've disabled the 'System Restore' service - see the Services chapter for details. 
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 BACKING UP THE WINDOWS REGISTRY 

The Windows Registry is a critical component of Windows, and any problems you experience with it can 
make Windows unbootable, or result in a variety of errors or strange behavior - see the Windows Registry 
chapter. That is why it is important to have a backup of the registry before undertaking any tweaking or 
system-intrusive changes.  
 

ERUNT 

 
 
The most efficient and foolproof way of backing up the entire registry is not to use the Export function in 
Registry Editor - that method is only handy for saving individual branches of the Registry. Unfortunately 
full Registry backups made by Registry Editor will not restore your entire registry correctly if it becomes 
corrupted. Instead, I strongly recommend you use a free utility called Erunt (Emergency Recovery Utility for 
NT). Download this small program and install it, but note that during the installation of Erunt you should 
answer 'No' when asked if you want Erunt to be placed in the startup folder, as this is unnecessary. 
 
To make a backup of the Windows Registry using Erunt, launch the program. You will be prompted to 
backup your registry to a folder, which you should accept by clicking Ok until the backup has been made. If 
you want to restore this backup at any point, simply go to the directory where the backup was made - 
typically \Windows\ERDNT\[Date of backup]\ - and launch the ERDNT.exe file there to restore that backup. 
 
 BACKING UP & RESTORING PASSWORDS 

One of the biggest headaches when running Windows would be losing your main login password, 
particularly if you're the Administrator on your machine. With the NTFS file system it is quite difficult to 
access the data on your system drive without the correct login password. Clearly the best thing to do is 
backup your password now before anything happens, so that if necessary you can restore it without any 
difficulties. If you don't use a password to login to Windows then you can skip these instructions. 
 
The recommended way to backup your login password is as follows: 
 

BACKING UP LOGIN PASSWORD 

1. Go to Control Panel>User Accounts and click on your User Account. 
2. Click on 'Create a Password Reset Disk' in the left pane. The Forgotten Password Wizard will open up. 

Click Next. 
3. Insert a blank formatted 3.5" floppy disk into your A:\ drive or attach a USB flash drive and click Next. 

If you need to format the drive first, insert the floppy disk or USB drive, open Windows Explorer, right-
click on the relevant drive letter and select Format. 

4. Type your current User Password in the box and click Next. Once the backup has been created, click 
Next and select Finish. Store this disk/stick somewhere safe, as anyone can use it to access your account. 
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Note that some people may use any old 3.5" floppy disk they find to backup their password and often these 
disks are quite old. A floppy disk has an error-free life of 10 years on average, so I urge you to buy a small 
USB flash drive just for this purpose. 
 

RESTORING LOGIN PASSWORD 

If you ever need to restore your password from the backup created above, follow these steps: 
 
1. Boot your PC as normal, and on the Windows Login screen select your User Name.  
2. Try entering your password (or just press Enter), and if it's incorrect you'll get a message saying the 

Username or Password is incorrect. Click OK and then select 'Reset Password', inserting the password 
reset disk or USB flash drive you created earlier. 

3. Follow the Password Reset Wizard to set a new password and log back into your system. 
 
Note that the password reset disk needs to be write-enabled so that Windows can update it with the new 
password automatically during this procedure. When done, you should once again put it away in a 
physically secure place. 
 

RESETTING YOUR LOGIN PASSWORD  

There is a method by which you can get to your data in case you've lost your main Admin login password. 
The utilities and methods are covered on this Offline NT Password & Registry Editor site. The site provides a 
bootdisk image which when used to boot up your PC will provide an option to unlock user accounts that 
would otherwise be inaccessible. It is a method of last resort, since it can actually corrupt data if used 
incorrectly, or if your files have been EFS encrypted for example. Read the instructions on the site carefully, 
and use with caution. 
 

STORING PASSWORDS 

 
 
If you want to hold all your various usernames and passwords in a relatively straightforward central 
database protected by high level encryption, which also provides the ability to securely export and store the 
database for backup purposes, use the free KeePass Password Safe utility. There is both a Classic Edition and 
a newer version available to download. The differences in features are spelled out in this table, but for the 
most part all the functionality required, in addition to portability and smaller footprint, can be found in the 
Classic Edition (ZIP Package) version of this software, which is the one I recommend and describe below. 
 
To use KeePass, launch KeePass.exe and select New under the File menu, then enter a Master Password 
and/or select a Key File. These measures are used to secure the password list, and while the key file is not 
essential, make sure to enter a master password which has a high bit-rate by using a combination of letters 
both lowercase and uppercase, as well as numbers, and not just a common word or name. This master 

http://pogostick.net/~pnh/ntpasswd/�
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password is a critical component - if you forget it, there is no way to unlock your password list. Once the 
database is created, you can populate it. The database is sorted by groups, which are simply categories of 
passwords. You can right-click in the left pane and add new groups, add sub-groups under the existing 
groups, or remove any group or sub-group as you wish. Highlight the group which you believe your 
username/password combination is best stored under, and in the right pane right-click and select 'Add 
Entry' to create a new entry containing your username and password combination for a particular Windows 
feature, other software, or a website. Do this as many times as required to populate the database with all the 
username and password combinations you wish to store. 
 
You can backup this password database to any location you wish by using the 'Export To' feature under the 
File menu. I strongly recommend exporting the database as a KeePass Database .KDB file. This database can 
then be stored or backed up wherever you wish, and its contents can only be successfully viewed by using 
KeePass to open the file and entering the correct master password. Because the database is encrypted, it is 
virtually impossible to access the database contents without the right password/key file. 
 

RECOVERING PASSWORDS 

 
 
If you haven't stored your passwords and you've managed to forget or lose a username/password, there are 
several utilities you can use to recover various passwords currently stored on your system. To recover 
passwords in Internet Explorer, MSN or for your Outlook Express accounts you can use the Protected 
Storage PassView Utility. If you have forgotten a password which is now only visible as a series of ****'s in a 
password dialog box or on a website, you can try using Revelation or Asterisk Key to show you the actual 
password being used. Finally, you can use RockXP to retrieve a series of passwords and keys on your 
Windows installation that are usually hidden. 
 
Detailed usage instructions for these utilities are not provided as they are relatively straightforward to use. 
The presence of these tools also lets you see that nothing is completely safe on your machine, so it is 
important to always restrict physical access to your machine only to trusted individuals, and always follow 
the tips in the PC Security chapter. 
 
 FILE DELETION AND RECOVERY 

Accidental deletion of files is one of the most common ways in which files are lost. By default Windows XP 
has minimal protection against accidental deletion; as noted earlier in this chapter, System Restore does not 
protect or backup personal files and folders. Aside from leaving the Recycle Bin enabled and making sure 
that files are moved there when deleted, there isn't a great deal of protection against unintended permanent 
deletion of files. Fortunately, when you delete a file from your system the file is removed from view and you 
regain the space on your drive, however it is not actually permanently deleted from the drive. In fact, 
nothing on your drive is permanently removed when you delete it. Whenever you delete a file Windows 
simply marks it for deletion by changing one character in the file table. The entire file is still sitting on your 
drive, but is not visible. Windows then allows other files to write over the space where it resides if required, 
but the file is not gone from your drive until it is completely overwritten at some point. This means that you 
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can recover files that have been 'permanently' deleted, but you need to act quickly and will require special 
software to do so. 
 

RECOVERING DELETED FILES 

There are several tools you can use to potentially recover your deleted files: 
 

 
 
Recuva: To use Recuva, after installing it you can simply follow the wizard which appears. For more options, 
click the 'Switch to advanced mode' button in the main Recuva window, or disable and exit the wizard at 
startup. Essentially once you specify the particular drive to scan, or all available drives if you so wish, you 
then specify the file type you're looking for - whether by using the drop-down list, or entering a portion of 
the filename (or leave the box blank for all files), and then click the Scan button. One of the benefits of 
Recuva is that it provides a preview of the recovered files wherever possible, making it easier to determine 
which may be the suitable one to restore. Another benefit is that Recuva can find and restore deleted emails. 
If nothing is found after a basic scan, you can opt for an in-depth scan if prompted, or click the Options 
button and under the Actions tab tick the 'Deep Scan' box and scan again, but bear in mind this could take 
quite a while. 
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Restoration: To use Restoration first download the file and run it to extract the contents to an empty directory, 
preferably on a USB flash drive or another drive. Then run the Restoration.exe file and either enter a filename 
in the search box, or a file extension (e.g. JPG, DOC, TXT), or leave the box blank (to find all recoverable 
deleted files) and click the 'Search Deleted Files' button. Restoration will scan your drive for files which can 
be restored and list them. Once done, you can highlight a file and click 'Restore by Copying' to recover it.  
 

 
 
IsoBuster: If you want to recover deleted or damaged files on a CD or DVD disc, you will have to use a more 
specialized utility such as IsoBuster. While it can be downloaded for free, IsoBuster requires purchase for 
full functionality. However you can use the free version to first check to see if there is any recoverable data 
on your particular disc. There is no guarantee that any usable data can be recovered from a damaged or 
deleted disc - particularly if it has been overwritten. 
 
Regardless of which tool you use, the more activity there is on the medium where the deleted files reside, the 
less chance you can fully recover them, since portions of them may have been overwritten by new data. This 
is why the files recovered by any tool are often not complete since portions of them have already been 
overwritten, so there is no guarantee you can recover a usable file this way. For this reason, if you have 
accidentally deleted an important file, try and minimize any further activity before running a data recovery 
utility. If you can't run a recovery utility straight away it is best to shut down Windows immediately to 
prevent a background task from commencing as these will potentially overwrite the areas where deleted file 
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portions are sitting. Furthermore it is best to install on and run a recovery utility from another drive, again to 
prevent overwriting data on the drive where the deleted files reside. 
 

PERMANENTLY DELETING FILES 

As you may have noticed, it is entirely possible to recover some or all of a file after it has been 'permanently' 
deleted in Windows. If you ever want to truly permanently delete a file so that others can't recover it in any 
practical sense, you can use the Recuva, Restoration or CCleaner programs to do this - see the Cleaning 
Windows chapter for CCleaner details. 
 
To securely permanently delete a file, first delete the file as normal in Windows - i.e. highlight it in Windows 
Explorer, press Delete, then empty the Recycle Bin.  
 
Next, if using Recuva, launch it and do a scan for that filename (or all files) as normal, and it should show up 
in the list of recoverable files. Right-click on the file and select 'Secure Overwrite Highlighted'. This will 
overwrite all areas of that file with data such that it can't be recovered. If you want to adjust how secure the 
overwriting is, click the Options button and under the General tab, select the desired level of overwriting for 
the 'Secure overwriting' option; the more passes the more secure it will be. 
 
If using Restoration, then launch it and enter the name of the file (or leave blank for all files) and click 'Search 
Deleted Files'. When Restoration finds the file and lists it, highlight the file and go to the Others file menu in 
Restoration and select 'Delete Completely'. 
 
These methods will permanently delete a file so that it is effectively unrecoverable by virtually any program 
or method. However there always remains the possibility that the file may still be recoverable by law 
enforcement agencies using specialized methods, although it is highly unlikely that anyone could recover 
the bulk of this data regardless of the methods used. 
 

LOW LEVEL FORMAT AND ZERO FILL 

People might suggest that you Low Level Format your drive to permanently remove data or fix a drive 
problem. This is not recommended unless you are experiencing severe hard drive problems, and even then it 
is not possible on most modern hard drives due to the complexity involved. Modern hard drives are low-
level formatted at the factory to create tracks and sectors and do not need to have it done again. The correct 
course of action is to Zero Fill your drive, which people often confuse for a low-level format. This method 
overwrites the entire hard drive with blank data, ensuring that everything is deleted permanently for most 
intents and purposes, but it is not as intensive or potentially disk-damaging as a low-level format. A zero fill 
is your best bet in getting back to a 'good as new' hard drive.  
 
A quick and easy way to zero fill a hard drive and error check it at the same time is to use the built-in 
formatting functionality of Windows itself to do a full format. If however you insist on low level formatting 
a hard drive and/or using a custom diagnostic program to error check it and ensure that it is wiped 
absolutely clean, then check your hard drive make and model and consult your manufacturer's website for 
an appropriate utility such as: Seagate DiskWizard & SeaTools for both Seagate and Maxtor drives, Western 
Digital Data LifeGuard, or Hitachi Drive Fitness. If you are using an SSD, you will need to use a custom 
utility to erase the drive, which should be available from your SSD manufacturer's website. 
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 SYSTEM RECOVERY 

This section covers methods of recovering data and/or control of Windows after a major system error. Also 
refer to the Windows Errors chapter for more details of troubleshooting Windows errors which could be the 
source of such problems. 
 

RECOVERING FROM A CORRUPTED REGISTRY 

 
 
After any changes you make to Windows XP, if your system is crashing and you are having major problems 
booting into Windows, it is typically because the Windows Registry contains incorrect or corrupted settings. 
If you can't boot into Windows to use System Restore or Erunt to restore your system or registry, follow one 
of the steps below: 
 
 During bootup, keep pressing the F8 key and you'll soon see a range of options, including 'Load last 

good configuration'. Select it and your computer should boot into Windows hopefully devoid of the 
recent changes you made which have caused problems. 

 If you have a recent Restore Point, but can't boot to the Windows desktop for some reason, keep pressing 
F8 during bootup, but this time choose the option to 'Boot into Safe Mode' (See further below). In Safe 
Mode you can access System Restore by going to Start>Run, typing MSconfig and pressing Enter, then 
clicking the 'Launch System Restore' button. 

 Alternatively you can press F8 repeatedly at bootup once again, and this time select to boot into 'Safe 
Mode with Command Prompt', and at the command prompt which opens type 
\Windows\System32\Restore\rstrui.exe then press Enter to open System Restore. 

 
For more details on how to recover from a corrupted registry, see this Microsoft Article. 
 

SAFE MODE 

Safe Mode is an important Windows mode which only loads up the bare essentials required for Windows XP 
to function. Third party drivers, graphical enhancements, startup programs, unnecessary processes etc. are 
all skipped and only the minimum required to display and use Windows and access your drives is provided. 
Safe Mode is provided precisely for troubleshooting purposes and not for general usage. The idea is that by 
reducing the number of software variables involved it is easier to identify the cause of a problem. You can 
read the full details of Safe Mode options in this Microsoft Article. To access Safe Mode do the following: 
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1. Make sure there are no discs in your optical drive(s) and reboot your PC. 
2. As your PC starts booting up keep pressing the F8 key and you will soon reach the Windows Advanced 

Options menu where you can see a range of options, each described in detail in the article linked above. 
3. Select the safe mode option you prefer - for most purposes I recommend the default 'Safe Mode' option 

which loads the least number of device drivers. 
4. You will reach the Windows Desktop which will be shown at low resolution, low color bit-depth and 

with no graphical enhancements. The words 'Safe Mode' will appear around the edges of the screen to 
inform you that you are running a cut-down version of Windows XP. Note: if you cannot enter Safe 
Mode, this is the sign of a more serious problem, and you will need to see the Recovery Console section 
further below. 

 
The main use for Safe Mode is to determine whether your device drivers or installed software are the source 
of a problem you are currently experiencing. Because Safe Mode does not load any of your installed third 
party device drivers - instead using the default versions built into Windows XP - and because Safe Mode 
does not load up any unnecessary startup programs or services, this gives you the opportunity to determine 
whether your installed applications or one (or more) of your startup programs is causing problems. 
 
If you couldn't boot into Windows XP normally, but you can in Safe Mode for example, that is a clear sign 
that one of your recently installed driver(s) or application(s) is the likely cause of the problem. You can 
choose to remove recent software or drivers completely by going to Control Panel>Add/Remove Programs 
and uninstalling them from there. Alternatively you can experiment by using MSConfig or Autoruns (See 
the Startup Programs chapter) to temporarily disable suspected startup items, drivers and/or services (by 
unticking them) and try to reboot normally into Windows to see if this resolves your problem. 
 
If you made a change to a system setting or the Windows Registry that would normally prevent you from 
booting into Windows, you can undo the setting in Safe Mode, or revert to an earlier Restore Point, or restore 
a Registry backup here. 
 
If however you find that you cannot boot into Safe Mode, or are having similar problems in Safe Mode as 
you are in normal Windows - for example your graphics are garbled or show glitches - then the problem is 
most likely hardware-based such as overclocking, excess heat, permanent damage to a component/faulty 
component(s), related to an incorrect BIOS setting or incompatibility, or hard drive corruption which 
requires use of the Recovery Console to fix. 
 
Finally, a major use for Safe Mode is the removal of malicious software such as viruses or spyware, or for 
any other type of file which Windows says is 'in use' during normal Windows. Many of these will load into 
memory areas that cannot be unloaded during normal Windows XP operation. However in Safe Mode there 
are no such protected memory areas, and no additional startup programs, drivers or services are loaded with 
Windows, so this is the best way of removing such troublesome software. Enter Safe Mode and either  
manually enter Windows Explorer and delete the troublesome file(s); edit your startup items or Services to 
remove unusual or harmful entries (See the Startup Programs and Services chapters); or run several malware 
scanners in Safe Mode to find and remove any malicious software (See the PC Security chapter). 
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RECOVERY CONSOLE 

The Recovery Console is an important repair and recovery tool built into Windows XP that allows you to do 
such things as check for faults on your drive and repair the Master Boot Records. You can read the full 
description of the Recovery Console, as well as its available commands and options in this Microsoft Article.  
The main use for the Recovery Console is when other methods of data recovery or troubleshooting have 
failed, and you simply cannot boot into Windows, even in Safe Mode. 
 

 
 
The quickest way to access the Recovery Console is to do the following: 
 
1. Insert your Windows XP CD into your main optical drive. 
2. Reboot and go into your BIOS. Set the 'First Boot Device' (or similar) option in the BIOS to your optical 

drive and reboot. 
3. As your PC starts booting up, keep pressing the F8 key until you see the message 'Booting from 

CDROM'. If this doesn't work, you should use a Windows XP Bootdisk instead (See the Installing 
Windows chapter). 

4. The blue Windows Setup screen will eventually appear.  
5. If you are running a SATA or RAID drive configuration, make sure to press F6 repeatedly when 

prompted during the loading of Windows Startup, and have your SATA/RAID driver disk handy; if 
these drivers are not loaded up the recovery console will not be able to identify your SATA/RAID hard 
drive(s) properly and/or will mistakenly identify them as corrupt volumes when they are not. 

6. Once in Windows Setup, press R to access the Recovery Console. 
7. If prompted, press a number that corresponds with your Windows installation - the default is 1. Enter 

your Admin password if required, or leave blank if you haven't set an Admin password for Windows 
XP, and press Enter. Note, if you cannot access your hard drive using the Recovery Console due to an 
incorrect Admin password, try the utility covered under the Resetting your Login Password section 
further above. 

8. Once the Recovery Console opens, there are a range of commands you can use. Just type Help and press 
Enter, and a list of commands will be shown. To see the options for each command in more detail, type 
the command followed by a blank space and then /?. A full list of command line commands can be 
found in this Microsoft Article. 

 
The most common methods of attempting to repair a Windows installation in the Recovery Console are: 
 
 Use the Chkdsk /R command to do a drive check and fix any errors if possible. If chkdsk says the drive 

is unreadable or there are too many errors, make sure that if you have a SATA/RAID setup, you loaded 
the appropriate SATA/RAID drivers from a disk or drive during Windows Setup loadup. If you're using 
the correct drivers and still see this error, it is likely your drive is actually corrupted or it may even be 
physically faulty. 

 Use the Listsvc command to list all current services and drivers and their startup status. Use the 
Didsable or Enable commands to enable or disable particular services which you think are related to 
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the problem. For example, Enable RPCSS Service_Boot_Start tells windows to set the RPCSS service 
to start at Windows Bootup, in case you had accidentally disabled this vital service in Windows. 

 Use the Fixboot command to repair the boot sector of the drive. 
 Use the Fixmbr command to repair the Master Boot Record of the drive. 
 
If you find the drive still doesn't boot up into Windows after all these steps, you may just have to return to 
the Recovery Console, and use the CD and Copy commands to go to various locations on the drive and either 
copy across data to the faulty drive to replace a missing or corrupted file for example, or from the faulty 
drive to another drive to back up data before a reformat. 
 
Although the Recovery Console is a very useful tool, it still may not resolve some hard drive errors or 
problems. In such cases you can try using a Repair Install of Windows which if successful should fix your 
Windows without any data loss. Chances are that if the Recovery Console or a Repair Install don't work, 
either you have faulty hardware which is corrupting the data as it's being written (e.g. overclocked or faulty 
CPU or RAM), or your drive has simply experienced too much corruption and/or has too many bad sectors 
to recover your Windows; you will simply have to try reformatting your drive and reinstalling Windows. 
 

SYSTEM FILE CHECKER 

 
 
The System File Checker is another built-in function of Windows XP that allows the system to go through 
and check all the major protected Windows XP system files against the original versions stored on a valid 
Microsoft Windows XP CD. This is extremely handy if you suspect corrupted/tampered system files that are 
leading to unusual Windows behavior. Full usage instructions for the System File Checker can found in this 
Microsoft Article. To access the System File Checker follow this procedure: 
 
1. Go to Start>Run and type SFC /scannow then press Enter to start an immediate scan of your system 

files. 
2. The System File Checker will go through all your important system files and make sure they have not 

been altered in any way. Where major system files are corrupted or shown to be different from original, 
they will be replaced with the originals from your \Windows\System32\Dllcache\ directory and/or your 
Windows XP CD. 

3. If prompted, reboot your PC as required. 
 
Note that instead of /scannow you can use the switches /scanonce (to scan after the next reboot) or 
/scanboot (to scan on every reboot). If you use /scanboot and then want to stop a scan after every reboot, 
use the /revert switch. 
 
 
The methods covered above are the most common and practical ways of both backing up your important 
information, as well as recovering from data damage or loss. Get in the habit of backing up regularly if you 
don't already as that is the only guarantee you have of retaining your valuable information. 
 

http://www.webtree.ca/windowsxp/repair_xp.htm#How%20to%20Repair%20Windows%20XP%20by%20Installing%20Over%20top%20of%20Existing%20Setup:�
http://support.microsoft.com/kb/310747�
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BIOS OPTIMIZATION 
 
 
Before delving any further into Windows optimization or customization, it is very important to first ensure 
that your hardware and connected devices are correctly configured for optimal operation. Regardless of any 
changes you make in Windows or your software, if your hardware is not configured properly its capabilities 
will not be correctly utilized, indeed serious problems such as random crashes or data corruption may occur. 
Whether you've built a PC or purchased a pre-built machine, you should make certain that all of the settings 
in the BIOS are correct, that the hardware is properly cooled, and that all of your devices are configured to 
function optimally in Windows. This chapter covers all of these topics in detail. 
 
Note that this chapter does not provide information on how to select and purchase a PC from new, however 
if you are interested in that type of information, see my Hardware Confusion article for general guidance. 
 
 
 THE BIOS 

 
 
The BIOS (Basic Input/Output System) is a program held on a small ROM chip on your motherboard. It 
provides the instructions for what your PC should do as soon as it turns on. Your BIOS is independent of 
your Operating System, which means it is not directly affected by the operating system you use, or which 
driver version you've installed, or what your settings are in Windows for example. The BIOS supersedes all 
of that, and your drivers and operating system will only load after the BIOS has loaded up. The BIOS 
controls a range of hardware-related features and is the middle-man between your CPU and other devices. 
 
If there is an incorrect setting in your BIOS - that is, a setting which is not optimal or correct for your 
hardware configuration - then you will have problems regardless of which setting you change in Windows, 
or which driver versions you install. Importantly, the BIOS is best configured correctly before installing 
Windows, as this reduces the number of unnecessary services and drivers which Windows may install, and 
helps reduce the potential for device conflicts. 
 
Note that some of the latest motherboards may have a different type of BIOS-like interface called UEFI 
(Unified Extensible Firmware Interface). UEFI is a new form of software interface between your hardware 
and the Operating System. While UEFI brings with it a range of changes as covered in this Intel Article, in 

http://www.tweakguides.com/Hardcon09_1.html�
http://en.wikipedia.org/wiki/BIOS�
http://www.uefi.org/about/�
http://community.edc.intel.com/t5/New-to-Intel-Architecture-Blog/Ask-a-BIOS-Guy-quot-Why-UEFI-quot/ba-p/2781�


 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 47 Copyright © 2010 Koroush Ghazi 

 

B
IO

S
 O

ptim
ization 

practice you will still need to configure all your hardware settings in much the same way as a BIOS, so the 
information in this chapter still applies in much the same way. 
 

POST SCREEN 

 
 
As your BIOS starts to load, the first thing it does is the Power-On Self Test (POST), a diagnostic program 
which quickly checks your components and makes sure everything is present and working OK. The POST 
sequence is usually extremely fast; you will only really notice it if it stops when encountering an error. POST 
error messages can be a bit obscure, but usually give you a lead as to where to look in your BIOS settings. A 
quick general guide to what the startup error beeps may mean is this POST Error Codes, but a more accurate 
description specific to your hardware is usually found in your motherboard's manual. 
 
If you have no initial POST errors you will then see your PC's startup screen, which shows such information 
as your BIOS type (e.g. American Megatrends), the key to press to access your BIOS settings (e.g. DEL, F1 or 
ESC), the type of processor and its speed, RAM amount and RAM test results, drive information, and so 
forth. Note that if any of this information is incorrect, it may be that your hardware is extremely new and 
hence not recognized correctly by the current BIOS version; you've overclocked your PC too far; or you have 
bad hardware or incorrect BIOS settings. 
 

BIOS SETTINGS 

To access the detailed settings in your BIOS, you typically need to press a particular key (e.g. the Delete key) 
repeatedly as your system is booting up - check your motherboard manual. If your BIOS also has a password 
then you'll need to enter it first to access your BIOS settings; if you've forgotten the password, then try this 
BIOS Password Site. Once in your BIOS screen you will see a multitude of settings. The layout of the BIOS, 
and the names of the various settings vary greatly depending on the particular motherboard brand and 
model you own, so I cannot possibly cover them all here. The best reference source is this Definitive BIOS 
Optimization Guide - scroll down that page to find the 'Free Access' link to the guide. It covers all the 
common BIOS settings, and combined with your motherboard's manual and Google, you can understand 
what all of your BIOS settings do and thus undertake the very important task of optimizing your BIOS 
before doing any Windows tweaking. 
 
I cannot stress the importance of making sure all the major settings in your BIOS are correct for your 
particular hardware setup and importantly that you've disabled all unnecessary devices and options. It may 
take some time and some research, but it ensures maximum performance and stability. No amount of 
Windows customization can overcome a badly set up BIOS. 
  

http://en.wikipedia.org/wiki/Power-on_self-test�
http://www.computerhope.com/beep.htm�
http://www.topbits.com/reset-bios-password.html�
http://www.techarp.com/show.aspx?fileID=18�
http://www.techarp.com/show.aspx?fileID=18�
http://www.techarp.com/show.aspx?fileID=18�
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BIOS UPDATES 

The BIOS is written on a rewriteable ROM chip, which means that it can be updated (or 'flashed') with new 
information. Motherboard manufacturers release new BIOS versions that can improve performance, stability 
and compatibility, add new features or modify existing features, and fix known bugs. These new BIOS 
versions are available for download on the manufacturer's website. I can't list all the manufacturer websites 
here, as there are far too many, however if you have a look through your motherboard manual you should 
see a link to the appropriate website. Download the latest BIOS for your exact motherboard brand and 
model number and follow the instructions on the site to Flash (reprogram) the BIOS chip on your 
motherboard with this new BIOS version. A word of warning: flashing the BIOS is not to be taken lightly. If 
something does go wrong then your PC may not boot up and you may have to take your motherboard to a 
dealer to have the BIOS chip replaced or reprogrammed. While this is rare, when updating your BIOS make 
sure you follow the instructions provided to the letter. 
 
Note that most modern motherboards allow flashing the BIOS from a CD, DVD or USB flash drive, so 
installing a floppy disk drive on your PC is no longer necessary. If using a floppy disk, do a full format of it 
first and make absolutely certain it is error-free before using it for the purposes of a BIOS flash. 
 

FIRMWARE UPDATES 

Your motherboard is not the only device which has a BIOS. Many components, indeed most major electronic 
equipment like TVs, DVD players and mobile phones have their own inbuilt BIOS chips. The software on 
these chips is typically referred to as Firmware, and all firmware can be updated using the correct 
equipment and software. This firmware can usually be upgraded in much the same way as flashing your 
BIOS - check your hardware manufacturer's website for recent versions of the BIOS/firmware you require, 
and any specific instructions or software necessary. The most common firmware updates are for optical 
drives. If you want to find out more about these updates, check your hardware manufacturer's website, and 
see this Firmware Database in particular for optical drives. A firmware upgrade can help resolve problems 
like difficulties reading from a particular disc type, 'disc not detected' errors, and other issues. Just like BIOS 
flashing it involves an element of risk, so please read any instructions carefully before proceeding. 
 
 
The motherboard BIOS is a critical component of the PC which is often overlooked, so I urge you to take the 
time to become more familiar with your own BIOS, and to configure it correctly. Of course if you are not 
sure what a setting in the BIOS does, do not change it from its default. If necessary check your hardware 
manufacturer's website for more details, or do a thorough search on Google. It might be tedious at first, but 
it's typically a once-only job - once you've done it, you don't need to go back and customize the BIOS settings 
again, you can reap the benefits of an optimal BIOS from that point onward. 
  

http://en.wikipedia.org/wiki/Firmware�
http://files.rpc1.org/�
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 INTERRUPT REQUESTS (IRQS) 

 
 
An important aspect of the way the BIOS manages your hardware is through Interrupt Requests (IRQs) - 
these are the way in which all of your major system devices get the CPU's attention for 
instructions/interaction as often as necessary. There are usually 16 - 24 main hardware IRQs in a modern PC. 
To view your current IRQ allocation go to Control Panel>System>Hardware>Device Manager and under the 
View menu select 'View Resources by Type', then expand the 'Interrupt Request' item. You will see all the 
devices currently active on your PC arranged by IRQ number, starting at 0 [System Timer]. Each IRQ has a 
priority assigned to it as to which gets the CPU's attention first when several are competing at once. While 
Windows XP is designed to allow several devices to share an IRQ, you may have problems or reduced 
performance if two or more major devices (such as the sound card and graphics card) share the same IRQ. 
To minimize IRQ sharing, try the tips below. 
 

DISABLE UNUSED DEVICES 

Under Windows XP, as this Microsoft Article explains, ACPI (Advanced Configuration and Power Interface) 
compliant systems - which is all modern PCs - will have their IRQs automatically allocated by Windows 
upon installation. Even if you can manually assign them in the BIOS, Windows XP typically reassigns them 
back to the default IRQs it has chosen. This default assignment of the IRQs is done when Windows XP is first 
installed, and eight IRQs (IRQs 0, 1, 2, 6, 8, 9, 13 and 14) are automatically reserved for critical system devices 
on all PCs and cannot be altered. 
 
The best way to ensure that you are less likely to end up with shared IRQs (and potential problems) is to 
disable any unused devices in the BIOS before installing Windows XP. Some examples of common devices 
that can be disabled are: 
 
 Serial Port1 (COM1) 
 Serial Port2 (COM2) 
 Parallel Port (LPT1) 
 Unused IDE Channels 
 Unused SATA Channels 
 RAID options 
 Onboard Audio 
 Onboard Video 
 Game Port 
 Midi Port 
  

http://en.wikipedia.org/wiki/Interrupt_request�
http://support.microsoft.com/kb/314068�
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Disabling unused devices not only frees up unreserved IRQs and reduces the chances of sharing, it can also 
speed up bootup time noticeably because Windows won't wait to detect them or load up drivers for these 
devices. Clearly if you already have, or plan to have, a piece of hardware connected to any of these Ports, or 
need to use a particular device, then you should not disable them. For example if you have one or more IDE-
based drives which connect to an IDE channel, then you cannot disable that IDE channel and expect the 
drives to work. You can always re-enable these devices in the BIOS at any time, so this is by no means a 
permanent disabling of particular devices. However for optimal results you should only disable devices in 
the BIOS that you are certain will not be utilized during your normal Windows usage. 
 

MOVE CONFLICTING DEVICES 

If you are using an existing installation of Windows XP you can attempt to reduce IRQ sharing by physically 
moving a device. Note however that on certain motherboards particular IRQs are shared by default and 
cannot be changed. For example on many systems the USB Host Controller (for USB peripherals) is often on 
an IRQ shared by another fixed system device, such as your Serial ATA Controller - this is unavoidable and 
usually does not result in any problems. In such cases where you feel there may be a conflict or reduced 
performance, your only course of action is to physically move one of the items to another location on your 
system if possible. For example, if your sound card is sharing an IRQ with your graphics card, physically 
shift the sound card from one PCI or PCI-E slot to another free one; if the USB Host Controller is sharing 
with another device, avoid using the particular USB hub that controller relates to. If neither of the shared 
devices can be physically moved then you will have to accept the situation. Remember that Windows can 
share IRQs without major problems in most cases, so you shouldn't automatically assume that a shared IRQ 
is the source of any problems. 
 

DISABLING ACPI 

If the above methods do not work, there is one final method of reallocating IRQs short of reinstalling 
Windows. Since ACPI is one of the reasons why Windows XP automatically allocates IRQs, if you disable 
ACPI you can manually allocate and rearrange IRQs and hence remove any IRQ sharing. I strongly 
recommend that you do not disable ACPI, as the side effects can be much worse than any potential problems 
IRQ sharing could cause. ACPI is there for a reason - disabling it can effectively destabilize your system and 
cause your components not to function correctly. The instructions provided below are for the sake of 
completeness, and for the truly desperate or the very curious: 
 
1. Backup all your important data before attempting this procedure as it is highly risky. 
2. Go into your Control Panel>System>Hardware>Device Manager and under the Computer component, 

double-click on the 'ACPI Uniprocessor PC' (or similar ACPI) device. 
3. Click the 'Update Driver' button, then select 'Install from a list or specified location'. 
4. Select 'Don't search. I will choose the hardware to install' 
5. Untick the 'Show compatible hardware' box, and in the list below click on the 'Standard PC' option and 

select Next. 
6. The non-ACPI drivers will be installed and you will need to reboot your machine, perhaps several times, 

to redetect all your hardware components. Make sure to disable any ACPI options in your BIOS. 
7. You can now use any BIOS options available to manually assign IRQs to particular devices. Note that it 

depends on your particular BIOS as to how much flexibility you have in assigning IRQs to all the devices 
on your system; disabling ACPI doesn't suddenly add any new BIOS options. 

 
Disabling ACPI may cause a lot of problems, and you may not be able to return to using ACPI unless you 
reformat and reinstall Windows XP completely.  
 
If after all of the above procedures you still have major difficulties which you feel are attributable to IRQ 
sharing, you will have to simply reformat/reinstall Windows XP - making sure to first correctly configure 
your BIOS and disable all unused devices of course. 
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INSTALLING WINDOWS 
 
 
If you are going to do a full reformat and reinstall of Windows XP on your drive, follow the procedures in 
this chapter to find out more about your options, ensure the correct setup of your drive and achieve an 
optimal installation of Windows. 
 
 
 PRIOR TO INSTALLATION 

Here are some important things you should remember to do before formatting your system drive and 
installing Windows: 
 
1. Scan for viruses and other malicious software - See the PC Security chapter. 
2. Backup your important data and passwords - See the Backup & Recovery chapter. 
3. Download any SATA/RAID drivers required during installation - See the Driver Installation chapter. 
4. Create some Windows XP Bootdisks if necessary - See further below. 
5. Read this Microsoft Article on partitioning and formatting hard drives. 
 
Here's a checklist of things you should have handy for a smooth installation of Windows XP: 
 
 Your original Windows XP CD. 
 Your Windows XP Product ID Number. 
 An earlier Full Version CD of Windows if you are using a Windows XP Upgrade Edition CD. 
 Your Windows XP Bootdisks if necessary. 
 A disk or USB flash drive containing a copy of the latest drivers and Service Pack 3 (SP3) - we want to 

minimize Internet usage immediately after installation, so it's best to have all the relevant core software 
ready to install on a separate disk or drive. See the Driver Installation chapter for a list of all the major 
drivers and software needed. 

 Any drivers which have to be installed during the Windows installation process - e.g. some 
motherboards require a floppy disk or drive with SATA and/or RAID drivers to be used during the XP 
installation process in order to detect your drive(s) or RAID array correctly. Check your motherboard 
package for such disks, or download the drivers from your motherboard manufacturer's website and 
copy them onto a floppy or USB drive. Note that if you're having problems with your nForce 
SATA/RAID drivers during installation, you can fix this using nLite (see below) along with these 
instructions. 

 Your motherboard manual, a printout of relevant portions of this book, and any other associated articles 
or guides below which you may need. Again since it's not recommended that you connect to the Internet 
immediately after installing XP for security reasons, ideally you should have offline copies. 

 All your backups as well as any applications and games on disk or flash drive. Also make sure to have 
software serial numbers or registration details handy. 

 Pen and paper for recording passwords, registration numbers or other important information. 
 
Once you've gathered as much of this material as possible around you, familiarize yourself with all the 
information below before beginning the actual formatting and installation process. 
  

http://support.microsoft.com/kb/313348�
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THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 52 Copyright © 2010 Koroush Ghazi 

 

Installing W
indow

s 

SLIPSTREAMING WINDOWS XP SP3 

If you own an older Windows XP CD that does not contain the latest Service Pack 3 (See the Driver 
Installation chapter) already built into it, you can create a new Windows XP Installation CD that neatly 
incorporates all the files from SP3 using a process called 'Slipstreaming'. When a slipstreamed XP CD is used 
for installation it automatically installs SP3 along with the rest of Windows XP, and hence you won't need to 
run SP3 separately after installation, nor do you need to worry about any outdated drivers/files being 
installed on your system first, or any SP3 installation or cleanup problems. It's a detailed process, but 
relatively straightforward if you use nLite (see below). However using a slipstreamed CD for installing 
Windows XP SP3 is not vital, and won't make any performance difference, so if you don't feel comfortable 
doing it you can skip this step. Note that you shouldn't slipstream XP SP3 from within a newer version of 
Windows as this may result in installation problems due to a bug. 
 

NLITE 

 
 
nLite is a free utility for customizing Windows XP prior to installation. It allows you to select the 
component(s) you wish to remove from Windows, as well as things you would like to add, such as SP3 or 
SATA/RAID drivers. Once you have integrated the relevant components and removed the components you 
don't need, nLite generates an .ISO file which you can burn onto CD and use as your Windows installation 
disk. 
 
I recommend installing Windows XP as normal, then manually installing or uninstalling the relevant 
components normally. This is the only way to guarantee that things work as intended - in particular I 
recommend against removing core Windows components like Internet Explorer or Windows Media Player, 
as you may need them in the future. Don't fall into the trap of thinking that it's cool to strip out virtually 
every component of Windows and replace it with a third-party alternative - often times the Windows 
version of an application is not only required, it is actually the best method of viewing particular content. As 
such, while nLite is a very handy utility and well worth downloading and investigating, I strongly 
recommend that you use it only to add various components to your Windows XP installation disk, rather 
than for removing components. In any case nLite won't be covered in detail here as the user interface is quite 
intuitive, and if you need additional help check the nLite Forums. 
  

http://www.nliteos.com/�
http://www.msfn.org/board/nLite-f89.html�
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 PREPARING THE DRIVE(S) 

Before commencing the formatting of your drive to prepare it for Windows XP installation, read through the 
details below on the various options available to you when formatting a drive. Take the time to research this 
aspect of Windows installation carefully. 
 

NTFS VS. FAT 32 FILE SYSTEMS 

During the formatting of a drive, you will be asked whether you want to use the NTFS (NT File System) or 
FAT32 (File Allocation Table) File System for the drive. This is an important choice and the answer generally 
depends on your requirements: 
 
Use FAT32 if 
 Your drive is smaller than 32GB. 
 You want to install more than one operating system on your computer, aside from newer versions of 

Windows. 
 You want maximum compatibility. 
 
Use NTFS if 
 Your drive is larger than 32GB and you are running only one operating system on your computer. 
 You want enhanced file security. 
 You need better disk compression. 
 
For more details of the differences read this FAT & NTFS File Systems Article. Essentially NTFS is a newer, 
more stable and much more secure file system that has several benefits FAT32 doesn't. For example, if you 
format your hard drive in NTFS and password protect it, it is more difficult to access the information on the 
drive without the correct password (but still possible - see the Backup & Recovery chapter). As for the speed 
difference, for larger drives it is negligible. For more technical details on NTFS, see this NTFS Article. In 
short there is no real reason to format your drive in the older FAT32, unless you have a very small drive 
such as a USB flash drive, and/or want to install more than one Operating System on it - particularly an older 
version of Windows. For most everyone NTFS is the recommended file system to use on the system drive. 
 

CONVERTING EXISTING FAT32 DISK TO NTFS 

If you already have a FAT32 drive and don't want to reformat just to use NTFS, you can still convert the 
drive to NTFS using the Windows Convert tool - however note that this may result in a sub-optimal cluster 
size, especially for drives formatted in FAT32 under older versions of Windows. To set an optimal cluster 
size you will have to read this Converting Fat32 to NTFS Guide. 
 
The following is the simple (but not optimal) method of converting an existing Windows XP FAT32 
installation to NTFS: 
 
1. Go to Start>Run and type cmd then press Enter. 
2. In the Command Prompt which opens, type Convert C: /FS:NTFS and press Enter. Substitute the 

correct drive letter in place of C: above if it is different. 
3. Enter the name of your drive when prompted. If you don't know the name of the drive, type Vol 

[driveletter] (e.g. Vol C:) to find it out. 
4. Reply Y to each of the prompts. Reboot if prompted. 
 
This will take some time to complete, so leave your system alone until the process is finished. 
  

http://aumha.org/win5/a/ntfs.htm�
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MULTIPLE PARTITIONS 

Before formatting a drive you must first Partition it. Partitions are fenced-off portions of a drive, and there 
must be at least one on a drive before it can be used. You can instead create multiple partitions, effectively 
dividing a single drive into several smaller logical drives of varying size, each with their own drive letter. 
There are various advantages and disadvantages to partitioning a drive, but it is important to understand 
that you should never create multiple partitions under the false impression that this improves performance. 
On a hard drive, the first (Primary) partition is always the fastest, and subsequent partitions are not as fast. 
On an SSD, partitioning makes no difference to performance as all partitions can be sought out with equal 
speed. 
 
Partitioning is not a true substitute for having two or more drives, it is most useful as an organizational tool. 
For example one of the major reasons you may wish to create multiple partitions is to allow you to dual boot 
with Windows XP and Windows Vista or Windows 7, as discussed further below. This allows you to run a 
new OS along with XP on the same drive for example, but completely separated from each other. 
 
Keep in mind that using multiple partitions on the same drive for backup purposes is not a good substitute 
for having backups of your important data on another drive. Drives can and do become physically corrupted 
and this affects data on all partitions of a drive, so backing up from one partition to another on the same 
drive is not appropriate as your main backup strategy. 
 
It is ideal to format and partition a drive prior to starting Windows installation, and you can do this either 
using a third party tool or you can use the built-in formatting and partitioning functionality of XP as detailed 
in this Microsoft Article. 
 

DUAL BOOT/MULTIBOOT SYSTEM 

 
 
If you want to set up your system so that each time you bootup you get the choice of two or more Operating 
Systems to use read this Microsoft Article, this Multiboot Configuration article, and this Dual Booting Guide 
for instructions as relevant. You will need to have at least two or more partitions on your current drive 
and/or have two or more drives to be able to multiboot. If dual booting with a newer version of Windows, 
you should boot up into Windows XP first, insert the newer Windows install DVD and run its setup from 
there. This ensures that Vista or 7 will correctly detect your existing Windows XP installation and configure 
the boot menu properly to give you the choice of booting into either OS. Importantly, if you run SATA or 
RAID drives, for Windows to correctly identify all of your drives prior to installation and correctly configure 

http://en.wikipedia.org/wiki/Disk_partitioning�
http://support.microsoft.com/kb/309000�
http://support.microsoft.com/kb/217210�
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the dual boot, you must have appropriate SATA/RAID drivers on a disk or separate drive and insert it 
during the drive identification stage of Windows Setup. 
 
Note that there are no performance benefits in dual or multibooting - it is normally done if you use software 
or a particular feature that only works under another operating system for example. Once again, unless you 
specifically require this functionality I do not recommend a multiboot system as it can make things more 
complex, especially if one drive has errors and prevents you from booting into the other OS for example. 
Dual booting Windows XP with Windows 7 in particular is somewhat redundant, as Windows 7 contains 
Windows XP mode which provides a fully functional and licensed virtual version of Windows XP 
Professional to use. 
 

RAID CONFIGURATION 

 
 
RAID (Redundant Array of Independent Disks) is a common method of configuring multiple drives to 
perform better and/or provide protection against data loss. The various RAID levels are best demonstrated 
in this RAID Article - click the numbers at the top right of the article to see the various RAID levels 
demonstrated graphically, including the common RAID 0, RAID 1, RAID 5, RAID 10 and RAID 0+1 
configurations. 
 
To set up a RAID array you need two or more drives, preferably of the same size and speed, and a 
motherboard with RAID support. You will then need to install the drives as normal and configure the 
appropriate RAID options in your motherboard's BIOS - see your motherboard manual for instructions. If 
your motherboard supports RAID, and most motherboards do, then there is no additional hardware 
required, it is all driven by Windows and the motherboard. Once configured correctly, the RAID 
configuration of multiple drives will be seen as a single drive by Windows, and treated as such. 
 
To determine which RAID configuration best suits your needs if any, you will need to read the articles 
linked above and consider your most common PC tasks. For the average user the most commonly used 
RAID array is a pair of similar drives in RAID 0 formation, which provides the best all-round performance at 
minimal cost. RAID 0 usually beats a single drive configuration in terms of speed, particularly for large file 
movements, due to there being two independent drives seeking data in place of one. However RAID 0 also 
provides absolutely no fault tolerance at all, and in fact doubles the chance for data loss. If one of the drives 
suffers a serious error or is damaged, you lose all the data on both drives since the data is split evenly 
(striped) across both drives. Therefore if you require proper protection against data loss, combined with 
good performance, you should consider a RAID 5 or RAID 10 configuration which is more costly, but far 
safer. 
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While setting up striped RAID arrays - that is, RAID arrays which split data evenly across two or more 
drives (such as RAID 0 or RAID 5), you will need to determine a Stripe Size - the smallest unit of data 
allocation - to be used in your RAID BIOS. In general, if you are uncertain of the size to choose, use the Auto 
setting (if available) or a 64kb stripe. If you use the drives primarily for gaming I suggest a smaller stripe size 
such as 16kb, as this can assist in reducing stuttering in games. 
 
In any case once you have connected your drives and set up your RAID array using the options in the 
motherboard's BIOS, you will need to have a disk or separate drive handy with the correct RAID drivers 
prior to starting the Windows XP installation procedure. Then during Windows Setup, press the F6 key 
repeatedly when prompted at the bottom of the screen, and enter your driver floppy or USB drive when 
prompted again and load up the RAID drivers, along with any other drivers (such as SATA drivers) as 
necessary. If you miss this step, the RAID drives will not be correctly detected by Windows as one large 
drive, and you will not be able to install Windows on them properly or you will break the RAID array and 
lose the benefits of RAID. 
 
Once XP is installed on your RAID drives, from that point onwards there are no special considerations as 
such; the drives are treated as one large normal drive for all intents and purposes in Windows. 
 
 INSTALLING WINDOWS 

At this point you are ready to begin the actual format and installation process, which differs depending on 
whether you're using a brand new/freshly formatted drive as opposed to a drive with an existing installation 
of Windows. See the relevant section below: 
 

NEW DRIVE 

If you have a new or blank formatted drive, the entire procedure for installing Windows XP is relatively 
straightforward. Follow these steps: 
 
1. If it is not already in your system, connect the drive to your system by following the instructions that 

came with the drive. Typically this involves turning off your PC, plugging into the back of the drive 
both a power connector and either a wide IDE ribbon cable, or a thin SATA cable. 

2. Start your system, go into your BIOS and make sure the drive is being detected, whether on one of the 
IDE Channels, or as a SATA device - whichever is relevant to the particular type of drive and channel 
it's connected to. If the drive is not detected at all in the BIOS, you cannot install Windows XP on it. 
Look around the BIOS and make sure you've enabled the channel on which the drive is connected. You 
may have to re-check your drive cabling (i.e. SATA/IDE cable and power cable), and also whether any 
small switches on the back of the drive are set correctly (e.g. the main drive is typically set as the Master 
on the Primary Channel). In some cases (mainly for SATA or SCSI drives and/or RAID configurations) 
you will have to insert a driver disk to load up appropriate SATA/RAID drivers during Windows 
installation, so have those handy if need be and proceed with the next step. 

3. Insert your Windows XP CD into your optical drive, and reboot your system. 
4. Upon rebooting your system, since the drive does not have an operating system installed, the computer 

will skip loading from it and instead will attempt to boot from the next boot device - which should be 
the Windows XP disk in the optical drive - and should lead to the blue Windows Setup screen. If that 
doesn't occur, check your BIOS settings to ensure that firstly the relevant optical drive is being detected 
as present on your system and that any option for 'First Boot Device' or 'Second Boot Device' (or similar) 
is set to your optical drive. 

5. From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or 
Windows XP Home Installation Guide as relevant. These guides cover the procedure in far more detail - 
including screenshots for every step of the way - than I can do here due to space considerations. You 
should ideally have a printout of them handy for use during the installation. 

  

http://www.pcguide.com/ref/hdd/perf/raid/concepts/perfStripe-c.html�
http://www.theeldergeek.com/xp_pro_install_-_graphic.htm�
http://www.theeldergeek.com/xp_home_install_-_graphic.htm�
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DRIVE WITH EXISTING INSTALL OF WINDOWS 

If you have a drive with a current installation of any version of Windows on it, follow the steps below to 
begin a reformat and subsequent installation of Windows XP. Note you shouldn't just install Windows XP 
over an existing installation of Windows - start afresh with a full reformat of your drive and a fresh 
installation of Windows XP otherwise you will get sub-optimal results and experience problems: 
 
1. Insert your Windows XP CD into your optical drive. 
2. Reboot and go straight into your BIOS settings. Set the 'First Boot Device' (or similar) option in the BIOS 

to your optical drive. Reboot your system. 
3. As your PC starts booting up keep pressing the F8 key repeatedly until you see a message saying 

'Booting from CDROM' (or similar). 
4. The blue Windows Setup screen will eventually appear.  
5. From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or 

Windows XP Home Installation Guide as relevant. 
6. Make sure that you choose to format the drive and do a clean installation of Windows XP. Again, do not 

install Windows XP over an older version of Windows as an 'upgrade' installation (not to be confused 
with the Windows XP Upgrade Edition which is fine) - start with a new installation of Windows XP. 

 
WINDOWS XP BOOTDISKS 

If you can't get to the Windows Setup screen using the instructions above, you can download a Windows XP 
Bootdisk image from the Microsoft site for your particular version of Windows XP as covered in this 
Microsoft Article. If you still have problems booting into Windows setup, or you just want an older version 
of a bootdisk, go to this Bootdisk Site to download free copies of various bootdisks. 
 

http://www.theeldergeek.com/xp_pro_install_-_graphic.htm�
http://www.theeldergeek.com/xp_home_install_-_graphic.htm�
http://support.microsoft.com/kb/Q310994�
http://www.bootdisk.com/�
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WINDOWS PRODUCT ACTIVATION & 
WINDOWS GENUINE ADVANTAGE 

 
 
 WINDOWS PRODUCT ACTIVATION 

One of the first things you will notice after installing Windows XP is the Windows Product Activation 
(WPA) notice. Even if you skip Activation at Windows startup and go to the Windows Desktop, a popup 
balloon in the System Tray area tells you that you have 30 days left to activate Windows XP, and when you 
click on it, provides various options for activation. Windows Product Activation is a protection system 
Microsoft uses to ensure that Windows piracy is reduced. If you're interested in how Activation works and 
what parameters it checks on your system read this detailed Windows Product Activation Guide, and you 
can also download this Technical Details of Activation document. 
 
Ideally if you've just installed Windows XP I recommend that you don't change any of your hardware - aside 
from attaching some peripherals. For performance and stability reasons major hardware changes (e.g. those 
involving your CPU, motherboard or graphics card) are best made prior to XP installation. If you are aware 
that your hardware setup may undergo some further changes shortly, it is recommended that you don't 
activate Windows XP right away. You have 30 days within which to bed down your final hardware 
configuration. Activating before your hardware setup is finalized could see you having to re-activate 
repeatedly, including having to call Microsoft to complete Activation. 
 
If you are certain that the major hardware components of your system are not going to change soon and/or 
that you are not going to reinstall Windows XP again shortly, then go ahead and activate XP. Otherwise 
ignore the constant nagging Activation gives you and wait until your system configuration is finalized 
before going through with Activation. Microsoft views multiple activations in a very short period of time as 
suspicious - precise details of this are in the links above. Something you can do after you have activated 
Windows XP is to backup your wpa.dbl file, found in the \WINDOWS\system32 directory. This file is the 
Windows Product Activation system file, and should your installation of Windows XP become corrupted 
and you need to attempt a recovery (See the Backup & Recovery chapter), you can use this backup file to 
help in restoring your system. 
 

 
  

http://www.microsoft.com/piracy/mpa.aspx�
http://aumha.org/win5/a/wpa.htm�
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THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 59 Copyright © 2010 Koroush Ghazi 

 

W
PA

 &
 W

G
A
 

 WINDOWS GENUINE ADVANTAGE 

 
 
Microsoft has implemented an additional anti-piracy feature called Windows Genuine Advantage (WGA). 
Any time Windows attempts to connect to Windows Update or download certain Microsoft updates, it may 
be asked to validate itself to make sure it is a legitimate copy. If validation fails, the user cannot download 
updates from Windows Update, and can only download critical security updates through the Microsoft 
Download Center or through the Automatic Update service - see the Control Panel chapter.  
 
If you are having problems with WGA on a legitimate installation of Windows, visit the Windows Genuine 
Advantage Diagnostic Site to run through a set of diagnostic procedures which can help fix the issue. In 
particular, if you use Firefox as your main browser, Microsoft has released a Firefox plugin to allow WGA to 
work on this popular browser. 
 
Please note I will not provide any information on how to view or change your Windows Product Key, or 
how to bypass Windows Product Activation or Windows Genuine Advantage. If you experience problems 
with these particular features on a legitimate installation of Windows XP, the only correct course of action is 
to contact Microsoft Technical Support for your particular country. 
 

http://www.microsoft.com/genuine/ProgramInfo.aspx?displaylang=en&tab=XP�
http://www.microsoft.com/downloads/en/resultsForCategory.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://www.microsoft.com/downloads/en/resultsForCategory.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://www.microsoft.com/downloads/en/resultsForCategory.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/downloads/Validate.aspx�
http://www.microsoft.com/worldwide/�
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DRIVER INSTALLATION 
 
 
Device drivers are the software which give instructions to your system on how to deal with particular 
hardware. Graphics drivers for example tell your graphics card what to do in various situations, such as 
during 3D applications and games, as well as translating information to and from your CPU. While 
Windows XP comes with built-in driver support for virtually any type of common computer hardware, and 
hence most of your hardware will operate in Windows even without installing additional drivers, the built-
in drivers are neither optimal, nor do they guarantee stability or full compatibility under certain situations, 
especially for newer hardware. Thus, you need to download and install the latest device drivers for your 
hardware to make sure your entire system performs optimally and with stability. 
 
The instructions below cover both the initial installation order of drivers on a fresh install of Windows, as 
well as being a list of which drivers and core software to install on an existing installation of Windows XP. 
The chapter also contains some general tips to clarify which types of drivers should be installed and why. 
 
 
 DRIVER INSTALLATION 

The first thing you should do with a fresh installation of Windows XP is to install the core system software 
and drivers that are vital in helping to run XP optimally. Installing these prior to anything else, and in the 
correct order, is key to reducing the chance of any problems and also ensuring peak performance. 
 
Note that during installation of these drivers, if you are prompted to reboot at any time, you must do so to 
allow proper driver installation. The reason for this is that some driver files are currently loaded into 
memory areas that are used by the system and protected from being overwritten by a different version. Thus 
they cannot be replaced without Windows first marking them for replacement, rebooting to remove them 
from memory, and subsequently replacing them with the newer version upon successful loadup of 
Windows. Therefore whenever Windows asks you to reboot after installing any driver or application, you 
should do so as soon as possible. 
 
If starting with a fresh installation of Windows, I recommend you download the following updates and 
drivers in advance of reformatting and reinstalling Windows XP as for security reasons you should try to 
minimize your Internet usage at this point. If you have a permanent connection to the Internet and it is 
already enabled straight after installing XP, first follow the procedure in Step 8 further below to turn on the 
built-in Windows XP Firewall before following the rest of these steps. If you are using nLite (See the 
Installing Windows chapter), make sure to read this chapter and download the latest versions of all the 
relevant drivers below, however if you've installed XP using an nLite install disk with integrated drivers, 
you don't need to follow these steps again. 
 
The initial core software installation process is provided below in order of first to last, starting immediately 
after you've installed Windows XP. If you're using an existing installation of XP, you should still follow these 
steps, installing/updating the relevant drivers which you may have missed previously. 
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STEP 1 - SERVICE PACKS 

Install the full version of Windows XP Service Pack 3 (SP3). A Service Pack is a compilation of important 
security, stability and performance updates for Windows, and SP3 is the latest and final Service Pack for 
Windows XP, containing every major Windows update released up to April 2008. You can read about the 
updates and types of changes it contains here. SP3 also contains all the fixes contained in SP1 and SP2, 
though note that you can install SP3 on an XP system which already has SP1 or SP2. However SP3 can't be 
installed directly on an original pre-SP1 copy of Windows XP - you need to either install SP1 first; use an 
original Windows XP SP1 or SP2 CD to install XP; or use a Slipstreamed XP + SP3 install CD. 
 
You can download and install SP3 via Windows Update, or download and use the full standalone SP3 
package from here: Windows XP SP3. The full standalone version is recommended as it is the least 
problematic method of applying the Service Pack. Obviously if you used a Windows XP CD which already 
has SP3 incorporated into it to install Windows, such as a Slipstreamed XP + SP3 CD you've created with 
nLite as covered in the Windows Installation chapter, then you don't need to undertake this step as all the 
relevant SP3 files were automatically installed along with Windows XP. 
 

STEP 2 - DIRECTX 

Install the latest version of DirectX from here: Microsoft DirectX. DirectX is already built into Windows XP, 
but you will need to install the latest version of it to ensure maximum performance, security and 
compatibility with the latest programs and games. In fact many recent games come with the latest build of 
DirectX on their installation disc, so check to see if that is the case and save yourself the extra download.  
 
Note that DirectX 10 and DirectX 11 are versions of DirectX designed solely for Windows Vista and 
Windows 7 and are not compatible with Windows XP, so any program or game which requires DirectX 10 or  
11 can only be run under Windows Vista or Windows 7. Fortunately most games and 3D applications do not 
require DX 10 or DX 11 and can run in DX9 mode on Windows XP. 
 

STEP 3 - DRIVER SIGNING & WINDOWS UPDATE 

 
 
Driver Signing is meant to ensure that the drivers being installed are verified as being authentic and are 
certified to work with Windows XP. However in practice, almost all unsigned drivers are perfectly fine to 
use, as long as you have downloaded them directly from your hardware manufacturer's website, or from 
another trusted source. Prior to installing any other drivers go to Start>Control Panel>System>Hardware and 
click on the 'Driver Signing' button. In the Driver Signing Options screen make sure 'Warn - Prompt me each 
time to choose an action' is selected so that unsigned drivers are not automatically blocked, and you will be 
asked to choose whether to install them. Then tick the 'Make this action the system default' box and click OK. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=68c48dad-bc34-40be-8d85-6bb4f56f5110&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=5b33b5a8-5e76-401f-be08-1e1555d4f3d4&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=2DA43D38-DB71-4C1B-BC6A-9B6652CD92A3&displaylang=en�
http://technet.microsoft.com/en-us/library/bb491036.aspx�
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If you click the 'Windows Update' button under Start>Control Panel>System>Hardware you will see several 
options which determine Windows behavior whenever you connect a new device, or a new device is initially 
detected. To start with I recommend selecting 'Never search Windows Update for drivers' and click OK. This 
is because to start with, you don't want any potentially out-of-date drivers on Windows Update installing on 
your system until you've had the chance to manually install the latest drivers for each major device as per 
the steps below. Once you've followed all the steps up to Step 8, you can then come back and set this option 
to 'Ask me to search Windows Update every time I connect a new device' if desired, or leave it to never 
search if this behavior bothers you. The drivers on Windows Update are generally older than the latest 
versions available from the manufacturers, so manual updating of drivers is necessary, and then only if 
newer drivers are found on Windows Update should you install them. 
 

STEP 4 - MOTHERBOARD DRIVERS 

Install your motherboard drivers. The motherboard is the hardware foundation of your entire system, so 
using the latest drivers for it is important in achieving optimal, trouble-free performance for your entire 
system, as well as providing additional motherboard-specific functionality such as onboard audio, onboard 
network adapter, RAID, and so forth. 
 
Finding all the correct motherboard drivers is not necessarily a straightforward task. To start with, it's 
important to understand that the motherboard chipset type is not the same as the motherboard brand or 
model number. The chipset type is based on the company that manufactures the actual chipset architecture 
used in the motherboard. The motherboard's brand is based on the company that buys this chipset, packages 
it with certain features and sells it under its own brand name with a specific model number. For example, an 
ASUS P6T Deluxe motherboard is manufactured by a company called ASUS, it uses an Intel X58 Express 
chipset and it has the specific model name P6T Deluxe. All of these details are important when determining 
the correct driver to use. A combination of the utilities covered in the System Specifications chapter, along 
with your motherboard manual and Google will give you all of these details about your motherboard. 
 
Your motherboard usually comes with a driver disc which contains the relevant drivers, however these are 
usually well out of date. The first place you should look for the latest version of these drivers is on your 
motherboard manufacturer's website - there are too many to list here, so check your motherboard manual 
for a link. Once at the site, under the Support or Downloads section you will usually find several different 
types of updates for your particular motherboard model. These are broken down by category below: 
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BIOS - These are not drivers, they are BIOS updates for which you should refer to the BIOS Optimization 
chapter for more details. 
Chipset - These are the core drivers which control your motherboard's key functionality. All systems require 
these for optimal performance and functionality. 
IDE, SATA, RAID - These drivers are required for correct operation of your motherboard's drive controllers. 
You may also require these drivers for correct detection of your drives during the installation of Windows - 
see the Installing Windows chapter. 
Video - If you are using your motherboard's onboard or integrated graphics capabilities, then these drivers 
are necessary. If you are using a separate graphics card, these are not necessary. Refer to Step 5 below. 
Audio - If you are using your motherboard's onboard or integrated audio capabilities, then these drivers are 
necessary. If you are using a separate sound card, these are not necessary. Refer to Step 6 below.  
USB - If you are using the USB ports on your motherboard, you may require separate USB drivers for correct 
functionality, although typically this feature is already incorporated into the Chipset driver. 
LAN - If you are using your motherboard's onboard network/Ethernet controller, whether for an Internet 
connection or a connection to a network of computers, then these drivers are necessary. 
 
There may be additional drivers for other specific functionality on your motherboard, but the ones above are 
the most important, particularly the Chipset and IDE/SATA/RAID drivers.  
 
If you're not using a particular function on your motherboard, I strongly recommend disabling it in your 
BIOS as detailed in the BIOS Optimization chapter. This will prevent Windows from automatically detecting 
them and installing drivers for them, and in turn reduces resource usage and speeds up Windows startup. 
 
If there are no appropriate drivers on your motherboard manufacturer's site, or they appear to be fairly old, 
you can download the latest drivers directly from one of the major chipset manufacturers: 
 
 For Intel motherboards, download and install the latest Intel Chipset Software.  

If you also have a RAID or AHCI setup install the Intel Rapid Storage Technology Driver. 
 For Nvidia motherboards, download and install the latest nForce Drivers. 
 For VIA motherboards, download and install the latest VIA Hyperion Drivers. 
 For SiS motherboards, download and install the latest SiS Chipset Software. 
 
Note that some of these drivers may contain a mix of driver components, including chipset, SATA/RAID and 
LAN drivers all in one package. Read the driver notes on the site for more details. 
 
Finally, remember that motherboard chipset drivers are not the same as a motherboard BIOS. The 
motherboard drivers are Windows drivers that control the way the motherboard communicates through its 
various components under Windows, the same as graphics drivers or sound card drivers for example. The 
BIOS on the other hand is not dependent on Windows at all and operates at the machine level to control the 
motherboard's behavior the second your PC starts booting up. See the BIOS Optimization chapter for more 
details. 
  

http://downloadcenter.intel.com/Product_Filter.aspx?ProductID=816�
http://downloadcenter.intel.com/SearchResult.aspx?lang=eng&ProductFamily=Chipsets&ProductLine=Chipset+Software&ProductProduct=Intel%C2%AE+Rapid+Storage+Technology+%28Intel%C2%AE+RST%29�
http://www.nvidia.com/Download/index.aspx�
http://www.via.com.tw/en/support/drivers.jsp�
http://www.sis.com/download/�
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STEP 5 - GRAPHICS DRIVERS 

Install your graphics card video drivers. Just as with motherboards, graphics chipsets are developed by one 
company and then sold to different manufacturers who then package them together with certain features 
and capabilities and market them under their own brand name. The important thing to know is the 
manufacturer of the chipset on which your graphics card is based - for most graphics cards this will be either 
Nvidia or ATI. For example, an EVGA GeForce GTX 285 graphics card uses an Nvidia GeForce 200 series 
chipset, packaged and sold by the company EVGA under its own brand. The chipset is the determinant of 
which driver to use, not the company selling the card. Determine your chipset and model name using the 
utilities in the System Specifications chapter, then download and install the relevant package: 
 
 For Nvidia graphics cards, download and install the latest Forceware Graphics Drivers.  

For details on how to install and set these up correctly read the Nvidia Forceware Tweak Guide. 
 For ATI graphics cards, download and install the latest ATI Catalyst Drivers.  

For details on how to install and set these up correctly read the ATI Catalyst Tweak Guide. 
 For Intel graphics cards, download and install the latest Intel Graphics Drivers. 
 For SiS graphics cards, download and install the latest SiS Graphics Drivers. 
 For S3 graphics cards, download and install the latest S3 Graphics Drivers. 
 For Matrox graphics cards, download and install the latest Matrox Graphics Drivers. 
 For motherboards with onboard graphics, check your motherboard manufacturer's website first (See 

Step 4), then check one of the sites above for Integrated or Onboard Graphics drivers. 
 
Note that unlike motherboards, you do not need to download your graphics drivers from your hardware 
manufacturer's website. Installing the latest 'reference' chipset drivers shown above is the best method as 
they are typically much newer. 
 

STEP 6 - SOUND DRIVERS 

Install your Sound card audio drivers. These vary depending on the brand of the sound card you are 
running. Only the major brands are covered below: 
 
 For Creative sound cards, download and install the latest Creative Audio Drivers. 
 For ASUS sound cards, download and install the latest ASUS Audio Drivers. 
 For Auzentech sound cards, download and install the latest Auzentech Drivers. 
 For Turtle Beach sound cards, download and install the latest Turtle Beach Audio Drivers. 
 For Hercules sound cards, download and install the latest Hercules Audio Drivers. 
 For AOpen sound cards, download and install the latest AOpen Audio Drivers. 
 For motherboards with onboard audio, check your motherboard manufacturer's website first (See Step 

4), then check your onboard audio chipset manufacturer's website such as Realtek. 
 

STEP 7 - PERIPHERAL DRIVERS 

Before installing any peripheral drivers, connect these devices (e.g. Mouse, Printer, Digital Camera) to your 
system and test their functionality. If they appear to work and all the major functions which you would use 
are intact, then do not install a new driver for them. For example, if you connect an optical mouse and it 
appears to have sufficient functionality, do not then install the drivers that come on the disc with the mouse 
or download and install new drivers from the manufacturer's website. The reason for this is that such drivers 
typically need to load into the background at Windows startup and usually add to overall resource usage, 
increase boot times, and quite often don't add anything of real value to the device's function. XP already 
supports the important basic functionality of most major peripherals without the need for additional drivers. 
 
However obviously should your device not function correctly, or a feature that you need to use appears 
disabled, you will then need to install the latest driver for that device. In that case I recommend you go to the 
device manufacturer's website and download the latest available drivers rather than using the older drivers 

http://www.nvidia.com/Download/index.aspx�
http://www.tweakguides.com/NVFORCE_1.html�
http://support.amd.com/us/gpudownload/Pages/index.aspx�
http://www.tweakguides.com/ATICAT_1.html�
http://downloadcenter.intel.com/default.aspx�
http://www.sis.com/download/�
http://www.s3graphics.com/en/drivers/index.aspx�
http://www.matrox.com/graphics/en/support/drivers/�
http://support.creative.com/�
http://support.asus.com/download/download.aspx�
http://www.auzensupport.com/site/download/updates.php�
http://www.turtlebeach.com/support/index.php?View=files�
http://ts.hercules.com/eng/index.php?pg=files_faq�
http://download.aopen.com.tw/Default.aspx�
http://www.realtek.com.tw/downloads/�
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that come on the disk with the device. There are far too many device manufacturers to list here, but the 
website address is usually prominently listed on the device's box and/or in the manual. Where possible 
follow the device installation instructions in the device's manual (or on its website) for the best method of 
installation. Typically this involves connecting the devices to your machine one by one, and when Windows 
detects them and prompts for drivers, insert the appropriate driver disk or point Windows to the directory 
where you have downloaded the latest driver files for the device and continue from there. 
 
If you have an older device which is not compatible with Plug and Play, or a newer device which isn't being 
detected correctly, and there is no appropriate driver to use, see the Add Hardware section under the 
Control Panel chapter for more details of how to manually install such a device. 
 

STEP 8 - FIREWALL, WINDOWS UPDATE & .NET  

 
 
You will need a connection to the Internet for this step. That means your network device must be installed 
and set up correctly - refer to your modem/router/network adapter's documentation as each has unique 
setup procedures and requirements. You must also have your ISP (Internet Service Provider) details handy 
(e.g. username, password, configuration information, etc.). Once you have installed the device, and prior to 
connecting to the internet, you must enable a Firewall. A firewall prevents malicious access to your machine 
via the Internet, and your network device may already have a built-in firewall. However to start with, enable 
the Windows XP Firewall if you're not sure. 
 
To enable the default Windows XP Firewall, which is recommended for most purposes, go to the Windows 
Control Panel, open the Windows Firewall component and on the main screen of the Firewall settings, make 
sure it is set to On. Now you can safely connect to the Internet, but do not visit any other website, nor check 
your email, or download any programs. Go directly to the Windows Update website, either by clicking the 
Windows Update icon in your Start menu, or by going to Internet Explorer>Tools>Windows Update, or by 
clicking this Windows Update link. Once on the Windows Update site, click the 'Custom' link and wait for 
the scan to finish. Note that Windows Update will only work on Internet Explorer by default - it will not 
have full functionality on other browsers - see the Internet Explorer chapter for more details. 
  

http://windowsupdate.microsoft.com/�
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You will notice that after selecting a Custom scan that all the 'High Priority Updates' items have 
automatically been added to your 'Review and install updates' list. It is important that you install all of these 
critical updates for security, stability and compatibility purposes. Under the 'Optional Software' section, you 
should also add any fixes or updates you see which are relevant to the programs or features you use or wish 
to use. Note in particular that certain programs and drivers have a user interface which has been developed 
using Microsoft's .NET Framework. This means that for these drivers to function correctly, you will need to 
install .NET on your machine. You can download and install the latest .NET Framework through Windows 
Update, or download it separately here: .NET Framework Version 4.0. ATI graphics card users in particular 
will find that the ATI Catalyst graphics drivers require .NET for the Catalyst Control Center to work. 
 
Finally, add in all 'Optional Hardware' updates shown, as these are important updates of drivers for the 
hardware on your system. They are all safe to use and should only be available for installation if they are 
newer than the drivers you are currently using for your device(s). You can (and should) install newer 
versions of hardware drivers over these versions if and when they become available in the future. 
 
Once you've added all the relevant updates, click the 'Install Updates' button. It may take quite some time 
for the various updates to download and install depending on your internet connection. Reboot as often as 
prompted. Don't install any other applications or games, and don't browse any other websites yet - go 
straight to the PC Security chapter. 
 
 GENERAL DRIVER INSTALLATION 

THE LATEST DRIVERS 

The drivers installed on your system need to be kept up to date, so regularly check all the sites linked to 
above and make sure you have the latest versions. To check the current driver version on a particular 
component, go to Control Panel>System>Hardware>Device Manager and expand the various categories. For 
each device, right-click on it and select Properties, then under the Driver tab look at the Driver Provider and 
Driver Version details. Alternatively, check the System Specifications chapter for automated system tools 
which can give you this information. 
 
I usually announce major driver releases as soon as they are available on the front page of TweakGuides.com 
so check there regularly for download links and details of the changes in the latest drivers. 
  

http://msdn.microsoft.com/en-us/library/ms973850.aspx�
http://www.microsoft.com/downloads/details.aspx?FamilyID=9cfb2d51-5ff4-4491-b0e5-b386f32c0992�
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UNINSTALLING DRIVERS 

 
 
Before installing any new drivers, always make sure to go to 'Add or Remove Programs' under the Control 
Panel and uninstall any previous drivers for the relevant device, then reboot Windows. Furthermore, you 
can use the Driver Sweeper utility to attempt to remove any remaining traces of particular drivers. Launch 
the utility, tick the driver(s) you wish to remove, click the Analyze button first to see what will be removed. 
Then if you wish to continue, click the Clean button and reboot your PC to make sure all driver files and 
related registry entries are removed. If you really want to remove all possible traces of previous drivers, use 
the Autoruns utility to identify and remove individual driver files which may be resident on your drive after 
uninstallation - see the Startup Programs chapter for more details. 
 
This 'clean install' method ensures that your system is free of any 'driver residue' - leftover components of 
previous driver versions which may cause conflicts with newer drivers. 
 

INSTALLING NON-EXECUTABLE DRIVERS 

Device drivers in .EXE format simply need to be executed to automatically install the drivers. However 
drivers which come as a collection of files in archived format (i.e. .ZIP, .ACE, .TAR, .RAR, .7Z) must have 
their contents extracted (using WinZip, WinRAR or the free 7-Zip), and then follow the steps below to install 
them on your system: 
 
1. Go to Control Panel>System>Hardware>Device Manager, and double click on the device to update. 
2. Go to the Driver tab and click the 'Update Driver' button. 
3. Select 'Install from a list or specific location' then click Next. 
4. Select 'Don't search, I will choose the driver to install' 
5. Click the 'Have Disk' button. 
6. Click on the Browse button and go to the directory where you placed the latest drivers. 
7. Highlight the relevant driver file (usually an .INF file) and click Next to install. 
8. Reboot your system if prompted and upon reboot the device should be using the latest drivers. You can 

check this by checking the driver tab in device manager again (Steps 1 & 2 above).  
 
You can use the above procedure to manually update (or downgrade) any of your device drivers whenever 
you download an archived driver package for any device. 
  

http://www.guru3d.com/index.php?page=driversweeper�
http://www.winzip.com/�
http://www.rarlab.com/�
http://www.7-zip.org/�
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GENERAL DRIVER TIPS 

The following is some general information and advice regarding all device drivers: 
 
Source of Drivers - Only download and use drivers directly from your hardware manufacturer's website, 
Windows Update, or from a reputable and well established third-party source which you know and trust. 
This does not guarantee their stability, but it does help ensure that they do not contain malware. While many 
people think nothing of downloading drivers from file sharing sites for example, you are essentially putting 
your trust in people you don't know, and who may even be infected with malware without knowing it. Then 
of course there are people who are deliberately malicious and will use any opportunity to spread malware 
through drivers. The hardware manufacturer's site should always be your first choice for obtaining drivers. 
 
User Feedback - Be wary of general user feedback on drivers on places like public forums and in blog 
comments. In recent years more and more users have turned to blaming drivers (or Windows itself) for 
various problems on their system, when the problems are often actually the result of factors resulting from 
general user ignorance or lack of system maintenance, such as overclocking, overheating, conflicting 
software, or excessive driver residue. This is particularly true for graphics and audio drivers, with any audio 
or graphics-related problem automatically being attributed to the drivers by the average user, when indeed 
many other factors can cause these issues. User feedback is useful, but should not be the sole or even the 
primary basis for determining which driver to install. 
 
Beta Drivers - Beta drivers are pre-final drivers which carry the risk of causing additional system problems 
because they have not necessarily undergone thorough testing, thus the hardware manufacturer provides no 
support to users of beta drivers. Generally speaking though, beta drivers downloaded directly from your 
hardware manufacturer should be relatively stable and safe to use, but best installed only if you are having 
problems with your current driver and/or only if the release notes and the consensus of user feedback clearly 
indicate that they provide some significant benefit. 
 
Alpha Drivers - Alpha drivers are even less polished than beta drivers and their use can lead to serious 
problems such as major instability and even data loss. They are only recommended for advanced users who 
wish to experiment, or for users who have absolutely no other available option for obtaining a working 
driver for their hardware. Make certain you prepare a full backup before installing an alpha driver. 
 
Leaked Drivers - Leaked drivers may be alpha, beta or final versions, but they have been unofficially released 
to the public, often against the wishes of the hardware manufacturer. They may be modified and/or not 
digitally signed, which only increases the risk that they contain malware and/or may not provide stable 
functionality for your device and result in data loss. As with alpha drivers, I do not recommend using leaked 
drivers unless you have absolutely no other option, and only after making proper backups beforehand. 
Aside from putting your data at risk of being lost, you are also putting your security at risk. 
 
Modified ('modded') Drivers - Current modified drivers do not provide any genuine benefit over the standard 
drivers from your hardware manufacturer. Don't be fooled by promises of large performance gains or magic 
fixes - these are almost always unfounded or exaggerated claims designed to entice people into using the 
driver. The only time I would recommend a modified driver is if they have been .INF modified to allow 
them to be installed and used on hardware they were not originally intended for. This is a simple text file 
modification done primarily to provide drivers for hardware which may otherwise not have frequent driver 
support, such as laptop graphics chipsets. Obviously .INF modification can result in unexpected behavior 
because the driver is being used on hardware it was not designed for, but it may be the only option available 
to people with certain hardware. In all other cases I recommend against using modified drivers for safety 
and stability reasons. If a manufacturer has disabled a particular feature in a driver, it is for a good reason. 
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Drivers are a critical component of the way your hardware interacts with Windows, and have a significant 
impact on performance and stability, so it is best to make sure they are kept up to date, and that you do not 
experiment unnecessarily with them. Regularly refer to the front page of TweakGuides.com for the latest 
news on official driver updates. 
 

http://www.tweakguides.com/�
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PC SECURITY 
 
 
Over the past few years PC security has become a major issue of concern due to the increase in the number 
of ways in which the security of the average home PC user can be compromised. I strongly advise you not to 
take the topic of PC security lightly or ignore it. It is extremely important that you become acquainted with 
the types of threats to the integrity and privacy of your PC, and ways to counter them. In particular 
Windows XP's security features are not as comprehensive as those found in newer versions of Windows, so 
security should be an even greater concern for XP users. 
 
It is incorrect to suggest that only the very careless or novice user will succumb to a security-related problem 
or Malware (malicious software) infestation. Even if you consider yourself an advanced user, you need to 
bear in mind that malware threats these days are becoming increasingly complex and dangerous. In the past 
a malware infestation would usually result in little to no real harm; you'd have to delete a few files or at 
worst reinstall Windows or restore a backup. Now however, malware development and distribution is often 
coordinated by organized crime groups for financial gain, so even a single incidence of malware infestation 
can potentially result in the loss of money, software serial numbers, email account details, and other 
sensitive personal information. Having a carefree attitude towards PC security is a thing of the past. 
 
However I do not advocate bogging your system down with security software that runs in the background, 
slowing things down, triggering software conflicts and crashes. Instead, this chapter explains the various 
types of threats to PC security and provides a range of important tips for maintaining a secure PC, because 
education and awareness are the best defense against malware. We examine the built-in Windows tools and 
some recommended third party software which deal with these threats in a non-intrusive manner with 
virtually no performance impact. 
 
 
 SECURITY THREATS 

There are a wide range of security threats which Windows users face, particularly from various types of 
malicious software. Malware can enter your system and cause problems ranging from the very minor to the 
very serious. Malware can remain hidden for long periods and have subtle effects, or its impact can be 
immediate and blatant. However it is important to understand that malware does not damage your 
computer hardware directly nor does it actually physically 'infect' the hardware. Malware is software-based, 
and its threat is to the integrity of your data, your privacy and your finances.  
 
There are different types of malware and security threats, and the major categories of these are covered 
below: 
 

VIRUSES & WORMS 

Viruses are small programs that load onto your computer without your permission and without your 
knowledge of their real function. They are called viruses because just like a human virus they are designed 
to self-replicate, attaching themselves to normal programs and files and spreading to other computers 
through exchange of these infected files, where they repeat the same process once on the new computer. 
Viruses range from the mischievous to the truly harmful, destroying valuable information through data 
corruption and causing a range of strange system behaviors. 
 
Worms are similar to viruses, however they generally do not attach to other files, they can spread 
independently. 
  

http://en.wikipedia.org/wiki/Malware�
http://en.wikipedia.org/wiki/Computer_virus�
http://en.wikipedia.org/wiki/Computer_worm�
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TROJAN HORSES 

A Trojan, short for Trojan Horse, is a malicious program that is often installed on your system under the 
guise of being another, often useful, program. Trojans differ from viruses in that they are used to provide an  
outside attacker with access to your system. This may be for the purposes of stealing valuable information, 
installing other forms of malware, or using your system as part of an illegal network such as a botnet. 
 

SPYWARE  

Spyware is similar to a Trojan, in that it is software that is usually installed on your system purporting to 
have different functionality, or as a component of a useful program. Spyware does not allow an outside 
attacker to take control of your system, but it does transmit information about you and your system, such as 
your passwords, keystrokes or Internet usage behavior to the distributor of the spyware. 
 

ADWARE 

Adware is similar to spyware, but is not necessarily malicious, as it is mainly used to target online 
advertising or create popup ads or redirect/force your browser to view pages with advertising. However 
again it is usually installed without your full knowledge or permission. Despite it's relatively less malicious 
nature, this software is usually undesirable, breaches your privacy and uses system resources and 
bandwidth for no genuinely useful purpose. 
 

ROOTKITS 

A Rootkit is a form of malware deliberately designed to mask the fact that your machine has been 
compromised and is now open to unauthorized usage by an outside attacker. The rootkit will prevent traces 
of itself or any associated malicious activity from being detected by usual detection methods such as running 
an anti-virus program or examining the Windows Task Manager for unusual processes. At the same time, a 
remote attacker can take advantage of the rootkit to access your machine for malicious purposes. 
 

PHISHING 

 
 
While not a form of malicious software, Phishing is fast becoming a common and significant security threat. 
Typically it involves fooling unsuspecting users into revealing important personal information such as credit 
card numbers or passwords. For example a phishing attempt may involve getting you to click a login link in 
a fake email from your bank, which then takes you to a fraudulent imitation of the user's bank login page, 
whereupon you enter your login details, giving the perpetrator all the details they need to then login to your 
real bank account and rob it. Phishing is not malware as such, since it does not usually involve software 
infection, it uses social engineering techniques instead to trick and defraud its targets. 
  

http://en.wikipedia.org/wiki/Trojan_horse_%28computing%29�
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The categories above are in no way conclusive or all-encompassing. There are many variants and 
combinations of the above security threat categories, and more are emerging every day. Over the past few 
years these types of threats have become ever-more sophisticated, intrusive and malicious. Even relatively 
tech-savvy users face the risk of picking up a serious piece of malware or even accidentally falling prey to 
phishing. It may not happen often, but it only takes one serious security breach to result in financial loss or 
data loss and the subsequent major hassles of having to obtain new credit cards, proving your case to a bank 
or financial institution, changing all your passwords, contacting software manufacturers for new serial 
numbers, and so forth. The people behind the creation of these security threats are making large sums of 
money from doing this, so they have the resources and the incentive to constantly adapt to existing malware 
defenses and innovate new and ever-more-intrusive forms of malware and online scams. 
 
Protecting yourself against these security threats is not as simple as installing lots of malware scanners and 
turning them all on. Aside from draining performance, causing software conflicts and other system issues, 
malware scanners often lag behind in the detection of new security vulnerabilities and exploits. The best 
defense against malware is a combination of correctly configuring Windows features, using appropriate 
third party security software, and most importantly, being educated and vigilant, and understanding your 
own system. This is one of the reasons I urge users to learn about how Windows and their PC works, 
because people who gain an intuitive understanding of the fundamentals stand a much greater chance of 
avoiding a security breach. 
 
The rest of this chapter contains the tools and methods you can use to counter a wide range of security 
threats. 
 
 ESSENTIAL SECURITY SOFTWARE 

While Windows XP has a range of built-in security features, these are completely insufficient on their own to 
protect you against malware. They provide a layer of defense against the most common security threats, but 
much more needs to be done to provide genuinely good security in XP. It is important to have additional 
layers of different types of protection so that even if several defenses are defeated, other layers exist to 
prevent or detect the malware before it does any serious harm. That's where the use of selected third party 
anti-malware scanners is absolutely critical to ensuring that your system is clean of malware and remains so. 
 
In this section I provide detailed configuration advice for the recommended malware scanners which I 
personally use on my system. This will help give you a balance between security and convenience, with 
minimal performance impact. You may notice that I recommend disabling certain real-time protection 
and/or background functionality - this may seem risky at first glance, however there are two very important 
reasons for this: 
 
 Background functionality typically involves constantly scanning your data in an attempt to detect 

patterns which may indicate the presence of malware. This not only uses system resources such as CPU 
and memory, of greater significance is the fact that it can induce stuttering and reduce performance in a 
range of scenarios, particularly during gaming or when running data-intensive applications.  

 Having background scanning/real-time protection functionality active on malware scanners can cause 
software conflicts which can result in the incorrect installation of software, as well as general system 
instability and crashes while running software. This is a known issue which many software developers 
specifically warn against in the documentation for their programs. 

 
I strongly believe that there is no reason to slow down a system with intrusive malware scanning features 
when the best protection comes from a combination of a range of built-in Windows security features, user 
vigilance, and regular manual scans of your system. See the advice throughout this chapter, and the tips at 
the end of this chapter for more details. 
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If you disagree with my security philosophy, particularly if you are a user who feels that the trade-off 
between security and performance should favor security in your own circumstances then ignore my advice 
and use the default settings for each of these software packages. Just keep in mind that installing and 
enabling any malware scanning package on your system does not automatically mean that you are protected 
against malware. There is no simple automated fix to the problem of malware, otherwise it would have been 
defeated by now; instead malware is a bigger problem than ever. This is because prevention is always better 
than any potential cure, and that comes from user education and awareness, not a reliance on a range of 
automated tools. Unfortunately user education requires user effort, whereas the relative ignorance of total 
reliance on automated tools requires minimal user effort, so obviously most users opt for the easy way out. I 
encourage you not to be such a user if you genuinely value your security. 
 
Below is the essential free security software I recommend that you install and use: 
 

MALICIOUS SOFTWARE REMOVAL TOOL 

 
 
To start with, regularly download and use the Malicious Software Removal Tool. This is a free Microsoft tool 
provided monthly through Windows Update, so as long as you keep up to date with Windows Update, it 
will automatically install and run itself when a new version is available. You can also download it from the 
link above and run it manually at any time, if you suspect an infection for example. Once it is downloaded 
and installed you can choose to do a Quick Scan or a Full Scan of your system for the most common viruses - 
a Quick Scan is sufficient if you also use another virus scanner. Note that the Malicious Software Removal 
Tool does not install itself permanently on your system and does not stay resident on your system, it simply 
runs a single scan each time it is downloaded from Windows Update, or if you manually download it and 
use it. 
 
The tool is designed to detect the most common malware threats, but as the tool itself recommends, you will 
need dedicated anti-malware scanning software which can perform regular full scans of your system for a 
wide range of viruses, worms and other types of malware. 
  

http://www.microsoft.com/security/malwareremove/default.aspx�
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MICROSOFT SECURITY ESSENTIALS 

 
 
I personally use and recommend Microsoft Security Essentials (MSE) as a dedicated all-purpose anti-
malware scanner. It is a free and lightweight malware scanner which contains a powerful engine designed to 
scan for viruses, worms, trojans, adware and spyware, as well are other types of security threats. After you 
install MSE, it is recommended that you allow it to download the latest definitions. There are four main tabs 
under the main MSE window, and each is covered below: 
 
Home: Displays your current security status: 
 
 Green - Everything is fine, and MSE is using its recommended settings. 
 Yellow - There may be a problem, usually due to outdated definition file, so you should go to the 

Update tab and allow MSE to update over the Internet. 
 Red - A potential threat has been detected, or you have disabled one or more of the real-time protection 

components. 
 
Seeing a red status indicator simply because you have disabled one of the real-time protection components 
can be misleading, since this does not mean you are at any significant risk as long as you follow the rest of 
the advice in this chapter. However look closely, because if the red status indicator is accompanied by details 
of a potential threat being found, and the red button on the home page says 'Clean computer', then malware 
has been detected. Click the 'Clean computer' button to have MSE undertake the default action for that risk 
type. Remember that the default action for severe and high risk levels is deletion of the suspected infected 
file, so check first before clicking 'Clean computer' -  see Default Actions below. 
 
Also available here are the manual scanning options. You can select from a Quick scan, a Full scan, or a 
Custom scan. The Quick scan is the fastest, going through your important system files, folders and the 
Windows Registry to look for traces of malware. A Full scan goes through all your files and folders looking 
for malware, and hence takes longer and provides greater security. A Custom Scan allows you to select the 
specific drive(s) and/or folder(s) you wish to scan. I recommend running a Custom scan on any file you 
download or consider suspicious at any time. I also recommend running a Full scan at least once a week to 
ensure your system remains free from malware. 
  

http://www.microsoft.com/security_essentials/?mkt=en-us�
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Update: Shows the current version and date for definition files. These files are what allow MSE to more 
accurately detect new malware, so you must keep MSE up to date by regularly clicking the Update button 
here, or by checking Windows Update for updates to MSE. I strongly recommend updating the definitions 
prior to launching a manual scan. 
 
History: Shows any malware detected by MSE, as well as any programs or file types you have manually 
excluded from scanning in MSE. Note that if the 'Allow all users to view the full History results' is not ticked 
in the Advanced section of the Settings tab, each user will not be able to see results from other users, which 
can protect privacy. 
 
Settings: MSE comes with a good default configuration, so beginner users in particular do not need to alter 
anything here. However I provide my recommendations for particular options below: 
 
 Scheduled Scan - The default is a Quick scan 2:00am every Sunday, but I recommend changing this to a 

Full scan instead for greater security. Also make sure the 'Start the scheduled scan only when my 
computer is on but not in use' and the 'Check for the latest virus and spyware definitions before running 
a scheduled scan' boxes are both ticked. 

 Default Actions - The default actions listed are described in detail in this Microsoft Article. The 
'Recommended Action' option is fine for each of these. However if the 'Apply recommended actions' box 
is ticked, MSE will automatically apply its recommended actions to your software - I strongly 
recommend against ticking this box to avoid seeing your software removed without your consent. For 
example, should a false positive occur and it is rated as a Severe risk, MSE will automatically delete the 
particular file(s). Alternatively, you can leave this box ticked, but for the Severe and High alert levels, 
you can change the default action to Quarantine to ensure there is no automatic file/program deletion. 

 Real-time Protection - The options here allow you to determine which types of activities and areas MSE 
constantly monitors in the background to prevent malware from installing or executing on your system. 
The performance impact of having full real-time protection in MSE is minimal, and hence for novice 
users all these options are best left enabled. However for intermediate and advanced users I recommend 
leaving real-time protection enabled, but unticking the 'Scan programs that run on my computer' box, 
leaving the 'Scan downloaded files and attachments' box ticked. This should minimize the potential for 
performance issues and conflicts, because MSE will only scan a file or attachment which is downloaded, 
and will not constantly scan in the background during normal system usage. Note however that this 
setting will cause the MSE status to go red, which is no cause for alarm. 

 Excluded Files and Folders, Excluded File Types - These two sections allow you to specify particular 
files, folders or file types which you don't want MSE to include as part of its scans. It is not 
recommended that you exclude anything from MSE's scans, as this may allow malware to slip past. 
However if you know for certain that a particular file, folder or file type is going to be picked up as a 
false positive (i.e. falsely detected as malware when it is not), then you can include it here. 

 Advanced - There several options here to further customize MSE's behavior. 'Scan archive files' if ticked 
allows MSE to scan inside archived files such as .ZIP, .CAB and .RAR archives - I recommend ticking 
this as malware can easily hide inside such files. 'Scan removable drives', if ticked, scans any removable 
drives such as USB flash drives when they are attached to the system - an extra form of protection, 
however ticking this may cause additional delays when you attach such drives, so untick it if this 
bothers you, but leave it ticked if you often connect removable drives from dubious sources. 'Create a 
system restore point' if ticked does precisely what it says: creates a new restore point for System Restore 
(if enabled) before taking any action against detected malware - I strongly recommend ticking this 
because it allows you to easily undo any system changes MSE makes which are undesirable. 'Allow all 
users to view the full History results' - I recommend ticking this, as it saves you having to click the 'View 
Details' button in the History section of MSE to see full details. You can untick this box if there are 
multiple users and you wish to protect each user's privacy, since infected filenames shown here may be 
something a user doesn't wish to have revealed. 

http://www.microsoft.com/security_essentials/helpTopic.aspx?assetid=24cc0df0-e784-462e-858f-02d093697985�
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 Microsoft SpyNet - MSE uses anonymous information collected from your machine as part of the Basic 
Membership status for Microsoft SpyNet. If you have concerns, see the Privacy Statement for more 
details. It is precisely because of this information from such a large user base that MSE can provide such 
powerful malware detection functionality without resorting to more intrusive measures that other 
scanners do. An example of the type of information collected can be found in this Microsoft Article. If 
you wish to provide more advanced information, including some potentially personally identifiable 
information, select the 'Advanced Membership'. Microsoft has proven in the past that it takes the 
protection of user information very seriously, so the risk to users is not great, but ultimately if privacy is 
a concern, the Basic Membership option is fine. If you still have privacy concerns, then you may wish to 
use another anti-malware package altogether. 

 
Click the 'Save changes' button when finished here. 
 
Note that MSE also installs a new service called 'Microsoft Antimalware Service' (MsMpEng.exe) which is set 
to Automatic, and needs to remain that way for MSE to work properly. MSE also installs a new startup 
program 'Microsoft Security Essentials Interface' (msseces.exe) which triggers the launch of MSE at startup. 
You can disable this item however it will disable all real-time protection features until you manually launch 
MSE in a session, so it is best left to load at startup. Once running, MSE also places an icon in your System 
Tray area which you can click to quickly open MSE at any time. 
 
Microsoft Security Essentials is a powerful anti-malware package which detects a range of malware, not just 
viruses, and provides a good balance between security and convenience. It is extremely tempting to allow 
MSE to replace all the other anti-malware packages on your system. However this is not recommended for a 
single reason: should MSE not detect a piece of malware, or provide what might be a suspected false 
positive, the only way you can be certain is to run a scan using one or more other anti-malware package(s). 
For this reason, I recommend installing at least one dedicated trojan scanner, as well as a dedicated spyware 
scanner on your system, though the background functionality of neither should be enabled. See further 
below for details. 
 
In any case MSE is not the only decent all-round anti-malware package. There is no consensus of opinion 
among security experts as to which particular package is the absolute best, but there are several other 
reputable scanners which you can use instead, though some of them are only free for a trial period, or may 
take quite a bit of work in reining in their intrusiveness: 
 
AVG 
Avast 
Kaspersky 
NOD32 
Trend Micro AV 
  

http://www.microsoft.com/security_essentials/privacy.aspx�
http://blogs.technet.com/mmpc/archive/2009/10/15/microsoft-security-essentials-week-one.aspx�
http://free.avg.com/�
http://www.avast.com/free-antivirus-download�
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http://www.eset.com/download/free-trial/�
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A-SQUARED FREE 

 
 
Trojans differ from viruses in many ways, and are increasingly becoming more of a threat than viruses. 
Some trojans are not detected by all-purpose virus scanners, so you need a dedicated trojan scanner as well, 
if only to provide a second opinion. While Microsoft Security Essentials provides reasonable defense against 
trojans, I strongly advise installing a dedicated trojan scanner. I personally use and recommend A-Squared 
Free - it is one of the best free trojan scanners while also being the least intrusive. The following is 
information on how to set up the recommended A-Squared Free trojan scanner. 
 
After installation of A-Squared Free, as long as you're running it under an Administrator account you can set 
the new 'A-Squared Free Service' it installs to Disabled as it is not needed. If you then have any problems, 
you can set it to Manual if necessary. 
 
On the main Security Status screen, click the 'Update Now' button to allow the program to download all the 
latest updates it requires - I recommend doing this each time before you do a manual scan. Fortunately the 
more intrusive aspects of A-Squared, such as 'Background Guard' background scanning, are not available in 
the free edition, so we do not need to configure/disable them. To set the depth of scanning used, click the 
'Scan PC' option on the left of the main screen, and for normal usage select either Smart Scan or Deep Scan - I 
recommend Deep Scan which is longer but much more thorough. For more control over the scanning, select 
Custom Scan and click the Scan button - you will be taken to a screen which allows you to configure 
individual scanning options. I recommend all options be ticked, with the exception of 'use extension filter' - 
unless you wish to manually exclude or include certain file types. Once you've set your chosen scanning 
method, whenever you want to run a scan using A-Squared, you need only click the 'Scan Now' button on 
the program's main screen. 
 
Note that from time to time A-Squared may find software which it classifies as Riskware, but is not actually 
malware. Such software is not necessarily malicious, it just carries greater risk in usage if your system is 
compromised by malicious software. I recommend investigating cases of Riskware by scanning with other 
malware scanners first, then doing some research on Google. To disable detection of Riskware, go to the 
Scan PC screen, select 'Custom Scan' and you can untick the 'Alert Riskware that is often used by Malware' 
option. 
  

http://www.emsisoft.com/en/software/download/�
http://www.emsisoft.com/en/software/download/�
http://www.emsisoft.com/en/malware/?Riskware�
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A-Squared is best used as follows: 
 
 To run a full scan of your system at least once a week. 
 To run a quick Custom Scan of a particular folder whenever you download a file or save an email 

attachment. 
 To run a full system scan if another malware scanner shows possible infection - this helps provide a 

valuable second opinion. 
 
In most respects A-Squared is ideal because it doesn't use any system resources or need to run in the 
background, so you can launch it whenever it is required and conduct scans when necessary. 
 

SPYBOT SEARCH & DESTROY 

 
 
A spyware/adware scanner will find and remove this common type of malware from your system. Once 
again, Microsoft Security Essentials detects such malware to a reasonable extent. However for even greater 
security you can install and use at least one additional third party spyware/adware scanner. There are two 
main alternatives: Ad-Aware and Spybot Search & Destroy. Both are powerful, and both are nominally free. 
However Spybot is completely free and does not contain any prompts to upgrade to a paid version. 
Furthermore while both require some modification to reduce their intrusiveness, Spybot is much easier to 
configure to remove its intrusive aspects, so on balance I recommend Spybot. The following are my 
recommended settings for Spybot: 
 
The most important configuration options for Spybot actually occur during the installation process. During 
installation of Spybot, you will be given the option to select the components it installs. I strongly recommend 
unticking everything that is available. If you wish to customize Spybot's appearance, the 'Skins to change 
appearance' option can also be ticked, and if you require multiple languages, the 'Additional languages' 
option should also be ticked. Otherwise everything else is unnecessary to the core functionality of Spybot, 
and will only increase its resource usage if selected. 
 
Furthermore, a few steps later in the installation procedure you will be asked to select common tasks for 
Spybot. Under the 'permanent protection' section I strongly recommend unticking the 'Use Internet Explorer 
protection (SDHelper)' option, which is a form of additional protection Spybot integrates into Internet 
Explorer and hence a level of undesirable intrusiveness and a background process which is unnecessary. 
Similarly, the 'Use system settings protection (Tea Timer)' option is a real-time protection functionality 
which always runs in the background if enabled, and as discussed earlier, is not desirable. 

http://www.lavasoft.com/products/ad_aware_free.php�
http://www.safer-networking.org/en/spybotsd/index.html�
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As long as you follow all of the steps above, Spybot will not install any additional services or startup items. 
 
Once Spybot commences, you will be given a message regarding advertisement robots - this is simply a 
warning that if you use Spybot to remove certain advertising features from specific programs, the programs 
may not function correctly. You will then be prompted to backup your registry. You can do this if you wish, 
but it is not necessary and best done later as covered in the Backup & Recovery and Windows Registry 
chapters. Click the green next arrow to skip this step, and click the 'Start using this program' button. 
 
To start with, click the Update button, select an update server closest to you, then I recommend making sure 
that you deselect any updates relating to disabled functionality, like the TeaTimer. Click Download and 
Spybot will update its definitions, then Exit the update box when done. Make sure to update Spybot before 
every manual scan. 
 
To run a full manual scan, click the 'Search & Destroy' button in the left pane, and in the right pane select the 
'Check for problems' button - if necessary click the 'Hide permanently' button to remove the tips box and 
allow you to see the list of potential problems found. If problem(s) are found and listed, you can highlight a 
particular item and select the 'Fix selected problem' button - red entries are relatively important spyware 
issues that should be fixed, while green problems are less harmful, although they can be fixed if desired. 
Check the additional information and/or search Google if you aren't certain. If anything is removed and later 
you wish to undo the change, you can click the Recovery item in the left pane. 
 
To access the advanced and more detailed settings in Spybot, under the Mode menu select 'Advanced mode', 
however there are too many settings to cover here, and for most users there is no need to alter them unless 
you have specific requirements. Furthermore, I do not recommend the Immunize function, which attempts 
to block certain sites using your Hosts file. This function has caused conflicts and false positives in the past, 
and is unnecessary. 
 
Spybot is best used as follows: 
 
 To run a full scan of your system at least once a week. 
 To run a full system scan if another malware scanner shows possible infection - this helps provide a 

valuable second opinion. 
 Conversely, make sure to run another malware scanner if Spybot detects a problem, because spyware 

and adware detection can often exaggerate or misreport the level of potential threat. 
 
Importantly there are a wide range of spyware, adware and other malware scanners which purport to 
remove malicious software, but ironically contain malware themselves, or are bad knock-offs of good 
scanners. Consult the lists below if you plan on installing any malware scanners other than the ones 
recommended in this book: 
 
Spyware Warrior Suspect List 
2-Spyware Corrupt List 
 
Also conduct a thorough Google search to read user feedback and as many reviews as you can find on your 
chosen anti-malware package, as there are far too many new packages coming onto the market which are not 
just useless and intrusive, but deliberately malicious or designed to hold your system hostage with dubious 
reports of malware infection and then constantly prompt you to purchase the paid version to remove such 
non-existent infections. In other words a great deal of alleged anti-malware software is now being created 
with exactly the same aims as malware itself: for financial gain through malicious or fraudulent means.  
  

http://www.spywarewarrior.com/rogue_anti-spyware.htm#products�
http://www.2-spyware.com/corrupt-anti-spyware�
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ROOTKITS 

A Rootkit is similar to a virus or trojan horse, but is specifically designed to mask its presence on your PC to 
make it easier for an intruder to secretly access your machine and conduct malicious activity. The problem 
with a rootkit is that it is specifically designed not to be detected, and actively works to remove telltale signs 
of itself so that most scanners cannot see it. There are however specific tools being designed to find and 
remove rootkits, with varying success. I don't recommend any single rootkit scanner, but the best free ones 
are: 
 
Rootkit Revealer 
Sophos Anti-Rootkit 
 
Furthermore, since one of the most common rootkits which was widely circulated in the past is actually 
found on legitimate Sony music CDs, you should also download and use the free Aries Rootkit Remover. 
Run the program, click 'Perform Scan' and you will see whether you have this rootkit installed. Note that to 
prevent the installation of such rootkits on your PC, whether from older Sony music CDs or other sources, 
make sure to disable the Autoplay functionality for your optical drives - see the TweakUI chapter. 
 
There is no need for specific usage advice, as these scanners are relatively straightforward to use - run them, 
start the scan and if anything suspicious is found you will be informed. However they do require some 
advanced skills in identifying whether an actual rootkit has been found, as opposed to a normal system file. 
If you are not clear on whether the identified potential threat is genuinely a rootkit, you will need to do a fair 
bit of additional research on Google to confirm whether something is a genuine rootkit or not. 
 

PHISHING PROTECTION 

Phishing is a form of deception which does not necessarily rely on any malicious software. Simply by 
tricking unsuspecting users into entering personal information into fake websites and falsified login screens, 
the originators of this form of online fraud obtain exactly the information they need to steal your money 
without having to go through any of the software defenses in Windows. Phishing is the age-old method of 
conning people taken to a new level through the use of technology. The main method for combating 
phishing is user vigilance. Fortunately there is some assistance, as the most popular Internet browsers - 
Internet Explorer, Firefox, Chrome and Opera - all have some form of phishing protection built into them, 
detecting reported phishing sites and warning users of the potential dangers of visiting such sites. 
 

 
 
In Internet Explorer the Phishing Filter is enabled by default and will warn you if it suspects that a site you 
are about to visit is fraudulent. I do not recommend disabling it - see the Internet Explorer chapter for more 
details. The Phishing Protection feature in Firefox is covered in more detail in the Firefox Tweak Guide, and 
once again it is strongly recommended that you do not disable this functionality. Chrome's anti-Phishing 
features are detailed in Chrome Help, and protect against phishing and malware, thus should be kept 
enabled. More details of Opera's Fraud Protection features are in this Opera FAQ and it too is best kept 
enabled. 

http://en.wikipedia.org/wiki/Rootkits�
http://technet.microsoft.com/en-us/sysinternals/bb897445.aspx�
http://www.sophos.com/products/free-tools/sophos-anti-rootkit.html�
http://www.lavasoft.com/support/securitycenter/aries_rootkit_remover.php�
http://www.tweakguides.com/Firefox_1.html�
http://www.google.com/support/chrome/bin/answer.py?hl=en&answer=99020�
http://www.opera.com/docs/fraudprotection/�
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Even the most advanced user can fall prey to phishing, either due to laziness or simply because some 
fraudulent sites and techniques are becoming so realistic that they can fool almost anyone. For various 
practices designed to prevent falling victim to phishing and malware see the Important Security Tips section 
at the end of this chapter. 
 

FIREWALLS 

The built-in Windows Firewall is completely sufficient, when combined with the information in the rest of 
this book, in protecting against system intrusion - see the Control Panel chapter for Windows Firewall setup 
details. It prevents external intruders from accessing your system, as long as you do not open lots of Ports 
and/or have lots of Exceptions. It also allows what it feels is necessary outgoing traffic, and asks you to 
choose whether to block particular connection attempts initiated by games or programs. This is one of the 
reasons why I recommend the built-in Windows Firewall, since it is the least troublesome to use, particularly 
for online gamers and the average home user. 
 
However you do have other options if you want greater security. There are several commercial Firewall 
packages you can turn to. For free alternatives, ZoneAlarm and Comodo provide two popular software 
firewalls for those who want to use a third party package. Note that your network device, such as a router or 
modem, may come with a hardware firewall which you can configure - see your manufacturer's site or your 
product's packaging for documentation. A combination of a software firewall like Windows Firewall, and 
the hardware firewall capabilities of most routers and modems, is totally sufficient to prevent the majority of 
unauthorized intrusions into your system, without crippling normal functionality on your system. Finally, 
note that your Network Device also requires a username and password to access its settings. I strongly 
recommend changing the default username/password combination for this device, which is usually just 
admin for both, as the default is a security risk. Log into the device's settings and change the password to 
anything else - see you device's manual for details. 
 
 IMPORTANT SECURITY TIPS 

All of Windows XP's built-in security features, and all the malware scanners and phishing protection in the 
world are no substitute for learning how to prevent malware infestation, and how to detect and avoid 
phishing and other forms of online fraud. Prevention is indeed much better than the cure, especially in the 
case of malware, because once your system is infected, and once your credit card details, login passwords, 
software serial numbers, personal documents and so forth have been compromised, then it is usually too 
late. Often times the infection may quietly spread to your backups as well, rendering them useless, so a 
simple reformat and reinstall of Windows may not rid you of the malware. Furthermore certain malware 
and exploits are so new that no malware scanner or known method can detect or block them, at least for a 
period of time, so you must learn other ways of preventing their entry into your system, and detecting their 
possible presence. 
 
This is why it is so important that you read and understand the information in this chapter, and throughout 
this book. In particular, the tips I provide below are lengthy, but can be just as valuable as any anti-malware 
feature or software. This advice has stood me in good stead for many years, steering me clear of malware 
infection and the loss of personal data or money, while at the same time allowing me to enjoy all the features 
of my PC and full use of the Internet without reducing my system performance in any way. 
  

http://www.zonealarm.com/security/en-us/zonealarm-pc-security-free-firewall.htm�
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MALWARE AVOIDANCE METHODS 

Below are a range of general rules for helping you avoid becoming victim to malware and online fraud. Of 
course I could write a thousand rules, and none of them could cover every single type of circumstance. But 
the rules below do provide a strong basis for warding off the bulk of malware, and set you on the right 
course for coming to intuitively understand how malware works: 
 
Address Book/Contacts: Don't keep any contacts in your email address book/contacts list. If you are infected 
with malware, this is one of the first methods it will use to distribute itself to all of your contacts, and since 
the email comes from someone they know, they are more likely to click a link or open an infected 
attachment. Instead save at least one email you receive from people you wish to contact regularly in a 
separate mail folder. Then whenever you want to email someone, open this folder and reply to their last 
email, clearing the existing contents and subject line before entering your text. 
 
Stay Up to Date: Regularly keep your system up-to-date in terms of Windows patches and security updates, 
definition files for malware scanners, and the latest versions of your installed programs. These updates often 
contain fixes for known security exploits and vulnerabilities, and are a simple but effective way to prevent 
infection. Don't wait until you suspect infection before updating your system, as by then it may be too late, 
since some malware deliberately blocks the use of certain updating features. 
 
Attachments and Downloads: A common methods for spreading malware is through infected email 
attachments and file downloads. Different file types can hold or trigger malware on your system depending 
on your settings. Any email attachment or download link should be viewed as a potential source of 
malware, even if it is from a known source, because even if the sender/host is not deliberately malicious, 
they could be infected themselves and hence accidentally spreading infected files. Only save attachments 
from trusted people, and always scan any saved attachments with malware scanners. 
 
Patches & Security Updates: If you receive an email with an update or security patch for a software package or 
Windows attached, do not use it. Furthermore any links to such updates or patches are likely also 
fraudulent. No reputable software company publicly distributes updates or patches via email, they are 
always hosted on the company's site. If unsure, use a bookmark or manually type the legitimate company's 
web address into your browser and check for any updates or patches that way. 
 
Unknown Sender: If you receive an email or message from someone you don't know, this is instant cause for 
suspicion. The vast majority of message from unknown individuals are spam, malicious and/or fraudulent. 
 
Too Good to be True: If you receive a message or see an online offer which seems too good to be true, then 
almost without exception, it is likely to be a scam or a form of malware. It may not be malicious, it might 
simply be a hoax or a chain letter, but in virtually every case, it is worth deleting. 
 
Spelling and Grammar Oddities: A dead giveaway that something is potentially malicious or spam/scam is the 
presence of bad spelling/grammar. This is not necessarily due to the author being foreign; the use of 
misspellings of common words, or symbols and other characters in place of standard letters, is a tactic 
designed to circumvent keywords in spam filters. 
 
Replying or Unsubscribing: There is a large online market for email lists used by spammers and malware 
distributors. These people place a particularly high value on email addresses where the recipient is known to 
still check their email, as opposed to a false or long-dead email account. One way they verify an email 
address is with a phony 'Click here to unsubscribe' or similar link. Worse still, some of these links take you 
to a phishing site or download malware when clicked. For similar reasons never reply to any such emails - 
spammers know full-well that they cause annoyance, so abusing them is pointless; replying simply lets them 
know your account is active. 
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IP Addresses: Any link starting with a series of numbers instead of a domain name should be viewed with 
extreme suspicion. For example http://74.125.45.100/ tells you absolutely nothing about the site (actually it's 
Google). In most cases the IP address is used instead of a domain name precisely to hide the true nature of 
the site. 
 
Backups: The need for regular backups has been covered in detail in the Backup & Recovery chapter. 
However malware also provides another important aspect to consider - you should always do a full 
malware scan of your system before creating any backups, and never backup if you suspect you are infected, 
otherwise you may wind up infecting your backups and rendering them useless. 
 
File Sharing: One of the biggest sources of malware infestation in recent times is file sharing, such as via 
torrents, usenet, FTP, IRC or web-based file sharing services. Many shared files are fakes containing 
malware, but equally, genuine files can also contain malware, especially in any 'key generators' or associated 
utilities or links allegedly designed to unlock the shared files. Legality aside, file sharing is very risky and 
one of the easiest ways of being infected with malware. Malware distributors are increasingly innovating in 
this area due to the surging popularity of file sharing. 
 
Address Check: If a particular email or website appears suspicious, check the address closely. Often times the 
address of an apparently well-known site can be easily spotted as false if you pay attention.  For example the 
addresses http://www.amazon.shop.com and http://webstore.us/amazon.com/ have nothing to do with the 
reputable online store http://www.amazon.com. Similarly, the address http://www.facebook.com.users.org 
has no relationship with the social networking site http://www.facebook.com A domain name is always read 
from right to left before the first single slash (/) mark. The first component of an address when read from 
right to left is the Top Level Domain (TLD) found in the main site name, such as .com, .net, .co.uk and so 
forth. The real site name always appears just after the first incidence of a TLD when read from right to left. 
So in the example http://www.amazon.shop.com, the amazon portion of the address is just a sub-location of 
the website Shop.com. Scammers and even advertisers are very inventive, and create all sorts of variations 
on legitimate site names, sometimes with only a letter or two out of place, so in reality the only true way to 
be completely sure you are going to a correct site is to open a new tab or window in your browser and 
manually enter a known and trusted site address. You can also use your bookmarks, but always check the 
address of the site which opens. 
 
Browser Security Check: For any secure transaction, the link which appears in  your address bar must contain 
https:// at the start, not just http://

Link Check: Even if a link on a web page or email appears completely legitimate and correct, spoofing links is 
extremely easy. For example this link: 

 - note the addition of the 's' in the first link, which indicates it is a secure 
web link. Do not enter any financial information on a site which doesn't start with https://. However the level 
of security provided by a secure https:// link can vary, so by itself this is not a guarantee that your 
transaction is completely secure. Your browser will usually give you some indication or warning about the 
level of security, and this should be combined with research on the site in question. 
 

http://www.google.com/ actually goes to my website 
www.tweakguides.com, not Google. The only way to safely tell where a link actually goes to, whether it is 
provided in an email or on a website, is to right-click on the link and select 'Copy shortcut' (or similar), and 
then paste it somewhere harmless (i.e. not in your browser address bar). For example you can paste it into a 
plain text document, or the search box of a web search engine like Google. Then look closely at the link to (a) 
see if it matches the original displayed text for the link - if it doesn't this instantly proves that the link was 
attempting to be deceptive and hence is untrustworthy; and (b) to see the actual site it links to, which you 
can research further as covered below. With the rise of services such as Twitter, it has become fashionable for 
people to use short link services to generate URLs which are short but completely non-descriptive and hence 
potentially unsafe. For example this link http://bit.ly/dxdpT should point to www.tweakguides.com, but 
there is no possible way to determine that using any of the methods above. The only way to check such links 
is to use a service such as ExpandMyURL which allows you to paste in a short link and see where it goes. 

http://74.125.45.100/�
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Domain Check: If you believe a particular website may be untrustworthy, you can check to see who owns it 
and where they are located. A Google search on the site name is a start, but for more details, enter the 
domain name in a WHOIS lookup box at a domain registrar, such as the one provided here. In most cases 
this will provide sufficient details regarding the owner of the domain to help determine whether it is 
reputable or possibly malicious. Any site where the owner and/or administrator details are deliberately 
protected tends to greatly reduce its trustworthiness. 
 
Financial Statement Check: If malware perpetrators gain access to your finances, they can sometimes be very 
cautious not to trigger any preset alarm points. Instead of withdrawing large sums of money which can 
arouse suspicion on both your part and the bank's, they can instead withdraw smaller irregular sums, or 
purchase normal goods and services online in an unpredictable and thus seemingly normal manner. The 
only way to detect this is if you regularly check your financial statements closely, making sure you can 
account for every transaction. 
 
Browser Tools: If an untrusted website prompts you to install a particular plugin, program or toolbar to view 
or download their content, chances are this is malicious or at the very least undesirable. Cancel all such 
attempts. The most common software you require for full Internet multimedia functionality are the Flash, 
Shockwave and Silverlight players, as well as Java. You can install these safely by downloading the latest 
versions directly from their respective websites: ShockWave Player, Flash Player, SilverLight and Java. Only 
if a completely trusted and reputable website, such as Microsoft.com for example, asks you to install a 
browser plugin or download manager should you consider accepting, and if in any doubt, cancel and 
research further. 
 
Intimate System Knowledge: One of the many benefits of becoming closely acquainted with your PC and the 
workings of Windows is that it allows you to spot odd behavior and unusual files and processes which most 
other users dismiss as normal. When properly configured and maintained, contrary to popular belief, 
Windows does not behave in an unpredictable manner, and your programs and games will not randomly 
crash. Therefore when strange things do begin to happen, such as unexpected program crashes or changes, 
your browser redirecting in odd ways, the system slowing down at times, or other unusual activity, you can 
spot it almost straight away and investigate. Using a range of tools, such as those covered throughout this 
book, you can then determine which processes and files are not normal for your system, and hence detect 
malware which may otherwise elude less knowledgeable users. Unfortunately there is no simple way to gain 
such knowledge, it takes time and patience, but there are many rewards for being familiar with the 
fundamentals of Windows and PCs. 
 
Block Internet Access: If you strongly suspect a malware infection on your system, disable your Internet 
connection as soon as possible - if necessary update your malware scanner definition files first and run 
Windows Update before doing this. The quickest and most foolproof way to disable your Internet 
connection is to turn off your router/modem and/or unplug your cable or DSL line. The main reasons to do 
this is (a) to prevent the malware from spreading; (b) to prevent it from sending out any of your personal 
information; and (c) to prevent any hacker from accessing your system using any newly opened exploits or 
vulnerabilities. You can then use the scan and research methods below to track down the malware and 
remove it, and once you're confident your system is malware-free, reconnect to the Internet. 
 
Scan for Malware: This is a somewhat obvious but necessary step. If you suspect a downloaded file or 
attachment of containing malware, or you believe your system is already infected with malware, then you 
must run a full manual scan using the scanners recommended earlier in this chapter. This is one of the 
reasons why I recommend several separate scanners, as running each one, one after the other, greatly 
increases your chances of successfully finding a variety of different malware types. Importantly, if you find 
your malware scanners are not launching or behaving oddly, or can't remove detected malware, then this is 

http://www.whois.net/�
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a sure sign that malware is resident on your system and blocking attempts to remove it. Reboot your system 
into Safe Mode and run your scans from there - see the Backup & Recovery chapter for details. 
 

 
 
Common Sense: The simple application of common sense can provide an excellent method for detecting the 
validity of many forms of fraud or malware. For example if you receive an offer from a foreign king to place 
$18m into your bank account, but he needs your details first, then common sense would tell you it is 
ridiculous and highly risky. Similarly, a beautiful woman you don't know contacts you out of the blue to 
become friends with you. Or a close friend sends you an odd email with an uncharacteristic request and/or a 
suspicious attachment. All of these threats can be easily countered with the application of common sense, as 
none of them remotely pass even a simple sanity check. Yet every year, thousands of people fall victim to 
these scams. Don't allow your curiosity or base desires to overwhelm your common sense. At the same time, 
you cannot live in a constant state of complete paranoia - there are reputable sites and individuals whom 
you know you can trust, and cases where a quick rudimentary check is sufficient. Still, the adage If there is 
doubt, there is no doubt rings true: if you have even the slightest bit of suspicion, act on it by conducting 
further checks; don't take silly risks. 
 
Research, Research, Research: This is the Golden Rule. You are not the only person in the world using the 
Internet or receiving emails, thus it is highly likely that you are not the first person to encounter a particular 
form of malware, fraud or related problem. This means that somewhere someone is quite likely to have 
posted about your problem, or similar symptoms, and furthermore, detailed sources of knowledge may 
already exist to help you determine the best course of action in an almost limitless range of scenarios. 
Everything from researching whether a particular website is potentially malicious, to the true nature and 
purpose of strange files on your system, to working out if a particular browser plugin is safe and actually 
necessary for certain functionality - the information is already there, you simply need to make use of it. 
Almost without fail I have always found sufficient information to determine virtually anything I need to 
know simply by using Google. Remember that knowledge is power. 
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BALANCING SECURITY VS. CONVENIENCE 

In the past the balancing act between adequate security and convenience tended more towards convenience, 
since security threats were not as prominent, and even if you caught a virus, it was often just a harmless 
prank or at worst it ruined a few of your files. Unfortunately in the past few years there has been a 
significant rise in genuinely malicious software; namely software designed solely to do harm to your system 
and/or compromise your personal information. This coincides with the rise in the number of people who are 
using the Internet to pay bills, do their banking and go online shopping. 
 
The stakes are much higher now, so no matter how advanced a user you believe yourself to be, it is 
incredibly important to pay attention to the security of your PC, and it will continue to become even more 
important in years to come as the malware creators and online fraudsters find increasingly more complex 
and intrusive ways of getting into your system. They make millions of dollars from undertaking this sort of 
activity, so they have every incentive to innovate. This is why you need to do more than just install and 
enable a few anti-malware packages on your system to keep it secure. 
 
The balancing act between security and convenience has now swung more towards security than purely 
convenience, so you must make some effort to keep your system secure, even if this can be a bit of a pain at 
times; it's simply unavoidable now. In this chapter I've provided what I believe is a good balance, especially 
for more performance-minded users. Rather than just suggest the use of background malware scanners 
which can hurt performance, I have recommended several key free third party tools used in minimalist but 
effective manner to create an excellent layer of defense with no real performance impact. Of course the most 
important theme throughout this entire chapter has been the need for user education and research, which as 
I've repeatedly stated, is the only genuine defense against malware and online fraud. 
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MEMORY OPTIMIZATION 
 
 
This chapter looks at the configuration and optimization of memory-related functionality on your system. It 
is very important to understand the basics of how your computer uses the various forms of memory on your 
system, including the way the Windows Memory Management system works. Memory-related hardware 
and software settings have a significant influence on your system's responsiveness and stability, not to 
mention your data integrity. A system with poorly configured memory-related settings risks slowing down, 
stuttering, becoming unstable, experiencing errors and sudden reboots, and ultimately causes data 
corruption. 
 
 
 MEMORY HARDWARE 

The following are the common forms of memory hardware used on most modern PCs: 
 

CPU CACHE 

 
 
The CPU Caches are small fast memory chips that cache (buffer) information for faster usage by the CPU, 
since the CPU is the central component of your system. They assist in temporarily storing the information in 
anticipation of reading/writing by the CPU, preventing any bottlenecks or slowdowns. There are usually 
several levels of CPU caches, Level 1 (L1), Level 2 (L2), Level 3 (L3) and so forth. The cache chips themselves 
vary in storage capacity depending on your CPU, but essentially they are physical chips that you should not 
have to worry about. Windows and your associated hardware are designed to automatically detect the size 
of these caches and use them optimally as long as you have them enabled in your BIOS. That is, if options 
relating to the use of CPU L1/L2/L3 Cache(s) are present in your BIOS, never disable them unless 
troubleshooting. Aside from BIOS settings, there is a SecondLevelDataCache Registry setting for 
attempting to manually adjusting your CPU's L2 Cache setting. However altering this setting is not 
necessary, as the default value of 0 already allows Windows XP to automatically identify and use the correct 
L2 Cache size. This setting is only for very old CPUs, such as pre-Pentium II models, which use direct-
mapped L2 caches. 
 
In general since the user has no control over the CPU's caches aside from ensuring that they are enabled in 
the BIOS, this is one area of the memory subset you should not worry about unless you are troubleshooting a 
memory-related problem. For example, a CPU with a faulty cache may exhibit strange behavior such as 
constantly returning data errors and CRC errors. In these cases you can try temporarily disabling the caches 
in the BIOS to see if this reduces or resolves errors. Also see the Benchmarking & Stress Testing chapter to 
find out how to run a CPU-specific stress test to isolate whether the CPU is indeed the source of such 
problems. 
  

http://en.wikipedia.org/wiki/CPU_cache�
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PHYSICAL RAM 

 
 
This is probably the most well-known and most important form of memory. RAM (Random Access 
Memory) is a temporary data storage area covered under the Memory section of the Basic PC Terminology 
chapter. The primary advantage of RAM over other forms of storage such as your hard drive is that it is 
much, much faster to access, so optimal RAM usage means smoother performance for your system. There 
are three main factors affecting RAM performance: RAM size, RAM speed and RAM timings, each covered 
below. 
 
RAM Size: This is the actual storage capacity of the RAM in Megabytes (MB) or Gigabytes (GB). The main 
impact of having more RAM is that - when combined with appropriate Windows Memory Management 
settings - your system will perform more smoothly. This is because data has to be loaded less often from 
your drive, as more of it is stored in RAM, making it easier to access rapidly by your CPU and the rest of 
your system when required. RAM size is important in Windows because of the way it can utilize physical 
memory to speed up your system. If you are into heavy multi-tasking or play games, I strongly recommend 
more than 2GB of RAM to allow reasonably smooth performance without stuttering or frequent loading 
pauses. There are no RAM size tweaks; if you have a low level of RAM then it is strongly recommended that 
you consider buying and installing more RAM in your system - see the Upgrading Memory section at the 
end of this chapter. Bear in mind however that Windows XP 32-bit cannot practically use more than 4GB of 
RAM; only the 64-bit version can do that, so any more than 4GB of RAM is effectively wasted in Windows 
XP 32-bit. 
 
RAM Speed: This is the frequency at which RAM operates (in MHz), much like the speed at which a CPU 
operates. The higher the RAM's speed, the faster it can undertake the operations it needs to perform. Each 
stick of RAM has a speed rating, which is the speed up to which a stick of RAM is certified to safely operate. 
However the actual speed a RAM module is currently running at on a particular system varies depending on 
how fast it is set to operate in the BIOS. It is possible to adjust your BIOS such that the RAM can operate at a 
higher or lower speed in practice. The bottom line is, the faster the RAM's actual speed in MHz, the faster it 
reads and writes information and the better your performance. Remember though that the more the RAM's 
actual speed surpasses its advertised speed rating, the greater the chance for instability, so ideally you 
should keep the RAM at or below its rated speed for maximum stability and data integrity. 
 
RAM Timings: These are composed of several variables, set in your BIOS, which determine not the frequency 
of the RAM module (i.e. the RAM speed), but the Latency of the RAM - that is, the amount of time it waits 
between updating various signals. For example the RAS (Row Access Strobe) and CAS (Column Access 
Strobe) latency settings measure in clock cycles the delay in sending signals which specify firstly the row in 
which a particular memory cell is located, and then the column. The lower the RAM timings, the less time 
the RAM rests between these operations, and hence the faster it performs, but the greater the chance for 
errors and instability. Just like speed ratings, RAM modules come with recommended timings already 
encoded in their Serial Presence Detect (SPD) on a special chip. These SPD settings are used by default by 
your system unless manually changed in the BIOS, and when used with the recommended speed rating (see 
above) ensure maximum stability. 

http://en.wikipedia.org/wiki/SDRAM_latency�
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To view all the details of your RAM, including current and maximum rated speeds and timings, use a utility 
like CPU-Z and check under its Memory and SPD tabs - see the System Specifications chapter for details. 
Also see the Overclocking chapter for more details on adjusting RAM speed and/or timings and the impacts 
this has. If you want to test your RAM for stability, see the Benchmarking and Stress Testing chapter for 
more details. 
 

VIDEO RAM 

 
 
Video RAM (VRAM) is the physical memory built into a graphics card, and the size of this is usually quoted 
in MB or GB as part of the graphics card's specifications (e.g. GeForce GTX 285 1GB). This RAM acts as a 
temporary storage location to hold graphics data for faster access by your graphics card, much the same as 
system RAM does for general data. For this reason the VRAM is also called the Frame Buffer, in that it holds 
(buffers) individual graphics 'frames' ready to send to your monitor one by one. Just like physical RAM, 
VRAM has a speed in MHz, and latency in clock cycles, with the higher the speed and the lower the latency 
the better the graphics performance. Unlike physical RAM, altering the latency of your VRAM is tricky and 
not recommended, though still possible. The speed in MHz can be easily altered up or down using an 
overclocking utility, with the faster the speed the higher the performance, but once again the greater the 
chance of graphical glitches and freezes. See the Overclocking chapter for more details. 
 

 
 
If you're interested in a plain English step-by-step overview of how the hardware memory features above 
are utilized for a task like gaming, check the Graphics Process section of my Gamer's Graphics & Display 
Settings Guide for details. If you want to see the actual amount of Video RAM being used at any time, for 
example during gaming or when using 3D applications, you can use the free Video Memory Watcher utility 
to dynamically monitor the amount of VRAM in use. Run it in the background during a brief gaming 
session, then exit and look at the graph it generates to see how much VRAM has been used. 
  

http://en.wikipedia.org/wiki/Video_memory�
http://www.tweakguides.com/Graphics_1.html�
http://www.tweakguides.com/Graphics_1.html�
http://translate.google.com/translate?hl=en&sl=sv&u=http://pcforalla.idg.se/2.1054/1.127411&ei=sd7OSdLIBoiGkQWLnZDdCQ&sa=X&oi=translate&resnum=2&ct=result&prev=/search%3Fq%3D%2522video%2Bmemory%2Bwatcher%2522%26hl%3Den%26safe%3Doff%26sa%3DG�
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 WINDOWS MEMORY MANAGEMENT 

An important part of your memory subset is the Windows Memory Management settings. These are 
software settings which include the System Cache and related Windows Registry entries. This is an area with 
the most tweaking potential, and all the major memory management settings are covered below: 
 

DISK CACHE 

 
 
The Windows Disk Cache size can be set through the System component of the Control Panel or in the 
Windows Registry. This setting controls how much RAM is set aside to assist in buffering information 
written to and read from your drive(s) to achieve faster information transfer. The optimal setting for most 
systems is the default 'Programs' option under Memory Usage in Control Panel>System. Selecting the 
'System Cache' option may result in drive errors for some people, and is really only designed for server 
applications - that is, machines which are constantly writing/reading from the drive - and hence it is strongly 
recommended that it not be used for home PC users. 
 

ICON CACHE 

Windows keeps a copy of all your most commonly used icons in its icon cache, speeding up the display of 
these icons (on the Windows Desktop or in Explorer for example), rather than fetching them directly from 
each executable or file every time you view them. You can assign the number of icons to hold in the cache by 
editing the Windows Registry entry below: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer] 
 
Max Cached Icons=2000 
 
Edit this STRING value to set the maximum number of icons which can be cached. A value of 2000 should be 
optimal for most systems. 
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GENERAL MEMORY SETTINGS 

There are several registry settings that are presented as controlling various memory usage behaviors in 
Windows. Unfortunately, over time these have proven to be useless. Specifically these are the 
DisablePagingExecutive, IOPageLockLimit and AlwaysUnloadDLL entries. If you have already 
applied these tweaks, don't worry as they are totally harmless, but they are unnecessary and completely 
non-functional. 
 

WINDOWS PREFETCHER 

The Windows Prefetcher creates prefetch files for the most commonly used programs, and attempts to use 
these to more efficiently seek and load up data. You can configure it through the following registry entry: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management\PrefetchParameters] 
 
EnablePrefetcher=3 
 
The allowable values for EnablePrefetcher are:  
 
0 - Disable Prefetcher 
1 - Application launch prefetching 
2 - Boot prefetching 
3 - Both application and boot prefetching 
 
The default is 3, which should be fine for most systems. Note that if the Task Scheduler service is Disabled 
(See the Services chapter), much of the Prefetcher functionality becomes disabled, so if you wish to use full 
prefetcher functionality, do not disable the Task Scheduler service. 
 

VIRTUAL MEMORY 

 
 
Virtual Memory refers to a memory management technique used in Windows. This Virtual Memory in 
Windows XP Guide gives you a good initial insight into how Virtual Memory works in Windows XP. 
During normal operation, system RAM is the best place to store information for fast access by your CPU and 
other components, since it has no moving parts and information in it can be accessed at many times the 

http://www.microsoft.com/whdc/archive/XP_kernel.mspx#E3KAC�
http://windows.microsoft.com/en-us/windows7/What-is-virtual-memory�
http://aumha.org/win5/a/xpvm.php�
http://aumha.org/win5/a/xpvm.php�
http://aumha.org/win5/a/xpvm.php�
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speed of any drive. So ideally Windows likes to keep a portion of all of your most commonly used programs 
in RAM, as well as most of your currently used application(s). There are also other memory requirements for 
the hardware and software on your system which all require some portion of memory resources. When 
RAM starts to run low, or if Windows determines that a particular application is no longer a high enough 
priority, it breaks up some of the portions of memory (called 'pages') and temporarily swaps them out from 
your RAM to your drive. The 'swap file' where the memory pages are held on your drive is called pagefile.sys, 
and resides in the base directory on your drive. Note you will only see this pagefile.sys file if you have 
unticked the 'Hide Protected Operating System Files' option under Folder Options - see Folder Options 
under the Control Panel chapter. 
 
To access your Virtual Memory settings, go to the Control Panel>System>Advanced>Performance>Settings> 
Advanced>Virtual Memory section and click the Change button. 
 
Clearing the Pagefile: Before setting a new pagefile size or location, you need to first clear your existing 
pagefile. To do this select each relevant drive, choose the 'No paging file' option and click the Set button, 
then you need to reboot your system. This step does two things: first it clears the pagefile, fixing any 
potential pagefile corruption which can occur after a bad shutdown; and secondly it ensures that any new 
pagefile you create will start off as a single unfragmented contiguous block on your drive for optimal 
performance, which will remain unfragmented in the future. Note that if you have any problems booting 
back up into Windows due to a lack of a pagefile during this step, enter Windows in Safe Mode and continue 
the setup procedures for Virtual Memory from there - see the Backup & Recovery chapter. 
 
Location of the Pagefile: Once you've cleared the pagefile, you can now set its physical location. Highlight the 
logical drive where you want the pagefile to be placed under the Drive window. Which drive(s) or 
partition(s) the pagefile should be located on is based loosely on the following scenarios: 
 
 1 Drive with 1 Partition - The pagefile can only be located on the first primary partition of your drive, 

which provides optimal performance. Do not create a new partition for the Pagefile. 
 1 Drive with 2 or more Partitions - Make sure the Pagefile is placed on the first primary partition as this 

is the fastest partition on hard drives; on SSDs it makes no difference which partition is chosen. Placing 
the Pagefile on another partition of the same drive does not provide any performance benefits. 

 2 Drives or more (similar speeds) - If all your drives are similar in terms of their rated speed, you should 
put the main portion of the Pagefile on the drive that doesn't contain your Windows installation and 
applications/games, e.g. put it on a general data drive. If you've already separated your Windows 
installation from your applications/games, then place the Pagefile on the drive which doesn't contain 
your applications/games, even if this is the Windows drive. Alternatively you can experiment with 
splitting the Pagefile evenly by creating multiple smaller Pagefiles, one on each drive. 

 2 Drives or more (different speeds) - If one drive is notably faster than the others, you should put the 
main Pagefile on that drive, regardless of whether it is the system drive or not. This is particularly 
important if you have low system RAM, since the Pagefile will be accessed more often, and thus needs to 
be on the fastest drive. Note that for the purposes of creating a memory dump, you may need to retain a 
small Pagefile on your system drive regardless of where the main Pagefile is located. 

 RAID Configuration - For striped RAID configurations such as RAID 0 or RAID 5, Windows sees these 
as a single large drive, hence you cannot actually choose which drive to place the Pagefile on; it will be 
split evenly across the drives, which is optimal. If you have a separate faster drive outside the RAID 
configuration, you may choose to shift the Pagefile there. 
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Pagefile Size: After selecting the location of the pagefile, you can then determine its size in MB. In the Virtual 
Memory settings screen select the 'Custom size' option. Although there are many differing opinions as to 
how big the pagefile should be, it is important not to 'disable' your pagefile regardless of how much RAM 
you have. Windows and certain programs need a pagefile in order to operate correctly. Setting the Pagefile 
to zero results in less efficient use of System RAM, and it also restricts the amount of memory resources your 
system can allocate should a program require more memory than you have in the form of available RAM. It 
also prevents memory dumps being created for debugging purposes after a crash. As such, do not set a zero 
Pagefile. 
 
The correct size of the Pagefile is often debated, and there are many conflicting accounts of the optimal size. 
By default, Windows XP will make your pagefile 1.5 times your physical RAM. So if you have 1GB of RAM, 
the pagefile will be set at 1.5GB by default. However we can improve this allocation by analyzing how much 
virtual memory your system actually needs. In the past I provided what I personally tested and found to be 
completely safe recommendations for the Pagefile size. However to remove all doubt and provide a concrete 
recommendation for this important system file, I now rely on the advice of the person best positioned on this 
topic with both practical and theoretical experience on the matter: Microsoft technical guru Mark 
Russinovich, as covered in this Microsoft Article. 
 
Essentially, the correct method to determine the optimal Pagefile size for your particular system is to 
examine the Peak Commit Charge value for the combination of programs you frequently run at the same 
time. The Commit Charge is the amount of Virtual Memory reserved for a particular process. Compare this 
value to the current Commit Charge Limit on your system, which is the sum of your system RAM + Pagefile. 
If the sum of Commit Charge for all your processes attempts to exceed the Commit Limit, then there will be 
memory allocation problems, potentially leading to crashes and even system failure. So the aim is to ensure 
that the peak value achieved for Commit Charge never exceeds the Commit Limit, which in turn tells us 
how big the Pagefile must be. 
 
The way to determine your Peak Commit Charge and also see the Commit Limit is as follows: 
 
1. Use your system normally for a lengthy period, including loading up any and all programs you would 

normally use in a session, as well as any additional data. For example, load up your most strenuous 
games one by one and play them for a while. Or load up your largest applications and load any custom 
data you may be working on within those applications. The aim is to see the maximum amount of 
memory resources you might potentially use in any session in the future. Don't artificially load up a 
dozen applications at once if that's not what you would normally do. 

2. Without restarting your system, after a period of time bring up the Task Manager and go to the 
Performance tab, then check the Peak figure under the 'Commit Charge (K)' section - this is 
approximately the maximum amount of memory in KB required so far by your system. Also examine 
the Limit figure under Commit Charge, as this is the maximum amount of memory resources (RAM + 
Pagefile) which Windows can possibly allocate to all programs. 
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Using this data, you should then set the pagefile minimum size according to this formula: 
 
Pagefile Minimum Size = Peak Commit Charge - Total System RAM 
 
If the value for this is negative (i.e. you have more RAM than the Peak Commit Charge), this does not mean 
you should set a 0 Pagefile minimum size. As a safe value for the Pagefile Minimum Size I recommend at 
least 1GB or the result of the formula above, whichever is higher. 
 
The pagefile maximum size is then calculated as: 
 
Pagefile Maximum Size = Up to 2 x Pagefile Minimum Size 
 
Given your Commit Limit has already been set such that it meets your most strenuous requirements as per 
the Pagefile minimum, you should already have plenty of headroom even if you set your Pagefile Maximum 
Size to equal that of the Pagefile Minimum Size. However I recommend being safe and setting the maximum 
up to twice the minimum to provide even greater headroom, especially in case of unforeseen usage patterns, 
and to future-proof against upcoming applications and games which may use more memory. Note that there 
is a 4GB limit for maximum Pagefile size if running a 32-bit version of Windows XP. 
 
If you've spread the Pagefile over multiple drives, ensure that the sum of the Pagefile sizes equals the values 
above, or that the main Pagefile follows the above rules, and the other Pagefiles are all very small. 
 
Once you've adjusted your Virtual Memory size settings click the Set button and reboot if required. 
 
The method for determining the Pagefile size in this section may seem tedious or confusing at first, in which 
case I strongly advise that you use the 'System managed size' option until you have the time to get a better 
understanding of it by reading the associated articles. As noted, the recommendation is fairly broad but it 
comes from one of the most reputable Microsoft experts available, so any other recommendations you find 
are unlikely to be as accurate. However keep in mind that the recommendation hinges solely on proper 
analysis of your Peak Commit Charge at a point in time. If over time you install and launch new programs 
and games which use much greater amounts of memory and/or you multitask with more programs than you 
originally envisioned, or load up data for your programs which are very large, then obviously there is 
greater likelihood that your Peak Commit Charge will rise, and you must therefore revisit your Pagefile size 
and go through the steps above again with more recent data. 
 
 UPGRADING MEMORY 

There is no real substitute for having a decent amount of physical RAM installed on your system. All the 
memory management features in Windows ultimately can't compensate for having too little RAM for the 
programs you choose to run. In Windows XP, even though the minimum RAM requirement is only 64MB, 
and the recommended is 128MB, these are insufficient amounts of memory for modern applications and 
games. If you are running recent software I strongly recommend a minimum of 1GB of RAM, preferably 2GB 
if you want reduced stuttering and greater responsiveness. However bear in mind that for Windows XP 32-
bit, the maximum useful amount of RAM is 4GB, so if you wish to use more memory you will need to switch 
to Windows XP 64-bit, or preferably the 64-bit version of Windows 7. 
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DRIVE OPTIMIZATION 
 
 
Windows Memory Management is intimately related to the way your drive(s) are used in Windows. Your 
drive is one of the relatively slower components of your system - even the fastest Hard Disk Drive (HDD) or 
Solid State Drive (SDD) cannot access, read or write data as quickly as RAM. So when one of your 
components such as the CPU or graphics card needs information, to prevent pauses, stuttering or 
slowdowns, Windows attempts to hold as much of the information as possible in RAM for fast access. 
However regardless of how much RAM you have, or how efficient Windows is with memory management, 
at the end of the day RAM is only a temporary form of storage which is cleared each time your PC shuts 
down. Therefore it is the physical drive(s) where all your information is permanently held, and your system 
must regularly access the drive for data. 
 
This chapter covers the primary means by which you can improve and maintain the performance of your 
drive(s) in Windows. Many aspects of drive performance are already covered in other chapters - you should 
have already: 
 
 Formatted and partitioned the drive correctly - See the Installing Windows chapter; 
 Made sure to have the correct BIOS settings - See the BIOS Optimization chapter; 
 Installed the latest motherboard drivers - See the Driver Installation chapter; and 
 Have correct relevant Windows settings - See the Control Panel and Memory Optimization chapters. 
 
Follow the rest of the instructions in this chapter to make sure your drive(s) remain fast and responsive. 
 
 
 WINDOWS DISK INDEXING 

 
 
This is a performance tip that I strongly recommend you implement. The Windows Disk Indexer constantly 
indexes all files on your machine to allow for faster searching using the Windows Search function for 
example. Since most people don't search their machine very often in XP, having Disk Indexing enabled 
provides a performance hit for no good reason, and also increases fragmentation. Follow these steps to turn 
off the Windows Disk Indexer to improve general drive performance and responsiveness: 
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1. Go to Windows Explorer, right-click on your hard drive name and select Properties. 
2. Untick the 'Allow Indexing Service to index this disk for fast file searching'. 
3. Select 'Apply changes to [Drive letter]\, subfolders and files' in the subsequent prompt.  
4. Your system will now go through and remove all indexing on existing files, and not index any new or 

moved files in the future - this will speed up drive read/writes and general responsiveness. Ignore any 
'errors' which are shown, this occurs simply because some files are in use or protected and can't have 
their properties changed to remove indexing - this is normal.  

 
Make sure you also disable the 'Indexing Service' service as it is no longer necessary when disk indexing is 
removed from your drive (See the Services chapter). 
 
 DRIVE CONTROLLERS 

To optimize the performance of your drive(s), first make sure you have installed the correct motherboard 
drives for your particular motherboard, as the drive controllers on your motherboard require these for 
optimal operation, as well as special functions like RAID - see the Driver Installation chapter.  
 
Next, open Device Manager, found under Control Panel>System>Hardware, and go to the Disk Drives 
section in Device Manager and expand it. Right-click on each hard drive available, select Properties, and 
under the Policies tab make sure 'Optimize for Performance' is selected. If available, also tick the 'Enable 
Write Caching on the disk' option. The aim is to allow the hard drive to use a Cache – a small area of 
memory set aside specifically for the hard drive – to speed up reading and writing to the drive. Note that 
these options may not be available to be changed here for certain SCSI, Serial ATA (SATA) and/or RAID 
configured hard drives or other types of drives. If presented with a 'SCSI Properties' tab, make sure that both 
'Disable tagged queuing' and 'Disable synchronous transfers' are unticked for maximum performance. 
 
To optimize all system drives, in Device Manager go to the 'IDE ATA/ATAPI Controllers' section and 
expand it. Right-click on each sub-controller listed and select Properties and see the relevant section below: 
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Parallel ATA Controller:  This controller affects all PATA drives which use the IDE interface - typically this is 
older IDE hard drives and optical drives. Go to the 'Primary Channel' and 'Secondary Channel' tabs and 
check the transfer speeds as relevant - the maximum possible speeds are Ultra DMA Mode 4 for optical 
drives, and Ultra DMA Mode 6 for IDE drives. If you untick the 'Let BIOS select transfer mode' box you may 
be able to alter the speed here, but if it is below the maximum then it may be due to one or more of the 
following factors: 
 
 Your motherboard does not support Ultra DMA 6 or Ultra DMA 5 modes for hard drives - these are also 

called ATA 133 and ATA 100 respectively. Check your motherboard manual and make sure you have 
installed the correct IDE drivers for this motherboard. 

 Your BIOS is not configured correctly to enable the highest speed - see the BIOS Optimization chapter. 
 You are sharing a hard drive and an optical drive on the same channel - move them to separate channels. 
 Your hard drive(s) or optical drive(s) don't physically support the highest transfer mode available on 

your motherboard. This should only be the case if they are quite old. 
 No drive should be running in PIO or Multi-word DMA mode as these provide poor performance. 

Check your BIOS and any switches on the back of the drive(s). 
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Serial ATA Controller: This controller affects all SATA drives connected to your motherboard. Right-click on 
this controller, select Properties, then go to the 'Primary Channel' and 'Secondary Channel' tabs. If a drive is 
connected to these channels, the 'Transfer Mode' should show the correct maximum speed for the drive - 
1.5GB/s for SATA I, or 3.0GB/s for SATA II. Alternatively click the 'Speed Test' button to do an actual quick 
benchmark of the drive's speed and see the speed rating. The 'Let BIOS select transfer mode' box should be 
ticked unless you are troubleshooting, or you see 'PIO Mode' for your drive, which is sub-optimal; in that 
case untick the box and manually attempt to switch to a better mode. The other boxes should all be ticked for 
maximum performance. 
 
AHCI Mode: If you run a SATA drive, you can try enabling Advanced Host Controller Interface (AHCI) 
Mode on your SATA controller in your BIOS. This mode has a range of benefits, especially on SATA II drives 
with NCQ support - this includes quieter operation and better multi-tasking capabilities. However it will not 
necessarily result in a speed boost depending on how you use your system. Furthermore it requires 
appropriate drivers from your motherboard manufacturer (e.g. the Intel Rapid Storage Technology drivers 
for Intel motherboards) to function properly. Most importantly, if you do not enable this mode in your BIOS 
prior to installing Windows, you may not be able to boot back into your system if you switch to AHCI on an 
existing install of Windows. It is recommended that if you wish to switch on AHCI mode, you make the 
appropriate changes in your BIOS and then reinstall Windows XP. 
 
If your drive is not set to the highest mode possible for its type, or some of the options are unavailable here 
then you have not set up your BIOS correctly or you have not installed the correct SATA motherboard 
drivers. To confirm your drive's actual speed, and whether there really is a problem, you can benchmark 
your drive using a utility HD Tune - see the Benchmarking & Stress Testing chapter. 
 
Most recent drives come with a technology called SMART - if available and enabled in the BIOS. This 
technology prevents drive errors and provides diagnostic information. To further diagnose any problems for 
non-RAID configuration hard drives using SMART, use a utility like PassMark Disk Checkup. 
  

http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Native_Command_Queuing�
http://en.wikipedia.org/wiki/Self-Monitoring,_Analysis_and_Reporting_Technology�
http://www.passmark.com/products/diskcheckup.htm�
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 MASTER FILE TABLE 

The Master File Table is a system area of Windows which contains an entry for every file and directory on 
your drive with information on its size, attributes, permissions, timestamps and so forth. In a way, it is like a 
table of contents for your drive, and as such serves a very important function. By default Windows reserves 
around 12.5% of your total drive space to allow the MFT to grow without becoming fragmented. This space 
cannot be reduced, but over time it may need to be increased - especially after creating lots of new files or 
installing numerous applications and games. Fortunately Windows will automatically manage the MFT, 
increasing its size as necessary. 
 
However if your drive has a relatively large number of files, over time the MFT may become fragmented as 
it grows beyond the initial space allocated to it by Windows, and this can affect performance. You can use a 
third party disk defragmentation utility to defragment the MFT and thus keep it optimal - see further below 
for details of these. 
 
If for some reason you want to manually increase the amount of space Windows reserves for the MFT in 
advance you can do so via the Registry Editor by going to: 
 
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\FileSystem] 
 
NtfsMftZoneReservation=1 
 
The DWORD above is set to 1 by default, which means it is automatically managed. However you can give it 
a value of 1 - 4, with higher values reserving larger portions of the drive for the MFT. The specific 
percentages for each value are purposely not documented by Microsoft, as they may change in the future. 
 
 WINDOWS DISK DEFRAGMENTER 

 
 
As data is written to or deleted from your drive, portions of individual files will become fragmented and 
physically spread out all over the drive. This happens because as Windows starts writing the data for a file 
onto the drive, when it reaches an occupied portion of the drive it jumps to the next available empty spot 
and continues writing from there. So a single large file may actually be in many separate chunks in various 
locations on your drive. The more the files on your system are fragmented, and in particular the smaller the 
fragments, the more time your drive takes to find all these fragments and access all the information it needs 
at any time. It's like trying to read a book with the pages out of order. This can clearly reduce drive 
performance and increase the potential for stuttering and loading pauses on hard drives. 
  

http://support.microsoft.com/kb/q174619/�
http://en.wikipedia.org/wiki/File_system_fragmentation�
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Windows Disk Defragmenter (Defrag) is a built-in utility that performs a very important function: it puts all 
these file fragments back together with each other in the same location on the disk and also attempts to pack 
them closer to the start of the drive to speed up reading and writing to these files. This reduces loading times 
and greatly reduces annoying loading pauses and stuttering. To access the Windows Defrag utility, go to 
Start>Run, type Dfrg.msc and press Enter, or look for the Disk Defragmenter in your 
Start>Programs>Accessories>System Tools menu. Make sure there are no open applications or games 
running in the background and then in the Defrag window simply click the Defragment button to begin 
defragmentation. Do not do anything else while this process is being completed. It may take quite a while to 
complete so be patient. The longer it takes, the more good it is doing your drive. If tweaking a new install of 
Windows, make sure to run Defrag after installing the system drivers and core software as this will move all 
the important system files to the start of your hard drive where drive access is fastest. 
 
Note that for any defragmentation program to work, you must have around 15% free drive space to give the 
program room to temporarily relocate files as it defragments. 
 

BACKGROUND DEFRAGMENTATION 

By default, Windows also defragments your hard drive in the background whenever your system is idle.  It 
does this to maintain optimal layout of your important files, such as your boot files. That is why you may see 
hard drive activity even when there are no programs or games running in Windows. This is fine, since it 
does not interfere with your programs or games - it only occurs when the system is truly idle. If you want to 
disable background defragmentation, untick the 'Optimize hard disk when idle' setting in TweakUI - see the 
TweakUI chapter. The other source of background drive usage is the Disk Indexer, which you should disable 
as covered further above. 
 
Note that if you are running an Solid State Drive (SSD), you should not defragment the drive since SSD 
random read times are extremely fast, counteracting any performance decreases due to fragmentation, not to 
mention that the act of defragmenting an SSD can reduce the lifespan of the drive. 
 
 ADVANCED DEFRAGMENTATION 

If you want to do a more thorough defragmentation of your hard drive and get better results you will have 
to look beyond the built-in Disk Defragmenter in Windows XP - even Microsoft admit this in this Microsoft 
Article. There are several applications which can defragment a disk in more efficient ways, and also 
defragment files which the Windows Defragmenter cannot move, such as system files (the green blocks in 
Defrag). Note that the Windows pagefile will not become fragmented if configured correctly as detailed in 
this book, so pagefile fragmentation is not an issue -  see the Memory Optimization chapter. 
  

http://support.microsoft.com/kb/305781/en-us�
http://support.microsoft.com/kb/130539�
http://support.microsoft.com/kb/130539�
http://support.microsoft.com/kb/130539�
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PAGEDEFRAG 

 
 
To defragment your system files for free, you can use the PageDefrag utility. It is fairly simple to use, and 
upon launching it you can see at a glance how many fragments your major systems files are in - to be 
optimal they should all be in 1 fragment each. To run a defragment using PageDefrag, launch the program 
and click the 'Defragment at next boot' option, then reboot. This will defragment your major system files, 
which can only be done at boot time, which is something the regular Windows defragmenter cannot do. 
However even the author of PageDefrag suggests you use it in combination with other defragmentation 
software such as a commercial package, or his own Contig utility.  
 

DIRMS & BUZZSAW 

If you are an advanced user, you can try the Dirms and Buzzsaw defragmentation utilities. These utilities are 
free but require re-registration every 30 days. They also require a bit more work in figuring out and using, so 
they are not covered here in detail, and are not recommended for the average user. 
 
For ease of use and maximum safety, I recommend a third party defragmentation package since these 
usually come with detailed instructions, are fully automated and fairly foolproof. Defragmenting involves 
lots of file movements, sometimes sensitive system files, so it is important that the software you use to 
defragment be rock-solid. There are several advanced defragmentation utilities you can use in XP which are 
not all free, but the free trial versions have full functionality with sufficient time for you to judge their 
usefulness before considering whether to purchase them or not: 
 
MyDefrag 
Auslogics Disk Defrag 
Diskeeper 
PerfectDisk 
O&O Defrag 
 
A third party defragmentation utility is not essential though, as the normal Windows Disk Defragmenter 
utility is sufficient for most tasks, especially when combined with the free PageDefrag utility. I do however 
recommend at least trialing a free third party utility like MyDefrag for a few weeks to see if it makes a real 
difference on your system - it may have a noticeable impact particularly in reducing stuttering in games. 
Regardless of whether you use the built-in defragmenter or a third party utility, make sure to defragment 
regularly as it is essential to optimal drive performance. 
  

http://technet.microsoft.com/en-us/sysinternals/bb897426.aspx�
http://technet.microsoft.com/en-us/sysinternals/bb897428.aspx�
http://www.dirms.com/home/docs/dirms1.asp�
http://www.dirms.com/home/docs/buzzsaw.asp�
http://www.mydefrag.com/�
http://www.auslogics.com/disk-defrag�
http://www.diskeeper.com/defrag.aspx�
http://www.perfectdisk.com/�
http://www.oo-software.com/home/en/products/oodefrag/�
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FREQUENCY OF DEFRAGMENTATION 

Whether using the Windows Defragmenter, or a commercial package, I strongly recommend also doing a 
manual defrag immediately after any of the following events: 
 
 Installation of any application or game. 
 Patching any application, game or Windows. 
 Installation of any drivers. 
 Adding or deleting very large file(s). 
 
This is particularly necessary for gamers, since games are already quite prone to stuttering and longer 
loading times due to their data-intensive nature, so by defragmenting your drive after a game installation or 
patch, you help reduce stuttering in the game. 
 
Neglecting to defragment your hard drive after a major drive operation such as those listed above may see 
your applications or games take longer to load, exhibit frequent stuttering and pausing, and generally 
reduce your hard drive's performance. There is no need to defragment daily or hourly, and indeed you 
shouldn't just defragment on a set time schedule. Manually defragmenting regularly also reduces the time it 
takes to defragment your drive, so that each time you do it, it should only take a few minutes at the most, 
even for a large drive, since only small portions of files need to be rearranged. 
 
 BOOT ANALYSIS & OPTIMIZATION 

By default Windows already detects and optimizes your Windows bootup time by placing the relevant files 
in optimal positions on the disk. This is done frequently, however you can speed up the process by doing it 
manually after you install major system drivers. Furthermore by analyzing your boot procedure you can 
troubleshoot any problems which may be slowing down your Windows startup. This is best done using a 
tool called Bootvis. 
 

BOOTVIS 

 
 
Bootvis is the Boot Visualizer tool from Microsoft, which shows information about the specific programs, 
drivers and services that are loaded up during your Windows startup procedure, and how long each one of 
them takes. This information can be very useful in identifying precisely what is taking the most amount of 
time at bootup, and if necessary uninstalling or altering hardware and software which is causing any long 
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delays. To access Bootvis download it from this Bootvis Download Site and install it. Before you use Bootvis 
however you should note that although it is a Microsoft-produced utility, it was removed from the Microsoft 
Bootvis Page a while ago for an unspecified reason. The likely reason is that it can cause problems on certain 
systems, although it is unclear which particular types of systems. The bottom line is that you should backup 
your data before using Bootvis, just in case. 
 
Note that for Bootvis to operate correctly, the Task Scheduler service needs to be set to Automatic - see the 
Services chapter. This is very important, otherwise Bootvis will not complete its Boot Trace or Optimization 
tasks after rebooting. 
 

ANALYZING SYSTEM STARTUP 

To analyze your system with Bootvis, run the program and go to the Trace menu, then select 'Next Boot + 
Driver Delays'. Let Bootvis reboot the system, and on rebooting wait patiently for Bootvis to pop back up 
when it's finished analyzing. It will display several graphs that show the various startup components laid 
out sequentially in time shares. Make sure to use the scroll bars to look at the various graphs in their 
entirety. If you want to identify which program files are associated with particular applications or drivers, 
consult the Startup Programs and Services chapters for more details. 
 

OPTIMIZING SYSTEM STARTUP 

To optimize your bootup procedure using Bootvis, first go to your \Windows\Prefetch folder and delete the 
entire contents. Then start Bootvis, go to the Trace menu and select 'Optimize System'. Once again let Bootvis 
reboot and wait for it to restart after the reboot. It will say 'Optimizing System' for a while. Once this is done 
you can reboot your system and observe whether your bootup times are now faster. 
 
This is not absolutely necessary though because by default Windows will automatically optimize your 
startup after several days, so if you don't feel confident using Bootvis for this purpose or don't have the time, 
it is not an important step. Using Bootvis to analyze your system startup is the most useful feature and can 
be extremely handy in helping you identify potential slowdowns in the startup process, so if only for that 
purpose, Bootvis is worth having on your system. 
 
 

http://www.softpedia.com/get/Tweak/System-Tweak/BootVis.shtml�
http://www.microsoft.com/whdc/system/sysperf/fastboot/default.mspx�
http://www.microsoft.com/whdc/system/sysperf/fastboot/default.mspx�
http://www.microsoft.com/whdc/system/sysperf/fastboot/default.mspx�
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THE CONTROL PANEL 
 
 
This chapter covers all the general options available under the default Windows Control Panel in XP, which 
is an important central location for accessing many Windows settings. I cannot go into each section of the 
Control Panel in great detail due to space considerations however all the important settings which are 
relevant to the average home PC user are covered here and where necessary you will be referred to other 
relevant chapters of this book for more information. Take the time to go through this chapter carefully as 
although it is long, it is very important for general Windows performance and functionality. 
 
Note that you may have additional items showing in your Control Panel, as some third-party programs will 
automatically insert shortcuts into the Control Panel, however only the default Windows XP items are 
covered below. If you wish to remove a third party shortcut from the Control Panel, in most cases you can 
right-click on it and select Delete to remove the icon (not the program itself). For some Control Panel icons 
you will have to find the relevant file under the \Windows\System32 directory - all Control Panel icons have 
the extension .CPL - so for example to remove the 'Nvidia Control Panel' icon rename or delete the nvcpl.cpl 
file in the directory above, then close and reopen the Control Panel, and it should be removed. Alternatively, 
you can go to the Control Panel section of the TweakUI utility and remove unnecessary components - see the 
TweakUI chapter for details. 
 

 
 
 
 ACCESSIBILITY OPTIONS 

There are a range of features here that can be used to accommodate different keyboard usage styles, make 
Windows easier to see on screen, or provide audible notification of events for example. Quite obviously 
which settings you choose will depend on your individual requirements. If you want to find out more about 
these options go to the Windows Accessibility Page. For the majority of users who do not need to use any 
accessibility functions, make sure that every option under each of the tabs is unticked for maximum 
performance and minimal interference with the functionality of games and applications. For example, if the 
'Sticky Keys' option is left enabled, it is known to cause unintended interruptions in some games - when the 
SHIFT key is pressed multiple times in a row this will activate it. 
  

http://www.microsoft.com/windowsxp/using/accessibility/default.mspx�
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 ADD HARDWARE 

This utility allows you to go through a set of procedures for adding a new piece of hardware to your system. 
In most cases though, since Windows XP is a plug-and-play operating system, and as long as you have 'Plug 
and Play' enabled in your BIOS (See the BIOS Optimization chapter) and the 'Plug and Play' service set to 
Automatic (See the Services chapter), all you need to do to add any new hardware is to connect it to your 
system and XP will detect it, and either automatically install basic drivers for it, or if it can't determine the 
type of hardware, request that you insert a driver disk - see the Driver Installation chapter. I strongly 
recommend that before adding any new piece of hardware, you spend some time and read through the 
installation instructions which come with the hardware, as some have unique requirements for optimal 
installation which may be different to what you might expect, and in some cases the default Windows XP 
driver will not function as well as the latest specific drivers for the device. 
 
 ADD OR REMOVE PROGRAMS 

 
 
The main use for this utility is not so much for the addition of new software - that typically only requires 
that you insert the installation disc into your drive and follow the procedures from there, or the execution of 
the software's setup executable file. Rather this tool is most useful for looking at the existing software and 
drivers currently installed on your system and quickly being able to remove ones that are no longer needed. 
It is always a good idea to go through this list periodically and remove software that hasn't been used for a 
long time. You can sort this list in various ways by going to the top right corner and for 'Sort by', selecting 
either Name, Size, Frequency of Use or Date Last Used. 
 
On the left side of the screen, you will see the major functions available under this utility. We've covered the 
addition and removal of software so far. You can also 'Add/Remove Windows Components', which is 
covered in the Cleaning Windows chapter. The final option is the ability to 'Set Program Access and 
Defaults', and that is covered below. 
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SET PROGRAM ACCESS AND DEFAULTS 

Click the 'Set Program Access and Defaults' button, and on the next screen you can choose from two presets 
(Microsoft Windows or Non-Microsoft), or as I recommend, click on the third Custom option. Next, click the 
double down arrows to the right of Custom. Here you can set the default Web Browser, email program, 
media player, instant messaging program and Java virtual machine. 
 
For example, if you want to make Mozilla Firefox the default Internet browser instead of Internet Explorer, 
as long as you already have it installed on your system the option to select it as the default should appear 
here. Select it, and make sure a tick appears in 'Enable access to this program' next to it. You can disable 
access to Internet Explorer by removing the tick in the 'Enable access to this program' box next to it as well. 
This won't uninstall Internet Explorer, it simply removes access to it, which is not recommended. I 
recommend you select 'Use my current Web browser' instead which should be fine for most purposes, and 
ensure a tick appears next to all browsers below it so that you can still access them all if necessary. 
 
Although Microsoft has incorporated this feature as a result of charges relating to monopolistic behavior, 
bear in mind that quite often you must use a Microsoft product for optimal trouble-free usage. For example, 
only Internet Explorer can access the Windows Update site properly by default, and only Windows Media 
Player can provide optimal playback of .WMV files. Other methods to access these sites and files do exist,  
and they are covered in the Internet Explorer and Windows Media Player chapters of this book, but they are 
not necessarily as secure or as optimal, so don't disable access to these default applications for that reason. 
Instead configure them correctly as detailed later in this book. In all cases I recommend selecting 'Use my 
current...' and allowing access to all the components beneath. There is one exception - if you want to disable 
access to Windows Messenger as part of removing it from Windows, untick the 'Enable access to this 
program' box next to it, as it has no other use. 
 
 ADMINISTRATIVE TOOLS 

 
 
There are seven main administrative tools under this category. Some of them may not be available if you run 
Windows XP Home. In particular if you are running Windows XP Professional, you will also have access to 
the Group Editor, but that is covered separately in the Group Policy chapter. If you have installed the .NET 
Framework on your machine, you may also have access to the .NET Config and .NET Wizard tools. I cannot 
go into detail about all the functions of these administrative tools because they are capable of a great many 
things, however I provide brief details of the primary Administrative Tools and point out their most useful 
aspects for the average home PC user below. 
 

COMPONENT SERVICES 

This tool allows system administrators the ability to deploy and administer component services applications 
or automate administrative tasks. For our purposes, the only practical usage is the Event Viewer and the 
Services components, both of which also have separate tools to allow direct access to them - see each of these 
further below. 
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COMPUTER MANAGEMENT 

The primary use for the Computer Management tool is the Disk Management sub-component, which you 
can access by expanding the Storage item in the left pane and then clicking on the Disk Management item 
that appears underneath it. You will then see your hard drive(s) listed in the top right pane, with all your 
available drives (including optical drives) listed in the bottom right pane. 
 

 
 
If you want to change any of the drive letters on your system - for example if you want to swap your DVD-
ROM drive from D: to E: or change it to a new letter like Z: you can do so here by right-clicking on the drive 
letter in the bottom right pane and selecting 'Change Drive Letter and Paths', then highlighting the drive 
letter which appears, and selecting the Change button, and assigning a new drive letter.  
 
If you want to convert a hard disk from a Basic to a Dynamic volume, you can do so here by right-clicking 
on the Disk 0 (or Disk 1, etc) box in the bottom right pane, and selecting 'Convert to Dynamic Disk'. Dynamic 
disks can emulate a RAID array - that is they can span multiple drives as though they are one large drive. 
The features of Dynamic Disks are discussed in this Microsoft Article. Note that dynamic disks are a storage 
type not supported on Windows XP Home Edition or earlier versions of Windows. However unless you 
have a specific need for this function, it is not recommended that you convert your disk from basic to 
dynamic, because even though you can covert back to a basic disk you will lose all your data. 
 

DATA SOURCES (ODBC) 

This tool lets you add and configure drivers for managing access to data on various database management 
systems. Unless you use databases extensively on your machine, you can ignore this tool. There are no 
general functions for this tool that can be discussed here. Note that this is the same tool as the Data Sources 
(ODBC) item in the main section of the Control Panel. 
 

EVENT VIEWER 

The Event Viewer tool shows a list of events under the Application, Security and System categories. These 
events are recorded by Windows over time, and reflect information alerts, warnings and errors that have 
occurred to date. You can view the (limited) details of an event by double-clicking on it. Event Viewer can be 
used to troubleshoot an event if you haven't had the chance to see an error message - for example because 
your system rebooted before you could read it. More details on using this tool are provided in the Windows 
Errors chapter. 
  

http://support.microsoft.com/kb/314343�
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LOCAL SECURITY POLICY 

This tool allows you to establish and alter security-related settings. This is best left at default and I 
recommend that you do not change any of these settings unless directed to by a Network Administrator or a 
Technical Support expert. All the important security settings relevant to home users can also be adjusted 
elsewhere as detailed in this book. 
 

PERFORMANCE 

This tool allows users to examine the various performance variables on their system, such as CPU usage or 
page file usage in graphical and numerical form. You can add components to the display by clicking the 
large '+' button above the graph. A more user-friendly interface can be added to the Performance Monitor by 
downloading the Microsoft Performance Monitor Wizard. 
 

SERVICES 

This tool is extremely useful in configuring service usage under Windows XP. Changes to settings made 
under this tool can affect performance, stability and XP functionality quite noticeably, so see the Services 
chapter dedicated to explaining these features in more detail and showing you how to optimize them. 
 
That covers the initial look at all the administrative tools in Windows XP. As mentioned, certain tools are 
covered in more detail later in this book due to the need to use them often. Generally though, aside from the 
Services utility and Event Viewer, and possibly Computer Management, you should not need to access the 
administrative tools very often and great caution should be used when changing any settings with them. 
 
 AUTOMATIC UPDATES 

 
 
The Automatic Updates function in Windows allows your machine to periodically check for updates on the 
Windows Update website and depending on the options you set here, download and install them as 
necessary. When set to Automatic here, Windows will check for updates as often as you specify, and if an 
important update for your system is found it will download and install it for you at the same time. If you 
specify 'Download updates for me, but let me choose when to install them', Windows will download the 
updates but only install them when you choose. Neither of these two options is recommended, as updates 
may be downloaded and/or installed at inconvenient times and without your explicit consent. Although no 

http://www.microsoft.com/downloads/details.aspx?FamilyID=31fccd98-c3a1-4644-9622-faa046d69214&displaylang=en�
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Microsoft updates are truly harmful, I still recommend you keep tight control over the downloading and 
installation of Windows Updates. 
 
Instead, if you feel as though you will forget to check the Windows Update site regularly, and want to be 
told whenever important updates are available, select the 'Notify me but don't automatically download or 
install them' option. That way you will be told when an important update is available, but you can still 
choose if/when to download and install it at your convenience. 
 
My personal preference - the one I believe is most optimal for performance and privacy - is the final option: 
'Turn off Automatic Updates'. This means the Windows Update service will not constantly run in the 
background, taking up resources, and at the same time you can simply check the Windows Update website 
manually every few days to see if you should download any important updates. Not only does this give you 
full control over updates, you will also be able to access updates much sooner this way, as they are often 
available via Automatic Update much later than on Windows Update or the Microsoft Download site. 
 
Note that the 'Automatic Updates' service must be set to Automatic to allow you to access the Windows 
Update website, even if you set Automatic Updates to Off here, so don't disable it.  
 
 DATA SOURCES (ODBC) 

This tool is discussed under the Administrative Tools entry above, and has exactly the same function. 
 
 DATE AND TIME 

 

 
 

DATE AND TIME 

Set the current date and time under this tab.  
 

TIME ZONE 

Select the time zone that applies to you, and also tick the 'Automatically adjust clock for daylight savings' 
option. This means that whenever daylight savings changes in your area, the clock will be automatically set 
forward or back as appropriate - handy if you rarely remember when daylight savings actually occurs. 
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INTERNET TIME 

In general it is best to leave the 'Automatically synchronize with an internet time server' option ticked so that 
the system time is always accurate. If you wish you can untick the box and periodically update manually 
whenever you are connected to the Internet by clicking the 'Update Now' button instead - see the Services 
chapter for details on how to disable the Windows Time service as well if you decide to disable this 
functionality here. 
 
 DISPLAY 

THEMES 

You can switch between the Windows Classic theme, which makes XP look like previous versions of 
Windows, or select the Windows XP theme. You can also save any changes you make to Windows XP's look 
by creating a custom theme and saving it. Selecting the Classic theme will provide some memory savings 
due its less graphically intense nature, and can improve performance on very low-end machines. However if 
you prefer the Windows XP theme I recommend you use it regardless. You spend a great deal of time 
looking at the XP interface, so on balance a few MB of memory sacrificed to make the interface easier on the 
eyes is not that bad - uglier does not really equal faster on the majority of systems. See the Visual & 
Convenience Tweaks chapter for details of how to further customize the interface and add more themes. 
 

DESKTOP 

 
 
Select a Wallpaper you would like to display in the background of the Windows Desktop. If the default ones 
listed in the preview pane are not to your liking, you can choose one from an existing picture anywhere on 
your drive(s) or from an inserted disc by clicking the Browse button. Note that if you need to minimize 
memory usage and speed up bootup time, you can either not use a wallpaper at all, or preferably select a 
wallpaper that is the same size as your desktop and less intricate - that is, a picture with a smaller file size. 
 
Click the 'Customize Desktop' button. Here you can also select whether to display or remove the My 
Documents, My Computer or My Network Places icons on your Desktop. Removing these icons (unticking 
them) here will not disable their functionality, it will simply remove their icons from the Windows Desktop. 
Note that if for some reason you wish to remove the Recycle Bin from the Desktop see the Group Policy 
chapter or the Windows Registry chapter for the relevant tweak. You may also wish to change the 
appearance of any of the main system icons that appear on the Desktop. You can choose to alter their 
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appearance by highlighting them in the scroll list below, selecting 'Change Icon' and assigning a new icon in 
their place. 
 

SCREEN SAVER 

You can select a particular screen saver here, to be displayed after a set period of idleness. Modern LCD 
monitors don't actually require screen savers to protect them from 'burn-in' (permanent image imprinting), 
so a screen saver is not an absolute necessity. However you may want to enable the screensaver to prevent 
static images becoming temporarily imprinted on some LCD screens, and of course Plasma screens are more 
susceptible to permanent burn-in and should definitely be protected by using a fully animated screensaver, 
or the Blank screensaver. Note that the settings under the Power button are covered under Power Options 
further below. 
 

APPEARANCE 

I personally prefer the Windows XP Style for Windows and buttons. This uses a small amount of extra 
memory over the Windows Classic Style, but looks much nicer in my opinion and has no significant impact 
on performance. If you are on an old system then you may notice an improvement in responsiveness by 
switching to the Windows Classic Style. You can adjust the individual elements of the desktop theme by 
clicking on the Advanced button, selecting the element you want to change from the drop-down list, and 
adjusting its properties accordingly. 
 
Under the Appearance tab, click the Effects button, and I recommend unticking the 'transition effects', 'show 
shadows under menus' and 'show window contents when dragging' options here for maximum 
responsiveness on the desktop. However once again if you particularly like these effects you can leave them 
enabled without any major impact on most modern systems. LCD users in particular should enable the 
ClearType option here under the 'smooth edges of screen fonts' setting - see ClearType further below for 
details. 
 

SETTINGS 

You may find two monitors listed under the Display list. This is normal for some graphics cards, even when 
only one physical display is currently attached. Select the Screen Resolution you want for the Desktop, and 
the Color Quality to go with it. Note that some recent programs and games may experience problems if the 
Desktop is anything less than 32-bit Color quality, so 32-bit (if available) is strongly recommended for 
maximum compatibility - the performance degradation is insignificant on your Desktop, and there is no 
reason to select any lower bit depth unless you have an extremely old or low-end machine, such as a 
portable device. 
 
If you click the Advanced button under the Settings tab, you will be taken to the control panel for your 
graphics card. While many sections of this screen differ based on your particular graphics card, all graphics 
cards share the following common elements, which are described below: 
 
General: The DPI (Dots Per Inch) setting determines the relative size of everything on your screen. If you run 
at extremely high or extremely low resolutions for example, you can change the DPI to scale the elements of 
your screen to a more suitable size without having to change your resolution. The default of 96 DPI is 
recommended for most people. I also recommend selecting the 'Apply the new display settings without 
restarting' option, so that you do not need to restart your machine each time you change a display setting. 
 
Adapter: Here you will find the details of your current graphics adapter (i.e. your graphics card). If the details 
are incorrect, this could indicate a poorly installed or incorrect graphics and/or motherboard driver, or 
modified/overclocked hardware. Check your details against those provided by the tools in the System 
Specifications chapter. 
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Monitor: Here you can set the Refresh rate used by your monitor for the current screen resolution. I strongly 
recommend that you first tick 'Hide modes that this monitor cannot display', then select the highest refresh 
rate listed. The refresh rate determines how many times per second the image onscreen is redrawn. The 
higher the setting, the more times the screen is 'refreshed', and the less strain there is on your eyes. It is 
strongly recommended that you use a utility called Refresh Force to force the highest possible refresh rates at 
each resolution on your system. This utility is easy to use, and is supported by all graphics cards. Note that 
many LCD displays generally refresh at 60Hz maximum, which is fine since LCD-based displays work on a 
different principle and don't need a high refresh rate - see this page of the Gamer's Graphics & Display 
Settings Guide for an explanation of what Refresh Rate is and how it works. 
 
Under the Troubleshoot tab, move the slider under 'Hardware acceleration' to the far right, and tick 'Enable 
write combining'. This ensures maximum performance, and you should only change these if troubleshooting 
a specific graphics-related problem. 
 
Under the Color Management tab, select the color profile that matches your monitor model and click the 'Set 
As Default' button. If there is no profile listed for your monitor, click the Add button and select one which 
matches your monitor model, or if none seem appropriate, insert the driver disc which usually accompanies 
your monitor, browse to the drive and find the correct .ICM file, then click Add. Alternatively go to your 
monitor manufacturer's website and download the latest driver for the monitor, then install it and recheck 
the list here when you click the Add button. The color profile ensures your monitor displays colors as they 
are intended to appear, which can be particularly important if you are doing things like web design. 
 

CLEARTYPE 

 

 
 
For users of LCD panels and other fixed-pixel display devices that may require some enhancement to make 
text appear sharper and clearer on screen, particularly when using non-native resolutions, Microsoft has an 
option called ClearType you can enable by going to your Display properties (See above), selecting the 
Appearance tab, clicking the Effects button, and changing the 'Use the following method to smooth edges of 
screen fonts' to ClearType. However, to fully customize ClearType you need to use this Microsoft Online 
ClearType Tuner, or download and use the ClearType PowerToy Utility. In either case, ClearType greatly 
improves font display quality by reducing jaggedness, so it is recommended that you use it if you run an 
LCD or other fixed-pixel digital display. 

http://www.pagehosting.co.uk/rf/�
http://www.tweakguides.com/Graphics_7.html�
http://www.microsoft.com/typography/cleartype/tuner/Step1.aspx�
http://www.microsoft.com/typography/cleartype/tuner/Step1.aspx�
http://www.microsoft.com/typography/cleartype/tuner/Step1.aspx�
http://www.microsoft.com/typography/ClearTypePowerToy.mspx�
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GRAPHICS CARD CONTROL PANEL 

For full details on how best to configure the remaining graphic card-specific elements of Display Properties, 
for ATI graphics cards you should refer to the ATI Catalyst Tweak Guide, and for Nvidia cards you should 
refer to the Nvidia Forceware Tweak Guide. Also check the Gamer's Graphics & Display Settings Guide for 
clear explanations of how major graphics-related settings and features work. 
 
When you're done altering the settings in Display Properties click the Apply button. Then go back to the 
Themes tab, click the 'Save As' button and select a new name and location to save your customized theme. 
 
 FOLDER OPTIONS 

GENERAL 

Under the General tab, select 'Use Windows classic folders' to get rid of the lumped-together 'common task' 
icons. The choice is yours of course, but this book assumes you are using the classic folders view when 
giving directions on accessing features. If desired you can use classic folders only while following this book, 
and then switch back to the default XP folder view once you're finished. 
 
Select 'Open each folder in the same window' to reduce open windows and hence prevent unnecessary 
memory usage. 
 
Select 'Double-click to open an item (single-click to select)' as this is the default method most Windows users 
are familiar with, and the one which is assumed when providing descriptions in this book, and most other 
places on the Internet. Again, you can always switch to the other method once you have completed using 
this book. 
  

http://www.tweakguides.com/ATICAT_1.html�
http://www.tweakguides.com/NVFORCE_1.html�
http://www.tweakguides.com/Graphics_1.html�
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VIEW 

 
 
I recommend you tick the following options: 
 
 Display file size information in folder tips 
 Display simple folder view in Explorer's folder list 
 Display the contents of system folders 
 Show hidden files and folders 
 Show and manage the pair as a single file 
 Remember each folder's view settings 
 Show encrypted or compressed NTFS files in color 
 Use simple file Sharing 
 
It is recommended that the following are unticked for best performance and functionality: 
 
 Automatically search for network folders and printers (don't untick if you are on a Network) 
 Hide extensions for known file types 
 Hide protected operating system files 
 Launch folder windows in a separate process 
 Show popup description for folder and desktop items 
 
Any remaining options can be ticked or unticked according to your tastes and needs. 
 

FILE TYPES 

You can view and change which tools will open particular file extensions by default. For example, scroll 
down to the TXT extension (text documents) and highlight it. In the details below you can see that the 
default tool for opening .TXT files is Notepad, and if you click on the Change button you can choose another 
application as the default. Sometimes certain installed applications will quietly change these default 
programs to suit their own needs without asking you, so check back here if you find your files opening with 
something other than the application you want to use, and make changes as appropriate. 
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OFFLINE FILES 

I recommend you untick 'Enable Offline Files'. You'll still be able to view saved/cached web pages offline. If 
the option is unavailable, it is because you have Fast User Switching enabled (See User Accounts further 
below), in which case you can ignore this section. 
 
 FONTS 

This item displays the contents of your \Windows\Fonts folder, which contains all your currently installed 
system fonts. Fonts are the various types of text styles used by a variety of programs such as word 
processors, paint programs and the Windows Wordpad for example. You can install a new font simply by 
copying its .FON or .TTF files into this folder, or by going to the File menu and selecting 'Install New Font...' 
and pointing to the directory where the new font files reside. Note that TrueType is a font technology that 
ensures good scaling so that what is displayed on your screen comes out exactly the same on your printer for 
example - other types of fonts may look slightly different in different applications and/or when printed 
and/or when using different font sizes. To find out more about fonts, go to the Microsoft Typography 
Website. For additional fonts you can download and install for free see Simply The Best Fonts. 
 
 GAME CONTROLLERS 

This tool allows you to add or remove gaming controllers on your system. This typically includes gamepads, 
joysticks and game simulation hardware. Note that although often used in PC games, the mouse and 
keyboard are not classed as 'game controllers' here - they have their own separate setup tools in the Control 
Panel (see Keyboard and Mouse below). 
 
Note that most joystick-based devices require something called Calibration - a process under the device's 
Properties which tells Windows when the stick is at absolute dead center, when it is at far right, far left, etc. 
If this is not done then often you will find the device may be unresponsive in certain directions, or it will 
constantly be read by Windows as moving in one direction when it is actually dead center, and so on. 
 
The majority of game controllers have their own software for installing and setting up the device, however 
firstly I recommend clicking the Add button in the Game Controllers section and using the closest device 
description which matches your device. If then during gameplay you find your device is not functioning at 
all, or missing certain functionality, you should then install and use the device-specific software. This will 
minimize the background resource usage that specialized device drivers often bring with them. 
 
Finally, if you play certain games only using the keyboard and mouse combination, and you find your 
character is displaying strange movement behavior (e.g. constantly moving in one direction with or without 
user input), then physically disconnect all game controllers from your system (excluding keyboard and 
mouse) and reboot, then relaunch the game. 
 
 INTERNET OPTIONS 

This setting in the Control Panel simply brings up the Internet Explorer 'Internet Properties' box. There is no 
difference between accessing it here and accessing from within Internet Explorer, so see the Internet Explorer 
chapter for full details of how to configure these options. Note if you are using another browser as the 
system default browser then clicking this item will still bring up the Internet Explorer 'Internet Properties' 
box - this is normal and cannot be changed. 
  

http://www.microsoft.com/typography/default.mspx�
http://www.microsoft.com/typography/default.mspx�
http://www.microsoft.com/typography/default.mspx�
http://simplythebest.net/fonts/�
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 KEYBOARD 

Under the Speed tab, I recommend you set the 'Repeat Delay' slider to the far right and also set the 'Repeat 
Rate' slider to the far right. This will increase the responsiveness of the keyboard in Windows XP. You can 
also adjust the 'Cursor Blink Rate' to your taste, and then click OK to apply. You can test these settings in the 
box provided to see if they suit you. Note you can further customize the cursor's blink rate and width under 
the Display tab of the Accessibility Options item in Control Panel. 
 
 MOUSE 

 
 
I only cover the basic mouse settings here, and most of the settings in this section can be adjusted to taste. If 
you have installed a special mouse driver, you may see different settings under this screen, however the 
settings below should still be available on most systems with a mouse. 
 

POINTERS 

I recommend you untick 'Enable Pointer Shadow' at the bottom. 
 

POINTER OPTIONS 

Ticking the 'Enhance pointer precision' option enhances the acceleration/deceleration of your mouse to 
provide for larger movements when you move the mouse fast, and finer movements when you move the 
mouse more slowly, allowing a balance between speed and precision. I recommend unticking the 'Display 
pointer trails' option to reduce mouse lagginess unless you have difficulty keeping track of mouse 
movements. 
 

WHEEL 

If your mouse has a mousewheel (also called a scroll wheel), you can increase the wheel's responsiveness by 
increasing the number of lines it will scroll on each turn of the wheel. Even an increase from the default of 3 
to 4 for example will make a subtle, but noticeable difference if you previously found the wheel relatively 
unresponsive. 
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INCREASING USB SAMPLE RATE 

If you have a USB mouse and want to increase the rate at which it takes samples of its current position - 
thereby increasing accuracy and responsiveness - check this USB MouseRate Switcher. A warning however 
that there is an element of risk involved in using this utility as it affects all USB devices, read the instructions 
closely before implementing, and only use this tweak if you are an advanced user. 
 
 NETWORK CONNECTIONS 

Because of the sheer variety of network connection hardware, and the potential for doing more harm than 
good, altering your Network Connections settings is not a simple procedure and I will not be covering it in 
detail in this book. If you have a Dialup connection - that is 56K or lower connection speed - then read this 
Dialup Modem Tweak Guide for more details. If you have DSL or Cable, use the information from this 
DSL/Cable Tweak Guide for guidance. If you are on a Network of computers, consult your Network 
Administrator before attempting to alter any of the Network Connection settings, and be very careful about 
which other settings you implement from this book, especially those under the Services chapter, as the 
advice is not designed for Networked users. 
 
In general, I recommend that you do not alter your network-related settings regardless of the type of 
connection you use, as more often than not, your connection will end up being slower rather than faster, and 
in many cases you may lose Internet functionality. Most network connections require specific procedures to 
set up optimally, and these are usually documented in the device's instructions which is the best place to 
look for tips and advice. 
 

 
 

QOS PACKET SCHEDULER 

The following is recommended for home dialup and Cable/DSL users (but not for Network or Shared users). 
Right-click on the device you use to connect to the Internet, and select Properties. Go to the General tab, and 
under the 'This connection uses the following items' list, make sure the 'Internet Protocol (TCP/IP)' option is 
available and ticked. Now select every other item listed, including the 'QoS Packet Scheduler' and click the 
Uninstall button to remove them. None of these are required for regular Internet usage by a single non-
networked machine, and removing them will reduce unnecessary resource usage. Should they be needed 
again you can always simply reinstall them from here at any time. Note if you disable the QoS Packet 
Scheduler you should also disable the 'QoS RSVP' service - see the Services chapter. Neither are required for 
the average home Internet user. 

http://www.majorgeeks.com/USB_Mouserate_Switcher_d4469.html�
http://www.techspot.com/tweaks/modem-win2k/�
http://www.dslreports.com/tweaks�
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WINDOWS FIREWALL 

Under the Advanced tab click the Settings button and turn the Windows Firewall On as advised previously, 
unless you have third party firewall software already installed, in which case activate that instead, and 
disable the Windows Firewall. To find out more about Firewall alternatives see the PC Security chapter. 
 
 NETWORK SETUP WIZARD 

This wizard will take you through the steps required to connect a network device, including any device that 
connects your machine to the Internet. You can follow the steps in the wizard to connect your device, 
however I generally recommend you follow the instructions that come with your device instead, along with 
instructions from your particular Internet Service Provider (ISP). 
 
 PHONE AND MODEM 

As mentioned under Network Connections above, because of the variety of devices that can be used to 
connect to the Internet, or to other electronic devices, I cannot provide specific setting recommendations here 
for each device. Check the links under Network Connections above for more details. 
 
As with installing any other type of peripheral device under Windows XP, typically the best installation 
procedure is to simply connect the device to your system, and wait for Windows XP to identify the device 
and install the default drivers. However in the case of modems I recommend installing the latest available 
drivers or at the very least the drivers which come on the device's driver disc. If you have any doubts about 
what settings to use once the device is installed, I strongly recommend leaving them at their defaults. 
Changing these settings can see your modem or device not function correctly, and hence you may not be 
able to connect to the Internet. Note that devices listed under Phone and Modem may include devices 
loosely identified as 'modems' such as any connected mobile phones. 
 
 PORTABLE MEDIA DEVICES 

If you have a portable media device connected to your system, such as an MP3 player, you can manage the 
device here. It is recommended that you refer to your device's instructions as to how best to configure it for 
connection and usage with Windows, as typically specific software is required for correct functionality. 
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 POWER OPTIONS 

 
 

POWER SCHEMES 

You can set the periods of time after which your monitor, your hard drive and/or your entire PC go into a 
power-saving standby state to conserve energy. You can select an appropriate preset scheme such as 
'Portable/Laptop' or 'Always On', or you can customize the settings yourself. 
 
Unless you have a power-limited device, such as a laptop running on batteries, I recommend selecting 
'Always On' to start with. Next, for the 'Turn Off Monitor' option, I recommend selecting a period which is 
not too short, so that the monitor isn't constantly switching off - e.g. select 20 minutes. Combined with a 
shorter period for a screensaver to kick in (See further above), such as 5 or 10 minutes, the two settings 
ensure that your monitor saves power without becoming a nuisance. I recommend against enabling the 
'Turn Off Hard Disks' option on a desktop PC - set it to Never. Even if you're not at your system, there may 
be scheduled drive-related tasks which are necessary such as background defragmentation, and so switching 
the drive off will only hurt performance for minimal power savings. Similarly, I don't recommend using the 
System Standby option for desktop PCs, as putting your entire system into standby mode once again 
prevents background tasks from executing. 
 

ADVANCED 

I recommend unticking the 'Always show icon in the taskbar' option to remove the unnecessary power icon 
in the system tray. If you don't use system standby, or if physical security is not a concern then I also 
recommend unticking 'Prompt for password when computer resumes from standby'. In the Power Buttons 
section, select the action you want for 'When I press the power button on my computer' - I recommend 
selecting Shut Down from the list for the most obvious and trouble-free result. 
 

HIBERNATE 

I recommend not using Hibernation for desktop PCs and hence I suggest you untick the 'Enable Hibernation' 
option here. Hibernation uses a great deal of disk space to store the state of your machine at the time of 
hibernation - equivalent to your physical RAM size in disk space - and for optimal stability I recommend 
that you start each computer session with a clean bootup. This will reduce the possibility of memory-related 
problems and crashes. 
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UPS 

If you have a power supply that is specifically classified as an Uninterruptible Power Supply (UPS), you can 
configure it here. Most people do not have UPS power supplies, and if you're not sure whether you have one 
then it's almost certain that you don't, hence you can ignore this section. See the Services chapter for more 
details about how to disable the UPS Service if you don't have a UPS power supply. 
 
 PRINTERS AND FAXES 

This section allows you to view all connected printers and faxes, and add or remove such devices. It is 
recommended that you refer to the particular device's instructions for optimal setup information under 
Windows XP as each can differ. 
 
Importantly, note that if you have disabled the 'Print Spooler' service then any printer on your system will 
not function - this also includes 'printer-like' utilities such as PDF makers. Make sure the 'Print Spooler' 
service is set to Automatic if you want to use a printer. Furthermore if you have disabled the port to which 
the printer is connected in the BIOS or in Device Manager (e.g. LPT1 or a specific USB Host Controller), 
perhaps to free up an IRQ, then once again your printer will not function - you will have to re-enable it. 
Finally, if you are connected to a network printer and you have followed my service configuration 
recommendations under the Services Utility chapter - which as noted are not intended for networked 
computers - then your network printer may not be detected by Windows. Go through this book again and 
make sure all network-related functions are enabled so you can access your network printer. 
 
 REGIONAL AND LANGUAGE OPTIONS 

 

 
 

REGIONAL OPTIONS 

Select the language format that suits your particular region of the world. You can also set your country at the 
bottom, and it is recommended that you do so to allow all your software to be able to customize options and 
text displays to suit you, not just in Windows XP itself, but also in all the games and applications you use. If 
you wish to customize any specific settings, such as date/time display formats, currency formats etc. click the 
Customize button and do so accordingly. If you've selected the appropriate country though, the defaults 
shown here should already be correct. 
  

http://en.wikipedia.org/wiki/Uninterruptible_power_supply�
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LANGUAGES 

Click the Details button and select your default input language. 
 
If you only ever use one particular text service on your machine for each language, such as Keyboard (the 
default, and a necessary service), then remove any other text services displayed under each language (such 
as Speech Recognition) as they take up additional memory. Do this by highlighting the displayed text service 
in the Installed Services box, and click on Remove.  
 
Alternatively, if you want to Add a text service, or configure these advanced text services for various 
functionality, see this Microsoft Article for more details. Remember, the use of advanced text services takes 
up memory and can reduce system performance, so only enable these functions if you really use them often, 
and not just as a novelty. 
 
In the Preferences section below it, if you have more than one text service installed you can click the 
'Language Bar' button (otherwise it is unavailable). I recommend selecting 'Close the language bar' to 
remove it from your desktop unless you specifically need it there. If you do use more than one language 
often, I still recommend closing the Language Bar, and instead assign keyboard shortcuts for switching 
between these languages, by clicking on the 'Key Settings' button here. This is a much more efficient and 
quicker method of switching languages. 
 
Under the Advanced tab, unless you use any advanced text services such as speech or handwriting 
recognition, tick the 'Turn off advanced text services' option. If you do wish to use advanced text services, 
and also want them to be available to all your programs and applications, then tick the 'Extend support of 
advanced text services to all programs'. Click Apply and OK to go back to the Regional and Language 
Options box. 
 
Back under the Languages tab of the main Regional and Language Options box, unless you use a right-to-left 
language (such as Arabic or Thai), or an East Asian language, then make sure both boxes under the 
Supplemental language support area are unticked, and click Apply. This removes unnecessary language files 
from your drive. 
 

ADVANCED 

Select the language you want for non-unicode programs. Since Unicode basically allows most modern 
programs to automatically adapt their menus and dialogs to your system's default language, this setting 
only applies to older non-unicode programs. These older (non-unicode) programs will use the Code page 
conversion tables listed to convert from other languages to your preferred language. While you can choose 
to remove or add (untick or tick) various conversion tables in this section, I recommend against doing so as 
this can affect the correct language display of any older programs you use. Some of the conversion tables are 
greyed out as these are installed by default for Windows XP and cannot be removed. 
 
If you want to make the settings you have modified in the Regional and Language Options box the default 
for every user account created on this system as well as the current account, tick the 'Apply all settings to the 
current user account and to the default user profile' box. 
 
 SCANNERS AND CAMERAS 

This section will allow you to manage any digital image devices such as scanners or digital cameras 
connected to your machine. Refer to your device's manual for specific setup recommendations. Typically 
you will simply need to attach your device, turn it on and Windows XP should detect it and install basic (but 
adequately functional) drivers. I recommend that only if you are having problems accessing the device, or if 
any of its important functionality is missing, that you install device-specific drivers or software. Otherwise 
the default Windows XP drivers are the most efficient and minimize background resource usage. 

http://support.microsoft.com/kb/306537�
http://www.unicode.org/standard/WhatIsUnicode.html�


 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 122 Copyright © 2010 Koroush Ghazi 

 

The C
ontrol Panel 

 
 SCHEDULED TASKS 

The Scheduled Tasks utility allows you to set up particular tasks that your machine will then run at a 
predetermined time and in a predetermined sequence. To create a new task, click the 'Add Scheduled Task' 
item, and the Scheduled Task Wizard will commence, allowing you to detail the task to be run. You can also 
view and edit existing scheduled tasks in this panel. I recommend you go to the Advanced menu and select 
the 'View Hidden Tasks' option to ensure all scheduled tasks are shown. I generally do not recommend 
having many scheduled tasks; regular system maintenance for example is best carried out manually, at 
intervals determined by frequency and type of use and not set periods of time - see the Regular Maintenance 
chapter. Note that the 'Task Scheduler' service must be set to Automatic for scheduled tasks to function. 
 
 SECURITY CENTER 

 
 
The Windows Security Center unifies access to, and monitoring of, major security-related Windows settings 
on your system. Primarily these are the Windows Firewall for protecting against externally-initiated 
intrusions into your system; Automatic Updates which ensures notification and/or installation of important 
Windows XP updates as they are released by Microsoft; and Virus Protection which works in conjunction 
with your virus scanner to make sure your system is free of infected files which can compromise your 
system's security, stability and privacy. 
 
Each of these areas and appropriate recommendations is covered in the relevant section of this book: the 
Windows Firewall is covered in the Windows Firewall section below; Automatic Updates is detailed in the 
Automatic Updates section above; and Virus Protection is covered under the PC Security chapter above. The 
Security Center is simply a means of gaining access to all of these and changing some of their settings in a 
central location. As such, it's not actually a dramatic improvement in security - simply one that makes users 
more aware of the types of things they have to monitor and change to maintain system security. 
 
The one setting which I do find very annoying and I recommend you change is the Virus Protection setting. 
In the 'Virus Protection' box in the Security Center click the Recommendations button. In the 
Recommendation box which opens, I suggest you tick the box at the bottom. This will prevent Windows 
from constantly reminding you that your virus scanner's reference file is out of date, or that your virus 
scanner is not found, or that it is not currently active. For starters many popular antivirus programs are not 
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supported by this feature. Secondly, it should be part of your regular maintenance procedure to manually 
update your virus scanner and run manual scans often. Finally, as I recommend throughout this book, 
having any malware scanner running in the background can and will reduce your system performance for 
marginal gains in security. For all intents and purposes as long as you follow the other recommendations in 
this book your system should be quite secure and clear of malicious software. If however you are genuinely 
forgetful and your virus scanner appears to be supported by this feature, you may wish to keep the 
monitoring function of Virus Protection enabled. 
 
Note the Windows Security Center won't function fully if the 'Security Center' service has been Disabled - 
see the Services chapter. I recommend that the 'Security Center' service be set to Automatic to begin with, 
adjust your settings as recommended above, then disable the 'Security Center' service again as it is not 
necessary to continually access the Security Center to maintain security on your system. That is, disabling 
the 'Security Center' service will not disable the Windows Firewall, Automatic Updates or Virus scanner 
functionality at all. Also see the PC Security chapter of this book for more tips on how to secure your PC. 
 
 SOUNDS AND AUDIO DEVICES 

 

 
 

VOLUME 

Adjust the volume to suit your taste, and make sure the Mute option is unticked. I recommend ticking the 
'Place volume icon in the taskbar' option as adjusting the volume is something you may do often in 
Windows, so this provides quick access via a speaker icon in the System Tray. I will cover the settings under 
the Advanced button a bit later below, as part of my instructions for optimal sound output. 
 
Under the Speaker settings section, you can independently adjust each speaker's volume level by clicking the 
Speaker volume button. In general this volume can be adjusted under the Volume tab as described above, so 
you only need use this section of the Sound options to check and make sure all speakers are outputting at the 
same volume, or adjust the individual speakers to have different volume levels each if that is what you want.  
 
Click the Advanced button here, and under the Speakers tab select the type of speaker setup you are using, 
such as Headphones or Desktop Stereo Speakers. Choose the setting closest to your particular setup. Under 
the Performance tab, move the 'Hardware acceleration' slider to the far right. This ensures full use of your 
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sound hardware's features. Only reduce the slider by one or two notches if you are troubleshooting sound 
problems in a game for example. Move the 'Sample rate conversion quality' slider to the far right. This 
ensures optimal sound quality, and there is no discernable performance difference between the various 
settings on this slider. 
 

SOUNDS 

You can assign different sounds to particular system events in this section. Click on the relevant Program 
events (e.g. 'Start Windows') and either scroll through the list of default system sounds in the Sounds list 
below and select one, or click the Browse button to find a sound file elsewhere on your system which you 
can use. Press the Play button to hear a preview of the sound. 
 
I strongly recommend that you disable as many system sounds as you can, as they take up system memory 
by being loaded into RAM at startup. In particular I recommend disabling sounds for 'Start Windows' and 
'Exit Windows' to both reduce memory usage and speed up booting up and shutting down Windows. Also 
note that various programs add sub-entries to this section and include their own specific sounds, even if you 
uninstall them later on. Go through the entire list carefully and disable all unnecessary sounds.  
 
You can quickly disable all system sounds by selecting the 'No Sounds' item under the Sound scheme area - 
this doesn't turn off sound on your system, it simply removes sounds effects from all the various system 
events thereby reducing memory usage by these sounds. If you want to keep sounds for certain important 
events, such as Default Beep or System Notification, I recommend you apply the same sound to several 
similar events. For example, on my system I use the Exclamation.wav sound for all warning and alert events 
(i.e. Asterisk, Critical Stop, Default Beep, Exclamation, New Mail Notification and System Notification). That 
way if Windows runs into a problem or provides a warning/notification I can still hear an audible indicator 
of it, but by using the same sound for each event, my memory usage is reduced. 
 
Once done, save these new settings by clicking 'Save As...' and entering a new name. 
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AUDIO, VOICE 

Make sure the default device in each of these categories is your primary sound hardware then tick 'Use only 
default devices' to minimize problems and conflicts with any other sound devices which may also be present 
on your system.  
 

OPTIMAL SOUND CONFIGURATION 

 
 
My suggested method for configuring your Sound settings for optimal sound output is provided below: 
 
1. Click the first Advanced button under the Volume tab of the Sounds and Audio Devices box. 

Alternatively, simply double-click on the Volume icon in the system tray. 
2. In the Volume Control dialog box that appears, go to the Options menu and make sure the 'Advanced 

Controls' option is ticked. 
3. Select the Properties item under the Options menu, and in the box that appears select your main sound 

output device in the Mixer Device list. Select Playback in the next section. Place a tick against every item 
in the list shown, and click OK. Back in the Volume Control window, you will notice it has expanded to 
show Volume, Balance and Mute options for every audio output method on your system. 

4. Go to the master Play Control (far left) and adjust the master Balance setting. Unless you specifically 
need an offset balance, the neutral (absolute middle) position is recommended.  

5. Make sure the 'Mute All' option is unticked 
6. Set the master Volume level to around the center position on the slider, then play a high quality music 

or audio file on your system (e.g. an MP3 file, not CD Audio as that uses independent sound) and adjust 
your speaker hardware's physical volume controls until the sound level is correct. 

7. Click the Advanced button, and if available to you (depending on your sound hardware) adjust the Bass 
and Treble settings to taste. If you don't have Digital Output capable sound hardware, make sure the 
'Digital Output Only' box is unticked, otherwise you will not hear any sound. Click Close when done. 

8. Now go to the Wave output method in the Volume Control box and make sure the Mute option is 
unticked. Again, while playing some music on your system adjust the Wave volume and your speaker 
hardware volume control together until the combination suits your taste and has the least amount of 
distortion and/or background noise. The Wave output method is the output method used by most 
games, applications and audio playback software so it's important to set it up correctly and at a tolerable 
level. 

9. Go through and adjust all the other sound output methods' Volume and Balance settings to taste. To 
further reduce background noise and hissing, I recommend muting (tick the Mute option) for every 
sound output method you do not regularly use. Input devices, such as Line-In, TAD-In and Microphone 
in particular can contribute to background hissing, so mute them unless needed. 

10. Once done, go to the Options menu and select Properties, then untick all the sound output methods 
except those that you will be adjusting the properties of quite often. This will not disable these methods, 
only remove them from displaying in the Volume Control box, making it more manageable the next 
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time you open it. At a minimum I recommend you leave the Play Control and Wave items ticked, as 
these are the ones used most often on all machines. 

 
If you have a complex speaker setup or third party audio software you may wish to use that to adjust 
equalizer settings for example. In which case after you've followed the advice above go into that software 
and conduct more setting tweaks as necessary. 
 
Importantly, if your sound hardware has any Environmental Audio or Special Effects settings in your sound 
card-specific software (such as the EAX Control Panel for Creative sound cards), open these settings and 
disable all effects. These additional effects typically cause problems in games and can distort music and 
other audio played back on your machine. 
 
 SPEECH 

This utility allows you to configure the speech recognition and text-to-speech capabilities of Windows XP. To 
use speech recognition, you will require an input device (i.e. microphone) connected to your system. To use 
text-to-speech functionality, you don't require anything other than audio playback hardware such as a sound 
card and speakers/headphones. You can select the voice style used to convert text to speech, and adjust its 
speed here. Note that this functionality must be supported by the program or game you are using if you 
want it to work. Also note that in most games or applications where you can enable a synthesized voice, you 
should be able to adjust the characteristics for this voice in this section of the Windows Control Panel since it 
is likely using the default Windows voice engine. If you want to download additional synthesized voices to 
use see this Text-to-Speech Voice site. 
 
 SYSTEM 

This is an important section of Windows XP, and each of the tabs under System Properties is covered below: 
 

 
 

GENERAL 

If any of the details displayed are incorrect then it is a sign of a bad install, new/unsupported hardware, IRQ 
conflicts, poorly installed/incorrect drivers or overclocking problems. In general if your system is 
functioning correctly then the information in this section should be correct. You may notice your CPU's 
speed rating is shown slightly higher or lower than its actual rating - this is normal. Importantly, you should 

http://www.bytecool.com/voices.htm�
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make sure that after your Windows version, it says 'Service Pack 3' - if it doesn't, make sure to follow the 
instructions under the Driver Installation chapter to install the latest Service Pack, as it is an essential update, 
especially as Microsoft has now dropped all support for pre-SP3 versions of Windows XP. 
 

COMPUTER NAME 

Leave the Computer Description field blank, or use a generic description. To change your computer name, 
click the Change button. In both cases I strongly recommend against placing anything uniquely identifiable - 
such as your real name or address - in these fields. Unless you are part of a network of computers (the 
Internet doesn't count as a network in this instance), there is no need to alter your Network ID, nor the 
Workgroup you belong to. If you are part of a network, consult your System Administrator before 
attempting to change any of the settings above as it may result in problems and confusion, or completely 
dropping out from the Network. 
 

HARDWARE 

The 'Driver Signing' and 'Windows Update' options are covered in more detail in the Driver Installation 
chapter. 
 

DEVICE MANAGER 

Click the Device Manager button, go to the View menu and select 'View Devices by Type' and also tick the 
'Show Hidden Devices' option. You will see all the devices connected to your system at the moment, most of 
which are physical devices, some of which are virtual devices. Devices with a yellow question mark or 
exclamation mark next to them will need further troubleshooting to correctly identify and install. Typically 
this involves ensuring the device is correctly attached to your system, then double-clicking on the device in 
Device Manager, selecting Update Driver under the Driver tab, and following the prompts to install or 
reinstall the correct driver for the device. You may also need to install any software that came with the 
device to correctly use it. See the Driver Installation chapter for more details of drivers, and the Windows 
Errors chapter for more details of Device Manager error codes. 
 
You should disable devices that you don't regularly use to speed up windows and free up resources. Ideally 
this should be done first in the BIOS - See the BIOS Optimization chapter. However, to disable a device in 
Device Manager, double-click on the device and select 'Do not use this device' under the Device usage area 
at the bottom of the box. A red cross will appear next to the device, indicating it has been disabled. Make 
sure to only disable devices you knowingly do not use. If in doubt leave them enabled, or re-enable them if 
you experience any unusual behavior. 
 
Go to the View menu and choose 'View Resources by type', then expand the 'Interrupt Request (IRQ)' item. 
Make sure each major device in your system (graphics card, sound card etc.) is on a separate IRQ from other 
major system devices. See the BIOS Optimization chapter for more details of IRQ sharing. 
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REMOVE UNUSED DEVICES 

 
 
For each device that has ever been connected to your system, Device Manager will retain a range of entries in 
the Windows Registry relating to the device type, and the drivers and settings it used. That way if the device 
is ever reconnected it can be quickly recognized again and ready for use. However there are times when you 
have permanently discontinued the use of a device and you want to clean out the Device Manager of these 
unused device(s). To view unused devices in Device Manager, do the following: 
 
1. Open a Command Prompt by going to Start>Run and type cmd then press Enter. 
2. Once the MS DOS prompt is open, type the following lines exactly as shown, pressing Enter after each: 
 

Set devmgr_show_nonpresent_devices=1 
 
devmgmt.msc 

 
3. You can now type exit and press Enter in the command prompt window to close it. 
4. In the Device Manager window that opens go to the View menu and select 'Show Hidden Devices'. Now 

expand the categories and start looking through all the devices. Devices in gray are usually old/unused 
and safe to remove by right clicking on each one and selecting Uninstall.  

5. In particular, you might find several entries under the Monitors section from previous graphics driver 
installations. You can typically delete all the greyed out entries but at least one un-greyed entry should 
remain. You may also find old entries for previous graphics cards under the Display Adapters section 
that again can be removed. Remember that even with only one monitor connected there may be two 
entries for some graphics cards, one of which is the Secondary - this is normal. 

6. You should not remove any Microsoft devices such as those under the Sound section, or devices that 
you are unclear about, or know that you will be reconnecting to your system regularly. 

7. Once done, you can close Device Manager the usual way and the next time you open it up it will not 
shown unused devices until you again use this method to do so. 

 
Use this method with great caution. In particular I recommend you create a new System Restore point 
beforehand. At the same time however if you do accidentally uninstall a hardware device which is currently 
connected to your system, in many cases you can simply disconnect and reconnect the device, or reboot 
Windows, and it will be redetected by Windows and the appropriate drivers installed again - so this method 
doesn't permanently remove any device nor prevent it from future usage. 
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Back under the Hardware tab of System Properties, click the 'Hardware Profiles' button and for optimal 
bootup speed have only one hardware profile and choose 'Select the first profile listed if I don't select a 
profile in' and set the time to 0 seconds. 
 

ADVANCED 

The Advanced tab of System Properties has three major areas of settings - Performance Settings, User 
Profiles Settings and Startup and Recovery Settings - these are covered separately below: 
 
Performance Settings: 
 
Visual Effects: For fastest performance, I recommend unticking everything except 'Use visual styles on 
windows and buttons' and 'Use drop shadows for icon labels on the desktop'. That will reduce usage of 
system resources for graphical effects, while still retaining the majority of Windows XP's trademark 
appearance. Obviously you can tick other effects if you specifically want to keep them. 
 
Advanced: In the Processor scheduling section select the Programs option for optimal performance on the 
majority of systems. The 'Background Services' option will only improve performance on systems where 
multiple programs are often run together. 
 
Under the Memory usage section, once again select the Programs option. The 'System Cache' option is 
designed for servers, where more memory is used to speed up disk access at the expense of available 
memory for programs. Importantly, data corruption may occur under certain conditions if the 'System 
Cache' option is enabled, so it is strongly recommended that you do not select it. 
 
For optimal settings under 'Virtual Memory', see the Memory Optimization chapter for full configuration 
details. 
  



 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 130 Copyright © 2010 Koroush Ghazi 

 

The C
ontrol Panel 

 
 
Data Execution Prevention (DEP): This is a technology introduced with Windows XP SP2, and uses software 
and (where supported) hardware detection of programs that try to access and run code from designated 
'non-executable' memory areas. Full details of it are in this Microsoft Article. In practice DEP protects against 
malware that has become resident on the system and which then tries running malicious code from such 
memory areas. When DEP detects an attempt to launch an executable from a non-executable memory area it 
will shut the program down and provide a notification that it has done so. Hence if you are experiencing 
crashes or problems in games for example, unless you see Windows give you a specific DEP-related 
warning, it is highly unlikely that DEP is the cause of the problem. 
 
By default when 'Turn on DEP for essential Windows programs and services only' is selected, DEP 
protection is only enabled for programs that choose to work with DEP, along with Windows system files. 
This is the minimum form of DEP protection. You can choose to extend this protection to all programs by 
selecting 'Turn on DEP for all programs and services except those I select' - and then choose which programs 
to manually exclude from DEP by using the Add and Remove buttons. I recommend leaving DEP at its 
default setting ('Turn on DEP for essential Windows programs and services only') as it is not problematic 
and helps reduce any potential damage from malware activity on your computer. However if you want to 
change your DEP settings in more depth, including the total disabling of DEP, you can do so by editing your 
Boot.ini file (To access and edit Boot.ini see further below). The entry to change in Boot.ini is the /NoExecute= 
option. By default it is set to /NoExecute=OptIn however you can change the OptIn value to one of the ones 
below to change DEP's implementation: 
 
OptOut - Applies DEP to all processes and you must then set which programs are excluded manually. This is 
the same as the 'Turn on DEP for all programs and services except those I select' option above. 
 
AlwaysOn - Provides full DEP coverage for your entire system. If you are concerned about potential malware 
activity on your system and want maximum protection you can use this setting, although older software 
may have problems with it. 
 
AlwaysOff - This option turns off DEP completely. It is not recommended unless you are having a lot of 
problems with program crashes directly related to DEP even after thoroughly cleaning your system by 
following the advice under the PC Security chapter of this book. 
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Once again, it is recommended that you leave DEP at its default setting unless you are specifically having 
DEP-related errors and problems, which is usually quite rare. 
 
User Profiles Settings: 
 
Back under the Advanced tab of the main System Properties box, click the Settings button under User 
Profiles, and examine the profiles stored on your computer. There will always be at least two profiles - the 
Administrator, and the default User profile here. If you are absolutely certain any other profiles are no 
longer in use, you can select them and press Delete to remove them from the system, which will free up disk 
space. 
 
Startup and Recovery Settings: 
 

 
 
Under the Startup and Recovery section, click the Settings button. For a system with a single operating 
system, select '"Microsoft Windows XP [Home/Professional]" /FASTDETECT...' in the list presented. For a 
multiboot system with two or more operating systems, select the one that you want to boot up by default 
each time you start your machine. If you only have one operating system, or you don't want to select a 
different operating system each time you boot up, untick the 'Time to display list of Operating Systems' 
option. Note that if you have an XP/Vista/7 dual boot, you can still untick this option, because the other OS' 
boot files which control dual booting are not affected by these settings. You will have to adjust your bootup 
options directly in Windows Vista or Windows 7 - see the Boot Configuration chapter of the relevant 
TweakGuides Tweaking Companion for details. 
 
Tick the 'Time to display recovery options when needed' option and select at least 10 seconds if not more. 
This is the amount of time you'll get to choose the type of bootup from the recovery menu after a bad system 
crash. 
 
Click the Edit button to edit your Boot.ini file. Change the timeout= value in the second line to =0. You can 
also change the /NoExecute= setting here as covered under the DEP information above. When done, save and 
exit the text editor and the changes will be made to your Boot.ini file in your base directory. Note again that 
under an XP/Vista/7 dual boot, the Boot.ini file is not used and hence editing it is irrelevant. 
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Under the 'System failure' section untick all three options for optimal performance, and the 'Write 
Debugging Information' option should be set to None. That way if you run into problems you'll see the error 
displayed - usually a Windows Blue Screen of Death (BSOD) message - and your system won't automatically 
reboot, giving you time to read and record the error details at your leisure. At the same time you won't get 
lots of logfiles and dumpfiles of the event cluttering up your drive. Re-enable these options if 
troubleshooting a vague problem, or if relevant Technical Support personnel ask you to provide these files. 
See the Windows Errors chapter for more troubleshooting tips. 
 
Environment Variables: 
 
Under the Environment Variables screen I suggest you leave all the listed variables at their default settings, 
as most are needed by Windows and various programs to operate correctly. These should only be changed if 
instructed by a particular program or by Technical Support, and even then you should record the original 
settings in case something goes wrong. 
 
Error Reporting: 
 
Click the Error Reporting button and select 'Disable Error Reporting' and tick 'But notify me when critical 
errors occur'. This will prevent your system continually informing Microsoft of errors occurring on your 
system, but at the same time will still show you important system messages and errors for notification and 
troubleshooting purposes. 
 

SYSTEM RESTORE 

Only tick the 'Turn off System Restore' box if you feel extremely confident about your Windows expertise. 
System Restore can take up a great deal of disk space, however I strongly recommend that you leave it 
enabled since it can also save you a great deal of heartache if things go wrong. See the Backup & Recovery 
chapter for more details of how to use System Restore to backup your system state. Also see the Cleaning 
Windows chapter for details of how to delete older restore points to reduce the amount of disk space used 
up by System Restore. If you choose not use System Restore, see the Services chapter for details on how to 
disable the 'System Restore' service to save on system resources. 
 

AUTOMATIC UPDATES 

See the Automatic Updates section earlier in this chapter for more information on this functionality. 
 

REMOTE 

I strongly recommend that you disable (untick) the available options in this section for security and 
performance reasons. Only re-enable these options if specifically asked to do so by a trusted Technical 
Support person who requires remote access to your machine. Allowing remote access can, under certain 
circumstances, let someone else access your machine and all its various files and settings as though they 
were sitting in front of your PC, so clearly it can compromise your security if left enabled. 
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 TASKBAR AND START MENU 

 

 
 

TASKBAR 

The Taskbar is the long bar which sits at the bottom of your screen and contains your Start button, buttons 
for any open programs, and the System Tray. Most settings in this section can be set to suit your taste. 
 
The 'Lock the taskbar' option prevents accidentally moving or resizing the taskbar when ticked. When 
unticked, you can resize the Taskbar by dragging the top edge of it upwards, or you can move the entire 
Taskbar to sit at the left, right or top of the screen by dragging the bar itself - if you wish to do this, unlock 
the Taskbar, reconfigure it as desired, then lock it again to prevent unintended changes. 
 
I recommend you initially untick 'Hide Inactive Icons' so that you can see all the programs which are loading 
in the background in your System Tray area. I then recommend disabling as many of these as possible - see 
the Startup Programs chapter for more information on how to identify and disable unnecessary 
startup/background programs, as this is a critical step. If you want to eventually enable 'Hide Inactive Icons', 
perhaps to hide an annoying but necessary icon in the system tray (such as the 'Safely Remove Hardware' 
icon), tick the option and click the Customize button to select precisely which applications to always hide in 
the system tray, which to always show, and which should be hidden when inactive. Again, I recommend no 
applications be hidden when inactive, or hidden at all, unless you are absolutely certain they are essential 
and thus can be left running in the background at all times. Many application or game incompatibilities and 
crashes occur due to background programs, so hiding them will only make it harder to troubleshoot 
problems in the future. 
 

START MENU 

I recommend you select the 'Start Menu' option here to use the Windows XP default menu system. It has 
many advantages over the Windows Classic menu system. Click on the Customize button next to it and 
under the General tab, choose settings to taste. If you want to remove the Frequently Used Programs listing 
normally available on the Start Menu under the pinned items, set the 'Number of Programs on Start Menu' 
option to 0 and click the 'Clear List' button. 
 
Under the Advanced tab, I recommend you tick 'Open submenus when I pause on them with my mouse' to 
speed up menu access, and untick 'Highlight newly installed programs' as it is generally unnecessary.  
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Under the 'Start Menu Items' section, I recommend you tick the following: 
 
 Enable Drag and Dropping 
 Run command 
 System Administrative Tools - Display on the All Programs menu 
 
These features should be enabled when using this book, and I recommend keeping them enabled afterwards 
also. The other settings in this section can be ticked or unticked according to what you wish to have 
displayed on your Start Menu. 
 
When finished, click the Apply button and your changes will immediately be made to the Start Menu. 
 
 USER ACCOUNTS 

 
 
Windows XP allows multiple users to have varying levels of access to the same machine. By creating a 
separate User Account, each user can store their own settings, keep their own documents private, and have 
limited access to the system-wide settings on the same computer.  
 
My recommendation is that unless you have several people using the computer and each need separate 
accounts, you should only use one Administrator-level user account for fastest performance. That way you 
don't need to worry about logging into and out of two or more separate accounts (the Administrator and a 
lower level User account) just to make system changes and install/uninstall system software. Some recent 
software, as well as many games, require administrator-level access to use properly. 
 
Technically this is a security risk, as using an Administrator level account by default allows greater access to 
your system if you are infected by malware. However if you follow the instructions in the PC Security 
chapter, as well as the rest of this book, the risks should be minimal when compared with the performance 
and convenience benefits. At the end of the day however, if security is your primary concern, you should 
create a separate account for day-to-day usage with more limited access so that if your regular account is 
compromised by a malicious program, it cannot be used to make changes to system files and settings. 
Remember though that you have to be logged in as the Administrator to make the majority of changes in this 
book, as well as being able to use certain programs and games properly. 
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FAST STARTUP - SKIPPING LOGIN SCREEN 

If you have only one user on your machine, to have the fastest startup in Windows XP you can bypass the 
Login screen altogether by doing the following: 
 
1. Click 'Change the way users log on or off' and tick 'Use the Welcome screen', and untick 'Fast User 

Switching'. 
2. Go back to the main User Accounts screen and click the Guest account, and then click the 'Turn Off the 

Guest Account' button. 
3. Delete any unused accounts other than your primary one on the main User Accounts screen by clicking 

each one and selecting 'Delete the Account'. 
4. Click on your main account, and if your account has a password select 'Remove my Password'. 
 
Click 'Apply Options' to finish. This method obviously reduces the security of your PC, so only use it if your 
machine is in a physically secure environment and cannot by accessed by others without your permission. 
 
 USER ACCOUNTS - ADVANCED 

 
 
Aside from the User Accounts tool in the Control Panel, you can access a further set of user account features 
by going to Start>Run> and typing Control Userpasswords2 then pressing Enter. The following are details of 
the settings in this advanced tool: 
 

USERS 

If you have only one User account and you left your password field blank during Windows installation you 
shouldn't be prompted for a username and password each time you bootup XP. This is the method I 
recommend for the fastest (though less secure) way to bootup. However, if you have several user accounts 
with associated passwords, but want one of those accounts to automatically log on to XP at bootup without 
being prompted for a password, go to the Users tab and untick 'Users must enter a username and password 
to use this computer', and click Apply. In the new dialog box that appears, enter the username and password 
for this 'autologon' user. Now each time you bootup Windows this user will automatically login to Windows 
- but this is not as fast as not having a password in the first place. It all depends on your particular security 
needs. 
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In general you should remove all user accounts from the list of 'Users for this computer' except for the 
Administrator and the individual accounts for known users of your PC. Accounts such as ASPNET (the 
.NET Framework account) can safely be removed by highlighting them and clicking the Remove button. The 
less accounts you have on your machine, the safer and more optimal your machine will be. Furthermore, as 
soon as you have two or more user accounts (aside from the Administrator), your system will prompt you to 
select an account on the welcome screen when booting up Windows, so if you find this has suddenly 
happened to you, you will need to remove any additional accounts recently created if they are not needed. 
 
You can also change the access level of individual accounts here by highlighting them and selecting the 
Properties button. Go to the 'Group Membership' tab and you can select the level of access they have. Aside 
from the Administrator and your own user account, you should ensure all other accounts have 'Standard 
User' or 'Restricted User' level access, not Administrator level access. 
 

ADVANCED 

Under the Advanced tab click the Advanced button under the 'Advanced user management' section. Select 
the Users folder in the left pane, right-click on the 'Help Assistant' account if it exists, select properties and 
make sure the 'User cannot change password', 'Password never expires' and 'Account is disabled' boxes are 
ticked for security purposes. You should do the same for the Support and Guest accounts. The only time you 
should enable these accounts is if someone you trust such as Microsoft Technical Support, asks you to do so. 
 
Under the 'Secure logon' section, if you want to increase your security you can tick the 'Require users to 
press CTRL+ALT+Delete' option. This will mean that users have to press the CTRL, ALT and DEL keys 
together to bring up a logon prompt which then allows them to enter their username and password for 
logging into Windows. This adds an extra layer of security however it can also be an inconvenience so I 
don't recommend it unless you actually need the extra security. 
 
 WINDOWS FIREWALL 

The Windows Firewall is an important security feature of Windows. A firewall is a barrier between your 
machine and anything that attempts to connect to your system from outside, usually via the Internet. Unless 
you are using a separate software or hardware-based firewall, it is strongly recommended that you enable 
the Windows Firewall. 
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In the General tab under the Window Firewall settings, I recommend you select On, and untick 'Don't allow 
exceptions' for maximum compatibility. Exceptions are temporary instances of connections to your machine 
that you have consciously authorized, such as connections for online games or messaging programs. To 
completely disallow exceptions would mean that many of your online games and programs will not function 
correctly. 
 
Whenever you launch an application or game which requires external access to your machine through the 
Firewall, you will be prompted by the Windows Firewall whether you want to 'Keep Blocking' the attempt, 
to Unblock it, or to 'Ask Me Later'. The simple rule is that you should only allow exceptions for (i.e. only 
Unblock) applications or games which you use often, and which you know should definitely require Internet 
communication with your machine, and which you trust. If a program that should have no need for Internet 
connectivity suddenly raises the firewall's alert without providing a sound reason, I recommend you 'Keep 
Blocking' it - at least until you can find out more about it through some research. 
 
Under the Exceptions tab of the Windows Firewall settings you can see all the applications and games which 
you are currently allowing to have Internet access to your machine. Remove any which you are no longer 
using, or which you do not know or do not trust. You can do this by unticking them and/or highlighting 
them and selecting Delete. For more details on exceptions, see this Microsoft Article. 
 
Some specific applications or games might require that you open a particular Port. A 'port' in this context is 
like a small doorway into your machine, so opening a port also lessens your machine's security. However 
some programs must have access through a specific port to be able to communicate with your machine. If 
the application or game which requires the open port is on your Exceptions list then highlight it, otherwise 
select 'Add Program' and add it to the list, then highlight it. Then select the 'Add Port' button and enter the 
port number and protocol exactly as specified by the application or game's manual, help documentation or 
technical support personnel. Remember that certain trusted programs simply cannot function without 
appropriate access through the correct port, so this must be done from time to time. Technically speaking 
though, the more ports you have open, the less secure your machine is - so remove all open ports for 
programs you have not used in a while. 
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Finally, the Advanced tab of the Windows Firewall settings contains a range of options that you can alter to 
allow or disallow greater access to your machine. I strongly recommend you leave these at the default 
settings, and only alter them if required by an often-used and trusted application or game. Almost all games 
and applications should function correctly without the need to alter any of the Advanced settings. If you 
want to know more about them refer to the articles linked above. 
 
See the PC Security chapter for more details of both preventing and detecting infection by malicious 
software, and other security tips which can help you secure your PC. See the Windows Errors chapter for 
potential solutions to Windows Firewall problems. 
 
 WIRELESS NETWORK SETUP WIZARD 

This feature launches a Wizard that takes you through the steps of connecting a security-enabled wireless 
device, such as a Bluetooth device. In many cases a wireless device shouldn't require additional drivers, 
however if necessary you may have to install them from your device's driver disc or the manufacturer's 
website. It won't be covered in detail here. 
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STARTUP PROGRAMS 
 
 
Windows loads up a range of programs into memory during its startup procedure, including drivers and 
programs needed to provide the main functionality in XP, just prior to showing the Windows Desktop or the 
logon screen. However many of the startup programs can be removed as they are not necessary for the 
general functionality you require on your system. Importantly, removing unnecessary startup programs will 
help reduce Windows startup time, and also reduce background resource usage, which in turn can improve 
overall responsiveness, reduce stuttering, and even prevent program conflicts and errors.  
 
The process of identifying and removing unnecessary startup items is an important one which requires some 
patience and troubleshooting using the tools and methods covered in this chapter. 
 
 
 FINDING STARTUP PROGRAMS 

The first step in the process is to find the names of all the programs and files which are running at startup on 
your system. To do this you will need to use one or more of the several tools covered below: 
 

MICROSOFT SYSTEM CONFIGURATION UTILITY 

 
 
Windows XP comes with a built-in utility which allows for additional tweaking and troubleshooting of your 
system. This tool is usually hidden, in that no icon is provided for it by default. To access it, go to Start>Run 
and type MSConfig then press Enter. The main use for the Microsoft System Configuration Utility 
(MSConfig) is to provide a brief snapshot of key system variables, and perform some diagnosis and 
troubleshooting of your Windows startup, as detailed in this Microsoft Article. Each section of the utility is 
covered below. 
 
General: This section shows the current status of system startup procedures. The default is Normal, which 
loads up all your device drivers, services and startup items. If you disable any startup items or alter system 
variables using MSConfig, the Selective Startup option becomes highlighted, showing which processes and 
items have been changed. You should only use Selective Startup mode for temporary troubleshooting 
purposes. 
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If at any point you want to quickly troubleshoot your system, and only want the essential services and 
drivers to load up with Windows, select the Diagnostic Startup item. This can help you determine if a 
problem is hardware or software based. This is similar to starting up using Safe Mode - see the Backup & 
Recovery chapter for more details. 
 
There is an option here to start System Restore by clicking the 'Launch System Restore' button - see the 
Backup & Recovery chapter for details of System Restore functionality. 
 
The 'Expand File' button provides a utility for extracting archived files from .CAB files such as those on the 
Windows XP CD. By selecting the location of the archive, and the specific file required, you can extract and 
restore individual files from the Windows XP CD in case the installed ones are corrupted or deleted. This is 
much more handy than having to reinstall Windows completely. There are other methods of repairing a 
Windows installation such as using the System File Checker - again, see the Backup & Recovery chapter. 
 
System.ini & Win.ini: These sections allow you to see and change the entries stored in the System.ini and 
Win.ini files, which typically reside in your \Windows directory. However unlike previous versions of 
Windows, Windows XP does not use these files at startup. The contents of these files are usually only 
required by very old 16-bit applications. As such, you should leave all the entries under these tabs at their 
default settings, unless specifically instructed to change them for a particular application. There are no 
performance gains to be had by editing them. 
 
Boot.ini: This section allows you to see and change the entries stored in the Boot.ini file, which sits in the base 
directory of the drive on which you have installed Windows XP (e.g. C:\). This file determines what XP 
should do at startup time, such as which options to display prior to loading up Windows. In general you 
should not change this file otherwise you may have problems booting into Windows. Details of what the 
most important boot.ini options do are covered under the Device Manager section of the Control Panel 
chapter. Note that if you're using an XP/Vista/7 dual boot arrangement, the Boot.ini file is not used. 
 

 
 
I recommend that you make sure all options under the 'Boot Options' area at the bottom of this section as 
well as those found under the 'Advanced Options' button are unticked for the fastest full-functionality 
startup. These options are only provided to disable certain features at Windows startup primarily for 
troubleshooting purposes: 
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/SAFEBOOT - Ticking this option will force Windows to boot into Safe Mode the next time you restart - see 
Safe Mode under the Backup & Recovery chapter. 
 
/NOGUIBOOT - This option prevents the Windows XP startup screen (the scrolling bar) from appearing 
prior to the Windows Desktop loading up. This won't make any real speed difference, but if you find that 
screen annoying this is how to remove it. 
 
/BOOTLOG - Generates a log of the bootup files in your system drive's base directory, handy if you are 
troubleshooting an error which occurs during Windows bootup. 
 
/BASEVIDEO - This option will force Windows to load up in standard VGA mode - that is, no graphics 
drivers will be loaded up. This can be useful for troubleshooting purposes if you feel your graphics drivers 
are the source of a particular problem. 
 
/SOS - Ticking this option will remove the Windows Startup screen, allowing you to see what goes on 
behind the scenes as Windows starts up, such as which drivers are being loaded up. 
 
One setting you can safely edit in Boot.ini is the timeout= line - which is the same as the Timeout setting 
shown on the right side of this box. It should be set to 0 seconds for fastest bootup, however it can't be set 
below 3 seconds in MSConfig, so you must manually go to the Boot.ini file, open it with a text editor such as 
Windows Notepad, and edit the timeout= line to timeout=0, then save and exit the file. 
 
Services: This section shows all the services currently installed on your system, and their present status - that 
is whether they are running or stopped. If you want to temporarily determine whether a service is necessary 
or not for troubleshooting purposes, you can untick a service here and it will not load up the next time 
Windows is booted. However this is not the recommended method for permanently disabling services. The 
most useful feature here is the ability to tick the 'Hide All Microsoft Services' box, and hence quickly see all 
the third party services which are currently installed (and active) on your system by software other than 
Windows itself. Many of these services can be disabled to reduce memory usage and speed up bootup time. 
See the Services chapter for full details on how to correctly configure your Windows Services. 
 
Startup: This section shows all the additional programs which load into system memory upon booting up 
your system (aside from Services). Many of these startup items are unnecessary and you will gain 
performance and most importantly stability from removing them from your Windows startup. The hard part 
is determining which startup items are absolutely necessary, and which aren't. Unfortunately there are no set 
rules for doing this; each individual startup item has to be assessed on each system to see whether it is truly 
necessary in providing certain functionality for a specific program, or whether it is a useless entry which can 
be safely removed without any negative impact. Follow the instructions further below to correctly identify 
and remove unnecessary startup items on your system. 
 
Tools: As of SP3, a new Tools tab has been added which simply provides quick links to handy XP utilities. 
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REGISTRY EDITOR 

The Registry Editor is detailed under the Windows Registry chapter, however here we look at its 
functionality related to startup programs. To launch the Registry Editor go to Start>Run and type regedit then 
press Enter. Below is a brief run-down of where startup items are held in the registry and how to remove 
them. The Windows Registry holds a record of the specific programs to launch at startup, contained in four 
separate areas: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run] 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\RunOnce] 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run] 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce] 
 
If you find any items listed under any of these keys, it means they are set to run at Windows startup, with 
those under the Run keys being permanent items, and those under RunOnce being temporary items which 
only run for the next bootup. You cannot temporarily disable a startup item here, however to permanently 
delete any of these items, right-click on it and select Delete. Note that there is no undo functionality in the 
Registry Editor, so you should consider doing a backup of the registry in part or in full, as detailed under the 
Backup & Recovery chapter, before deleting any items you're not completely certain about. 
 

AUTORUNS 

 
 
Autoruns is an advanced and highly useful free startup file identification and removal utility with unique 
features not available in the utilities covered above. It also serves a range of other purposes covered 
throughout this book, so it is a highly recommended program. Download it, extract its contents to an empty 
folder and run the Autoruns.exe file. Under the 'Everything' tab you will see a large number of items which 
are loaded up with Windows - far more than most other utilities will ever show; this is what makes 
Autoruns so valuable for a range of purposes. Most of the entries shown are required for various programs 
to run, and the vast majority are Microsoft items which Windows XP absolutely needs to function correctly. 
 
Correctly identifying and removing the truly unnecessary items using Autoruns is more complex precisely 
because it shows so much detail. To narrow down the list to remove core Windows items, go to the Options 
menu and tick the 'Hide Windows Entries' item, and also make sure there is a tick against the 'Verify Code 
Signatures' item. Then click the Refresh icon on the taskbar or press F5 to update the list under the 
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Everything tab. The list of items shown will be reduced, with only items primarily relating to third party 
programs showing, making it easier to spot unnecessary items. 
 
One of the key benefits of Autoruns is that it allows you to temporarily disable any item, as well as choosing 
to permanently remove it. This means that similar to MSConfig, you can temporarily disable specific items to 
see what impact this has on the functionality for that particular program, as well as on Windows in general. 
Remember however that Autoruns is listing not only startup programs, but also various components related 
to a range of programs, including context menu entries and Services. Click on each suspicious item and look 
in the Details Pane at the bottom of the program for more information, then right-click on it and select 
Properties and look under the Details tab for yet more details. If still unclear, right-click on the item and 
select 'Search Online' to initiate a Google search on the item's name in your default browser. A combination 
of the displayed information plus any additional information on the Internet should allow you to accurately 
identify what functionality the component relates to. 
 
You can then disable any suspected unnecessary item temporarily by unticking its entry, and Autoruns will 
prevent that item from loading up the next time Windows starts up. Reboot and test to see the impacts of 
disabling such items. 
 

WINDOWS STARTUP INSPECTOR 

 
 
Windows Startup Inspector is a basic startup identification utility you can use to make the task easier, 
particularly if you find using Autoruns too complex. Download and install the program, then launch it. You 
will see all your startup items listed on the main screen. Now make sure you have an active Internet 
connection, and click the Consult button in the top menu. The program will connect to its Online Database 
and try to provide information for each of your startup items - click on each startup item to see the details. 
While details may not be available for every startup item, there is a handy 'Find More on Google' link at the 
bottom of the information panel, which when clicked automatically initiates a Google search using the 
startup item's exact name - very useful. 
 
If you want to disable a startup item using Windows Startup Inspector, simply click the green tick mark next 
to the startup item's name, and when the tick mark has been removed click the Apply button at the top of the 
screen. Close Startup Inspector and reboot for the item to be removed from your startup.  
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HIJACKFREE 

 
 
HijackFree is an advanced free utility which provides details of all running processes, startup programs, 
services, even the open Ports and ActiveX controls currently in use by your system, all in a single interface. It 
is intended for advanced users who have some knowledge of what they're looking for. You can choose to do 
an automated online analysis of your data by clicking the 'Online Analysis' button at the top right of 
HijackFree, however note that the results can be confusing as it often lists both the good and bad potential 
uses for particular services/processes/files, but it can make it look like you're actually infected with a 
particular piece of malware when you're not. If you've followed the instructions in the PC Security chapter 
you can generally ignore these malware warnings - unless an item is listed as solely being bad. 
 
 IDENTIFYING STARTUP PROGRAMS 

Once you have noted the names of all the startup programs and files using one or more of the utilities above, 
and you have a reasonable suspicion as to which are unnecessary, the next step is to make sure you correctly 
identify their functionality and determine whether they are truly necessary. Some features require that a 
program or certain component(s) load into memory at Windows startup otherwise they may not function 
correctly or at all. Other times a startup component is not necessary for a program to function properly, or 
provides optional functionality for particular features you may not use. Some startup items may even be part 
of malware or other undesirable software and hence must be removed. 
 
Follow the steps below to try to correctly identify all of your startup programs: 
 
1. Some filenames will tell you quite clearly what the startup program relates to. If in doubt, also check the 

directory path of the file and see if there are any other indications as to which program it relates to. It's 
important to know the actual program the file is for, firstly so you can tell what functionality may be 
affected for testing purposes, and secondly for the purpose covered in the next step below. 

2. Launch the program which the file relates to and look through its options for settings like 'Load with 
Windows', 'Load at startup', 'Enable System Tray', 'Enable Shell Integration', and so on. In many cases 
you will be given the option to disable any such settings, and you may also see text or a warning which 
explains whether doing so will affect the program's functionality in any major way. Typically disabling 
a program component from loading at startup means it won't be running in the background after 
Windows loads; you will have to manually open it yourself. For some programs this is not an issue, and 
in fact is desirable; for others it can prevent them from working automatically in the background or even 
from being able to be launched. For our purposes, we want to minimize the number of programs and 
components running in the background at all times, but not damage the functionality for necessary 
programs. 

http://www.hijackfree.com/en/hijackfree/�
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3. If the filename still isn't clear, and you can't determine from its directory path which program it relates 
to (e.g. it resides in the \Windows\System32 directory) then you will have to do some online research to 
find out more details. Start by searching one of the following online resources using the exact filename: 
 
Google 
SysInfo Definitive Startup List 
ProcessLibrary 
Security Task Manager List 
 
Some of the more obscure Windows system files may not be listed in the sources above, or typically 
have ambiguous or even false information regarding potential malware, so reading through a large 
number of Google search results is the best method for finding the truth. 

4. Run the malware scanners recommended in the PC Security chapter to ensure that none of the startup 
files relate to malicious software. If any such files are flagged as malware by your scanner, you can 
usually click on their names or a provided link to find out more details from the scanner's own database. 

5. Use MSConfig or Autoruns to temporarily disable the startup item(s) in question - that is, untick it in 
Autoruns or MSConfig - then reboot Windows and test to see over a period of several days whether any 
of your regular program or Windows functionality is impaired. If still in doubt, leave the item 
temporarily disabled for an even longer period, and you should be able to categorically determine after 
a few weeks whether it is truly necessary. 

 
 REMOVING STARTUP PROGRAMS 

Once you've followed all the steps above, and you're confident that you've found a truly unnecessary startup 
item, the final step involves permanent removal. You can do this in several ways (in order of preference): 
 
 Go to the program in question and make sure there are no options to disable it from running at 

Windows startup. As noted further above, if any options such as 'Load with Windows', 'Load at startup' 
or similar exist, disable them otherwise if you just manually delete the item it may be recreated each 
time you boot into Windows or start that program. 

 Go to Autoruns, right-click on the relevant entry and select Delete. 
 Go to the Registry Editor, find the item under the relevant key, highlight it and select Delete. Remember 

that Registry Editor does not have any undo capabilities, so it is best used as a last resort. 
 
Once the item is removed from your startup, you should reboot Windows and see if it is indeed gone. If at 
any point any of your programs start to behave strangely or do not function at all, then uninstall and 
reinstall that particular program and its relevant startup items will be recreated. In general it's wise not to 
permanently remove any Microsoft startup programs unless you're certain you will never use such 
functionality. Having removed unnecessary startup programs make sure to run through the Services chapter 
and disable unnecessary services as well. 
 
Note that some startup items require special additional steps to completely remove from your startup. For 
example the CTFMON startup item, which relates to an unnecessary 'alternative user input text input 
processor' function for the Microsoft Office suite, requires following the procedures detailed in this 
Microsoft Article to completely remove. Simply removing its startup item from the registry will not remove 
it as it is recreated every time you run an MS Office application. 
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 REGULAR MAINTENANCE 

Removing startup items is far more important than most people believe. It is not a case of simply boosting 
your startup time, though it can help to do that. It is actually a critical step in ensuring overall system 
responsiveness, preventing stuttering and slowdowns, and also preventing potential crashes and conflicts 
which can otherwise be very difficult to resolve and are often incorrectly blamed on Windows, drivers or the 
program which is crashing. 
 
It is perfectly normal for almost all systems to have at least a few startup items which need to be kept 
enabled and serve a useful purpose. However any system which has a long list of startup items is at risk of 
experiencing performance and stability issues. Remember that the software you use on your system may not 
have been tested in combination with all the various other background programs you are currently using, so 
the results can be unexpected. Certainly people using system-intensive applications and games will be the 
first to trigger any potential conflicts or performance issues in such scenarios, so if you belong in this 
category, then make absolutely sure you follow the procedures in this chapter and remove all unnecessary 
startup items and thus minimize what runs at startup and in the background. 
 
Importantly, in the future as you install new programs you should continue to regularly examine and 
identify new startup items which are being added and remove those which are not needed. I generally 
recommend that after each installation of any new program you open MSConfig and quickly look under the 
Startup and Services tabs to see whether new item(s) have been added, and take the time to determine 
whether these are really needed or not. Though tedious, this is an essential part of regular maintenance on a 
PC. 
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SERVICES 
 
 
Services are programs that run in the background and support specific functionality in Windows. They can 
be initiated by Windows itself, or they can be installed and initiated by third party programs. They may start 
automatically at bootup (Automatic), they may be triggered to start by the launching of certain programs or 
functionality (Manual), or they can be blocked from running altogether (Disabled). There is scope to improve 
system resource usage and startup time in Windows XP by disabling unnecessary services. However as with 
startup programs in the previous chapter, it is wise to learn more about what a particular service does before 
considering altering its default status. 
 
In this chapter we look at customizing services, and I provide safe recommendations for Windows XP 
service configuration for the average home PC user. 
 
 
 SERVICES UTILITY 

 
 
The Services Utility gives you the ability to edit your Service configuration. To access the Services Utility, 
you can either go to Control Panel>Administrative Tools>Services, or you can go to Start>Run and type 
Services.msc then press Enter. This opens the Services Utility which lists all installed services, tells you 
whether they are currently running or not under the Status column, and whether they're set for Automatic, 
Manual or Disabled startup under the 'Startup Type' column. A brief description of each service is also 
provided. 
 
You can see the details of each service by left-clicking on it and the default Extended view will show the 
description to the left of the service. To see more details and configure a service, either double-click on the 
service, or right-click on it and select Properties. Here you can where the actual program file resides for the 
service, and you can also manually Start, Stop or Pause/Resume a service as applicable. Importantly, you can 
change its startup type here - the startup type of a service is defined as follows: 
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Automatic: This service is automatically started during the Windows boot process. 
 
Manual: This service must be started manually by the user, or typically, as requested by a program when 
needed. It does not reside in memory nor load at startup otherwise. 
 
Disabled: This service is blocked from running and does not load into memory at any point, even if a 
program requires it. It can only be started by manually setting it one of the above startup types then clicking 
the Start button, or rebooting. 
 

DEFAULT SERVICES 

Before we move on to service customization, it is important to backup your default service configuration in 
case you have any problems and need to return any of your services to their default state. Services may be 
configured differently on various machines based on the particular features and programs you are using, as 
well as your specific hardware configuration, so the best thing to do is save your current service 
configuration. To do this, open the Services utility, then right-click on the 'Services (Local)' item in the left 
pane and select 'Export List'. In the box which opens, enter a name for the list and save it as the default 'Text 
(tab delimited) (*.txt)' option. This file will then save with all the details of your services as they currently 
stand, and can then be viewed with correct formatting in a program like Microsoft Excel. 
 
For convenience sake, I have also listed my default Windows XP Professional SP3 service configuration in 
the table further below under the column labeled 'Startup Type (Default)'; but again, remember that this will 
vary from system to system, and also doesn't include non-Microsoft services, so as a precaution take the 
steps above before altering your own services. 
 

CUSTOMIZING SERVICES 

It is important to note that by setting a service to Disabled you may cause a particular function or feature(s) 
of Windows or your programs to stop working without warning. If you change several services at once in 
particular, it can sometimes be extremely difficult to track back your problems to a particular service - not all 
services are obvious in what they affect. Take a considered and slow approach to customizing your services. 
 
The main aim of customizing services is to: 
 
 Help speed up Windows startup time especially on systems with slower hard drives. 
 Reduce unnecessary RAM usage by removing unwanted services. 
 Speed up shutdown time since Windows has to close some running services before shutdown. 
 
Keep in mind that altering the service configuration will not necessarily increase performance, such as 
increasing your framerate in games - though it may reduce stuttering and loading times due to reduced 
RAM usage - and if done incorrectly, it can impair your functionality. It is not something to be taken lightly; 
it does have benefits, but they won't necessarily be dramatic. 
 
With all of the above in mind, on the next few pages are a list of the services in Windows XP, the defaults for 
XP Professional SP3 and my recommendations for any services that can be changed on an average 
standalone home PC not connected to a network of other PCs, but retaining full Internet functionality. This 
configuration should be safe on most any PC, however if your system is unique in some way, or is on a 
network of PCs, make sure to read the descriptions for any service in the Services utility before altering it. 
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Important: There are some unnecessary services which are already set to Manual, and hence don't need to be 
altered. Many services don't need to be set to Disabled as that has no benefit whatsoever - a service set to 
Manual is not taking up any resources nor will it load up unless it is needed, yet provides a safeguard 
because if it is truly needed it can be easily restarted by Windows or a program. Only disable a service if it 
keeps restarting and/or you are 100% certain that it is not needed on your system. Some services can be very 
tricky in the impact they have, so I urge you not to consider the disabling of services as some sort of major 
performance tweak and go crazy turning everything off. 
 
If you want to research services in more detail refer to the BlackViper Service Configuration Guide and The 
Elder Geek Services Guide. 
 
On the next two pages I provide my recommended Windows XP service configuration. 
  

http://www.blackviper.com/WinXP/servicecfg.htm�
http://www.theeldergeek.com/services_guide.htm�
http://www.theeldergeek.com/services_guide.htm�
http://www.theeldergeek.com/services_guide.htm�
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Service Name Startup Type  
(Default) 

Recommended 
Change Notes 

    
Application Layer Gateway Service Manual   
Application Management Manual   
Automatic Updates Automatic   
Background Intelligent Transfer Service Manual   
ClipBook Disabled   
COM+ Event Service Manual   
COM+ System Application Manual   
Cryptographic Services Automatic   
DCOM Service Process Launcher Automatic   
DHCP Client Automatic   
Distributed Link Tracking Client Automatic   
Distributed Transaction Coordinator Manual   
DNS Client Automatic   
Error Reporting Service Automatic   
Event Log Automatic   
Extensible Authentication Protocol Service Manual  Added in SP3 
Fast User Switching Compatibility Manual Disabled If not using multiple 

accounts on one PC 
Health Key and Certificate Management Service Manual  Added in SP3 
Help and Support Automatic   
HID Input Service Automatic Manual Set back to Automatic 

if peripherals don't 
function properly 

HTTP SSL Manual   
IMAPI CD-Burning COM Service Manual Disabled Not required if using 

third party burning 
software 

Indexing Service Manual Disabled If you've also disabled 
disk indexing 

IPSEC Services Automatic   
Logical Disk Manager Automatic   
Logical Disk Manager Administrative Service Manual   
Messenger Disabled   
MS Software Shadow Copy Provider Manual   
Net Logon Manual   
NetMeeting Remote Desktop Sharing Manual Disabled Network related 
Network Access Protection Agent Manual  Added in SP3 
Network Connections Manual   
Network DDE Disabled   
Network DDE DSDM Disabled   
Network Location Awareness (NLA) Manual Disabled Network related 
Network Provisioning Service Manual Disabled Network related 
Performance Logs and Alerts Manual   
Plug and Play Automatic   
Portable Media Player Serial Number Service Manual Disabled Set back to Manual if 

any DRM-protected 
media doesn't play 

Print Spooler Automatic Disabled If not using a printer 
or printer-like device 

Protected Storage Automatic   
QoS RSVP Manual Disabled Provides no benefit 
Remote Access Auto Connection Manager Manual   
Remote Access Connection Manager Manual   
Remote Desktop Help Session Manager Manual Disabled If not using remote 

assistance 
Remote Procedure Call (RPC) Automatic   
Remote Registry Automatic Disabled Security risk 
Removable Storage Manual   
Routing and Remote Access Disabled   



 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 151 Copyright © 2010 Koroush Ghazi 

 

S
ervices 

Service Name Startup Type  
(Default) 

Recommended 
Change Notes 

 
Continued... 

   

Secondary Logon Automatic Disabled If main user is 
Administrator 

Security Accounts Manager Automatic   
Security Center Automatic Disabled If you follow advice 

in PC Security chapter 
Shell Hardware Detection Automatic   
Smart Card Manual Disabled If not using a Smart 

Card 
SSDP Discovery Service Manual Disabled Network related 
System Event Notification Automatic   
System Restore Service Automatic Disabled If not using System 

Restore 
Task Scheduler Automatic   
TCP/IP NetBIOS Helper Automatic Disabled Network related 
Telephony Manual   
Telnet Manual Disabled Security risk 
Terminal Services Manual   
Themes Automatic   
Uninterruptible Power Supply Manual Disabled If not using a UPS 
Universal Plug and Play Device Host Manual   
Volume Shadow Copy Manual   
WebClient Automatic Manual  
Windows Audio Automatic   
Windows Firewall/Internet Connection Sharing 
(ICS) 

Automatic   

Windows Image Acquisition (WIA) Manual   
Windows Installer Manual   
Windows Management Instrumentation Automatic   
Windows Management Instrumentation Driver 
Extensions 

Manual   

Windows Time Automatic   
Wired AutoConfig Manual  Added in SP3 
Wireless Zero Configuration Automatic Disabled If not using wireless 

network devices 
WMI Performance Adapter Manual   
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RESTARTING A SERVICE 

If for some reason you find that a Disabled or Manual service is actually required for certain functionality 
you want to use, but is not starting up, then you can simply go to the General tab for that service, change the 
Startup Type back to Automatic or Manual, and then click the Start button. If the Start button is greyed out 
or the service fails to restart, it is because it is dependent on another service which is currently disabled or 
stopped. Go to the Dependencies tab for the service and under the first box you will see the other services it 
relies on - go to those services and set them to Manual or Automatic as required and start them. The bottom 
box displays the services which depend on this service to function, so keep that in mind when disabling a 
service, as other dependent services will also stop working. 
 

NON-MICROSOFT SERVICES 

You may notice that your services list has several additional services that are not on the list provided on the 
previous pages. This is because particular programs and drivers, such as graphics drivers, antivirus 
programs and system utilities, even games, can install their own unique services. These services power some 
of their specialized functionality, but as with many of the Microsoft services some of these can be set to 
Manual or even Disabled to reduce background resource usage and prevent conflicts without affecting the 
program's functionality. 
 

 
 
The best way to quickly find all non-Microsoft services is to run MSConfig (See the Startup Programs 
chapter), go to the Services tab and tick the 'Hide All Microsoft Services' box at the bottom. The only services 
which will then be shown are those that have been installed by third party software. To determine which of 
these are truly unnecessary, you will have to work out which software package has installed the service - in 
most cases it is fairly obvious. However some services are either not clear, or may even be part of malware 
and hence difficult to identify. 
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IDENTIFYING NON-MICROSOFT SERVICES 

To correctly identify which program a service relates to, and in particular which file is launching it, follow 
these steps: 
 
1. In MSConfig, under the Services tab having ticked the 'Hide All Microsoft Services' box, write down the 

exact name of each non-Microsoft service (e.g. PnkBstrA). 
2. Go to Control Panel>Administrative Tools>Services and find the same service name in the listing. 
3. Double-click on the name of each non-Microsoft service and under the General tab for that service, look 

at the 'Path to executable' item and note both the filename and its directory path. For example the 
service 'PnkBstrA' service has the path C:\Windows\system32\PnkBstrA.exe. Write down the actual 
filename (i.e. PnkBstrA.exe). 

4. Search Google or one of the databases shown under the Startup Programs chapter for this particular 
filename. This should give you an indication of what its functionality is related to. If necessary you can 
temporarily set the service (one at a time) to Manual or even Disabled to see what functionality it 
impacts on. 

 
As with Microsoft Services, you should be able to Disable a range of these third-party services as they are not 
necessary. In some cases, Manual is the correct choice, and in other cases Automatic must be chosen 
otherwise the relevant program will not launch or will have problematic functionality. I cannot provide 
guidance in this respect as it depends on the program and the functionality you wish to use. If in doubt, 
leave a non-Microsoft service on its default setting. 
 

CHANGE SERVICE STATUS VIA COMMAND LINE 

If you wish to change the status of a service without opening the Services Utility, you can do so by using an  
MS-DOS Command Prompt - go to Start>Run and type cmd then press Enter. To change a service status here 
you will first need to know the name of the service, either its short name or full name. For example the full 
name for the Application Layer Gateway Service is 'Application Layer Gateway Service', while its short 
name is simply ALG. You can find these details in the Services utility by double-clicking on a service, or 
under the following key in the Windows Registry: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services] 
 
To start or stop a service via command line, go to the Command Prompt and use the form: 
 

Net [Start/Stop] "servicename" 

 
Note, if using the short name for a service, quotes are not necessary, but if using the service's full name, 
quotes must be used around the name. For example to start the Application Layer Gateway Service, you can 
use either command below to achieve the same result: 
 

Net start alg 
Net start "application layer gateway service" 

 
You will receive a confirmation that the service has been started or stopped if successful. This method is 
mainly useful if you want to compile a batch file to start or stop particular services, or if you can't access the 
Services utility for some reason. 
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Service editing is an area of ongoing debate. Some people suggest that altering services from their default is 
completely pointless and unnecessary and should not be done due to the potential problems it can cause; 
others will argue that many services should be disabled to 'increase performance'. I tend to be in the middle - 
there is certainly a case for disabling genuinely unnecessary services in Windows XP for functions you will 
never use, but this must be done with a bit of thought and research: only disable services if you are 
absolutely certain of their functionality and that you don't need them, and if in doubt, leave the services set 
at their defaults. This is particularly true of most Manual services which do not need to be set to Disabled as 
this has no impact on resource usage. 
 
Editing services wisely is one more way of reducing resource usage and improving startup times, but it is 
not a major performance-boosting exercise. I've tried to provide the best of both worlds in this chapter by 
giving you a thorough list of 'safe' changes you can make, and also showing what the default settings are in 
case things go wrong. However if you are not confident in what you are doing, or don't have the time or 
patience to do the research and sort out your own service needs properly, then leave your services on their 
default Windows configuration for the moment. This will prevent a lot of problems in the long run. 
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CLEANING WINDOWS 
 
 
As you use your system in day-to-day activities, a range of unnecessary temporary, backup and log files can 
build up on your drive. Many of these files are automatically deleted whenever you close an application, or 
whenever you shut down Windows. Unfortunately some of them aren't, and over time they can build up, 
taking up disk space and cluttering your directories. This chapter looks at the tools and methods required to 
safely clean out unnecessary files from Windows. 
 
 
 DISK CLEANUP 

 
 
The Disk Cleanup utility provides the ability to automatically find and remove unnecessary Windows files, 
old System Restore points, and unwanted Windows components. To access the Disk Cleanup utility go to 
Start>Run and type Cleanmgr.exe then press Enter, or look for it under your 
Start>Programs>Accessories>System Tools menu. 
 
The Disk Cleanup utility has several functions, which are covered below: 
 

REMOVE UNNECESSARY WINDOWS FILES 

To remove unnecessary Windows files at any time, open the Disk Cleanup utility and under the main Disk 
Cleanup tab you can safely tick the following: 
 
 Recycle Bin 
 Setup Log Files 
 Temporary Files 
 Catalog files for the Content Indexer 
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Also tick the 'Temporary Internet Files' option if you want to clean out your Internet Explorer cache. If you 
are short on disk space you can also tick the 'Compress Files' option, however I strongly recommend against 
this as disk compression can be time consuming and will reduce your overall performance in Windows XP, 
increasing the frequency of fragmentation. Click OK when done, and OK again. This will remove a lot of 
unnecessary files on your system and may take a while. 
 

ADD OR REMOVE WINDOWS COMPONENTS 

To add or remove Windows XP components under the 'More Options' tab click the 'Clean Up' button under 
the 'Windows Components' section. In the 'Windows Components' box that opens, items with ticks next to 
them are currently installed. You can install additional items by ticking them, and untick any existing 
components that you want to remove. Note that some items, such as Windows Messenger or Internet 
Explorer, cannot be fully uninstalled this way - unticking them only removes the shortcut to the program 
which is not much use. 
 
When you highlight certain components, you may see a Details button appear on the bottom right. Click it to 
see which particular sub-components you can select to install/keep/uninstall. For example, if you highlight 
the 'Accessories and Utilities' component, click Details and you will see two types of sub-components - 
Games and Accessories. Highlight the Accessories sub-component and click Details again, and you'll see the 
full list of Windows accessories installed on your system. Untick the ones that you know you do not need or 
use, and tick those which you want to install or keep. If in doubt, do not install or uninstall any items. Items 
that are already ticked are currently installed, and leaving the tick mark against them won't see them 
installed again - it just means you wish to keep them. 
 
Once you're finished, click OK until you are back at the main Disk Cleanup utility screen and click Next. 
Any changes will see the relevant components installed/uninstalled as specified. Note that you may be 
prompted to insert your original Windows XP CD if you have chosen to install new Windows component(s). 
 
To access a more detailed list of the components you can install or uninstall on your Windows, do the 
following: 
 
1. Go to your \Windows\Inf directory and open the Sysoc.inf file with Windows Notepad. 
2. Do a search for all occurrences of the word ,hide, and replace them with ,, (i.e. just delete the word hide). 

Make sure there are no spaces around or in between the commas. 
3. Save the file and close it. 
 
Now when you reopen the Windows Components section under Options in Disk Cleanup, you will see 
many more items listed. Note that some of them - such as those shown with grey box icons - are important 
system files which may result in problems if removed. Be very careful here as to what you add or remove.  If 
you really want to strip out a large number of Windows components, I recommend using nLite instead, that 
way these components will never be installed in the first place - see the Installing Windows chapter. 
 

REMOVE OLD SYSTEM RESTORE POINTS 

If you have System Restore enabled, and want to remove all System Restore points other than the most 
recent one, thereby freeing up a great deal of disk space, under the 'More Options' tab click the 'Clean Up' 
button under the 'System Restore' section. Click Yes on the subsequent prompt, then click the OK button. 
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ADVANCED DISK CLEANUP USAGE 

You can access more disk cleanup options by going to Start>Run, typing cleanmgr /sageset:1 and pressing 
Enter. In the dialog box which opens, tick the items you wish to clean - I suggest ticking all boxes except the 
'Compress old files' option - and then click OK. Now to execute this extended cleanup at any time, go to 
Start>Run and this time type cleanmgr /sagerun:1 then press Enter, and cleaning will commence immediately.  
Note that this method will clean all your drives - you cannot choose a specific drive to apply it to, so keep 
this in mind before using this method in case you don't want any other drives affected by Disk Cleanup in 
this way. 
 
 RECYCLE BIN 

 
 
The Recycle Bin provides a storage area for deleted files and acts as an additional layer of protection against 
permanently deleting files on your system. This section covers the optimal configuration of this essential 
Windows tool. 
 

CONFIGURATION ADVICE 

If you don't want deleted files to automatically move to the Recycle Bin and instead want them permanently 
deleted every time, right-click on the Recycle Bin icon on your Desktop, select Properties and under the 
Global tab tick the 'Do not move files to the Recycle Bin. Remove files immediately when deleted' option. I 
don't recommend that you do this, since the Recycle Bin is useful insurance to have against accidentally 
deleting important files. 
 
I recommend you untick the 'Display delete confirmation dialog' option under the Global tab of the Recycle 
Bin Properties. This will stop Windows from asking you each and every time you want to delete a file 
whether you really want to do it - instead the file will go immediately into the Recycle Bin when deleted. 
 
If you have enabled the Recycle Bin, but at any time want to delete a file and not have it moved to the 
Recycle Bin first, highlight the file(s) and press SHIFT + DELETE. You will be asked to confirm this action, 
but this will delete all highlighted files immediately without placing them in the Recycle Bin. 
 
You can specify the maximum amount of disk space the Recycle Bin can take up at any time by adjusting the 
slider under the Global tab of the Recycle Bin Properties. I recommend allowing enough disk space so that 
should you delete several large files on your system you can still recover them if necessary. Typically around 
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4GB is sufficient for most people. Work out what percentage of your drive that would be, and apply it here 
(e.g. 4GB of an 80GB drive is around 5%). To see the exact amount of maximum space allocated, click the tab 
that has your drive's name. 
 
For more details of how to recover files which you have permanently deleted from the Recycle Bin, see the 
Backup & Recovery chapter. 
 

RENAMING OR DELETING THE RECYCLE BIN 

You can rename the Recycle Bin or even delete it from your Desktop by using this tweak. Open the Registry 
Editor and go to: 
 
[HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-101B-9F08-00AA002F954E}\ShellFolder] 
 
CallForAttributes=0x00000000(0) 
 
Attributes=50 01 00 20 
 
First double-click on the CallForAttributes DWORD and change its value to 0. Then double-click on the 
Attributes DWORD and change its value to 50 01 00 20 to add a Rename option to the Recycle Bin 
icon's context menu - when you right-click on Recycle Bin, the Rename option now appears. To add a Delete 
option as well, change the value to 70 01 00 20. You will have to reboot your machine for this tweak to be 
implemented. Note, it is strongly recommend that you do not delete the Recycle Bin. At the very least, create 
a System Restore point before deleting the Recycle Bin. 
 
 CCLEANER 

 
 
CCleaner is a free utility which can automatically find and remove a wide variety of potentially useless files 
from your system. CCleaner automates a task that you can perform manually to some extent (see further 
below), but which takes much more effort to do by hand: it finds and removes a range of files with common 
extensions or locations which can indicate that they are unnecessary. If used with caution it is usually quite 
safe in removing only unnecessary files. 
  

http://www.piriform.com/ccleaner�


 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 159 Copyright © 2010 Koroush Ghazi 

 

C
leaning W

indow
s 

Run the program and click the Options button, and adjust the following settings: 
 
1. Under the Settings section, all available boxes can be unticked if desired, as none are vital to running 

CCleaner correctly. Selecting the 'Normal file deletion' option is recommended, as secure deletion can 
make it virtually impossible to recover accidentally deleted files. 

2. Under the Cookies section, in the left pane are a list of cookies CCleaner will automatically delete if the 
Cookies option(s) are ticked under the main Cleaner portion of the program. If you have ticked any of 
the Cookies boxes in the Cleaner portion, select any cookies you would like to keep from the list. 

3. Under the Include and Exclude sections you can manually add particular files or folders which you 
would specifically like CCleaner to scan for deletion or exclude from deletion. This is only 
recommended if you know categorically that the contents of these files or folders are safe to delete. 

4. Under the Advanced section I recommend ticking the 'Show prompt to backup registry issues' box as a 
safety mechanism if you use the registry cleaning functionality; and the 'Only delete files in Windows 
Temp folders older than 24 hours' to prevent deletion of temporary files which are required for the 
current session. 

 
To start the cleaning process, first make sure you close all open applications to prevent conflicts if CCleaner 
tries to delete actively used files. Then launch CCleaner and under the Windows tab of the Cleaner function, 
take the time to go through and select or unselect particular options. As a general balance between safety 
and removing all unnecessary files, I recommend the following configuration for each category: 
 
 Internet Explorer - If you don't use Internet Explorer as your main browser, all options here can be 

ticked. If you do use Internet Explorer, I don't recommend ticking any options here as it can reduce 
performance and functionality in IE. Proper configuration of IE is covered under the Internet Explorer 
chapter will ensure the necessary files are kept or removed by IE itself during normal operation. 

 Windows Explorer - All options can be ticked, however I recommend unticking the 'Thumbnail Cache' 
option as it means any folders in which you use Icon views will need to regenerate their thumbnails, 
slowing down browsing of those folders. 

 System - All options can be ticked, but bear in mind that ticking items like 'Windows Log Files', 'Memory 
Dumps' and 'Windows Error Reporting' can make troubleshooting much more difficult, so only select 
these if you are having no problems on your system. I also don't recommend ticking the 'Empty Recycle 
Bin' option here for the reason covered at the end of this chapter. 

 Advanced - I recommend against ticking any of the options here, as most of the options here will result 
in deletion of files which are self-maintained by Windows. For example, 'Old Prefetch data' is 
unnecessary, as Windows automatically purges the Prefetch folder periodically to maintain a list of the 
most commonly used programs based on its analysis. Various caches are also necessary to speed up 
normal Windows functionality, so regularly deleting them simply works against this. For security 
purposes you can tick the 'Wipe Free Space' option, but I recommend against this, as it prevents you 
from recovering any accidentally deleted files and also makes cleaning very lengthy. 

 
Under the Applications tab I recommend unticking all available options. This is because in the vast majority 
of cases removing application-specific files in this manner can remove desirable functionality from such 
applications and introduce unexpected behavior - deletion of application-specific files can result in the loss 
certain custom preferences for example. Also be aware that CCleaner may add and automatically tick new 
options here when you install new applications, so check under this tab regularly. 
 
Once you have ticked all the relevant options, click the Analyze button and after a while CCleaner will come 
up with a list of files it wants to delete. However the results are shown in summary form, which can make it 
difficult to determine what will be deleted. Right-click in the analysis window and select 'View detailed 
results' to see precisely which files are going to be deleted, and scroll through the list to make sure no 
desirable files are here. If in doubt, go back and untick any options, then click the Analyze button again. 
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When you are satisfied that the files to be deleted are truly unnecessary, click the 'Run Cleaner' button and 
the files will all be permanently deleted. There are two more useful functions of CCleaner: 
 
Registry: The Registry function in CCleaner attempts to find redundant Registry entries, and is relatively safe 
to use if configured correctly. This functionality is covered under the Windows Registry chapter. 
 
Uninstall: The Uninstall function found under the Tools section of CCleaner can be used to remove faulty 
entries from the  Add or Remove Programs list. 
 
CCleaner is a useful tool in removing a range of unnecessary files. However many files will simply recreate 
themselves the next time you start Windows or use a program, so in many ways all you are doing by 
deleting them with CCleaner is actually slowing down normal Windows and application functionality. The 
recommendations in this section try to limit CCleaner to deletion of genuinely unnecessary files. 
 
 MANUAL DRIVE CLEANING 

Below is a basic method for manually finding and removing the more obvious redundant files in your 
system. If you don't trust an automated cleaner, or just want to be certain of what it is you are deleting, or if 
you simply want to do the most thorough job, read the following. However this method is not recommended 
for beginners as it requires a reasonable level of knowledge and personal judgment in determining which 
files to delete and which to keep. 
 
Before manually cleaning out any files, first close all open applications and games as some of these may have 
created temporary files that cannot be deleted because they are in use, or would be pointless to delete. Then 
restart your system just to be certain, as Windows will remove many unnecessary temporary files upon 
shutdown. Now make sure that the option to move files to the Recycle Bin is enabled. This will provide 
protection against accidentally deleting a necessary file. Then follow these steps: 
 
1. Open Windows Explorer and navigate to the following directories on the drive where you have 

installed Windows. Delete any files or subdirectories beneath them, but not the directories themselves: 
 
\Documents and Settings\[Username]\Local Settings\Temp 
\Windows\Temp 
 

2. Go to \Windows and delete any $NTUninstall directories. These are directories which allow you to 
uninstall Microsoft updates typically installed through Windows Updates. Unless you've installed a 
beta Microsoft product, it is highly unlikely you will ever need to uninstall a Microsoft patch. Note that 
you should not delete the $hf_mig$ directory. 

3. Find files with extensions that identify them as redundant. Go to Start>Search and select 'All files and 
folders' to bring up the Search box. Enter the following text, and in each case you can usually delete all 
incidences of these files without a problem: 
 
*.BAK 
*.TMP 
~*.* 
*.OLD 
*.LOG 
 

4. Delete any files you are sure are not needed anymore, such as older versions of downloaded driver 
packages and setup files from downloaded programs. 

5. Note, if any files cannot be deleted because they are in use by Windows, reboot your system and go into 
Safe Mode (See the Backup & Recovery chapter) and from there you should be able to delete any file.  
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Alternatively you can use the method further below. Usually however if a file is in use it is a good 
indication the file is needed and best not deleted unless you are certain it's unnecessary. 

 
Once you have deleted these files, keep them in your Recycle Bin and don't empty it for a few days until 
you've had a chance to see if any of your applications or games are not functioning properly without these 
files. If in doubt, I recommend only using an automated cleaning utility such as CCleaner. 
 

CLEANING UP AFTER SERVICE PACK 3  

During the installation of Windows XP Service Pack 3 (SP3), it will create a range of backup files which allow 
you to uninstall SP3 if necessary. However for all intents and purposes, once you've installed SP3 there 
should never be any need to uninstall it again. To delete these unnecessary files, you should go to your 
\Windows directory and delete the $NTServicePackUninstall$ directory and all its contents. Once this 
directory is deleted, you will no longer be able to uninstall SP3, but again, this should never be required as 
Service Pack 3 is a necessary update. Generally speaking, if you are having issues with SP3 on your system, 
it is wiser to reinstall XP and then install SP3, or use an installation image of XP which incorporates SP3. 
 

DELETING 'IN USE' FILES 

 
 
If during manual file cleaning you find that you cannot delete an unnecessary file because Windows claims 
that it is 'in use' by another person or program, or simply denies you access to the file or folder, then reboot 
your system and try again. If that doesn't work, then it is usually either a driver or some other system-level 
file which is loading up during bootup, or a file required for an active program. Go through and close all 
active programs, particularly ones which load at startup and try again. If necessary, temporarily disable the 
suspected startup program(s) using MSConfig, reboot and try again. Alternatively use Autoruns and see if 
the file is shown there, and untick it to prevent it being loaded up at startup, then reboot and try again. See 
the Startup Programs chapter for more details of how to use these programs. 
 
Ultimately however some files will refuse to be deleted no matter what you try, in which case you should try 
the free Unlocker utility. To use the program, right-click on the relevant file or folder and select Unlocker, 
then click the 'Unlock All' button to unlock the file. Alternatively choose from the list of actions at the bottom 
left of the box shown, and reboot if necessary for the action to complete. Be warned however that in general 
Windows locks files or prevents deletion for a reason, so only use Unlocker if you're absolutely certain that 
that file in question is genuinely no longer required. 
 
After deleting all files you consider unnecessary via any of the methods above, importantly you should not 
empty your Recycle Bin. Reboot your system and use it normally for a few days just to be sure the files you 
have deleted are genuinely no longer needed. In general the use of CCleaner - if enabled with sensible 
options - is the safest method for conducting regular cleaning of your system, however manual cleaning is 
also necessary at times, particularly after uninstalling a program which does not correctly remove all 
portions of itself from your system. Again, cleaning Windows is not a performance boosting method, it is 
primarily for reducing clutter and freeing up disk space, and even then it is not to be done without some 
thought as to what precisely it is you are removing. 

http://ccollomb.free.fr/unlocker/�
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TASK MANAGER 
 
 
The Windows Task Manager is a utility that allows you to view important real-time information about 
which applications and processes are running on your system. You can also see how much memory, CPU 
resources and network bandwidth is being consumed at present by these various processes. As an 
information and troubleshooting tool it is invaluable. To access the Task Manager at any time, press the 
CTRL, ALT and DELETE keys together, or go to Start>Run and type Taskmgr then press Enter. 
 
One of the Task Manager's most common uses is to allow you to attempt recovery from system lockups and 
crashes. Whenever a program stops responding you can attempt to launch the Task Manager and under the 
Applications or Processes tab you can select the offending task or process and select 'End Task' or 'End 
Process', usually regaining control of your PC without the need to reboot. If the Task Manager does not 
appear after pressing CTRL+ALT+DEL several times then your system has 'hard locked', meaning a reboot is 
required to regain use of your computer. In any case, Task Manager's useful functionality is covered in this 
chapter. 
 

 
 
 
 CONFIGURATION ADVICE 

To customize the Task Manager so that it displays the specific system information you want to see, go to the 
View menu and under it click the 'Select Columns' option. You will be presented with a dialog box that 
allows you to select a range of items that can be displayed as separate columns under the Processes tab of the 
Task Manager. I recommend that at the very least the 'CPU Usage' and 'Memory Usage' items be ticked. 
These will show you for each process the proportion of the CPU's resources the process is currently using, 
and how much system memory (RAM + Virtual Memory) it is using. I recommend also ticking the 'Peak 
Memory Usage' item as well, as this will show you just how large a particular process has been at some point 
- we discuss one use for this information in the Memory Optimization chapter when ascertaining Virtual 
Memory requirements. 
  

http://support.microsoft.com/kb/323527�
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Next, go to the Options menu and make sure the 'Show 16-bit tasks' setting is ticked, then under the 
Processes tab make sure the 'Show processes from all users' option is also ticked. This ensures that all 
running programs and processes will be shown. Note that at any time if you cannot see any menu items or 
tabs in the Task Manager window, simply double-click anywhere on the borders of Task Manager and it will 
revert to its normal view. Also note that you don't usually require the 'User Name' column, however if you 
are on a PC with multiple users you can enable this functionality by making sure the 'Fast User Switching 
Compatibility' service is set to Automatic - see the Services chapter. 
 
 RESOURCE USAGE MONITORING 

One use for Task Manager which can be of great benefit to system performance and even security is that of 
monitoring your startup state. That is, the programs and processes which are running in the background 
after a fresh bootup, and the amount of memory being used. After a fresh bootup immediately open Task 
Manager, and click on the Processes tab, then examine the following areas of Task Manager: 
 

PROCESSES 

Check the list of running processes - there should be as few as possible. Note that certain processes can 
appear multiple times - this is fine for svchost.exe for example, since it is the Service Host process and as such 
runs groups of several Windows services. However some processes may be initiated by a virus or 
completely unnecessary program, so see the Services and Startup Programs chapters for details of precisely 
how to identify the programs behind these processes and how to disable or remove the unnecessary ones. 
 

COMMIT CHARGE 

Look at the total Commit Charge at the bottom of the Task Manager window. This shows the amount of 
memory (System RAM + Virtual Memory) that has been used out of the maximum available. Although this 
may grow dramatically after you have run several programs - and this is quite normal - the main point to 
consider is that the first figure in the Commit Charge section should be quite low at Windows startup. Once 
again, see the Services and Startup Programs chapters for details on how to reduce such resource usage. 
Minimizing memory usage at startup is not about 'freeing up' as much RAM as possible. Rather, the aim is 
primarily to speed up startup times and reduce the likelihood of program conflicts. The less information is in 
memory prior to launching a program or game, the less chance there is for memory conflicts, and the less 
pagefile usage you will experience. Games manufacturers specifically recommend that background 
programs and processes be minimized precisely to prevent game conflicts and stuttering for example. 
 

CPU USAGE 

Pay attention to the CPU usage for your system when it is idle - that is, when you have no open games or 
applications. It should be at or close to 0%, and the 'System Idle Process' process should have around 99% 
CPU usage, indicating that the CPU has as minimal a load as possible. A CPU that idles correctly stays 
cooler and uses less power. More importantly though, if your system is using CPU resources even when 
supposedly idle, this indicates that you have a background program(s) or process(es) which may be 
unnecessarily drawing resources and hence there is scope for you to improve performance by disabling it. 
 
You can also open the Task Manager during the running of an intensive game or application and check the 
CPU % being used by its process - for a single-core CPU it should be consistently at, or close to, 100% CPU 
usage. If for some reason it is quite low, again check to see if any other processes are drawing CPU resources, 
and once again refer to the Startup Programs and Services chapters of this book to remove/disable 
unnecessary background programs. Note that on systems with dual or multi-core CPUs, the CPU usage 
figure shown here may be lower, since each core may share a proportion of the total load, hence overall CPU 
usage for a particular process may only be around 50% or less for example. For more details see further 
below. 
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I do not recommend manually changing the process priority. For example you can right-click on a process 
and select Set Priority>High. Such tweaks are more likely to increase system instability, and should have no 
impact on an optimized machine since by default your current program should have maximum potential 
usage of the CPU (which isn't always 100% by the way - it depends on the program), thus the highest 
priority. 
 

MEMORY USAGE 

Examining the memory usage for each process can provide valuable information. If you have selected the 
'Peak Memory Usage' item to add to the list of columns under the Processes tab (as recommended above), 
you can combine that information with current Memory Usage to learn some interesting facts about the 
performance of the processes over time. For example, you can open the Task Manager while running a 
particularly intensive application or game and check to see how much memory its process is currently using, 
and how much it has used at its peak so far. Compare these figures to the number on the right of the Commit 
Charge figure at the bottom of the Task Manager window – which is the total amount of memory (RAM + 
Virtual Memory) available to the system. If the game or application is using close to the total amount of 
memory available on your system, you may have to increase the maximum size of your pagefile (See the 
Memory Optimization chapter) otherwise you may experience crashes, increased stuttering, or errors. 
 
Note that whenever a program is minimized, i.e. shrunk down to the Taskbar, it will use less memory and 
resources than normal. Therefore check the resource usage of a program when it is taking up the full screen 
or running in a large window to get an indication of how intensive it is during normal usage. 
 
 PROCESSOR AFFINITY 

 
 
Most desktop PCs now contain a CPU with two or more cores - that is, a single CPU which is actually made 
up of two (or more) separate CPU chips. Furthermore some Intel CPUs have a technology called 
HyperThreading which in effect emulates two physical cores on each single core of a CPU. For a program to 
truly take advantage of two or more cores on a CPU, it needs to be multi-threaded. That means several 
program 'threads' will run in parallel, with each thread assigned to a particular core to handle. Alternatively, 
multiple separate programs can be run together much more smoothly on a multi-core system, as each 
program can be run on a separate core. However some older programs and games are not multi-threaded, 
and hence show no real benefits when run individually on a multi-core system. In fact some programs made 
prior to around 2005 exhibit problems, such as stuttering or incorrect speeds when run on a multi-core CPU. 
 
If your programs show problems launching or running on a multi-core system then you have two options. 
For AMD multi-core CPU users, install the AMD Dual Core Optimizer which resolves these issues. For both 
AMD and non-AMD users, you can install the Microsoft Dual Core Hotfix. These steps will ensure that any 
problems in older games or applications due specifically to multi-core CPUs are removed or minimized. 
  

http://www.intel.com/technology/platform-technology/hyper-threading/index.htm�
http://support.amd.com/us/Pages/dynamicDetails.aspx?ListID=c5cd2c08-1432-4756-aafa-4d9dc646342f&ItemID=153�
http://support.microsoft.com/kb/896256�
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However if you feel you are still having multi-core CPU related problems, or want to troubleshoot a 
potential hardware issue with any specific core of your CPU, you can manually force the main process for a 
program to temporarily run on only one specified CPU core. Do this as follows: 
 
1. Launch the program in question, and as soon as it appears to be loading, or immediately after it has 

loaded up, open the Task Manager. 
2. Under the Processes tab, find the game/program's main process; if necessary go to the Applications tab, 

right-click on the program and select 'Go to Process'.  
3. Right-click on the relevant process and select 'Set Affinity'. 
4. In the box which appears, untick 'CPU 1' (and any other available CPUs), so that only 'CPU 0' is ticked. If 

you're troubleshooting problems you suspect on one particular core, you can do the opposite - disable all 
cores except CPU 1 (or CPU 2 or CPU 3 etc.). The aim is to restrict the program to run on only one core. 

 
The program is now forced to run on only one CPU core, which should resolve any problems if they were 
genuinely related to the multi-core setup. If this works, or if you have problems attempting to change 
affinity this way, or you find it inconvenient, there is a way of permanently forcing the affinity change on a 
program each time it loads. Before undertaking it, be aware that it modifies the executable file to which it is 
applied, so backup that file first before using this method: 
 
1. Download the file imagecfg.exe from this page and put it into your \Windows\System32 directory. The file 

is safe to use, as it was originally a Windows NT system file. 
2. Identify the problematic program's main executable. To do this go to the program's launch icon, right-

click on it, select Properties and highlight and copy the text in the Target box. 
3. Make a backup copy of this executable first and put it somewhere safe. 
4. Go to Start>Run and type cmd and press Enter. This will open up a new command prompt. 
5. In the command prompt window type: imagecfg -a 0x1 followed by the text you copied from step 1 above 

(right-click in the command prompt box and select Paste) then press Enter. Make sure to put quote 
marks around the path if it's not already there. E.g.: 
 
imagecfg -a 0x1 "c:/program files/RegCleaner/RegCleanr.exe" 
 

6. Windows will now only allow that program to see and use the specified CPU core each and every time it 
is launched by using that particular executable. 

 
Alternatively if you're having problems with imagecfg, you can use this small SetAffinity program instead. 
Download and extract the contents to an empty folder, and run the setaffinity.exe file. This will bring up the 
interface where you can select to run a particular process or executable with only one CPU core, either 
temporarily or permanently. 
 
For all other intents and purposes a multi-core CPU-based system will behave the same way as a single core 
system. You should only use the steps above if you run into a problems with a particular program which 
you genuinely believe is associated solely with multi-core CPU usage - usually the program will be an older 
one; recent programs are designed to take into account the existence of multi-core CPUs, so even if they 
don't take full advantage of your CPU they won't cause problems because of it. 
  

http://www.robpol86.com/index.php/ImageCFG�
http://www.megaupload.com/?d=PNX2NO1U�
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 PROCESS EXPLORER 

 
 
If you want an advanced form of Task Manager which provides even more details about processes and has 
multiple options for performance analysis and troubleshooting, you can download Process Explorer. When 
launched, Process Explorer looks similar to Task Manager, however aside from the same sort of functionality 
as Task Manager covered above, you can also see much more information about a process by double-clicking 
on it. In the box which opens, there are various tabs which provide valuable information specific to the 
process. For example under the Performance Graph tab you can see resource usage graphs for the process; 
under the Performance tab is a range of data which is neatly summarized to give a good overview of 
resource usage, and under the Image tab you can details about the file itself, including the ability to verify if 
a file is a Microsoft system file. Process Explorer is a valuable tool to add to your system and is safe to use. 
 
 
As you can see, the Task Manager has multiple functions as detailed above. Familiarizing yourself with its 
various uses will help give you a good idea of what is happening on your system at any time. For example, 
regularly checking active processes and memory usage will give you early warning of things such as 
malware infections, since they often cannot be hidden from the Task Manager's Processes list or memory 
usage statistics. If you see a sudden increase in memory usage at startup, or a new and unknown process 
appears, or CPU usage increases at idle, you can be sure it is the result of a new program or service running 
in the background. Most often this is the result of recently installed legitimate software adding a program or 
service to your startup, and you should use the procedures in this book to determine whether it is necessary 
or not. If left unmonitored, your background resource usage can and will blow out, slowing down your boot 
time and causing stuttering and potential program conflicts, so stay vigilant. 
 

http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx�
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WINDOWS REGISTRY 
 
 
The Windows Registry is a central database for a range of system and program-related settings. Whenever 
you change your Windows settings, add or remove components or install new programs and/or change their 
settings, or even move or resize open windows, the registry will be updated with key pieces of information 
marking these changes. This chapter covers the optimization and editing of the Windows Registry. 
 
 
 REGISTRY EDITOR 

 
 
To access the Windows Registry Editor, go to Start>Run, type regedit then press Enter. You can also access 
the Registry Editor by typing regedt32 instead of Regedit, but Regedt32 is a just a small program that runs 
Regedit anyway, so there is no difference between either method. For our purposes, the main reason for 
editing the registry is to alter settings that cannot otherwise be changed using the normal Windows 
interface. Learning to use the Registry Editor is important because it is a powerful tool, and unlike any third-
party utility designed to edit the registry, using Registry Editor provides the most direct access to the entire 
Windows Registry and ensures that you are aware of precisely what has been changed each time, and where 
it originally resides should you need to change it back. I recommend you take the time to learn more about 
using this important tool. 
 
To use the Registry Editor correctly, open it and you will see what looks like a directory listing under 
Computer, with five folders starting with 'HKEY_', e.g. [HKEY_CURRENT_USER]. Under these Root Keys 
are a series of sub-folders called Keys. Within each key there is at least one Value called (Default), visible 
in the right pane of the Registry Editor window when you click on the key name. Typically there are several 
other values underneath the Default entry. These values can be of several types, including STRING, 
DWORD and BINARY values. 
 
The most common form of registry editing involves changing the contents of values, or adding new values 
under certain keys. Note that in this book the root key and subfolder name(s) are provided in square 
brackets [ ], and the name of the value to be edited is shown underneath. The data to be entered into the 
value is given after the '=' (equals) sign. An example is provided below. 
  

http://support.microsoft.com/kb/256986�
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EDITING REGISTRY ENTRIES 

To edit an existing registry entry follow the example below to see the correct procedure: 
 
[HKEY_CURRENT_USER\Control Panel\Desktop] 
 
CursorBlinkRate=600 
 
The text above indicates that to make this registry change, you should open Registry Editor and then: 
 
1. Double-click on the HKEY_CURRENT_USER root key (or click the '+' sign next to it) in the left pane of the 

registry editor window. This will show every key sitting directly under it. 
2. Next, you must double-click on the Control Panel key. 
3. Highlight the Desktop key by left clicking on it once, and in the right pane of the Registry Editor 

window, look for a value called CursorBlinkRate. 
4. Double-click on this item and in the box that opens, click in the Value box, delete the current number 

there, and enter 600 instead. 
5. As soon as you click OK the change has automatically been saved to the registry. 
6. You can now close Registry Editor if you wish. 
 
Note that the impact of changes made to the registry can either come into effect straight away, or may 
require a reboot - it depends on the change. If in doubt reboot and test for new or altered functionality. 
 

CREATING AND DELETING REGISTRY ENTRIES 

At various times you may need to create a new key or value if it does not exist by default in your registry. To 
create a new entry from scratch correctly, follow this procedure: 
 
1. Go to the particular subfolder under which you need to create a new key. 
2. Right-click on the relevant sub-key and select New>Key to create a new subfolder beneath it; 

alternatively, select New> and the correct value type to create a new value (entry in the right pane). 
3. Enter the name for the new key or value and press Enter. 
4. To confirm that the new key or value is in the correct location, left-click on it and look at the bottom of 

Registry to see if the full path matches that which you desire. 
 
Note that Registry Editor does not give any confirmation or sign that you've entered a valid key or value, so 
there is no way to know if what you have created is correct, aside from checking the instructions you were 
following and then testing to see if it has the intended impact. Remember, you may need to reboot or logoff 
and logon again to implement the registry change. 
 
To delete a key or value, simply go to the particular key or value you wish to remove, right-click on it and 
select Delete. Take all possible care to make sure that what you're deleting is the correct key or value, and 
that you trust the source which has instructed you to do so, otherwise you may be doing irreparable damage 
to the registry. 
 
A more detailed guide to editing the Windows Registry is in this Microsoft Article. Just remember that the 
Windows Registry is very important, and editing it is not to be taken lightly, so if in doubt, don't edit the 
registry unless you absolutely have to. 
  

http://support.microsoft.com/kb/256986�
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BACKING UP AND RESTORING PORTIONS OF THE REGISTRY 

The registry is an important component of Windows and it is crucial for you to understand that the Registry 
Editor does not have an 'undo' function. Hence the best course of action prior to using the Registry Editor to 
alter any part of the registry is to back up your important data and settings, as well as your entire registry 
(See the Backup & Recovery chapter for details). A more practical precaution is to make a backup of the 
particular registry key(s) you are about to edit, especially if you don't feel confident about making the 
change, or aren't sure how the change will impact on your system. That way if anything goes wrong you 
don't have to go through a lengthy process to restore the entire registry - you can just restore the individual 
key(s) that you have changed quickly and easily. The steps to backing up a specific registry key are as 
follows: 
 
1. In the left pane of the Registry Editor window, right-click on the name of the key that holds the settings 

you wish to edit. 
2. Select the Export option, and choose a suitably descriptive name and appropriate location for the file. 

Make sure that the 'Selected Branch' option is ticked at the very bottom of the box, so that only the 
particular key and all its sub-components are saved, not the entire registry. Click the Save button and 
the file will be saved with a .REG extension. 

3. Once the relevant section of the registry has been saved, you can go ahead and edit the registry entries 
underneath the key you've just saved. 

 
If you experience any undesirable behavior after your registry changes - and remember that some registry 
changes require a reboot before their effects can be seen - then you can restore the backup of your registry 
keys by going to the place where you saved them, and double-clicking on the relevant .REG file. This will 
overwrite the existing sections of the registry with the backed up versions, effectively undoing your changes 
quickly and easily. 
 
If you don't feel comfortable with the above method, or if you want to backup the entire registry, see the 
Backup & Recovery chapter for more details on how to make proper full registry backups, as well as forms 
of protection against unintended Registry changes. 
 
 MAINTAINING THE REGISTRY 

The Windows Registry has thousands of entries, and just like any large database, over time some of these 
entries can become obsolete due to changes in hardware and software, and some entries can even become 
corrupted due to bad shutdowns, overclocking or faulty software or hardware for example. For the most 
part the Windows Registry is self-maintaining, so on balance I recommend that you do not attempt to run 
any utilities which try to optimize the registry by cleaning it. There are more risks involved and more 
likelihood of unintended consequences than any marginal benefits. 
 
However for the sake of completeness, and also for more advanced users who feel ready to accept the risks, 
and want to use a registry cleaner to assist in removing debris left over from bad driver or program 
uninstalls for example, then this section briefly covers this topic. 
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CCLEANER 

The free CCleaner utility, whose prime functionality is covered in detail under the Cleaning Windows 
chapter, also has a useful registry cleaning ability. This is the recommended method of cleaning your 
registry, and is covered below: 
 
1. Open CCleaner and click the Options button on the left side. 
2. Click the Advanced button and make sure there is a tick against the 'Show prompt to backup registry 

issues' box. 
3. Click the Registry button on the left side. 
4. I recommend ticking everything under the Registry Integrity section except 'Unused File Extensions', 

'Start Menu Ordering' and 'MUI Cache'. 
5. Click the 'Scan for Issues' button and wait for the scan to complete - nothing will be altered. 
6. Examine the list carefully, focusing on any entries related to programs or drivers which are no longer 

installed on your system - leave a tick next to these entries. 
7. Untick any others unless you are absolutely sure they are safe to remove. 
8. Click the 'Fix selected issues' button to commence removal of the ticked registry entries. 
9. When prompted, click Yes to backup registry changes and save the backup to an appropriate location. 
10. Click the 'Fix All Selected Issues' button then click OK to remove all ticked items from the Registry. 
 
Over a period of several days, if Windows features or any of your programs start acting strangely, you can 
undo the changes caused by registry cleaning by double-clicking the backed-up .REG file you saved in Step 9 
above and rebooting. 
 

JV16 POWERTOOLS 

 
 
JV16 PowerTools is a package of various tools relating to system cleaning and modification. The registry 
cleaning functionality is the main reason why this software is being covered here, and note that the latest 
version of JV16 PowerTools supersedes the RegSupreme and RegCleaner software previously released by 
the same company. 
 
To access the registry-related functionality we require, download the software from the JV16 PowerTools 
Site and install it, but note that it is only free for a limited trial period. However this should be sufficient to 
undertake the bulk of the registry cleaning we require. Once JV16 PowerTools is installed, click on the 
Registry Cleaning module on the main page. The default options are fine for most users, however I 
recommend that you can make the following adjustments: 
  

http://www.ccleaner.com/�
http://www.macecraft.com/�
http://www.macecraft.com/�
http://www.macecraft.com/�
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 Under Engine Settings move the slider down a notch (i.e. to sit one notch from the bottom). This will 
increase the effectiveness of the registry cleaning without introducing too much more risk. Also untick 
the 'List MRU and other history data', as these items shouldn't be regularly cleaned out. 

 Under Advanced Options, tick the 'Don't show items that would automatically be recreated' and 'Don't 
show the scan report after finishing'; both options are redundant features. 

 
Once configured, click the tiny disk icon in the bottom left corner of the box to save your settings, then click 
the Start button to begin scanning. When completed you will see a full list of all the 'invalid' entries the 
registry cleaner has found, though note that nothing has been deleted or altered yet. Sometimes thousands of 
supposedly invalid entries may be found (especially when using the default options), but don't be distressed: 
this doesn't mean your registry was a total mess. Most of these are just MRU (Most Recently Used) entries 
for example, and are harmless and perfectly normal, and will simply recreate themselves over time if 
removed. 
 
Now go to the Select menu and choose All to tick all the entries. Advanced users can scroll through the list to 
see if there's anything you want to individually exclude or delete. Otherwise once everything is selected, 
click the Fix button, and make sure to create a backup before proceeding. JV16 PowerTools will then attempt 
to fix, or delete if necessary, the invalid entries. This may take a while so be patient. Again, if you have 
doubts, don't use this form of registry cleaning as there is an element of risk involved when altering the 
registry this way. 
 
JV16 PowerTools has a range of other potentially useful registry-related functionality, particularly via the 
Registry Manager component. This component allows you to view various types of registry entries sorted 
under different categories in a user-friendly manner. You can then delete entries related to unwanted 
functionality or left over from an incomplete uninstall of software for example. There's also a Registry 
Compactor component which performs the same sort of task as NTRegOpt (See below). 
 
There are a range of other system cleaning and maintenance modules, however in general I recommend 
against using these. I only recommend using JV16 PowerTools primarily for its registry cleaning 
functionality as covered above - the other functionality is best done manually and with the full benefit of 
understanding through research and using the other tools and techniques covered in this book as 
appropriate. It is quite easy to make an absolute mess of your system and subsequently have no idea what 
caused the problem - or how you can fix it - if you become reliant on an 'all-in-one' tweaking utility like JV16 
PowerTools. Each task requires different tools, and every aspect of Windows tweaking requires knowledge 
to perform correctly, for which there is no automated replacement. 
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NTREGOPT 

 
 
After cleaning the registry, and before we enter into any registry editing, there is a utility called NTRegOpt 
you can use to optimize the size and layout of the Windows Registry. If you have installed Erunt as covered 
earlier in the book then you will have already installed NTRegOpt. If not, or you're not sure, download it 
from the link above and install it. Then run the NTRegOpt.exe file to start the program and click OK to begin 
the optimization procedure. It may take some time, so be patient. You will have to reboot for the 
optimization procedure to complete. This process compacts your registry, which can help improve Windows 
startup times and memory usage. NTRegOpt is best used infrequently, perhaps once every month or two, to 
ensure optimal registry size is maintained. Note however the program does not physically defragment your 
registry; only one of the defragmentation utilities under the Drive Optimization chapter can do that. 
 
 MISCELLANEOUS REGISTRY TWEAKS 

Once you've learned how to edit the registry, you can use a range of tweaks to customize your system using 
the Registry Editor. This section only covers the tweaks which don't fall under any specific category; most 
registry tweaks are actually covered under the chapter relevant to the area of Windows they relate to. For 
example, registry tweaks relevant to Internet Explorer are covered in the Internet Explorer chapter. 
Remember that some registry changes require a reboot before they come into effect. Importantly, don't forget 
to backup your registry properly before changing anything in it. 
 
Below are a range of miscellaneous performance and convenience tweaks - implement the ones you want to 
use. My recommended values are provided for the performance-related tweaks: 
 

IMPROVE MENU RESPONSIVENESS AND SHUTDOWN SPEEDS 

The following tweaks improve the responsiveness of Windows. The values shown for each are the 
recommended values for your system. 
 
[HKEY_CURRENT_USER\Control Panel\Desktop] 
 
HungAppTimeout=4000 
 
This STRING controls the delay before a hung application is allowed to terminate (each 1000 = 1 sec). 
 
WaitToKillAppTimeout=4000  
 
This STRING controls the delay before windows finally starts to shutdown (each 1000 = 1 sec)  
 
MenuShowDelay=20  
 
This STRING controls the delay before a menu or sub-menu pops open (each 1000 = 1 sec)  
 
AutoEndTasks=1  
 
If enabled this STRING automatically closes all running applications when Windows shuts down. 
  

http://www.larshederer.homepage.t-online.de/erunt/�
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INCREASE NTFS SYSTEM PERFORMANCE 

These tweaks improve the performance of Windows systems that use the NTFS File System. See the 
Installing Windows chapter for more details of NTFS. If the following entries don't exist, create them and 
assign the recommended values shown: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem] 
 
NTFSDisableLastAccessUpdate=1 
 
This DWORD disables the constant updating of dates a file/folder was last accessed if set to 1, improving 
disk performance. 
 
NTFSDisable8Dot3NameCreation=1 
 
This DWORD disables support for old MSDOS 8-character filenames if set to 1, which can improve 
performance. 
 

CHANGE FOREGROUND APPLICATION PRIORITY 

For users who usually run one major application or game at a time on their machine, you can set Windows 
XP to give even higher priority in allocating resources to such 'foreground applications'. Follow the tweak 
below to implement the change: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PriorityControl] 
 
Win32PriorityControl=38 
 
Create a new DWORD called Win32PriorityControl and allocate a value of 38 to it in Decimal view. 
 

PREVENT MSN MESSENGER FROM RUNNING 

If you don't use the Windows MSN Messenger utility and want to prevent it from running - e.g. when it is 
launched automatically by certain applications - then implement these changes to your Registry: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client] 
 
PreventRun=1 
 
This DWORD will prevent MSN Messenger from running if set to 1. 
 
PreventAutoRun=1 
 
This DWORD will prevent MSN Messenger from popping up automatically if set to 1. 
 

TURN OFF CD AUTOPLAY 

By default Windows XP will automatically detect the presence of any disc inserted into an optical drive on 
your system. As soon as such discs are detected, any applications, audio or video files on these discs will 
automatically be launched. This Autoplay functionality can be annoying to some, and can also lead to 
unwanted and potentially insecure software being automatically installed. To disable Autoplay 
functionality, make the following change: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CDRom] 
 
Autorun=0 
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Setting this DWORD to 0 disables Autoplay, setting it to 1 enables Autoplay. Note that instead of using this 
tweak, you can temporarily disable Autoplay behavior at any time simply by holding down the SHIFT key 
while inserting a disc. 
 

TURN OFF WINDOWS XP BUILT-IN CD BURNING 

Windows XP has a basic form of disc burning which although adequate is not good enough to replace the 
functions of a dedicated burning package like the recommended Nero Burning ROM. If you are using a 
third-party burning package you can disable the built-in XP burning functionality by doing the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer] 
 
NoCDBurning=1 
 
This DWORD disables the built-in Windows burning functionality if set to 1, but still allows other burning 
software to work. 
 

TURN OFF SYSTEM BEEPS 

By default Windows XP makes beeping noises under certain situations, regardless of your Windows sound 
settings. To alter this behavior, go to the following Registry entry: 
 
[HKEY_CURRENT_USER\Control Panel\Sound] 
 
Beep=Yes 
 
Set this STRING to No to disable any system beeps that occur during Windows usage. Note that to disable 
other Windows event-based sounds you will still need to go into Control Panel>Sounds and Audio Devices -
see Sounds & Audio Devices under the Control Panel chapter. 
 

CHANGE THUMBNAIL QUALITY & SIZE 

Whenever you view a folder with pictures in it, by default Windows will show the contents in Thumbnails 
view. To change the size and quality of these thumbnails use this tweak: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer] 
 
ThumbnailQuality=50 
 
To alter the quality of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in 
Decimal view between 50 and 100. The larger the value, the better the thumbnail image but the slower the 
thumbnailed images will load up. 
 
ThumbnailSize=32 
 
To alter the size of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in 
Decimal view between 32 and 256. The larger the value, the larger the thumbnail but the slower the 
thumbnailed images will load up. 
  

http://www.nero.com/�
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DISABLE THUMBNAIL CACHE 

When displaying folder contents in Thumbnails view, Windows creates caches of thumbnailed images, 
usually saved in files called Thumbs.db in each folder that has been viewed in Thumbnails view at any point. 
Thumbnail caching helps speed up repeated viewing of these folders in Thumbnails view, but you can 
disable thumbnail caching by doing the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced] 
 
DisableThumbnailCache=0 
 
Set this DWORD to 1 to disable thumbnail caching, or set it to 0 to enable thumbnail caching. If you disable 
thumbnail caching and/or don't use thumbnail view in any folder, you should also go to Windows Search 
and find and delete every instance of the file Thumbs.db on your system as they are no longer necessary. 
 

TURN OFF 'LOW DISK SPACE' NOTIFICATION 

Once the free space on your drive falls below a certain percentage Windows XP will give you a 'Low Disk 
Space' notification. To disable this warning, implement this tweak: 
 
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer] 
 
NoLowDiskSpaceChecks=1 
 
Set this DWORD to 1 to turn off the notification altogether. 
 

DISABLE BALLOON TIPS 

Balloon Tips are the small yellow pop-ups that appear throughout Windows informing you of various facts 
or functions. To disable these, implement this tweak: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced] 
 
EnableBalloonTips=0 
 
Setting this DWORD to a value of 0 turns off the balloon tips. 
 

DISABLE WINDOWS KEY 

If you want to disable the Windows Keys on your keyboard, perhaps because they are interfering in a game 
you are playing, use this tweak: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Keyboard Layout] 
 
Scancode Map= 
 
Under the Keyboard Layout key (not Keyboard Layouts) create a new BINARY value called Scancode 
Map and then double-click on it and click once in the top right hand side of the value data box and manually 
type in the following values in the exact order as shown (note all the 0's are zeros, and no spaces are 
necessary): 
 
00 00 00 00 00 00 00 00 03 00 00 00 00 00 5B E0 00 00 5C E0 00 00 00 00 
 
You will need to reboot for this change to come into effect. If you want to reverse this tweak, delete the 
above key and reboot. Since the Windows keys are useful for many keyboard shortcuts, I generally don't 
recommend implementing this tweak. 
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That's just a small number of what I believe are the more useful miscellaneous registry tweaks. If you're in 
the mood for more registry tweaking, a large range of Windows Registry tweaks can be found on this 
Registry Tweaks for XP page. Note that some of them may not work correctly on Windows XP SP3, and of 
course make sure you backup the registry appropriately before using any of them. Note that I don't 
recommend implementing a large number of registry tweaks at once, as this makes troubleshooting any 
resulting problems extremely difficult. Select one or two that you feel are the most necessary for 
performance and convenience sake, implement them and reboot. If your system remains stable and trouble-
free, implement a few new ones at a time, and repeat the process. Also make a new System Restore point 
before each major change to the Windows Registry just in case. 
 

http://www.kellys-korner-xp.com/xp_tweaks.htm�
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GROUP POLICY 
 
 
The Group Policy editor is an Administrative Tool designed primarily for network administrators to alter 
the way in which Windows XP behaves for groups of users on their network - see Administrative Tools 
under the Control Panel chapter. It is only available in Windows XP Professional, but fortunately for 
Windows XP Home users the majority of the tweaks covered in this chapter can be performed using other 
utilities, such as TweakUI. To access the Group Policy settings, go to Start>Run, type gpedit.msc and press 
Enter. This will open the Group Policy editor, which shows two main branches: 'Computer Configuration' 
and 'User Configuration'. Changes made under the 'User Configuration' sections affect only the current user, 
while changes made under the 'Computer Configuration' section apply to the entire machine and affect all 
users who log onto that machine. 
 

 
 
 
 GROUP EDITOR TWEAKS 

Below are a range of tweaks that you can apply through the Group Policy editor. To change a setting, go to 
the sub-folder shown and double-click on the setting in the right pane and then choose Enabled, Disabled or 
'Not Configured' as required then click Apply. My recommended settings for each are provided in brackets, 
however you should first click once on the setting you wish to change and in the Extended view you can see 
a brief description of the setting to the left of it. If in doubt, do not change a setting - leave it at its default. 
 

DISABLE AUTOMATIC SYSTEM RESTORE CHECKPOINTS 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Installer 
Setting: Turn off Creation of System Restore Checkpoints  (Leave at default) 
 

TURN OFF BUILT-IN XP CD BURNING 

Folder: User Configuration\Administrative Templates\Windows Components\Windows Explorer 
Setting: Remove CD Burning Features (Enabled) 
 
Note: Still allows third party burning software such as Nero Burning ROM to work without problems. 
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PREVENT WINDOWS MEDIA DIGITAL RIGHTS MANAGEMENT FROM INTERNET ACCESS 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Media 
Digital Rights Management 
Setting: Prevent Windows Media DRM Internet Access 
 

REMOVE 'SHARED DOCUMENTS' FOLDER 

Folder: User Configuration\Administrative Templates\Windows Components\Windows Explorer 
Setting: Remove Shared Documents from My Computer (Enabled) 
 

REMOVE SHUTDOWN/LOGOFF/RESTART MESSAGES 

Folder: Computer Configuration\Administrative Templates\System 
Setting: Remove boot /Shutdown /Logon / Logoff messages (Leave at default) 
 

TURN OFF USER TRACKING (WILL ALSO DISABLE PERSONALIZED MENUS) 

Folder: User Configuration\Administrative Templates\Start Menu and Taskbar 
Setting: Turn off user tracking (Enabled) 
 

PREVENT ACCESS TO WINDOWS COMPONENTS 

Folder: User Configuration\Administrative Templates\System 
Setting: Don't run specified Windows applications 
 
Note: You can also prevent users from accessing the Registry Editor and Command Prompt in this folder. 
 

TURN OFF CD/DVD AUTOPLAY 

Folder: Computer Configuration\Administrative Templates\System 
Setting: Turn off Autoplay (Enabled) 
 

DISABLE WINDOWS MESSENGER 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Messenger 
Setting: (Set both to Enabled) 
 

CUSTOMIZE INTERNET EXPLORER TITLE 

Folder: User Configuration\Windows settings\Internet Explorer Maintenance\Browser User Interface 
Setting: Browser Title (Personalize as desired) 
 

REMOVE RECYCLE BIN ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove Recycle Bin icon from Desktop (Leave at default) 
 

REMOVE MY DOCUMENTS ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove My Documents icon from Desktop (Enabled) 
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REMOVE MY COMPUTER ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove My Computer icon from Desktop (Leave at default) 
 
Note: Use this tweak with caution as enabling it can cause a great many problems. 
 
 
There are a range of other Group Policy tweaks you can undertake, so have a look through the other areas of 
the Group Policy editor and see if there is anything you would like to change. However be very careful to 
remember precisely what you have changed, because when troubleshooting problems people tend to forget 
the changes they implemented in Group Policy and spend a great deal of time checking elsewhere, especially 
since you can perform many of these same tweaks in a variety of other places. 
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TWEAKUI  
 
 
TweakUI is a free Microsoft utility that provides a convenient tweaking User Interface (UI) for safely 
customizing many of Windows XP's hidden settings. It is easy to use and includes helpful instructions on 
what the various settings do. If you don't feel confident in using the Registry Editor or Group Policy editor 
to make certain changes for example, TweakUI allows you to change many of the same settings in a 
relatively foolproof way. To access TweakUI, first download it from the Microsoft PowerToys site, then 
install it and launch it. To navigate to the various areas of TweakUI, click once on the name of the section 
(e.g. General), and in the right pane tick or untick the appropriate settings and then make sure to click the 
Apply button for every section or sub-section you change. The effects of most changes will be visible 
immediately. 
 

 
 
 
 CONFIGURATION ADVICE 

TweakUI covers a large number of settings, and as such I can't cover them all here. Below are a selection of 
the more significant settings which I recommend that people change in order to improve general 
performance and functionality. Descriptions for each can be seen in TweakUI whenever you highlight the 
relevant setting. These changes should be safe for almost every system, but obviously you can undo them by 
reversing the changes in TweakUI should they not suit you. 
 

GENERAL 

Tick 'Optimize hard disk when idle' 
 

GENERAL>FOCUS 

Tick 'Prevent applications from stealing focus' 
  

http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx�
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EXPLORER 

Tick 'Detect accidental double-clicks' 
Untick 'Maintain network history' 
Untick 'Show Links on Favorites menu' 
Tick 'Use intuitive filename sorting' 
 

EXPLORER>SHORTCUT 

Select None to remove the shortcut arrows from shortcuts 
 

EXPLORER>THUMBNAILS 

Move the slider to the far left for Image Quality 
 

EXPLORER>CUSTOMIZATIONS 

To conserve memory use a relatively low setting like 400 folders 
 

TASKBAR AND START MENU 

Untick 'Enable balloon tips' 
Untick 'Warn when low on disk space' 
 

MY COMPUTER>AUTOPLAY>TYPES 

To disable the Autoplay functionality of your optical drive(s), untick 'Enable Autoplay for CD and DVD 
Drives'. Some malicious software such as Rootkits can be prevented from installing by turning off Autoplay. 
 

CONTROL PANEL 

Untick all the Control Panel components you never use, or which are installed by third party programs and 
are unnecessary. Note that this only removes their icons from the Control Panel, not the programs 
themselves, and doesn't affect that program's functionality in any way. However I recommend you do this 
tweak after you have read about and adjusted all the settings in the Control Panel - see the Control Panel 
chapter. 
 
You should customize the remaining settings as you see fit, then click OK when done. 
 
 
Although TweakUI is very safe to use, don't change settings that you are unclear about. If anything goes 
wrong, it may be difficult for you to figure out which change in TweakUI is causing the problem, or has 
removed the functionality you want. Take it slow and change a few things at a time. Also have a look at the 
other XP PowerToy utilities on the PowerToys site, as you may find some of them useful. 
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WINDOWS EXPLORER 
 
 
Windows Explorer is the primary means for manipulating files and folders in Windows XP. This interface 
appears in the Windows Explorer application itself, as well as in many applications which prompt you to 
open or save files, and of course in most standard Desktop windows. Windows Explorer can be accessed in 
several ways, including by going to Start>All Programs>Accessories, or by going to Start>Run, typing 
explorer and pressing Enter, or by pressing WINDOWS+E at any time to name just a few methods. 
Importantly, there are many settings you can alter in Folder Options that have a direct impact on what you 
can see when in Windows Explorer. These are covered under Folder Options in the Control Panel chapter, so 
make sure you use the recommended settings there for maximum performance and functionality. For 
example, by making sure that file extensions and system files aren't hidden in Folder Options, you will be 
able to see these files in Explorer and perform some of the tweaks in this book, as well as making general 
troubleshooting easier. 
 
This chapter contains a range of tweaks and tips for Windows Explorer: 
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SET EXPLORER'S DEFAULT STARTUP FOLDER 

If you usually open Explorer from a shortcut, this tweak allows you to set which directory it will start in by 
default when launched from that shortcut: 
 
1. Right-click on the shortcut icon you use to launch Explorer and select Properties. If no such shortcut 

exists, you can first create one by right-clicking on a blank spot on your desktop or in a directory and 
then selecting New>Shortcut. 

2. In the Target box replace any existing text with the following: 
 
%SystemRoot%\Explorer.exe /e, path 

 
3. In place of path above you should enter the actual path to the directory you want open by default. The 

path doesn't require quote marks around it. For example:  
 
%SystemRoot%\Explorer.exe /e, C:\Windows  

 
4. Click OK, and now using this shortcut will open a Windows Explorer window in the directory specified. 
 
Note that there are several other switches and options you can use in the Properties box to further customize 
Explorer's default view as detailed in this Microsoft Article. 
 

SPEED UP EXPLORER 

The following tweak can improve the response time of Windows Explorer (and also Internet Explorer). Go to 
the following key in the Windows Registry: 
 
[HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\RemoteCom
puter\NameSpace] 
 
To prevent Windows Explorer from searching for remote scheduled tasks, under the Namespace key in the 
left pane find the {D6277990-4C6A-11CF-8D87-00AA0060F5BF} key if it exists, right-click on it and 
select Delete to remove it. To also prevent Explorer from searching for remote shared printers, delete the 
{2227A280-3AEA-1069-A2DE-08002B30309D} key as well. This will speed up the time it takes for 
Explorer to open and navigate. If you are connected to a network of computers do not undertake this tweak. 
 

REMOVE 'SHARED DOCUMENTS' FROM MY COMPUTER 

If you want to remove the 'Shared Documents' folders under My Computer use this tweak: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\MyCompute
r\NameSpace\DelegateFolders] 
 
{59031a47-3f72-44a7-89c5-5595fe6b30ee} 
 
Delete the key above by right-clicking on it in the left pane and selecting Delete. This will remove all the 
superfluous 'Shared Documents' folders permanently. 
  

http://support.microsoft.com/kb/307856�
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FORCE ALL COLUMNS IN EXPLORER TO BE VISIBLE 

Sometimes when you open Windows Explorer or Explorer-based interfaces (and there are many, such as the 
Registry Editor) there may be columns that are much too wide or narrow to show everything they contain. 
To quickly force Windows to resize these columns appropriately press the CTRL key and the + (plus) key 
together. This will instantly resize all columns so that even the largest value in each column is visible. This 
may require you to expand the surrounding window or use the bottom scroll bar to see them all, but at least 
there won't be any hidden or overly wide/thin columns. See the Visual and Convenience chapter for other 
handy keyboard shortcuts. 
 

RENAME MULTIPLE FILES 

If you have a large number of files you want to rename, you can do it rapidly by doing the following: 
 
1. Highlight the group of files you want to rename in Windows Explorer. You can do this two ways:  

 Hold down the SHIFT key and click on the first file in the group, then while still holding down shift, 
click on the last file in the group and everything in between will also be highlighted; or  

 Hold down the CTRL key and click on any individual files you want to select until all the files you 
want to select are highlighted.  

You can also combine the two methods, i.e. SHIFT select a range of files, then use CTRL to remove or 
add individual files to the highlighted ones. 

2. Without clicking anywhere else, right-click on the first file you want to rename, and select Rename. 
3. Enter a name for the file and press Enter.  
 
Now all the remaining highlighted files will be renamed with the same name you gave the first file, however 
they will also have a number in brackets after them. For example, if I rename the first in a series of files 
Screen.jpg using this method, the remaining highlighted files will be renamed Screen (1).jpg, Screen (2).jpg, etc. 
 

EDIT CONTEXT MENUS 

 
 
When you right-click your mouse button on any location you will see a range of context menu entries. As the 
name implies, the entries are dependent on the context in which the right-click was used, whether it was on 
a file, folder, an empty location on the Desktop, and so forth. Unfortunately some of the entries in the context 
menu have been unnecessarily inserted by programs you have installed, and you may wish to remove these.  
 
The first step in getting rid of any unwanted entries involves opening the programs to which the entries 
relate and looking through the program's options to see if you can unselect any 'shell integration' or 'context 
menu' settings they have. If that doesn't work or is not possible, you can use several other methods to find 
and remove these entries. Before making any changes to your context menus, make sure to use System 
Restore to create a new restore point, as some of these changes cannot be easily undone. 
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Autoruns 
 
The free Autoruns startup identification utility can be used in a relatively straightforward manner to 
temporarily disable or permanently remove context menu entries. For our purposes look under the Explorer 
tab of Autoruns - the majority of the entries will be context menu entries of one type or another. The 
Description, Publisher and Image Path columns should provide sufficient information to identify which 
Autorun entries relate to which particular context menu items. Untick any you wish to temporarily disable, 
then close Autoruns, reboot and check to see if the undesirable context menu entries are gone. To 
permanently remove an item, right-click on it and select Delete. For full details of how to use Autoruns, see 
the Startup Programs chapter. 
 
ShellMenuView 
 

 
 
The free ShellMenuView utility is an automated tool which displays all static context menu items. Download 
and run the shmnview.exe file to launch the utility - no installation is required. The interface is confusing at 
first, but keep in mind that most standard Windows entries are not being displayed as long as the 'Hide 
standard menu items' option is ticked under the Options menu, so the bulk of these entries relate to third 
party programs. 
 
Each entry under the 'Menu Name' column is precisely that, the name of a menu entry in one of the context 
menus on your system. To determine which entries apply to which particular applications, expand the 
columns and look under the 'File Type' column - the associated applications for each menu entry are shown. 
Highlight the entries you believe you wish to remove, right-click and select 'Disable selected items', and 
check to see if this removes the relevant entries from your context menu. If not, you can easily undo this by 
highlighting the same entries, right-clicking and selecting 'Enable selected items'. 
 
ShellExView 
 
Some context menu entries are not static, they enable additional functionality which makes them a shell 
extension. You can use the free ShellExView utility, which is similar to ShellMenuView, to view and adjust 
these. Download and run the shexview.exe file to launch the utility - no installation is required. The interface 
is once again slightly confusing at first, however non-Windows shell extensions are highlighted in pink by 
default, as long as the 'Mark non-Microsoft extensions' option is ticked under the Options menu. Right-click 

http://technet.microsoft.com/en-us/sysinternals/bb963902.aspx�
http://www.nirsoft.net/utils/shell_menu_view.html�
http://www.nirsoft.net/utils/shexview.html�
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on any extension you wish to disable and select 'Disable selected items'. Test to see if this disables the item, 
however you will likely have to reboot to see the impact of the changes. 
 
Windows Registry 
 
The utilities above are recommended for most users as they are automated and provide safeguards to more 
easily undo changes. However if you wish to manually (and hence permanently) remove context menu 
entries via the Windows Registry, look under the following locations using the Registry Editor: 
 
[HKEY_CLASSES_ROOT\*\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Directory\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Drive\shell] 
[HKEY_CLASSES_ROOT\Drive\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Folder\shell] 
[HKEY_CLASSES_ROOT\Folder\shellex\ContextMenuHandlers] 
 
The subfolders above are locations which hold most context menu entries in Windows. Under each, aside 
from standard Windows items such as Sharing or Offline Files, you may find keys or values which 
relate to particular third party programs. Right-clicking on the relevant program key and selecting Delete 
will remove its context menu entries. In most cases as you remove unwanted program entries, you can test 
the effects immediately by checking to see if the relevant entry was removed from the context menu. In some 
cases - mainly with shell extensions - you may need to reboot to see the effects. There is no undo function in 
Registry Editor, so make sure to back up the relevant branch before editing it. See the Windows Registry 
chapter for full details of registry editing instructions. 
 
Note that if any of the programs whose context menu entries you've edited or removed start displaying 
strange behavior, or you accidentally deleted the wrong entry, restore the registry entries you backed up 
previously, or just reinstall that particular program. As long as you only delete clearly marked program 
entries and none of the default Windows entries, all the normal context menu items will still remain. 
 

ADD 'COPY TO' AND 'MOVE TO' CONTEXT MENU ITEMS 

If you want to add two useful commands to your context menus - namely 'Copy To' and 'Move To', follow 
the steps below: 
 
[HKEY_CLASSES_ROOT\AllFileSystemObjects\shellex\ContextMenuHandlers] 
 
Copy To= {C2FBB630-2971-11d1-A18C-00C04FD75D13} 
Move To= {C2FBB631-2971-11d1-A18C-00C04FD75D13} 
 
Create two new keys under the ContextMenuHandlers folder - that is, right-click on 
ContextMenuHandlers and select New>Key twice and name them Copy To and Move To respectively. 
Then left-click once on each folder, go to the right pane in Registry Editor and double-click on the 
(Default) entry and assign the appropriate values shown above, including the parentheses around the 
numbers. This will create two new entries that allow you to select either 'Copy To Folder...' or 'Move To 
Folder...' in the context menu for a particular file or folder and then specify the location to copy or move 
them to. Obviously if you wish to add just one of the above entries to the context menu then only create the 
relevant key. 
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FOLDER VIEWS NOT BEING SAVED 

Sometimes when you change the way a folder's contents look, or its position on your Desktop, or the size of 
the window it opens in, after a reboot the changes don't seem to have been saved. The first thing to do is go 
to Control Panel>Folder Options and under the View tab make sure that 'Remember each folder's view 
settings' is ticked. However even with this setting ticked you may inevitably end up with unsaved settings. 
This can be due to corrupted registry entries brought on by a bad shutdown for example. The easiest way to 
fix this problem is to open the Registry Editor and go to the following keys: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\ShellNoRoam\BagMRU] 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\ShellNoRoam\Bags] 
 
Right-click on each key (i.e. BagMRU and Bags) and select Delete to get rid of both of them. Reboot your PC 
and open up each folder or window you want to customize. They will be back at their default appearance, 
and you will need to adjust again them to suit your tastes. However this time after you reboot your PC the 
view settings should be exactly as you set them prior to the reboot. By deleting the registry entries above 
Windows is forced to recreate them and in doing so get rid of corrupted entries. If you find you have to do 
this often, then see the tips throughout this book for stabilizing your system. This is a clear sign that your 
system is not completely stable, and contrary to popular belief, it is not normal behavior for Windows XP to 
constantly forget folder views. Also see the Explorer Customizations section of the TweakUI chapter for 
details of how to set the maximum number of folders for which Windows retains the saved customization 
settings - if this is set too low it may be the reason why your folder views are constantly being lost. 
 

REPAIR INCORRECTLY DISPLAYED ICONS 

By default Windows stores a range of commonly used icons, such as Desktop and folder icons, in a cache to 
speed up their display. If you are experiencing problems with your icons displaying incorrectly, go to your 
\Documents and Settings\[Username]\Local Settings\Application Data directory and delete the IconCache.db file. 
Reboot Windows and this file will be recreated, resolving any icon incorrectly displayed. Also see the 
Memory Optimization chapter for details of how to set the maximum size of the Icon Cache. 
 

MOVE THE MY DOCUMENTS FOLDER 

By default the 'My Documents' folder is in a specified location, and moving it manually will not work. To 
correctly move the My Documents folder to another location, you must do the following: 
 
1. Click on Start, go to My Documents and right-click on it, then select Properties. Alternatively in 

Windows Explorer find the My Documents folder under your \Documents and Settings\[Username]\ 
directory, right-click on it and select Properties. 

2. Click the Move button and select a new location, then click OK. 
3. Choose whether you wish to move your existing documents across to this location. 
 
Alternatively you can just type the new path in the Target box. When you're done, Windows will now 
recognize the new location as the home of My Documents. This can be useful if you wish to move your 
personal documents to a separate data drive for example. Note that you can also change the name of My 
Documents to something else if you wish, such as simply 'Documents'. 
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MAKE THE MY DOCUMENTS FOLDER PRIVATE 

If you want to password protect your My Documents folder, or in fact any folder which is unique to your 
user account (such as My Photos, Favorites, Desktop, Start Menu), and you're using the NTFS file system, 
you can do the following: Right-click on the folder in Explorer, select the Sharing tab and tick the 'Make this 
folder private' box. Now the folder and all its subdirectories will be password protected with your user 
password. If you're logged in as the Administrator, or you have not set a user password (for quicker logon to 
Windows), this tweak won't do anything - if you try it, you'll be prompted to set a password for your user 
account, and unless you're worried about others accessing your private folders, I do not recommend setting 
a password. Also see the PC Security chapter for more details on how to protect files and folders using 
Windows Encryption. 
 

DISABLE WINDOWS FILE PROTECTION 

By default Windows XP protects a range of important system files from accidental deletion. This tweak 
allows you to remove that protection, but I strongly recommend against using it unless you are an advanced 
user: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon] 
 
SFCDisable=0 
 
Setting this DWORD to 1 will allow you to view, alter and delete protected system files. This is not 
recommended as these system files are protected for a reason: to specifically prevent harmful changes or 
deletions to core system files that can destabilize your system. Note you need to untick the 'Hide protected 
operating system files' option under Control Panel>Folder Options>View to be able to see protected files in 
Windows Explorer. Use this tweak only if troubleshooting a problem, such as malware infection, and only as 
a last resort. 
 

CHANGE DEFAULT LOCATION FOR PROGRAMS AND COMMON FILES 

To change the default location for the Program Files and/or Common Files folders, open Registry Editor and 
go to the following key:  
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion] 
 
ProgramFilesDir=C:\Program Files 
 
Change this STRING entry to another path if you want to change where Windows points to by default when 
installing new programs.  
 
CommonFilesDir=C:\Program Files\Common Files 
 
Change this STRING entry to another path if you want to change where Windows points to by default when 
installing common files for programs.  
 
Reboot Windows to bring the changes into effect. Keep in mind that using this tweak may result in problems 
with existing installed programs and file associations, as well as running Windows Update. You may have to 
manually move some of the existing program folders to the new location for them to work correctly. 
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INTERNET EXPLORER 
 
 
Internet Explorer (IE) is the most popular Internet browser in the world today. Most Windows users are 
extremely comfortable and familiar with Internet Explorer, and also know that it is the one browser upon 
which pretty much all Internet content will display as intended. Even if you use an alternate browser as your 
main browser, you may need to use Internet Explorer from time to time because certain websites will not 
display or function properly on other browsers. The best example of this is Microsoft's own Windows 
Update website which is only fully functional and secure when viewed with Internet Explorer. While I 
recommend that you begin trialing alternatives to Internet Explorer, it is a fast, efficient browser, and you 
should not feel you have to use another browser if you are happy with it.  
 
Internet Explorer 6 is the version built into Windows XP, even with SP3 installed. However Internet Explorer 
8 is now the latest official version of IE and the one I strongly recommend that all IE users to upgrade to for 
security, performance, stability and compatibility reasons. Accordingly, the advice in this chapter relates 
solely to IE8. You can download Internet Explorer 8 for free from here. 
 

 
 
 
 CONFIGURATION ADVICE 

To configure Internet Explorer, open the browser, go to the Tools menu and select 'Internet Options' - note 
this is the same as if you go to the Windows Control Panel and choose 'Internet Options'. Below are the 
descriptions and my recommendations for the important settings under each tab of Internet Options in IE: 
 

GENERAL 

Home Page: Here you can set the page that opens by default whenever you start Internet Explorer. If you 
don't want any homepage to start when IE is opened, click the 'Use blank' button; if you want to set the 
website you are currently viewing as your homepage, click the 'Use current' button; clicking 'Use default' 
will restore IE's default homepage which is a Microsoft site such as MSN (depending on your location). If 
you are using tabbed browsing (see further below), then you can enter multiple website addresses in the box, 
one on each line. Then whenever you open IE, all of these pages will open at the same time, as separate tabs. 
  

http://www.microsoft.com/windows/internet-explorer/default.aspx�
http://www.microsoft.com/windows/internet-explorer/worldwide-sites.aspx�


 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 190 Copyright © 2010 Koroush Ghazi 

 

Internet Explorer 

Note, if the home page will not change regardless of what you do here see the Programs section further 
below as well as the PC Security chapter - this may be caused by malware such as a browser hijacker. 
 
Browsing History: As you browse the Internet, certain files and settings are stored on your drive (cached) by 
IE to make your browsing faster in the future. Click the Settings button and you can select how IE uses this 
cache to speed up your browsing. Under the 'Check for newer versions of stored pages' you can tell IE how 
often to check to see if a web page has been updated; any parts of a site which don't appear to be updated 
will be loaded from your cache rather than site, and this can increase page load times especially for sites 
which have a lot of items to load up. I recommend selecting 'Automatically' as this allows IE to detect 
updated content and reload from the site only when it believes it is necessary. However this does not 
guarantee that you will always see the very latest content on the sites you visit, so if you want to see the 
absolute latest version of every page you visit select 'Every time I visit a webpage', though note this may 
increase page loading times. If you only want to view the latest version of certain pages at any time, press 
CTRL + F5 when on that page and this forces IE to reload the entire page from the site rather than from its 
own cache. Importantly, do not select the Never option here as that will mean IE will not update web pages 
you commonly view; it will always rely on the cached version which always results in out-of-date web 
pages. 
 
If for privacy purposes you wish at any point to delete any components of your browsing history from the 
cache, click the Delete button back under the General tab - see further below for details. If you just wish to 
browse privately from time to time, see the InPrivate Browsing feature covered in the section of the same 
name further below.  
 
Disk space to use: You specify the maximum amount of space IE uses for its Temporary Internet Files cache in 
Megabytes in the box provided. If the cache is too small, it will generally result in longer page loading times; 
if the cache is too large then depending on your Internet connection speed and your drive speed, you may 
still get longer page loading times as IE has to search its cache to find the components of a web page to load, 
when it may actually be faster just to reload them from the original site. Therefore I recommend 150MB of 
disk space for the cache as a balance of size and speed. If you have a faster drive and view more complex 
sites with lots of large images or scripts you may wish to increase this cache to 300MB or even larger if 
desired. 
 
Current Location: Internet Explorer lists the current location of its cache - this is where all of IE's stored 
content is held on your drive. You can view the files already there by clicking the 'View files' button, and you 
can view any downloaded programs necessary for certain sites to run by clicking the 'View objects' button. If 
you wish to move the cache, for example to a faster drive, click the 'Move folder' button. To delete cache 
contents, it is recommended that you follow the instructions further below rather than manually deleting 
any files here. 
 
History: Internet Explorer can keep a record of the addresses of all the websites you have viewed for a certain 
number of days. Here you can select how many days worth of recently viewed websites IE keeps. If you 
don't want a history of visited sites to be kept at all enter 0 in the box. Alternatively, see the InPrivate 
Browsing section if you just want to browse periodically without keeping a record of your history. 
 
Delete Browsing History: By clicking the Delete button under Browsing History, you will open a new box 
which contains a range of options. These options list the individual components of your browsing history, 
giving you greater control over the specific elements you can delete. If you don't wish to leave any trace of 
your browsing history for each and every session, you can use the InPrivate Browsing feature of IE, which is 
covered later in this chapter. In general it is completely safe to tick all of these boxes and click the Delete 
button to remove all traces of browsing, however doing so too often will also decrease the efficiency of your 
browsing. For this reason, there is an option entitled 'Preserve Favorites website data' which if ticked 
(recommended) will keep your preferences and cached files for any sites you have in your Favorites. This 
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increases convenience and speed when accessing your favorite sites, without retaining date for non-favorite 
sites. However if you want to remove all stored content then untick this box as well. In any case once you've 
selected which components you want to remove, click the Delete button at the bottom and they'll be 
removed immediately. 
 
Search: The Instant Search box at the top right of Internet Explorer allows you to quickly initiate a web search 
using the search engine of your choice, the results of which are displayed on the main IE screen. By default it 
is set to use Bing, however if you wish to set it to another engine such as Google, click the Settings button 
and select a new engine, then click the 'Set as Default' button. If you want to use a search engine not listed 
here, click the 'Find more providers' link at the bottom of the box. If you don't want sites or programs to 
suggest changes to your default search provider, then tick the relevant box at the bottom as well. If you just 
want to use a particular provider for particular searches, then in the main IE window click on the small 
arrow to the right of the Search box, select a provider from the list, enter your search query and press Enter - 
that search provider will be used only for that search, it will not change your default provider. 
 
Tabs: Tabbed browsing means that new web pages launched from links or popups can be opened as tabbed 
pages within the current browser window, rather than opening a new browser window. This helps reduce 
resource usage and it is also much easier to manage multiple open pages this way. To configure tabbed 
browser, click the Settings button. In the box which opens you can select whether to enable or disable tabbed 
browsing altogether, and set the behavior of it if enabled. Briefly, I recommend ticking the following: 
 
 Enable Tabbed Browsing - As mentioned above, tabbed browsing reduces resource usage by only keeping 

one IE window open; each new tab takes up far less memory than additional entirely new IE windows. 
 Enable Quick Tabs - Quick Tabs places a small box at the far left of your tabs when you have multiple 

open tabs. Clicking it opens a page which contains previews of the content of every open tab. 
 Enable Tab Groups - Tab Groups allows IE to group together tabs which are related. Tabs originating from 

the same source page are grouped next to each other and use the same color. 
 When a pop-up is encountered - Always open popups in a new tab - This prevents popup windows from 

attempting to hide by forcing them to open in a new tab instead of a new window. 
 Open links from other programs in - A new tab in the current window - When a program launches a web page, 

this option forces it to open a tab in any existing IE window rather than open a new IE window, again 
conserving resources. 

 
You can select the other options as you wish, but the main aim of tabbed browsing is to make viewing 
multiple web pages more manageable and prevent having lots of separate open IE windows which can use 
resources and space for no good reason. Some tips you can use to make tabbed browsing easier in IE include: 
 
 Clicking on any hyperlink with the middle mouse button opens that link in a new tab. 
 Clicking on any tab with the middle mouse button closes that tab. 
 Holding down SHIFT and left-clicking on any link forces it to open in a new IE window. 
 Holding down CTRL and left-clicking on any link forces it to open in a new tab. 
 Use CTRL+TAB to quickly switch from tab to tab. 
 You can reopen a recently closed tab by pressing CTRL+SHIFT+T. 
 Left-click and hold on any tab and you can then drag and drop it to rearrange tab order. 
 Right-click on any tab to bring up a tab-specific context menu. 
 If you want to save a set of tabs as a single bookmark folder, click the Add to Favorites icon (the star 

with a plus sign), select 'Add to Favorites' and select 'Add Current Tabs to Favorites'. 
 To open the contents of an entire Favorites folder in a series of tabs, right-click on the folder under 

Favorites and select 'Open in Tab Group'. 
 To manage Tab Groups, right-click on a tab within the group and you can close the entire group for 

example by selecting 'Close This Group'. 
  



 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 192 Copyright © 2010 Koroush Ghazi 

 

Internet Explorer 

Appearance: These options allow you to change the appearance of web pages, customizing colors, fonts and 
even forcing particular style sheets. In general you shouldn't alter these options unless you have specific 
needs. 
 

SECURITY 

Security level for this zone: You can set the level of security Internet Explorer uses on the slider here, from 
Medium to Medium-High, to High. I recommend the default Medium-high level of security as it designed to 
allow most normal Internet functionality without being overly restrictive nor too relaxed. However if you 
constantly browse unsafe or untrusted websites, you may wish instead to set the High security level, though 
this will impact on Internet functionality. If you want to be even more selective, click the 'Custom level' 
button and manually select each security function; clearly though this is for more advanced users - the preset 
levels are fine for most users. 
 
Note that the Windows XP version of Internet Explorer differs from the Windows Vista and Windows 7 
versions of IE, as it does not include the added security of Protected Mode. 
 

PRIVACY 

Settings: The slider here controls the level of privacy in IE, which for the most part pertains to Cookies - small 
files stored on your machine designed to hold your preferences for particular websites. Cookies are not 
usually malicious or dangerous, as they cannot read or delete data on your computer, and can be very 
useful. Some cookies may attempt to track your online behavior for advertising purposes for example, and 
for this reason, the 'Medium High' level is recommended as it provides the best security/functionality 
compromise and should not prevent legitimate cookies from being placed on your machine while still 
protecting your privacy. However to be even more selective, you can click the Advanced button and tick 
'Override automatic cookie handling'. Third-party Cookies can usually be Blocked without any major issues, 
as these are mainly from advertisers. First-party Cookies on the other hand are often useful (e.g. for holding 
your login details for forums, or recording visual settings for particular sites), and blocking them can impair 
a site's functionality. If you do decide to block all first party cookies, and/or if you select a higher Privacy 
setting on the slider, click the Sites button and here you can manually allow or block specific website's 
cookies. I recommend adding your trusted favorite sites to this list and allowing them to prevent any 
problems with functionality. For example, if you set a High or Very High privacy setting this will block 
almost all cookies, making some sites non-functional, but you can still allow specific sites' cookies by making 
sure they're in the list of allowed sites. For broader blocking of third party content see the InPrivate Filtering 
section further below. 
 
Pop-up Blocker: A 'popup' is a new window which opens when you visit particular sites and/or click on 
particular links or areas of a site. They are most commonly used for advertising, and hence the option here to 
block them. I recommend ticking the 'Turn on Pop-up Blocker' box, but you should also click the Settings 
button and manually add the names of websites you trust which have legitimate popups that would 
otherwise be blocked. For example you may wish to add your Internet banking site to the list, or 
Microsoft.com. By default when a popup is blocked by IE, a small yellow warning bar will appear at the top 
of the page to inform you of this, and you may also hear a sound. If you want to disable either or both of 
these visual warnings, untick the relevant boxes here. Bear in mind that this may mean you will not be 
aware that a legitimate site is trying to open a necessary popup box, and thus you may run into problems on 
some sites - again make sure to add trusted sites manually to the list if you want them to function properly. 
  

http://msdn.microsoft.com/en-us/library/bb250462.aspx�
http://en.wikipedia.org/wiki/HTTP_cookie�
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InPrivate: InPrivate Browsing is a new feature of IE8 which allows you to surf the web without leaving any 
trace of your activities on the PC. This is covered in more detail in the InPrivate Browsing section further 
below. The options here relate to the way in which the InPrivate Browsing and InPrivate Filtering features 
operate when enabled. By default IE keeps a record of the sites you visit for the purposes of determining 
what data to automatically block from third party providers. If you tick the 'Do not collect data for use by 
InPrivate Filtering' box, IE will not record any such data. This will impact on how effective InPrivate 
Filtering is at automatically blocking third party content, but start off by ticking this box and if you find 
problems on particular sites, make manual adjustments in the InPrivate Filtering settings box - see the 
InPrivate Filtering section further below.  
 
When using InPrivate Browsing, ticking the 'Disable toolbars and extensions when InPrivate Browsing starts' 
box will disable all such toolbars and extensions to prevent them from saving any private data during an 
InPrivate session. This is recommended for maximum privacy, but if you absolutely require their 
functionality during InPrivate Browsing, then untick this box but make sure to research your installed 
toolbars and extensions to ensure they do not breach your privacy, as otherwise it will defeat much of the 
purpose of InPrivate Browsing in the first place. Note that in general I strongly recommend against installing 
many (if any) toolbars and extensions wherever possible, for both security, stability and performance 
reasons. 
 

CONTENT 

Content Advisor: If enabled, the Content Advisor allows you to attempt to filter out and control access to 
websites that contain offensive or inappropriate material. Go through each category of content and use the 
slider below the box to set the restrictions on that category. Once done, click OK and you will be prompted 
to set a Password, as well as a Hint in case you forget that password. IE will now attempt to restrict content 
based on content advice from ICRA (Internet Content Rating Association), so this is not a fool-proof method. 
 
Certificates: Certificates are a form of electronic authentication method to verify that a particular website or 
individual is what/who it/they claim to be. Certificates are described in more detail in this Microsoft Article, 
and are beyond the scope of this book in detailing their functions. I don't recommend altering any of the 
settings in this section unless you are acting under advice from a trusted tech support person. If a particular 
site displays a certificate error or warning, I recommend pursuing this further with the site owner or 
researching via Google before conducting any financial transactions with the site, as advised in this 
Microsoft Article. 
 
AutoComplete: AutoComplete can save any website address you have typed into the address bar (or have 
already stored in your History), any text you've entered into online forms, and any usernames and/or 
passwords you've entered on a web page. The aim is that next time you start to type a URL, or visit a site, 
AutoComplete will automatically complete or restore your typed text, speeding up logging in or filling out 
details, or typing URLs into the address bar. Click the Settings button to configure which particular aspects 
of a web page AutoComplete will function for, but in general for security purposes I don't recommend 
enabling any of these options unless you have strong protection on your User Account and the PC is 
physically isolated from anyone else. 
 
Note that ticking the 'Use Windows Search for better results' box will mean that an item called 'Internet 
Explorer History' will be added to the Indexing Options used by Windows Search. This item cannot be 
removed from within the Indexing Options; to remove it, untick the box here and click OK. 
 
Feeds and Web Slices: If a website you're viewing has RSS or Web Slice capability, you will see the orange RSS 
or green Web Slice icon. You can then click the relevant icon to view the feed or to preview relevant slice 
information. Clicking the Settings button here allows you to configure how often such feeds and slices are 
updated, how they're read, and how IE warns you about capable websites. If you don't use these features, 
untick all the boxes on the Settings page. 

http://www.fosi.org/icra/�
http://technet.microsoft.com/en-us/library/cc785237.aspx�
http://support.microsoft.com/kb/931850/en-us�
http://en.wikipedia.org/wiki/RSS_(protocol)�
http://www.microsoft.com/windows/internet-explorer/features/easier.aspx�
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CONNECTIONS 

You should set up and customize the details of your Internet connection as provided to you by your Internet 
Service Provider (ISP), and make sure the settings here match your connection type and details. 
 

PROGRAMS 

Default web browser: If you have installed any other browsers, you can choose to set or reset IE as your default 
browser by clicking the 'Make default' button. Unless you are worried about another browser taking over 
this default association, you needn't tick the 'Tell me if Internet Explorer is not the default web browser' box 
for optimal startup speed. If you wish to make another web browser your default, see 'Set Program Access 
and Defaults' under the Add or Remove Programs section of the Control Panel chapter for details. 
 
Manage Add-ons: Clicking this button allows you to configure Add-ons in IE. Any small program installed for 
use within Internet Explorer is an add-on, and generally you will be aware that a site is installing an IE add-
on through prompts. However you can view all the main add-ons here by selecting the relevant category 
and making sure that the Show drop down box under the Toolbars and Extensions category says 'All add-
ons'. For example Adobe Flash Player is a common add-on which allows flash-based content to play on web 
pages, such as YouTube videos. When you first visit a web page with a flash animation, IE will prompt you 
with a yellow warning bar that 'This website wants to install the following add-on:' and mentions the name 
of the add-on, in this case 'Adobe Flash Player from Adobe Systems Incorporated'. If you wish to continue 
then click the warning bar and follow the prompts. 
 
For the most part some add-ons are legitimate, such as allowing you to view PDF files from within Internet 
Explorer, or running free browser games. You can also download a Range of Add-Ons which provide useful 
additional functionality for Internet Explorer, such as spell checking. Many of these add-ons are free and 
operate similar to Extensions for Firefox, making Internet Explorer more functional and customizable. 
 
The problem is that some sites try to install add-ons which contain potentially harmful or intrusive scripts 
designed to alter Internet Explorer's settings to suit their purposes. Furthermore some sites and programs 
will insist on installing useless toolbars in IE which take up space, collect data on your browsing behavior, 
and add to resource usage unnecessary. For this reason it's extremely important that you don't just 
automatically accept the installation of any add-on; only install add-ons from trusted websites and only if 
absolutely necessary. In general the less add-ons the better, both for security and performance purposes. 
Even legitimate add-ons can potentially slow down the launch and browsing speeds of Internet Explorer. 
Regularly check the list of add-ons in this section and disable those you don't trust; do a Google search if the 
name does not seem familiar. 
 
The Search Providers category in the Manage Add-ons box is covered under the General section further 
above; the Accelerators category is covered under the Accelerators section later on in this chapter, as is 
InPrivate Filtering.  
 
HTML Editing: Here you can set the program IE uses for editing the HTML code of web pages when you 
select the 'Edit with [program name]' option under the Page menu. 
 
Internet Programs: Clicking the 'Set Programs' button here simply opens the Default Programs component of 
Control Panel, covered in full detail under the Default Programs section of the Control Panel chapter. 
  

http://windows.microsoft.com/en-us/windows-vista/internet-explorer-add-ons-frequently-asked-questions�
http://get.adobe.com/flashplayer/�
http://www.ieaddons.com/en/�
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ADVANCED 

This section contains important settings for Internet Explorer's functionality, security and general behavior. 
There are too many settings to be able to describe each one of them in full here, however I want to discuss a 
few important options in more detail before going into the recommended settings: 
 
Phishing Filter/SmartScreen Filter: As discussed under the PC Security chapter, Phishing is a form of deception 
designed to illegally secure your personal details, such as logon, password and credit card numbers. It is 
usually done for financial gain, and is becoming an increasingly significant threat. Internet Explorer 7 
introduced the built-in Phishing Filter which warns you if a particular site seems to be deceptive or a known 
phishing perpetrator. Internet Explorer 8 has changed the name of this option to the SmartScreen Filter. 
More than just a name change, the way in which the filter works has also changed. The filter now works 
much more efficiently, has new features to detect and block potential malware downloads, and in general it 
is strongly recommended that you leave the 'Enable SmartScreen Filter' box ticked under the Advanced tab. 
If you visit a potentially unsafe site, the prompts you will receive are quite intuitive. If you still wish to 
continue visiting the reported site, click the 'More Information' link at the bottom of the warning, or click 
'Disregard and download unsafe file' to continue downloading an allegedly unsafe file download. Obviously 
in both cases this is not recommended unless you are certain the report is false - remember that even trusted 
websites can unintentionally host malware without their owner's knowledge. 
 
To manually check a particular site using the SmartScreen Filter, go to the Safety menu in IE, highlight the 
'SmartScreen Filter' menu and click 'Check this Website'. To report a website as being unsafe, go to the same 
menu and this time select 'Report Unsafe Website' - however bear in mind this doesn't automatically add the 
site to the list of unsafe websites, it only reports it for further examination by Microsoft. Finally, you can 
disable SmartScreen Filter by selecting the 'Turn Off SmartScreen Filter' option, but this is not recommended.   
 
Zoom: Different web pages have different sized text and pictures. Internet Explorer allows you to zoom 
in/out of any page at any time simply by selecting the zoom level using the Zoom box at the bottom right of 
the screen - click on it and select the desired zoom level. However a quicker method is to hold down the 
CTRL button and scroll up or down on your mousewheel. Alternatively you can use CTRL + (plus key) or 
CTRL - (minus key) to zoom in and out respectively, and to reset the page to its default size, use CTRL 0 
(zero). Under the Advanced options you can alter how this behavior works, particularly for new tabs and 
windows. For example if you tick the 'Reset zoom level for new windows and tabs', regardless of how 
zoomed in or out you are on your current tab, opening a new tab will mean the page will open at the default 
zoom level; if unticked, the new tab will open at the same zoom level as your current page. Experiment with 
these settings as well as the zoom feature to determine what suits your tastes. 
 
Compatibility View: Internet Explorer 8 introduces Compatibility View which helps correctly render web 
pages that use code designed for older browsers. You can switch to Compatibility View at any time by 
selecting the option under the Page menu, or by clicking the small 'broken page' icon to the right of the 
Address Bar. This essentially changes IE8 into IE7 for the purposes of rendering the page. You should only 
use this option if you believe a web page is being shown incorrectly, typically when elements on the page are 
out of alignment, obscured by other elements, glitchy or missing objects/text is visible, and so forth. Most 
sites will render correctly in IE8, so this is not a common problem. To manually force any page to 
permanently show itself in Compatibility View, select the 'Compatibility View Settings' option under the 
Page menu and add it to the list. You can also tick the 'Include updated websites lists from Microsoft' to use 
a pre-compiled list held by Microsoft which determines which sites require Compatibility View to 
automatically be enabled - more details can be found in this Microsoft Article. Of relevance to this section, 
under the Advanced tab in the main IE Internet Options, there is an option entitled 'Automatically recover 
from page layout errors with Compatibility View' - if ticked, as the option implies, page layout rendering 
errors will result in the page being shown in Compatibility View. You can leave this option ticked, however 
if you notice a site you regularly visit triggering this option, it is better to add it to the list under 
Compatibility View Settings for faster rendering. 

http://windows.microsoft.com/en-US/windows-vista/Phishing-Filter-frequently-asked-questions�
http://blogs.msdn.com/b/ie/archive/2008/07/02/ie8-security-part-iii-smartscreen-filter.aspx�
http://blogs.msdn.com/ie/archive/2008/08/27/introducing-compatibility-view.aspx�
http://msdn.microsoft.com/en-us/library/dd567845(VS.85).aspx�
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The rest of my recommendations for the more important Advanced settings in IE are provided below. 
 
I recommend that the following options be ticked for maximum performance, stability and convenience: 
 
 Disable script debugging (Internet Explorer) 
 Disable script debugging (Other) 
 Enable automatic crash recovery 
 Enable third-party browser extensions 
 Enable visual styles on buttons and controls in webpages 
 Show friendly HTTP error messages 
 Use Passive FTP 
 Use smooth scrolling 
 Use HTTP 1.1 
 Use HTTP 1.1 through proxy connections 
 Always use ClearType for HTML 
 Enable automatic image resizing 
 Show pictures 
 Check for publisher's certificate revocation 
 Check for server certificate revocation 
 Check for signatures on downloaded programs 
 Do not save encrypted pages to disk 
 Enable DOM storage 
 Enable Integrated Windows Authentication 
 Enable native XMLHTTP support 
 Enable SmartScreen Filter 
 Use SSL 3.0 
 Use TLS 1.0 
 Warn about certificate address mismatch 
 Warn if POST submittal is redirected to a zone that does not permit posts 
 
I recommend the following be unticked, again for maximum performance, stability and convenience: 
 
 Display a notification about every script error 
 Enable Suggested Sites 
 Allow active content to run in files on My Computer 
 Allow software to run or install even if the signature is invalid 
 
Settings for which I have no specific recommendation, but which are noteworthy: 
 
Display Accelerator Button on selection: Accelerators are covered in more detail in the section of the same name 
further below. If ticked, this option brings up the blue Accelerators button whenever you highlight a 
selection on a page for example. This may be annoying for some people, especially if they keep accidentally 
clicking the button. Unticking this option removes the button. 
 
Do not submit unknown addresses to your auto-search provider: If selected, this option prevents the search 
functionality of the Address Bar. Given IE already provides an Instant Search box at the top right of the 
screen, this functionality appears superfluous. If you wish to retain it, select 'Just display the results in the 
main window', then whenever you enter some plain text in the Address Bar it will initiate a search using the 
default search engine used for the Instant Search box. 
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Empty Temporary Internet Files folder when browser is closed: As discussed under the General section above, the 
use of the browser cache speeds up browsing in IE. However if for privacy and/or security purposes you 
want the cache cleared every time you close IE, tick this option. This may result in slower browsing each 
time you start a new session of IE. A better alternative might be to browse with InPrivate Browsing 
automatically enabled - see further below for details. 
 
The remaining settings not covered above can be set to suit your taste, or simply left at their default. 
 

INPRIVATE BROWSING 

 
 
InPrivate Browsing is a feature of Internet Explorer 8 designed to allow you to surf the Internet without 
leaving any trace on the PC you are using. To access this feature, select the 'InPrivate Browsing' option under 
the Safety menu, or press CTRL+SHIFT+P - a new browser window will open, clearly marked as 'InPrivate'. 
Any browsing done using this InPrivate session will not store data on your drive. This is ideal for people 
who browse the Internet using publicly shared machines, but it is also useful if you simply want to ensure 
that there is no potentially embarrassing Internet-related material stored on your PC via normal browsing. 
 
While using an InPrivate session, IE will generate and store several temporary pieces of information, mainly 
to ensure that website functionality is maintained. Cookies and cached internet files will be stored 
temporarily for example, but as soon as you close the InPrivate browser window, these are all automatically 
removed. Importantly however, there are a range of caveats to keep in mind when using InPrivate Browsing:  
 
 If you add any Favorites, RSS Feeds or Web Slices while using InPrivate, or you install any software, or 

add a new home page, then such changes will be saved and kept permanently even after you close it. 
 If you don't close the InPrivate window before terminating your session, then others may be able to view 

your browsing history and temporary files on the same PC. 
 InPrivate functionality does not extend to protecting your anonymity when surfing - your IP address for 

example will still be visible and stored on various sites as you browse the Internet. 
 An InPrivate session does not offer any greater security than using the standard IE mode. Do not 

mistake InPrivate as a form of protection against malware or phishing for example. 
 
Note also that if you have installed any third party toolbars or extensions in IE, then unless you tick the 
'Disable toolbars and extensions when InPrivate Browsing starts' box as covered under the Privacy section 
further above, these toolbars and extensions may be saving and transmitting private data regardless. For that 
reason, I recommend ticking this box, but more importantly, resisting the urge to install additional software 
for IE as much as possible unless absolutely necessary. 

http://windows.microsoft.com/en-US/windows-vista/Keep-your-surfing-to-yourself#section_2�
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While InPrivate Browsing is a useful feature, especially for those using shared machines, it is not a substitute 
for correctly configuring all of IE's options (see the rest of this chapter), and also exercising common sense as 
to general browsing. InPrivate does not guarantee that others will not find out about your browsing habits 
through other techniques, so minimize the extent to which you undertake potentially embarrassing or secure 
browsing on shared PCs for example.  
 
You can configure Internet Explorer to always open in InPrivate Browsing mode by default - see the 
Advanced Settings section later in this chapter. 
 

INPRIVATE FILTERING 

InPrivate Filtering is an additional Internet Explorer 8 feature which goes hand-in-hand with InPrivate 
Browsing. As noted above, InPrivate Browsing is designed to remove traces of your activity from the PC, but 
it does not protect your privacy when online. InPrivate Filtering attempts to do just that, to a reasonable 
extent, by preventing your private data from being broadcast unnecessarily to third party sites which are 
displaying content on the page you are viewing. For example, when you visit a trusted site, it may have 
content such as an interactive map or advertising which is drawn from another provider. You may wish to 
block data regarding your current actions on the trusted site from being transmitted to these third party 
providers. 
 
To turn on InPrivate Filtering, go to the Safety menu in IE and select the 'InPrivate Filtering' option to enable 
it; this must be done each time you start IE, although there is a advanced tweak to overcome this covered 
later in this chapter. Once enabled, you can then refine the way in which it works by selecting the 'InPrivate 
Filtering Settings' option under the Safety menu. Alternatively, you can access these options by clicking the 
small lock icon in the Status Bar at the bottom of the screen. 
 
You have three main options for InPrivate Filtering: Automatically Block; Choose Content to Block or Allow; 
or Off. When 'Automatically Block' is chosen, if the same third party content appears frequently across a 
range of sites it will be tracked and eventually blocked by IE to protect your privacy. However you can 
manually choose to block or allow content yourself if you're not satisfied with the automated results. At the 
bottom of the Settings box there is a small box which allows you to change how many websites need to be 
visited with the same third party content before it appears on the list of Content Providers in the Settings 
screen at the bottom of the screen. The default is 10, but you can lower it to 3 or raise it to 30; the lower the 
number the more third content will be blocked and hence also appear for you to choose to block or allow in 
the list. 
 
Alternatively, click the 'Advanced Settings' link at the bottom of the Settings box and you will be taken to the 
Manage Add-Ons box which then allows you to import pre-made filters for InPrivate Filtering. One example 
is this list which a user has compiled, mimicking the filter list from Adblock plus, a popular ad-blocking 
extension for Firefox. Save the list and use the Import feature in the InPrivate Filtering category of Manage 
Add-Ons to apply it to IE. 
 
Remember however that InPrivate Filtering is not specifically designed to block advertising as such, it is a 
general tool to limit the amount of data you send to third party providers. Enabling InPrivate Filtering can 
result in some sites not displaying correctly, or missing importantly functionality. However more 
importantly, constantly using InPrivate Filtering and thus blocking advertising can and will affect the 
viability of many sites on the Internet which rely on third party advertising income to remain free to view. If 
you block the ads on sites you enjoy, consider donating to them directly if you wish to see them remain open 
and free. 
  

http://windowshelp.microsoft.com/Windows/en-US/Help/d3b8a320-ec04-49f8-984c-1387619bda5e1033.mspx#section_4�
http://www.dslreports.com/forum/r22124619-IE8-InPrivate-filter-from-adblock-plus-list�
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ACCELERATORS 

 
 
Accelerators are browser-based tools which provide additional functionality for a site. You can access an 
Accelerator by highlighting a portion of a site and clicking the blue Accelerators button which appears. To 
access a list of Accelerators currently installed on your IE, right-click the blue button and select 'All 
Accelerators', or go to the Tools menu in IE, select 'Manage Add-Ons' and then select the Accelerators 
category. There are a range of additional free Accelerators you can download, you can view the full list by 
right-clicking on the Accelerators button and selecting 'All Accelerators'>'Find More Accelerators', or by 
clicking the 'Find More Accelerators' link in the 'Manage Add-Ons' screen. While they provide useful 
functionality, I recommend exercising constraint in how many you add to IE and keep active at any time to 
reduce resource usage. 
 
If you find the Accelerators functionality unnecessary, then disable all the available Accelerators in the 
'Manage Add-Ons' box, and also disable the blue Accelerators button - see the Advanced settings section 
further above. 
 
 ADVANCED SETTINGS 

The following are some more advanced customizations to make IE easier to use: 
 

CUSTOMIZE INTERNET EXPLORER 8'S APPEARANCE 

Internet Explorer 8 does allow customization of its interface, although in practice there isn't a great deal of 
scope for changing the way IE8 looks. To streamline IE8's appearance, try the following changes: 
 
1. Right-click on an empty area of the main IE toolbar (e.g. in the blank area to the right of any open tabs) 

to access the customization options. 
2. Untick any components you do not wish to view. For example the Favorites Bar, Menu Bar and the 

Compatibility View button are prime candidates for removal, as they are not frequently used by most 
people and their functionality is duplicated in a range of other places. 

3. Select the 'Lock All Toolbars' option to turn it off, and you can now move the Command Bar - the icon 
bar on the right side of the screen holding your main IE options. Grab the dotted line to the left of the 
Command Bar and you can move it up slightly to sit on a new line above your Favorites button and tabs 
for example; this might make access to it quicker for some people. Regardless of whether you do move 
the Command Bar, make sure the 'Lock All Toolbars' option is ticked at this point to prevent accidental 
movement of any toolbars. 

4. Select the Customize option and tick or untick the 'Use Large Icons' option to toggle the size of the icons 
to suit your taste, and also tick or untick the 'Show Stop and Refresh Buttons Before Address Bar' option 
if you wish to move the location of the Stop and Refresh buttons accordingly. 

http://www.microsoft.com/windows/internet-explorer/features/faster.aspx�
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5. Select the Customize option and then select whether you wish to display any text next to icons or not - 
selecting 'Show Only Icons' will reduce the space they take up and is recommended. 

6. Select the Customize option and then select 'Add or Remove Commands'. 
7. Highlight the commands you wish to add or remove to/from the Command Bar and use the Add and 

Remove arrows to make the appropriate changes in the box on the right. For example you may wish to 
remove the Read Mail and Help buttons, and instead add a 'Delete Browsing History' button to the 
Command Bar. Once done, click Close to see the changes. 

 
Unfortunately there isn't much more that can be done to truly customize IE8's appearance without resorting 
to more advanced methods covered further below. Fortunately, for the most part IE8's interface is reasonably 
streamlined. 
 

CHANGE OR DISABLE INTERNET EXPLORER CLICK SOUND 

Every time you navigate anywhere using Internet Explorer, or for that matter in Windows Explorer, you will 
hear a 'click' sound. To disable this clicking sound, or to change it to another sound follow these steps: 
 
1. Go to Control Panel>Sounds and Audio Devices>Sounds. 
2. Under the Program Events list, scroll down to 'Start Navigation' under the 'Windows Explorer' section.  
3. Left-click on 'Start Navigation' to highlight it. 
4. To disable the sound completely go to the sounds list below and select [None] at the very top of the list, 

then click Apply. 
5. To change the sound, pick another more suitable sound from the list, or click the Browse button to find 

another sound file on your drive to use. Remember that the larger the sound file, the more memory is 
used - see Sounds & Audio Devices under the Control Panel chapter. Click Apply when done. 

 
Note that changing or disabling this sound will affect both Internet Explorer and Windows Explorer equally. 
Further note that the default click sound is called Windows XP Start.wav. 
 

CHANGE INTERNET EXPLORER DEFAULT DOWNLOAD DIRECTORY 

By default Internet Explorer uses the same directory path to save files whenever you download a file from 
the Internet. You can change this default path at any time by opening the Registry Editor and going to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer] 
 
Download Directory=C:\Documents and Settings\User\Downloads 
 
This STRING specifies the default directory where IE will save downloaded files. Enter the path to wherever 
you want the new default to be. 
 

START WITH INPRIVATE BROWSING MODE ENABLED 

By default the InPrivate Browsing mode in IE8 requires that you start up IE normally, then select the 
'InPrivate Browsing' option under the Safety menu (or press CTRL+SHIFT+P) to open a new browser 
window which specifically uses InPrivate. To avoid all this, you can create a shortcut which opens IE already 
in InPrivate Browsing mode, ready to go at the start of every session. To do this, follow these instructions: 
 
1. Right-click on the icon you normally use to launch Internet Explorer 8. 
2. Select 'Send to>Desktop' if you wish to create a duplicate of it. 
3. Right-click on the icon to be modified and select Properties. 
4. In the Target box, go to the very end of the existing text, insert one blank space and then add the -private 

switch, and click Apply then OK to close the box. 
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Now whenever IE is launched from this modified icon, it will automatically open already in InPrivate 
Browsing mode every time. 
 

START WITH INPRIVATE FILTERING MODE ENABLED 

By default InPrivate Filtering needs to be enabled each and every time you start a new session of IE if you 
wish to use it. If you want InPrivate Filtering to be on by default all the time, then open the Registry Editor 
and  go to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Safety\PrivacIE] 
 
StartMode=1 
 
This DWORD needs to be created. When set =1 it forces IE8 to automatically begin with InPrivate Filtering 
mode enabled with each session. Delete it if you wish to undo this option. 
 

CUSTOMIZE INTERNET EXPLORER TITLE BAR 

If you want to customize what is displayed at the top of each Internet Explorer window - typically the name 
of the site followed by Windows Internet Explorer - go to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main] 
 
Window Title= 
 
Create a new STRING called Window Title (there is one space between the two words), and assign 
whatever text you wish to use. The next time you launch a new Internet Explorer window this text will be 
displayed at the top of IE. 
 

BUILT-IN FLASH BLOCKING 

If you want to block Flash-based content on any web page, you can use the new functionality in the 'Manage 
Add-Ons' screen in IE8 which allows greater control of ActiveX content, as described in this Microsoft 
Article. Follow these steps to customize how Flash content is allowed/blocked on a per-site basis: 
 
1. Go to the Tools menu in IE, select 'Manage Add-Ons'. 
2. Highlight the 'Toolbars and Extensions' category and make sure the 'All add-ons' option is selected 

under the Show drop-down box. 
3. Left-click on the Flash-related entry (e.g. Shockwave Flash Object), and at the bottom of the screen select 

the 'More Information' link, or simply double-click on the entry. 
4. In the box which opens, at the very bottom you will see a section where you can manually enter the 

names of sites which are allowed to use Flash-based content. By default it says * (asterisk) which means 
all sites. Remove the *, or click the 'Remove All Sites' button and click Close to disallow all Flash-based 
content on all sites. Alternatively, remove the * and then manually enter only the names of specific sites 
for which you wish to allow Flash functionality. 

5. With Flash functionality disabled for sites, you will see a yellow information bar when a site requires 
flash for full functionality. You can either ignore this bar, or if you wish to add the site to your allow list, 
click on the bar and select the 'Run Add-On' option and follow the prompts. 

 
As noted earlier, be aware that blocking flash-based content not only affects the functionality on certain sites, 
but it may also affect their viability if you block all their advertising as well. 
  

http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
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SPEED UP / FIX INTERNET EXPLORER 8 

Many users have reported that this tweak has improved IE8's speed and/or stability, and in general it should 
be quite harmless either way, so it is included here for the sake of completeness. If you believe IE8 is running 
slowly on your machine, or you are experiencing problems with the browser, open a Command Prompt and 
type the following then press Enter: 
 
regsvr32 actxprxy.dll 

 
Reboot your system and open IE8 to see if there is any difference. 
 
If you are having problems with Internet Explorer, you can browse through this Microsoft Fixit Site. In 
particular, to attempt to automatically diagnose and repair an Internet Explorer issue, you can run through 
this Microsoft Interactive Support Wizard. 
 
Furthermore, you can first attempt to reset all of Internet Explorer 8's settings to their defaults by opening 
Internet Options - via the Windows Control Panel if you can't access it from within Internet Explorer itself - 
then under the Advanced tab, click the Reset button and follow the prompts. 
 

INCREASE MAXIMUM SIMULTANEOUS CONNECTIONS 

By default Internet Explorer 7 only allowed two items to be downloaded at a time from a server, but Internet 
Explorer 8 has raised this limit to 6. This can still be slow for sites which have multiple items that need to be 
downloaded before the page can be displayed. You can increase the value beyond 6 by going to the 
following location in the Registry: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 
Explorer\MAIN\FeatureControl\FEATURE_MAXCONNECTIONSPERSERVER] 
 
iexplore.exe=10 
 
The value above doesn't exist, so create it as a new DWORD and in Decimal view assign the maximum 
number of connections you wish to have (e.g. 10 as shown above). You must also change the value at the key 
below: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 
Explorer\MAIN\FeatureControl\FEATURE_MAXCONNECTIONSPER1_0SERVER] 
 
iexplore.exe=10 
 
The value above doesn't exist, so create it as a new DWORD and in Decimal view assign the maximum 
number of connections you wish to have (e.g. 10 as shown above). 
 
Restart Windows or logoff and logon to implement this change. You can experiment with higher values if 
you wish, but note that increasing the maximum number of simultaneous connections to a very high value 
may technically be a breach of Internet Standards, or result in your connection being refused, so if you 
experience any problems reset these values to 6 or simply delete these values altogether. 
  

http://support.microsoft.com/gp/cp_fixit_main�
http://support.microsoft.com/gp/pc_ie_intro�
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DNS CACHE ISSUES 

Whenever your browser tries to load up a page on the Internet, it has to access a Domain Name System 
(DNS) server to resolve or translate the text address you use (e.g. www.google.com) into the actual IP 
address for the website (e.g.: 74.125.67.100). Since your browser needs to check DNS addresses each time it 
loads any web pages, the browser speeds up this process by locally storing the DNS addresses you use for a 
period of time so that next time you try to go to the same address it uses the IP address it has cached rather 
than looking it up again on a DNS Server. Unfortunately if a site is down temporarily, or has recently 
moved, then your DNS cache may store the site as being inaccessible for a while even if it comes back online 
shortly afterwards, and therefore every time you try to connect to it for a while you will get an error.  
 
To resolve any DNS problems with web pages not loading up at all or loading up with outdated 
information, open an Administrator Command Prompt and type ipconfig /flushdns and press Enter. 
This will clear your DNS cache. Furthermore, to make sure that your browser never stores a negative DNS 
cache entry - i.e. one which says a site is inaccessible - then go to the following location in the Registry: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters] 
 
MaxNegativeCacheTtl=0 
 
If the value above doesn't exist, create it as a new DWORD and assign it a value data of 0 so that no negative 
DNS entries can be kept in the DNS cache. You can also set the length of time in Time To Live (TTL) for a 
positive (or working) DNS cache entry to remain active before being updated. To do this, add the following 
DWORD in the same location: 
 
MaxCacheTtl=10800 
 
Assign it a value which measures (in seconds) the total Time To Live for the positive cache entry. Make sure 
to enter the amount of seconds in Decimal view. Do not set this value too low as your DNS cache will 
effectively become useless and browsing will take longer. A value of between 3 and 6 hours (10800 - 21600 
seconds) should be fine. 
 

ADVANCED CUSTOMIZATION 

While Internet Explorer is a good browser in many respects, it is very limited in the extent to which it can be 
truly customized using relatively simple methods. This is one of the reasons why, if you are interested in 
undertaking more advanced customization of browser functionality and appearance, you may wish to 
explore the option of using one of the other free web browsers covered at the end of this chapter. 
 
However if you still wish to try advanced customization of IE, you can use the free IE7Pro add-on which 
despite its name also works with IE8. Download and install IE7Pro, but during installation make sure the 
'Enable Userscripts Plugin' option is ticked, and then select the 'Do not install ProgSense' option. Once 
installed, to access the new features which IE7Pro enables, go to the Tools menu in IE and select 'IE7Pro 
Preferences'. In the window which opens you will see a range of options which you can use to alter the 
appearance and behavior of Internet Explorer. 
 
For example, using the 'User Scripts' component in the IE7Pro preferences box, you can load up a range of 
user-made scripts, such as those freely available at UserScripts.org, to achieve a range of customizations - 
though be aware that some user scripts can be deliberately malicious or annoying, so research a script 
carefully before enabling it. 
  

http://en.wikipedia.org/wiki/Domain_Name_System�
http://www.ie7pro.com/�
http://userscripts.org/�
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The various other functionality of IE7Pro won't be covered here, but clearly this add-on provides users with 
a great many options for further customization of Internet Explorer if used wisely. Note that if at any time 
you wish to disable the additional toolbar IE7Pro installs, right-click on the toolbar area and untick the new 
'Grab Pro' item. This will also remove the 'IE7Pro Preferences' item in the Tools menu. You can re-enable 
these again by right-clicking on the toolbar area and reticking the 'Grab Pro' item. 
 
 WINDOWS UPDATE 

Windows Update is an essential website which you should access regularly to download and install 
important updates for Windows. To access Windows Update at any time, open Internet Explorer, go to the 
Tools menu and select Windows Update. Alternatively, if you want to create a shortcut or bookmark to it, 
the address is Windows Update. If you are having problems accessing the site through the common methods 
above, you can try accessing it using a secure server through this link: Windows Update Secure. Note that 
the secure link differs by having https:// instead of http:// in the address. Note also that Windows Genuine 
Advantage does not allow pirated copies of Windows to fully access updates on Windows Update - see the 
Windows Product Activation & Windows Genuine Advantage chapter for details. 
 

WINDOWS UPDATE USAGE 

Whenever you access Windows Update I strongly recommend that you click on the Custom button instead 
of the Express method. This is because Custom allows you to see what updates are available, and you can 
select which you want to install. Once you've clicked on Custom you will see Windows Update scanning 
your machine and after a while it provides a list of updates. If the scanning doesn't seem to stop, or you have 
problems getting Windows Update to work, see further below. 
 
Now click on the 'Review and Install Updates' option and make sure all the High Priority security-related 
updates are selected - these should be installed on any Windows XP installation. However you should then 
check the 'Optional Software' and 'Optional Hardware' links on the left and go through the list of optional 
updates. These updates include important application updates, newer versions of drivers for the hardware 
on your system, etc. and I recommend that you first follow the procedures in the rest of this book to update 
your drivers, and then if these driver updates still appear you should install them as well. They won't cause 
any harm to your system and you can always manually install newer versions over them. 
 
If you feel adventurous and want to see any pre-release software in Windows Update, click on the 'Change 
Settings' link under Options in the left pane and place a tick against the 'Show beta products and related 
updates' box at the bottom of the screen and click the 'Apply Changes Now' button. Do a rescan with 
Windows Update and a new 'Beta Software' category will be visible in the left pane. 
 

SECURITY PATCH LINKS AND RELEASE DATES 

Microsoft usually releases new drivers and software updates as necessary, but they have a set release 
schedule for security patches - typically they are released together on the first Tuesday of every month. To 
find out when the next update is due, check the Microsoft Security Bulletin Site. You can find the direct 
download links to major security updates at any time on the Windows Security & Updates Download Site - 
click the 'Released' column header once to sort by date. 
 
Important: According to the Microsoft Product Lifecycle mainstream support for Windows XP ended in 
April 2009. This means that feature updates for example will no longer be released for XP. However 
Microsoft will continue to provide Extended Support until April 2014, which means that important security 
updates will continue to be released as required until that date, as long as you are running Service Pack 3. 
  

http://windowsupdate.microsoft.com/�
https://windowsupdate.microsoft.com/�
http://www.microsoft.com/technet/security/bulletin/advance.mspx�
http://www.microsoft.com/downloads/Browse.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://support.microsoft.com/lifecycle/?LN=en-gb&x=16&y=12&C2=1173�
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WINDOWS UPDATE ON OTHER BROWSERS 

Browsers other than Internet Explorer cannot access Windows Update correctly by default. If you use Firefox 
or Opera for example, you can use an updating service like WindizUpdate. This site should be safe enough 
to download updates from, however I strongly recommend using Internet Explorer and the proper 
Windows Update site to ensure maximum security and minimum delay in obtaining critical updates for 
Windows. Also see the Windows Product Activation & Windows Genuine Advantage chapter of this book 
for an official Microsoft Firefox plugin to validate the browser for use with downloads that require WGA 
verification. 
 

REPAIRING WINDOWS UPDATE 

Windows Update can exhibit strange behavior such as endlessly scanning your machine but never providing 
any list of updates, or gives strange error codes. The following are some things you can try to repair 
Windows Update: 
 
1. Try the secure Windows Update address instead: Windows Update Secure. 
2. If Windows Update seems to scan forever, or no updates appear, see this Microsoft Article. 
3. If you are experiencing specific Windows Update errors such as error code 0x800A138F, see this 

Windows Update Fails page. There is no single fix for all error codes and each one has several methods 
you can try to resolve the issue. 

 
 
As always, remember to run Windows Update at least once a week and install all important updates to 
maintain the security of your PC. Alternatively keep an eye on the front page of TweakGuides.com as I 
provide details of the latest patches and miscellaneous Windows updates of importance, and when to check 
Windows Update for Microsoft patch release days. If you're paranoid or forgetful and want to ensure you 
always have the latest patches and updates, enable Automatic Updates as covered under the Control Panel 
chapter. 
 
 OTHER INTERNET BROWSERS 

You may be wondering if there are other reputable browsers you can try if you are not happy with Internet 
Explorer. Fortunately there are at least three other major free browsers which are a viable and secure 
alternative to IE: Mozilla Firefox, Google Chrome and Opera. 
 
My personal preference is for Firefox. It is an excellent browser which is free and well-supported and runs 
without any problems alongside Internet Explorer, giving you the opportunity to try it out to see if you 
prefer it. The main advantage of Firefox over Internet Explorer and many other browsers is that Firefox is 
much more customizable through a range of Extensions and Themes. If you want to find out more about 
Firefox I recommend you read my Firefox Tweak Guide which covers all aspects of Firefox from the basic to 
the advanced. 
 
You have nothing to lose by trying other browsers out. All of the major browsers, including Internet 
Explorer, have the essential features required for fast, secure browsing. It all depends on which browser best 
meets your needs, as there is no outright best browser. 
 

http://windizupdate.com/�
https://windowsupdate.microsoft.com/�
http://support.microsoft.com/kb/836973�
http://www.updatexp.com/0x800A138F.html�
http://www.tweakguides.com/�
http://www.mozilla.org/products/firefox/�
http://www.google.com/chrome�
http://www.opera.com/�
http://www.tweakguides.com/Firefox_1.html�
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OUTLOOK EXPRESS 
 
 
Outlook Express - not to be confused with the full version which comes with the Microsoft Office Suite and 
is called Outlook - is a useful email and newsgroup program which is built into Windows XP. It should meet 
all your basic email needs, but it also has some features people rarely get around to configuring or using. 
This chapter covers advice for how to configure Outlook Express, as well as some tips and tweaks. If you 
prefer a more recent and more advanced email client, you can use Microsoft's free Windows Live Mail client 
instead - see the end of this chapter for details. 
 

 
 
 
 CONFIGURATION ADVICE 

The first thing to do is optimize Outlook Express' basic settings for efficient, trouble-free operation. Open 
Outlook Express, go to the Tools menu and select Options. Below are my recommendations for the  more 
important settings under each tab of Options: 
 

GENERAL 

Tick 'When starting go directly to my Inbox folder' 
Untick 'Automatically Log on to Windows Messenger' if the option exists 
 
Note if you have removed Windows Messenger from your system, you may also have to apply the Outlook 
Express slowdown fix (See further below) otherwise Outlook Express may take longer to load each time it 
starts. 
 

READ 

Untick 'Automatically download message when viewing in the preview pane' 
 
This is recommended for security reasons, so that unsolicited/spam email is not automatically downloaded 
in the preview pane when it is highlighted. 
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RECEIPTS 

Read receipts tell the sender of a message whether a message has been opened by the recipient. I personally 
don't like sending or receiving read receipts. They can be quite annoying, and whether you want to use them 
is up to you, but for the 'Returning Read Receipts' section I recommend selecting 'Notify me for each read 
receipt request'. That way you know when someone has sent an email to you with a receipt request, and you 
can choose whether to accept the request when you open the email.  
 
Secure receipts are similar, but might be more useful if you're sending a very important message and you 
want to make sure that the recipient has opened the message, and that the message arrived at the other end 
unaltered. Otherwise the same settings apply. 
 

SEND 

Tick 'Send messages immediately' 
Untick 'Automatically put people I reply to in my Address Book' 
 
Making sure that you don't add everyone to your Address Book is one way of preventing any viruses on 
your system from emailing everyone in your Address Book with the virus. I recommend instead either 
writing down email addresses or keeping at least one existing email from various people so you can reply to 
them that way. 
 

COMPOSE, SIGNATURES, SPELLING 

There are no specific recommendations for these tabs. Configure them to suit your taste. If you want to know 
what any of these features do, right click on them and click 'What's this' or select them and press F1 for 
Windows Help. 
 

SECURITY 

The security features in Outlook Express are reasonable but somewhat dated in protecting against most 
viruses and malicious code sent in emails. You need to know how they work and configure them correctly.  
 
There is an option to select either the 'Internet Zone' or 'Restricted Sites Zone' for your default email 
behavior. When in Internet Zone mode, HTML-based emails with active content will display their content 
just like a web page in Internet Explorer. In fact the security settings you choose under the Security tab in 
Internet Explorer Options also apply to Internet Zone email content. When in Restricted Sites Zone mode, 
Outlook Express will disable active content from HTML-based emails, which is much more secure, but 
reduces email functionality. I recommend running in Restricted Sites Zone mode, as most HTML-based 
emails nowadays are spam or malicious in intent. 
 
Tick 'Warn me when other applications try to send email as me' so that no other program on your system 
can automatically send out an email under your name without you knowing about it. 
 
Tick 'Do not allow attachments to be saved or opened that could potentially be a virus'. This important 
feature will protect you against email attachments, the vast bulk of which are dangerous, unsolicited 
malware. See the PC Security chapter for tips on how to prevent infection through emails. If you receive an 
attachment from an address you know, it may still be malware which was auto-mailed from that user's 
account, so double-check with the sender if you're genuinely unsure of whether to save or open the 
attachment. If you believe it's a legitimate attachment, then save the attachment and scan it with several 
malware scanners. If you're not allowed to save the attachment, first close the email, open Options and 
untick this setting, go back and open up the email and save the attachment, then make sure to retick this 
option afterwards. Once again, make sure to thoroughly scan all suspicious attachments, and remember that 
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executable attachments in particular (e.g. those with .EXE, .BAT, or .COM extensions) are almost always 
bound to be malware unless you are 100% certain of the source of the email. 
 
As noted, certain file types (e.g.: .EXE files) are automatically blocked with this setting enabled. To configure 
which other types of files are affected when this setting is ticked, go to Control Panel>Folder Options>File 
Types, highlight a file extension and click the Advanced button. Select 'Confirm open after download' to add 
the file type to the unsafe file list which Outlook Express uses to block attachments when this setting is 
enabled. Some file types are permanently on the unsafe list and cannot be taken off. 
 
Tick 'Block images and other external content in HTML email' - once again for security reasons. In practice 
very few people send legitimate HTML-based emails with images. 
 
You shouldn't have to change the remaining settings in this section. 
 

CONNECTION 

Uses the same settings as Internet Explorer, so see the Internet Explorer chapter. 
 

MAINTENANCE 

I recommend the following settings to reduce wasted disk space: 
 
Tick 'Empty message from the Deleted Items folder on exit' - this means any messages you have in your 
Deleted Items folder will be permanently deleted each time you quit Outlook Express. 
Tick 'Purge deleted items when leaving IMAP folders' - only affects email accounts which use IMAP 
protocol, which is not necessarily common. 
Click the 'Clean Up Now' button and select Compact to reduce existing wasted space immediately. 
 
If you are wondering where your emails are physically being saved, then the following option will show you 
email store directory: 
 
'Store Folder' – This is the location of your emails and Outlook Express folder settings. Typically it is the 
\Documents and Settings\[username]\Local Settings\Application Data\Identities\{ID String}\Microsoft\Outlook 
Express directory. 
 
Once you've changed all the settings you wish to change in Outlook Express, click the Apply button and exit 
the settings screen. You will need to close and relaunch Outlook Express for some of the settings to come 
into effect. 
  

http://en.wikipedia.org/wiki/Internet_Message_Access_Protocol�
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 TIPS & TWEAKS 

BACKING UP EMAILS 

If you want to manually back up the emails you've saved in Outlook Express, follow these procedures: 
 
1. Open Outlook Express, go to Tools>Options and open the Maintenance tab.  
2. Click the 'Store Folder' button and highlight the directory path shown with your mouse (right-click on 

the text and choose Select All).  
3. Right-click again on the highlighted text and select Copy.  
4. Go to Start>Run and right-click in the box. Select Paste, then click OK. This opens an Explorer window 

in the folder where Outlook Express holds your emails and email folders as .dbx files. 
5. The folder names should be self-explanatory. Select individual .dbx files where you stored emails and 

copy them to another location for backup purposes. 
 
These database files can be restored not only in Outlook Express, but also in newer versions of Windows 
Mail. 
 

RESTORING EMAILS 

To restore these emails back into Outlook Express at any point, say after a reformat of Windows, follow 
these procedures: 
 
1. Open Outlook Express, go to File>Import>Messages. 
2. Select 'Microsoft Outlook Express 6' from the list (or whichever version of OE you saved the messages 

under). 
3. Select 'Import mail from an OE6 store directory' and click OK. 
4. Browse to the directory where you backed up your Outlook Express messages as .dbx files. Click OK, 

then click Next. 
5. Click All Folders, select Next, then select Finish. Your messages should be restored as you saved them. 
 
You can also use these Import and Export functions in Outlook Express to save and restore your Address 
Book, Email account and Newsgroup account data. These aren't detailed here, but the procedure is similar to 
that outlined above. The procedures to restore Outlook Express emails in Windows Vista and Windows 7 are 
covered in the relevant versions of the TweakGuides Tweaking Companion. 
 

FILTERING SPAM 

Spam is unsolicited email with useless and often offensive content. Outlook Express has some built-in 
features which can be used to sort mail automatically and prevent spam. Note that these features won't work 
for IMAP and HTTP (i.e. Web-based) email accounts such as Hotmail. Use these tools for your POP3 
accounts such as the ones your ISP provides. To access and configure these tools: 
 
1. Open Outlook Express and go to Tools>Message Rules and select Mail. 
2. Click the New button to create a new rule. The New Mail Rule window will open. 
3. Select a condition for your rule. For example, we will choose 'Where the message is more than size'. We 

can set the size parameter for this rule in Step 5.  
4. Select the action for the rule. For example, 'Move it to the specified folder'.  
5. Set any parameters required for the rule by clicking on the blue underline text in the Rule Description 

box. For example, we will click on the Size text and choose 100KB as our size limit for the rule set up in 
step 3. We will click on the Folder text and choose Deleted Items. 

6. Give the rule an appropriate name, such as 'Large email filter' and click OK. 
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7. In the Mail Rules window, put a tick next to this new rule and click the Apply Now button. If you want 
to add more parameters or change the rule, click the Modify button, and go back through steps 3 - 6 
above until you're happy. 

8. Create as many rules as you like, and arrange them in order of priority/application to new messages by 
using the Move Up and Move Down buttons. 

 
Now when you check for new emails, the above rule will automatically check each email's size and if it is 
over 100KB, will redirect it to your Deleted Items folder automatically. You can have a quick look in there 
after checking your mail and see if it's anything you want to keep, otherwise just empty the deleted items 
and you've cleared some hefty spam straight away. Create more rules once you identify patterns in your 
email. For example if you are getting a lot of spam emails with the word viagra in them, set up a new rule 
which automatically deletes from the mail server any emails with 'viagra' (and other variations of the word) 
in the message body - i.e. choose the 'Delete it from server' action for the rule - this way you won't even 
download them before they get sorted by the filter; they'll be automatically deleted from the server, saving 
time and bandwidth. 
 
Of course you can do a lot more with Message Rules, such as block certain individuals, block any email 
accounts from particular domains (such as Yahoo or AOL), etc. Experiment with the tool as it is more useful 
than most people would believe. To begin with I strongly recommend setting the action for any rule to 
redirect flagged mail to a separate folder you set up and see if any legitimate mail is getting caught up by the 
rule. Also, you can create multiple layers of rules to finely sift through the mail and get rid of the genuine 
rubbish. That way if the email gets through one rule, it is subjected to the next one and so forth, and if it 
makes it through several rule checks it should be fine to view. 
 
If you can't be bothered configuring filters and you want an automated method of junk mail filtering, I 
strongly recommend that you install and use Windows Live Mail - see the end of this chapter for details. 
 

REMOVE SPLASH SCREEN 

The following is a simple tweak which skips the blue Outlook Express splash screen when Outlook Express 
is loading up. To perform this tweak, open Registry Editor and go to: 
 
[HKEY_CURRENT_USER\Identities\{numbers}\Software\Microsoft\Outlook Express\5.0] 
 
NoSplash=1 
 
Create this new DWORD value and set to =1. Delete the entry if you want to regain the splash screen. 
 

SLOWDOWN ISSUES 

If you have disabled MSN Messenger then you may experience slowdowns when launching Outlook 
Express. To resolve this problem, implement the following change to your Registry: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{FB7199AB-79BF-11d2-8D94-
0000F875C541}] 
 
Find this key in the left pane and under it left-click once on the IniProcServer32 key. In the right pane of 
the Registry Editor double-click on the (Default) entry at the top and completely delete the data it 
contains. Now do the same for the LocalServer32 key as well. This prevents the slowdown which some 
users experience with Outlook Express when MSN Messenger has been disabled. 
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 OTHER EMAIL CLIENTS 

Outlook Express should be adequate for basic email needs. However if you want a more recent, more secure 
and much more advanced email client which contains useful features absent in Outlook Express, you can 
download Microsoft's free Windows Live Mail. It does require some customization to become easier to use, 
particularly for those used to the interface in Outlook Express, however detailed configuration advice for 
Windows Live Mail is covered in the Windows 7 version of the TweakGuides Tweaking Companion. 
 
If you want to try other free email clients, see this Wikipedia Article which lists and compares a range of 
email clients, providing feature details and relevant download links. Or you can simply use an online web 
client, such as Yahoo, Hotmail or GMail. These sites not only provide free email accounts and 
comprehensive web-based interfaces, they also provide plenty of storage space. However obviously they 
cannot be accessed in offline mode, and in general I don't recommend relying solely on an online provider, 
because if your email account is hijacked for example, you lose access to both your account and any stored 
emails. 
 
Finally, I strongly suggest that you examine the tips provided in the PC Security chapter of this book for 
ways you can protect yourself from Email-related security risks while also preventing the spread of spam 
and malicious software. 
 

http://download.live.com/wlmail�
http://en.wikipedia.org/wiki/Comparison_of_e-mail_clients�
http://www.yahoo.com/�
http://mail.live.com/�
http://gmail.google.com/�
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WINDOWS MEDIA PLAYER 
 
 
Windows Media Player is Window's built-in utility for playing music and movies. It has many useful 
features and is actually a very efficient, feature-packed media player, but is often dismissed as being 
'bloated' or 'spyware'. In actuality it is smaller and more efficient than some popular media players, and if 
configured correctly should provide good privacy. This chapter contains configuration advice and details on 
WMP's features. If you don't like Windows Media Player, some alternative free players are covered at the 
end of this chapter, as well as a discussion of media-related issues including Codecs.  
 
This chapter assumes that you are using the latest version of WMP for Windows XP which is Windows 
Media Player 11. This is not the version that originally comes with Windows XP, nor does it install as part of 
SP3, so you should download it from here. All Windows XP users are encouraged for both security and 
functionality reasons to upgrade to this version. Note, if you're not going to use WMP 11's online music store 
functionality and/or to control any portable media devices connected to your PC via WMP, you can disable 
the 'Windows Media Player Network Sharing Service' - see the Services chapter for details of how to do this. 
 

 
 
 
 CONFIGURATION ADVICE 

To access Windows Media Player, go to Start Menu>All Programs>Accessories. To access Windows Media 
Player's menus, in Full View mode right-click on an empty spot on the black command bar, or just press the 
ALT key. To configure Windows Media Player as covered below, first select Tools>Options then see the 
details for each tab as follows: 
 

PLAYER 

Automatic Updates: WMP will automatically check for updated versions of itself at set intervals. Since it is not 
updated very often, the 'Once a month' option should be fine. If you tick 'Download codecs automatically', 
whenever you attempt to play a media file for which you don't have the correct codec (and you are online), 
Windows Media Player will automatically try to find and download the required codec and install it so you 
can play the file. This is recommended, and also see the Audio and Video Codecs section below for more 
information. 
 
Player settings: You can set these to suit your taste. 
  

http://www.microsoft.com/windows/windowsmedia/default.mspx�
http://www.microsoft.com/windows/windowsmedia/player/11/default.aspx�
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Start the mini player for file names that contain this text: This option allows you to tell WMP to automatically 
launch into Mini Player mode (see further below) for files containing the specified text in their filename. 
 

RIP MUSIC 

Rip music to this location: Ripping music is the process of copying it from an audio CD to a media file on your 
computer. Click the Change button and select the directory where any ripped music or media is to be placed; 
by default it will be placed under the \My Music directory. Click the 'File Name' button to specify the 
particular attributes of the CD/track which will be used to compose the ripped music track's filename. Check 
the preview at the bottom of the box to see how this will look. 
 
Rip Settings: I strongly recommend you untick the 'Copy protect music' option as otherwise each track you 
rip will become DRM protected and this cannot be changed. On the slider below, choose the audio quality 
you prefer for ripped music - 160Kbps or above is recommended for good quality audio, 128Kbps is the 
minimum recommended. The higher the quality the larger the file size of the ripped file however. 
 
To use WMP to convert any audio tracks you want from a non-protected Audio CD to .WMA or .MP3 format 
do the following: 
 
1. Insert the Audio CD in your optical drive. 
2. Close and restart Windows Media Player to make sure it detects the CD. 
3. Maximize WMP so you can see the track listing. 
4. Click the Rip button at the top of the screen. 
5. Put a tick against the track(s) you wish to rip 
6. Click the arrow under the Rip button and you can select the specific Format you wish to use - .MP3 is 

recommended as a good balance between quality, size and compatibility with a wide range of media 
players, Windows Media Audio (.WMA) is good but less compatible, and .WAV provides the best 
quality but is usually too large because it doesn't compress the audio information. 

 
There are better third party ripping tools available, however Windows Media Player is free, quick and easy 
to use, and the audio tracks it produces will not contain any copy protection as long as you use the options 
further above, so it is well worth using. 
 

DEVICES 

The devices listed under this tab are capable of media playback, whether video or audio or both. Select each 
playback device and click the Properties button. Adjust settings as appropriate, and if in doubt leave at their 
defaults which are fine for most purposes. Note that for your Display properties, you can alter the aspect 
ratio for video/DVD playback if it appears to be too wide or too narrow; the circle shown should be perfectly 
round on your screen. 
  
I recommend that you untick the 'When deleting playlists from devices, also remove their contents' option to 
prevent undesired file deletion on your device. 
 
Click the Advanced button to alter the settings for audio and video file conversions when being transferred 
to/from multimedia devices and set to suit your tastes. 
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BURN 

Windows Media Player allows you to also burn music or media files to disc. Music can be burnt as an audio 
CD, but other media can only be burnt to CD or DVD as data files. Note that for general burning purposes a 
full-featured burning program like Nero Burning ROM is recommended, which comes in a cut-down free 
trial form as well as a non-free full version. Deep Burner is a useful free burning program which provides a 
good alternative to Nero. 
 
Burn Speed: Select the burning speed, keeping in mind that if you are continually having errors with burnt 
disks, you should reduce the speed to Medium or even Low to ensure accurate burning. If you want the disc 
automatically ejected after the burn is complete, tick the box. 
 
Apply volume leveling across tracks on the CD: If burning an audio CD, you can tick this option to have WMP 
attempt to set a common volume level for all audio tracks. This can help prevent some tracks from being 
overly loud or soft relative to others on the same disc. 
 
Use media information to arrange files in folders on the disk: If you are burning a data disk and this option is 
ticked, WMP will sort your media into separate folders using \Music\Artist\Album, \TV, \Video and 
\Picture folders. If unticked, WMP will burn all tracks to the base directory of the disk without sorting. 
 
Conversion: If you select the 'Convert to' option here, you will be able to use a slider which determines how 
the various music files will be resampled for burning to audio CD. I strongly recommended against allowing 
conversion, as most music files will lose quality if converted, especially if it's to 128Kbps or below, and more 
importantly WMP automatically converts all files to .WMA format during conversion which is not 
necessarily desirable. 
 
To burn a disc, open WMP in full view, click the Burn button at the top of the screen, and an interface for 
arranging files for burning appears. Click the small arrow under the Burn button to select whether to burn 
an audio CD or a data CD/DVD. You can then drag and drop files into the right-hand pane to add them to 
the list of media to be burnt to disc, and when finished clicked the 'Start Burn' button at the bottom. 
 

PERFORMANCE 

Connection Speed: I recommend the first option, however if WMP consistently has problems detecting your 
connection speed, then set it manually here.  
 
Network Buffering: The 'Use default buffering' option is usually fine to use, but if you find streaming videos 
are constantly disjointed, then experiment with increasing the buffer size. 
 
Video Acceleration: Under this section click the Advanced button. These options affect all DVD and video 
playback, and can be used to help resolve issues with particular videos or DVDs. If your video goes out of 
sync - sometimes due to lack of sufficient bandwidth - tick the 'Drop frames to keep AV In sync' for example. 
Tick the 'Use video smoothing' option if playing back video with low framerate, as WMP will try to 
interpolate frames (fill in the blanks) to provide the appearance of smoother video playback.  
 
In particular, when playing fullscreen video, if the 'Display full screen controls' option is ticked, a set of 
controls will be shown at the bottom of the screen. If you want these removed, untick this box for true 
fullscreen video playback. You can then control playback at any time using your mouse and the following 
keyboard/mouse commands: 
  

http://www.nero.com/�
http://www.deepburner.com/?r=download�
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 Play or Pause - Left-click. 
 Change Volume - Use the mouse wheel to increase or decrease volume. 
 Mute Volume - Press the middle mouse button. 
 Fast Forward/Rewind - Press and hold the front and back thumb buttons (if any) for Fast 

Forward/Rewind. 
 Skip Forward/Back - Click the front or back thumb buttons to Skip Forward/Skip Back. 
 Command Menu - Right-click. 
 Return to Full Mode - Press ESC. 
 
If you have a standalone graphics card, tick the 'Turn on DirectX Video Acceleration for WMV Files' option 
to allow your graphics hardware to provide better video playback performance for .WMV videos. Finally, 
for videos which don't fill the entire screen due to their aspect ratio being different to your monitor shape, 
you can set the color used to display the surrounding area. For example for playback on a Plasma TV to 
prevent burn-in or uneven phosphor aging, you can set a white background by clicking the Change button. 
 
Note, if you get black and white video playback for color videos, untick the 'use high quality mode' option 
here. 
 

LIBRARY 

Sharing: If you wish to share the media on your current PC with other machines or devices on the same 
network, click the 'Configure Sharing' button. For instructions on how to configure this, click the 'Learn 
about sharing Online'. It won't be covered here as it's not a feature for the average home PC user. 
 
Update Library: By default when Windows Media Player is first run it checks your personal folders to find 
any media files it can use, and adds them to your Library - a listing of all the media files on your PC. 
Windows Media Player will keep monitoring your personal folders to add or delete listings from the library 
as you add or delete your media files. You can access the Library listings by category at any time by going to 
WMP and clicking the Library tab. Here you can view the media files in various ways, sorted by categories 
such as Album, Genre, even Rating. You can also create specific Playlists from the listings.  
 
While this is handy, the Library function is not absolutely necessary, it is simply an organisational tool. If 
you don't wish to use the Library feature, or want to alter it, click the 'Monitor Folders' button, then on the 
next screen click the 'Advanced Options' button. You can now add further folders to monitor if you wish, 
but you cannot remove the default folders WMP monitors; you can only choose to Ignore certain folders. If 
you want to prevent WMP from adding any more files to the Library, enter the maximum values of 9999 for 
the 'Skip files smaller than' boxes at the right side, so that any file smaller than 10MB is not automatically 
added to the Library. When done click OK and WMP will scan for any changes it needs to make to the 
Library. Finally, back under the main Library tab I strongly recommend unticking the 'Delete files from 
computer when deleted from library' box to prevent accidental deletion of files. This allows you to edit or 
delete items in your Library listing without deleting the corresponding media files on your drive. 
 
Automatic Media Information: If you want WMP to retrieve information about the particular media you are 
playing from the Internet - such as the name of the Album or Artist for a track - then tick the 'Retrieve 
additional information from the Internet box'; you can then choose to have it fill in the gaps or overwrite all 
existing information for the media. This information can be useful in making searches much easier. You can 
also manually force Windows Media Player to fill in missing information for particular files by clicking the 
Library button in WMP, then right-clicking on a particular track which isn't fully identified and select the 
'Find Album Info' option - a new box will open which loads up the possible matches for this track and you 
can select the appropriate one, or enter the media information manually. 
 
The remaining options here determine how WMP behaves when a track is ripped - see the Rip Music section 
further above. 
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PLUG-INS 

Plug-ins are various modules which add functionality to Windows Media Player such as Visualizations or 
Digital Signal Processing (DSP) effects. These can be added, removed or configured here. To find more 
plugins to add, click the 'Look for plug-ins on the web' link, and for more visualizations, click the 'look for 
visualizations on the web' link - you will be taken to relevant Microsoft sites where you can download useful 
plugins or visualizations which should be safe to use with WMP. You can remove any added plugin by 
highlighting it and selecting the Remove button, and you can configure any settings they may have by 
selecting the Properties button. Bear in mind that the more plugins you use in WMP, the more resources the 
player may take up, and also the greater the chance for potential problems, so only install plugins you feel 
are genuinely necessary. 
 

PRIVACY 

This is an important area of Windows Media Player which causes users a lot of concern. There is a common 
fear that by using Windows Media Player, Microsoft is spying on your media usage behaviors. This is not 
true, however if you want to ensure that none of the media on your drive is altered, or any information 
about it reported back to Microsoft, follow the recommended settings in this section. To begin with untick 
every option on this page. None of them are necessary for normal media playback. If you use DRM-
protected media, you may want to tick the 'Download usage rights automatically when I play or sync a file' 
and 'Automatically check if protected files need to be refreshed' options to prevent problems, but best to do 
so only if you run into a problem playing back such files. 
 
If you don't want your media files altered in any way without your permission, I suggest that you make all 
of your media files (e.g. .MP3, .MPG, .WMV and .AVI files) write protected. To do this, in Windows Explorer 
go to the folders where your media files are stored and highlight all of them, right-click on them, select 
Properties and place a tick in the 'Read Only' box. By write-protecting all your media, Windows Media 
Player can't alter them or add any additional identifying information without your permission. 
 
Finally, see the Windows Media Digital Rights Management (DRM) option under the Group Policy chapter 
of this book and enable it if you want to prevent Windows DRM checking features from accessing the 
Internet when you use Windows Media Player. In the end though, at no point does Microsoft truly 'spy' on 
you, there are no real privacy risks to using Windows Media Player. 
 

SECURITY 

Your Internet Explorer security settings will be used when Windows Media Player is browsing any web 
content, so see the Internet Explorer chapter for details. For the remaining boxes here, I recommend you set 
them to suit your taste. You can start off by having them all unticked for maximum security, then if you 
encounter a legitimate website with multimedia content that doesn't function correctly, you can tick these 
options to allow it to do so. None of these options should be necessary to view most online media. 
 

FILE TYPES 

Here you can select the media file types for which Windows Media Player is the default player. Change to 
suit your tastes, and note that if another player keeps becoming the default for a particular media type 
against your wishes, you will have to either open that player and check its settings to ensure it is not 
forcefully changing these options each time it is opened, or go to Control Panel>Folder Options and under 
the File Types tab change the default program association for the relevant file type. 
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DVD 

If you have a DVD drive on your system and use Windows Media Player to play DVD movies, you can 
adjust the settings in this section to suit your particular tastes and needs. 
 

NETWORK 

Configure this section according to your needs - the defaults should be fine. 
 

GRAPHIC EQUALIZER 

Windows Media Player comes with a fairly decent graphic equalizer which can noticeably enhance audio 
quality if set up correctly. To alter it, go to Full View mode and under the View menu select 
Enhancements>Graphic Equalizer. While you can use a range of presets, I recommend selecting the 
individual slider movement option - the top option on the far left - and then customizing the settings to suit 
your tastes. For reference, my personal settings from left to right for each slider are: 3 6 4 0 0 2 2 5 6 9. Your 
settings will vary both based on your playback device, as well as your any adjustments you may have made 
to the Tone settings for your playback device - see the Sounds and Audio Devices section of the Control 
Panel chapter. 
 
Other options found under the Enhancements section include enabling SRS WOW effects; Video Settings to 
alter the Brightness, Contrast, Hue and Saturation of video; Crossfading which provides the ability to slowly 
fade out one song while the next song is overlapped and slowly faded in at the same time; and Auto Volume 
Leveling which attempts to normalize the volume level across various songs so that they do not vary greatly 
in overall volume. 
 
You can close the Enhancements box at any time by clicking the small red 'x' at the far right of the 
Enhancements area. 
 

SKINS 

 
 
You can customize the way Windows Media Player looks through the use of skins. These skins can change 
the appearance and visible functionality of Windows Media Player. There are some skins which already 
come with the player, and you can view them by opening Windows Media Player, and under the View 
menu select 'Skin Chooser'. In the Skin Chooser box you can click on a skin to see a preview of it in the right 
pane. If you want to try a skin out, click the 'Apply Skin' button. If you want to get new skins online click the 
'More Skins' button, or go to a site such as The Skins Factory to download more free skins. Some skins will 
install automatically when you download them, but if you download a skin file in .WMZ format you can 
manually install it so that it appears in the Skin Chooser by putting the .WMZ file into your \Program 
Files\Windows Media Player\Skins directory. Note that using more complex skins can take up slightly more 

http://www.srslabs.com/�
http://theskinsfactory.com/skinsfactory/?page=portfolio_view&portfolio=2�
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memory and possible extra CPU power when you run Windows Media Player, so if you want to ensure the 
fastest performance and least resource usage simply use the default WMP appearance - that is, under the 
View Menu select 'Full Mode'. 
 
My preferred look for WMP is to switch to Full Mode and then simply use the resizing button at the bottom 
right of the player to shrink it down to the Compact Mode. In 'Mini Player' mode WMP uses even less 
resources - see below. 
 

MINI PLAYER MODE 

 
 
One of the neat features of Windows Media Player which sets it apart from many other media players is the 
ability to shrink it down into a 'Mini Player' interface which sits in the Windows Taskbar. To activate this, 
right-click on an empty area of your Windows Taskbar and under the Toolbars menu select the 'Windows 
Media Player' option so a tick appears next to it. Now open Windows Media Player and click the Minimize 
button on the top right of the player window. The player will minimize and sit in your Taskbar with a handy 
interface that allows access to all the major functions of the player, and whenever you want to maximize it 
again click the Maximize button on the bottom right of the mini player. Not only is this a neat feature, but 
while sitting in the Taskbar the player also uses less resources. You can also access WMP's seek functionality 
by hovering your mouse over the mini player, and using the slider bar which appears. 
 
 AUDIO & VIDEO CODECS 

A Codec (Compressor Decompressor) is a program which allows audio or video to be compressed and 
decompressed to or from its original format. Compressed files use special algorithms to achieve their size 
reductions, and it is the codec which can encode/decode these algorithms. Note that a Codec is not the same 
as a file format - a file format is simply a container type, while a Codec relates to the actual encoding of the 
media held in the container. For the most part you don't need to worry about this, because if you can play or 
record audio/video in a particular format, you have a Codec for that format already installed on your 
system. 
  

http://en.wikipedia.org/wiki/Codec�
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To view and adjust the codecs already installed on your system, do the following: 
 
1. Go to Control Panel>Sounds and Audio Devices>Hardware 
2. Double-click Audio Codecs or Video Codecs to see the relevant codec lists. 
3. Click on the Properties tab and you will see all the currently installed codecs on your system. To see 

more details about each one, double-click on it. 
4. To disable an audio codec for troubleshooting purposes, double-click on it and select 'Do not use this 

audio codec' and click Apply; to remove it from your system, highlight the codec and click the Remove 
button in the main list. 

5. Video codecs cannot be temporarily disabled, but they can be removed by highlighting them and 
clicking the Remove button in the main list. 

 
If you want to uninstall a non-standard codec, the best way to remove them is to go to Control Panel>Add or 
Remove Programs and look for the codec name in the list shown. More details of common codecs can be 
found in this Codecs for Windows Media Player article. I don't recommend completely removing a codec as 
several programs may be dependent on it. In particular do not remove any unfamiliar or default Microsoft 
codecs. If you do, you can re-download the default codecs for Windows Media Player as a package from 
Microsoft Codecs. 
 
If you want to determine what codec(s) a particular file uses, install the free GSpot utility. Use GSpot to load 
the file and the relevant Codec information will be displayed on the main page. If you then want to then 
manually find the required Codec, the most common third party codec required to play back video found on 
the web is DivX, however you can also download FFDShow which is a filter that decodes most common 
video and audio formats, including DivX, XviD, AC3, FLAC and OGG. If you simply want FLAC and OGG 
support, install the Xiph Directshow Filters. For FLAC only, install the FLAC codec. 
 
There are also certain types of media which won't normally play back on Windows Media Player or other 
common media players due to proprietary issues. The QuickTime .MOV and the RealPlayer .RM formats are 
two types of files which require special codecs and are usually viewable using their respective players: 
QuickTime Player and RealPlayer. If you don't want to install these players and instead want to view these 
audio/video files on Windows Media Player, or other players, you should install the Real Alternative and 
QuickTime Alternative codecs. For more obscure codecs usually a Google search should find you a place to 
download it, but very old or proprietary codecs may be difficult to find or may even cost money to obtain. 

http://www.updatexp.com/codec-for-windows-media-player-9.html�
http://www.microsoft.com/windows/windowsmedia/forpros/format/codecdownload.aspx�
http://www.headbands.com/gspot/�
http://www.divx.com/en/software/divx-plus/codec-pack�
http://www.afterdawn.com/software/audio_video/codecs/ffdshow.cfm�
http://xiph.org/dshow/�
http://flac.sourceforge.net/download.html�
http://www.apple.com/quicktime/download/�
http://www.real.com/�
http://www.free-codecs.com/download/Real_Alternative.htm�
http://www.free-codecs.com/download/QuickTime_Alternative.htm�
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I strongly advise against installing any general Codec Packs. These packs are tempting as they typically 
advertise themselves as containing all the Codecs you'll ever need in one simple package. However they are 
known to cause conflicts which result in a range of problems, from reduced performance, glitches and 
crashes in games and multimedia playback, to the complete loss of audio in certain applications. Even 
Microsoft warns against the installation of Codec Packs, so this is not a warning to be taken lightly, 
especially as the thorough removal of Codecs can be extremely difficult, and in some cases, a full reinstall of 
Windows may be required to undo the damage caused by a Codec Pack. 
 
 OTHER MEDIA PLAYERS 

If you don't wish to use Windows Media Player to view multimedia content, there are a range of alternatives 
including the following popular free players: 
 
VLC 
WinAmp 
DivX Player 
QuickTime Player 
iTunes 
 

 
 
I can't go into detail about each of these players in this chapter, however they are each good players, 
depending on your personal preference and specific needs. One specific media player worth noting further 
however is Media Player Classic. There is a free generic media player which can play back most formats, 
including proprietary formats, and is also both easy to use and utilizes very little system resources. 
Download and launch the mplayerc package - it requires no installation because it is in a single .EXE file 
which contains the player. It also requires no reconfiguration as such, it is ready to be used immediately 
without any issues.  
 
 

http://www.videolan.org/vlc/�
http://www.winamp.com/�
http://www.divx.com/en/software/divx-plus/player�
http://www.apple.com/quicktime/download/�
http://www.apple.com/itunes/download/�
http://sourceforge.net/projects/guliverkli2/files/�
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VISUAL & CONVENIENCE TWEAKS 
 
 
This chapter covers a range of tips and tweaks designed to allow you to further customize the appearance of 
Windows XP, as well as improving functionality. None of the tweaks in this chapter is necessary for 
ensuring that you have a fast, stable system, however many of them will save you time or make using 
Windows XP more enjoyable, so they are still worth considering. Please note that some of these tweaks can 
also be performed by a range of tweaking and customization utilities covered elsewhere in this book, such as 
in the TweakUI chapter, so you don't have to use the Registry Editor for example if you don't want to. 
 
 
 TIPS & TWEAKS 

REMOVE TEXT FROM DESKTOP ICONS 

To remove the text beneath any icon on your Desktop, follow these steps: 
 
1. Right-click on the icon whose title you want to remove and select Rename 
2. Instead of entering any characters in the text box, hold down the ALT key and type 255 (ALT + 2 + 5 + 5). 

Note that you need to use the NUMPAD numeric keys for this to work, that is the numbers to the right 
of your arrow keys, not the ones at the top of the keyboard.  

3. When you release the ALT key the title will be blank, and you can press Enter to accept this. Blank titles 
are usually denied under Windows, but not when done this way as it inserts a special blank character. 

4. For every icon whose title you wish to remove, do the same as above. However since no two icons can 
have the same name, for each subsequent icon you'll have to add an additional ALT 255 to the end of the 
string you enter. E.g. to blank a second icon name you'll need to hold down ALT and type 255, release, 
then hold ALT and type 255 again, then release and press Enter. For a third, you'll have to type ALT 255, 
ALT 255, ALT 255, Enter and so on. 

 
If you want to regain the icon names you will have to manually edit each icon's name to whatever you want. 
 

REMOVE THE BOX AROUND DESKTOP ICON TITLES 

If you have applied the 'Remove text from desktop icons' tweak above and you still see a faint box where the 
text was, you can also remove that box by doing the following: 
 
1. Go to Control Panel>System>Advanced and click the Settings button under Performance. 
2. Tick 'Use drop shadows for icon labels on the desktop' under the Visual Effects tab and click OK. 
3. Check your desktop. The boxes should be gone, regardless of whether you removed the text or not. If 

they're still there, right click on the desktop, look under 'Arrange Icons By' and make sure there's no tick 
against 'Lock Web Items on Desktop'. 
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CREATE DESKTOP ICONS FOR SHUTDOWN OR RESTART 

 
 
Instead of using the 'Turn Off Computer' or Restart options on the Start Menu, you can create desktop icons 
which automatically shutdown or restart your PC with just a double-click. This tweak makes use of the 
Shutdown.exe command to create a new shortcut as follows: 
 
Shutdown Icon: 
 
1. Right click on an empty area on your desktop. 
2. Select New>Shortcut. 
3. In the first box of the Create Shortcut Wizard, type the following and click Next: 
 

shutdown /s /t 00 

 
4. Call the shortcut something descriptive like Shutdown and click Finish. 
5. To add the finishing touch, right click on this new icon, select Properties, click the Change Icon button 

and select an appropriate icon. 
 
Reboot Icon:  
 
To create a Reboot icon, follow the same steps as above, but substitute the following steps in place of the 
corresponding ones above: 
 
3. In the first box of the Create Shortcut Wizard, type the following and click Next: 

 
shutdown /r /t 00 

 
4. Call the shortcut something descriptive like Restart and click Finish. 
 
Note that double-clicking on these icons will commence shutdown or restart of the PC straight away without 
any warning. If you want a countdown before a shutdown or restart, substitute a time in seconds in place of 
the '00' entries in the shortcut properties above (e.g. shutdown /s /t 10 gives 10 seconds warning before 
shutting down). Also note that once the shutdown or restart process begins it can't be aborted. If you want 
more command line switches which can be used with the shutdown command, open a command prompt 
and type shutdown and press Enter. For example you can use the /h switch instead of /r or /s above to 
create a Hibernate icon instead. 
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CREATE DESKTOP ICON TO LOCK THE COMPUTER 

Just as you can create Shutdown and Restart icons, you can also create an icon which locks your computer 
immediately and requires that a user login again before gaining access. To do this, follow these steps: 
 
1. Right click on an empty area on your Desktop. 
2. Select New>Shortcut. 
3. In the first box of the Create Shortcut Wizard, type the following: 

 
Rundll32.exe User32.dll,LockWorkStation 

 
4. Call the shortcut something like Lock PC and click Finish. 
5. To add the finishing touch, right click on the new icon, select Properties, click the Change Icon button 

and select an appropriate icon. 
 
Now whenever you click this icon your PC will instantly be locked, and can only be accessed by the user 
entering a correct password in the Login box. Note you can also lock the computer at any time by pressing 
WINDOWS + L. Also note that if you have an account with no password, locking the desktop is pointless as 
anyone can login by just leaving the password field blank and clicking OK to log back in. 
 

SAVE DESKTOP ICON POSITIONS 

This tweak allows you to save the current positions of your desktop icons so that if the icons are rearranged 
or moved you can quickly restore them back to their saved positions at any time. To give you this added 
functionality do the following: 
 
1. Download the file Layout.zip (mirror: here) and extract the contents to an empty directory. 
2. Copy the Layout.dll file to your \Windows\System32 directory. 
3. Double-click on the Layout.reg file to automatically make the appropriate changes to your registry. 
4. Go to your Desktop and arrange all your icons as you would like them to be saved. 
5. Once done, right-click on the Recycle Bin and select the new 'Save Desktop Icon Layout' option. The 

positions of all the icons are now saved.  
6. You can move the icons around freely and whenever you want them restored to their original saved 

positions, right-click on Recycle Bin again and select 'Restore Desktop Icon Layout'. 
 
This tweak is particularly handy if you're installing new graphics card drivers for example and your 
Desktop icons get messed up, or you change resolutions and they get scrambled around. 
 

CHANGE DESKTOP ICON SIZE 

You can alter the size of Desktop icons by using this tweak as follows: 
 
[HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics] 
 
Shell Icon Size=32  
 
The value of this STRING entry determines the size in pixels both for the height and width of desktop icons. 
The smaller the value, the smaller the desktop icon. The default value is 32, which is a 32 x 32 pixel icon. 
Create the entry if it doesn't exist and assign the desired value, then reboot Windows to implement it. 
  

http://www.pcnineoneone.com/tweaks/layout.zip�
http://www.nthelp.com/proggy/layout.zip�
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SET SPACING BETWEEN DESKTOP ICONS 

To adjust the spaces between your desktop icons, you can manually move them. However if you've chosen 
automatic spacing (Right-click on the Desktop and select Arrange Icons by>Auto Arrange) then you can 
adjust the automatic vertical and horizontal spaces placed between each icon by doing the following: 
 
1. Right-click on the Desktop and choose Properties to bring up the Display Properties box. 
2. Select the Appearance tab, then the Advanced button. 
3. Under Items select 'Icon Spacing (Horizontal)' and 'Icon Spacing (Vertical)' and edit their values to 

determine how many pixels are placed between the icons. The defaults are 43 pixels between icons. 
Smaller values squeeze them closer together, higher values spread them further apart. 

4. If your Desktop icons are aligned to the Desktop grid, you may have to right-click on your Desktop, go 
to Arrange Icons By>Align to Grid and untick it, then go back and retick it for the icons to reposition to 
the new spacings. 

 
REMOVE 'SHORTCUT TO...' FROM NEW SHORTCUTS 

Whenever you create a new shortcut, the words 'Shortcut to...' appear in front of the shortcut's name. To 
remove this default prefix for new shortcuts, open Registry Editor and change the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer] 
 
Link=00 00 00 00  
 
Create this BINARY value if it doesn't exist and set it equal to 00 00 00 00 to remove the 'Shortcut to...' prefix 
in front of new shortcuts. Reboot Windows to implement the change. 
 

CREATE A CUSTOM POPUP MENU ON THE TASKBAR 

To put your favorite shortcuts all under one easy-to-access pop-up menu on the taskbar, do the following: 
 
1. Open Windows Explorer and create a new folder wherever you prefer. 
2. Put shortcuts to all your favorite programs, pictures, documents, songs etc. in this folder. 
3. Right-click on an empty area of your Taskbar, and choose Toolbars>New Toolbar. 
4. In the New Toolbar dialog box, browse to where you created your new folder with all the shortcuts, 

highlight the folder and click OK. 
 
You will now have a new item on your Taskbar with the name of the folder you created earlier. Click on the 
double arrows just above its name and you'll get a popup menu of all the programs you can now quickly 
access. If you want to remove this folder from the Taskbar, right click on an empty area of the Taskbar and 
select Toolbars, and untick the folder's name from the list. 
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 CUSTOM WINDOWS THEMES 

 
 
Windows XP allows you to customize Window's Graphical User Interface (GUI) or 'skin'. By default XP 
comes with two main Visual Styles - 'Windows Classic Style' and 'Windows XP Style'. You can choose either 
of these by going to Control Panel>Display Properties>Appearance and selecting one under the 'Windows 
and Buttons' section. Note that you must have Themes enabled to do this; you can enable Themes by going 
to Control Panel>System>Advanced, click the Settings button under Performance and on the Visual Effects 
tab make sure there's a tick next to 'Use visual styles on windows and buttons'.  
 
Aside from the built-in themes you can also download newer official ones like the Zune or Royal Noir 
themes. Royal Noir in particular has many similarities with the Vista theme. These themes provide an 
attractive alternative to the regular Windows themes, and will work without requiring any third party 
utilities or system customization. 
 
Unfortunately Microsoft has not made it easy to modify or install any unofficial styles beyond those which it 
provides. Only themes digitally signed by Microsoft - such as those linked to above - can be installed 
without a problem. To install custom themes, you will need specialized tools and some detailed information. 
Full details can be found in this comprehensive Windows Customization Guide, but the main methods are 
covered below. 
 

WINDOWBLINDS 

To install a custom theme quickly and easily, you can use an automated utility called WindowBlinds. The 
basic version of this program is free and implements most aspects of a theme. Once you have installed 
WindowBlinds you can download a wide range of free custom themes from WinCustomize or DeviantArt 
for example. Note however that WindowBlinds needs to run in the background in Windows for the theme to 
work, and can therefore increase resource usage. For this reason, I generally recommend the method below 
which is trickier but less resource-intensive. 
  

http://go.microsoft.com/fwlink/?LinkID=75078�
http://www.istartedsomething.com/20061029/royale-noir/�
http://www.wincustomize.com/article/92719�
http://www.stardock.com/products/windowblinds/�
http://www.wincustomize.com/explore/desktopx_themes�
http://browse.deviantart.com/customization/skins/windows/windowblindsxp/?order=9&alltime=yes�
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UXTHEME.DLL PATCHING 

If you want to use a manual method which does not involve a program running in the background like 
WindowBlinds, you will have to directly patch the uxtheme.dll system file to allow custom themes. This file is 
held under your \Windows\System32 directory, and is a protected file, so it cannot be altered, deleted or 
replaced without using a special utility. As of Windows XP SP3, many of the older methods to patch this file 
may not work properly. Use the following method: 
 
1. To start with, you will need a theme file which is in MSStyles format. This means the downloaded theme 

package has to have at least one .MSSTYLES file for Windows to see it and use it. Typically you should 
extract the contents of your custom theme package to sit under the \WINDOWS\Resources\Themes\ 
directory. 

2. Make sure to create a new System Restore point. Also create a backup copy of your original uxtheme.dll 
file found in your \WINDOWS\system32 directory, preferably to another drive or disk. This is an 
important step - see Step 5 below for more details. 

3. Use the free SP3 UXTheme Patcher to automatically patch your uxtheme.dll file, or download a 
replacement uxtheme.dll file which has already been modified to allow you to run custom themes. You 
can download a relevant one from here or here - check to make sure it matches the build version of 
Windows XP you are using. Also make sure to scan the file for malware just in case. 

4. If you downloaded a modified uxtheme.dll file, download the Replacer utility and run it. Drag your 
original uxtheme.dll file into the Replacer window and press Enter, then drag the modified uxtheme.dll file 
into the Replacer window and press Enter, then press Y to confirm, and reboot as required. 

5. If something goes wrong and you find you cannot reboot your system to get back into Windows, go to 
the Windows Recovery Console and copy your backed up uxtheme.dll to the \Windows\System32 
directory and reboot. If this doesn't work, see the Backup & Recovery chapter for other recovery 
methods. 

6. Go to Control Panel>Display and select the Appearance tab. Under the 'Windows and Buttons' scroll 
box, select the new theme and click Apply - it should immediately come into effect. 

 
Once again, because this procedure involves modifying a core system file, it can cause problems if things go 
wrong. However for the most part it should be safe if you follow these instructions and in particular you 
make sure to create appropriate backups as explained in step 2. Implementing a custom theme using this 
method is the least resource-intensive way of having a custom theme, and best of all it's completely free. 
 

ROCKETDOCK 

RocketDock is a free application launcher which combines a range of impressive graphical effects with the 
convenience of being able to access and launch your most commonly-used programs in one prominent 
location. It can greatly improve the visual appearance of Windows XP and has minimal performance impact. 
 

GLASS2K 

If you also want to make any of your themes appear transparent and glasslike, you can download and use 
the free Glass2K program. It allows you to add any level of transparency to any window as well as the 
Taskbar. Give it a try as it is simple to use, however note that it needs to run in the background to work. 
 
 
As a final note, if you have low amounts of system RAM I recommend you steer clear of installing overly 
complex themes and GUI enhancements as they may make your system less responsive and increase loading 
times and stuttering in applications and games. For most systems however, a custom theme, particularly if 
implemented via the Uxtheme method, should provide no discernable drop in performance. 
  

http://www.softpedia.com/get/System/OS-Enhancements/SP3-UxTheme-Patcher.shtml�
http://www.neowin.net/forum/index.php?showtopic=633040�
http://www.megaupload.com/?d=DIVLBL28�
http://www3.telus.net/_/replacer/�
http://rocketdock.com/�
http://chime.tv/products/glass2k.shtml�
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 KEYBOARD & PROGRAM SHORTCUTS 

Most people know that you can use the keyboard to speed up access to common commands and functions in 
Windows XP. Some people use these keyboard shortcuts a great deal, others rely mainly on their mouse for 
everything. On the following pages are some of the most useful Windows XP keyboard shortcuts, and even 
some shortcuts you can type in the Start>Run box to gain quick access to useful utilities and Control Panel 
items in Windows. I recommend you get used to using some of these regularly as they quickly become 
second nature. 
 

COMMON KEYBOARD SHORTCUTS 

 
Keyboard Combination Function 

  

CTRL + A Select all 
CTRL + C Copy selected item(s) 
CTRL + X Cut selected item(s) 
CTRL + V Paste copied/cut item(s) 
CTRL + Z Undo last action 
CTRL + Y Redo last action 
SHIFT + DEL Deletes item, bypasses Recycle Bin 
CTRL + ESC Open Start Menu  
ALT + TAB Switches between active programs 
CTRL + ALT + DEL Opens Task Manager 
ALT + F4 Closes program or opens 'Shut down computer' 
SHIFT + LEFT CLICK Select multiple items at once within a range 
CTRL + LEFT CLICK Select multiple items at once individually 
TAB Steps forward through screen elements 
SHIFT + TAB Steps backward through screen elements 
F1 Open Help function 
F2 Rename/Enter text for item 
F3 Search key 
F5 Update/Refresh active window 
F11 Toggle Fullscreen mode 
SHIFT + F10 Open Context Menu for item 
ALT + SPACEBAR Open Windows Properties menu 
SHIFT + CD/DVD INSERT Hold Shift while inserting a disc to prevent Autoplay 
WINDOWS Show Start Menu 
WINDOWS + D Minimize/Restore all Windows 
WINDOWS + E Open Windows Explorer 
WINDOWS + F Open Windows Search 
WINDOWS + L Lock Workstation 
WINDOWS + R Open Start>Run box 
WINDOWS + U Open Accessibility Utility 
WINDOWS + BREAK Open System Properties 
WINDOWS + F1 Open Help & Support 
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PROGRAM & CONTROL PANEL SHORTCUTS 

The following are file names for common Windows utilities and Control Panel items which you can insert 
into shortcuts or in the Windows Run box (Start>Run). 
 

Services.msc Services Utility 
Gpedit.msc Group Policy Editor 
Comexp.msc Component Services 
Eventvwr.msc Event Viewer 
Secpol.msc Local Security Policy 
Perfmon.msc Performance Monitor 
Compmgmt.msc Computer Management 
Cmd Command Prompt 
Calc Calculator 
Cleanmgr.exe Disk Cleanup Utility 
Dfrg.msc Disk Defragmenter 
Notepad Notepad 
Pbrush Paint 
Wmplayer Windows Media Player 
Wordpad Wordpad 
Wupdmgr Windows Update 
Control Control Panel 
Sysdm.cpl System Properties 
Devmgmt.msc Device Manager 
Desk.cpl Display Properties 
Main.cpl Mouse Properties 
Timedate.cpl Clock Properties 
Inetcpl.cpl Internet Properties 
Mmsys.cpl Sounds & Audio Devices 

 
 

DIRECTORY SHORTCUT 

If you want to get to a particular directory folder, go to Start>Run and type the name and path of the folder 
in the Run box, then press Enter. Windows Explorer will open up in that directory instantly. If you don't 
specify the full path, Windows Explorer will open up at the first incidence of that directory. You can also 
assign this path to a shortcut and use it to open Windows Explorer there by default whenever the shortcut is 
used - see the Windows Explorer chapter for details. 
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MICROSOFT ON-SCREEN KEYBOARD 

 
 
If you are having problems using your keyboard you can bring up the Microsoft Onscreen Keyboard utility 
by going to Start>Run, typing osk then press Enter. The virtual keyboard will be displayed, allowing you to 
use your mouse to click on virtual keys as though you were using a keyboard. To make things easier, 
position the Onscreen Keyboard somewhere convenient and then select 'Always on Top' under its Settings 
menu so you don't constantly have to switch back and forward between tasks to use it. 
 
Note if you can't click the left mouse button to select keys, under the Settings menu select 'Typing Mode' and 
then select the 'Hover to Select' option. Now you can just place your mouse cursor over a key on the 
Onscreen Keyboard and it will register as an entry. Set the length of time needed to hover over a key before 
it registers as an entry (values in seconds between 0.00 and 1.00 second). 
 

MOUSEKEYS 

If instead of your keyboard you are having problems using your mouse, you can enable the Windows 
MouseKeys functionality by going to Control Panel>Accessibility Options>Mouse and ticking the 'Use 
MouseKeys' box. Alternatively you can press CTRL + Left SHIFT + NUMLOCK to activate this functionality. 
MouseKeys allows you to use the Numpad keys - the numerical keys on the far right of your keyboard - to 
move the mouse cursor around on screen. 
 



 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 230 Copyright © 2010 Koroush Ghazi 

 

O
verclocking 

OVERCLOCKING 
 
 
When people want additional performance from their machines, they may undertake a procedure called 
Overclocking. This is the process of increasing the clock speed of a component in your PC above its normal 
specifications, hence the term 'over clocking'. The clock referred to is a specialized oscillator pulsing with a 
frequency that determines the rate at which a data processor can perform instructions. The theory of 
overclocking is simple: increase this clock speed and you will increase the rate at which instructions are 
performed, leading to a faster PC. Overclocking is possible on a range of hardware components including 
CPUs, Graphics cards, Motherboards and RAM. 
 
Another method of overclocking which doesn't involve increasing the clock rate is by altering timings. 
Memory-based components such as system RAM and Video RAM have latency timings - rest periods 
between operations measured in clock cycles. By decreasing the latency time, a memory component can be 
made to wait less between completing specific operations and hence function faster. 
 
So why are these methods possible? Why aren't the hardware components you buy not already performing 
to their peak potential? The reason for this is that hardware components are expected to work in diverse 
environmental conditions and be put to vastly different tasks. Hardware manufacturers ensure safe 
headroom is provided so that in adverse conditions the component can still operate safely and with stability. 
Overclocking takes up this slack by pushing the component beyond manufacturers' specifications. 
 
Of course when you push a component beyond its recommended specifications the component requires 
ideal conditions to continue operating with stability. That usually means more cooling on/around the 
component, since any cooling device it already uses is only really designed to deal with stock operation. The 
component also requires stable voltage from the Power Supply either directly or through the motherboard. 
Often to achieve a stable overclock the component may also require additional voltage, which in turn can 
add to heat and hence raise the cooling requirements even further. Furthermore, the additional heat being 
dissipated from one component may cause other nearby components to overheat. As you can see 
overclocking is not as simple as it first appears, and there are often complex interactions involved both at the 
hardware and software level which must be taken into account to achieve proper stability. This chapter 
examines the general theory and operation of overclocking, and is a starting point for people interested in 
this topic. 
 
 
 BENEFITS AND DRAWBACKS 

Before going into any more detail about overclocking it is important to discuss the advantages and 
disadvantages of overclocking objectively, so you don't undertake it without knowing what you're getting 
yourself into: 
 

BENEFITS 

 Increased performance - this is of course the primary reason why people overclock. The degree to which 
performance improves depends on the component(s) being overclocked, how far they are overclocked, 
and whether they are the hardware most relied upon by particular games and applications. The 
performance difference can be anywhere from negligible to quite significant. 

 Bragging rights or 'coolness factor' attached to overclocking - some people gain a great deal of 
satisfaction and prestige in having the fastest machine, or the highest overclocked component, or the 
highest benchmark score. Or they may simply feel they are extracting the most out of their hardware by 
overclocking it. Some people also enjoy the tinkering and hobbyist aspect of overclocking and hardware 
modification. 

http://en.wikipedia.org/wiki/Overclocking�
http://en.wikipedia.org/wiki/Ram_Latency�
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DRAWBACKS 

 There will be costs in providing improved cooling - in almost all cases you will have to purchase more 
effective and/or additional cooling for your system in the form of more efficient heatsinks and/or more 
fans, a case with more space or better airflow, or specialized equipment like a water cooling setup. Of 
course if you start out by planning your system purchase carefully, you can minimize the additional 
costs to some extent by beginning with the right components. 

 The overclocked component, and therefore your entire system, may become unstable and crash 
randomly - without a doubt the number one cause of problems in games and applications is 
overclocking. People often refuse to acknowledge that their overclocking is the cause of the problem, 
and mistakenly blame Windows, their drivers or the game or application instead. Different programs 
react differently to overclocking. Some can tolerate much higher levels of overclocking on particular 
components, some cannot tolerate any overclocking at all; it all depends on how stressful the game or 
program is, and how stable or unstable the overclock actually is in your particular setup. 

 Potential data corruption if certain components are pushed beyond their limits - pushing components 
like the CPU or RAM beyond their limits on your system can result in instability leading to data 
corruption, up to and including the loss of all your data. Often this data corruption can occur subtly over 
time without any indication or warning. 

 Excessive heat can damage or permanently kill a component - since computer hardware is based on 
sensitive electronic equipment, if a hardware component is not kept adequately cool (and even in some 
cases if it is) it can be permanently damaged or destroyed through overclocking. It happens quite often, 
especially with graphics cards, so it is not as rare as might be thought. 

 Overclocking automatically voids the warranty on the component - most hardware manufacturers make 
it clear that overclocking beyond recommended clock speeds or timings will instantly void your 
warranty. This also goes for any physical modifications to the hardware such as changing its cooling. 
Unless explicitly stated otherwise, a warranty is only designed to cover unmodified hardware operating 
within specifications. 

 Overclocking reduces the life span of the component - since the component is working beyond 
specification and working hotter and faster than it was designed to handle, most components will have 
reduced life spans. This can reduce the useful life of a component sometimes negligibly or sometimes 
noticeably, depending on the extremity of the overclock, the quality of the components, and how well 
the components are kept cool and powered. A mild overclock typically has little or no practical impact 
on the life expectancy of a component; an extreme overclock can drastically reduce the error-free life of a 
component. 

 
So far the disadvantages appear to far outweigh the advantages of overclocking. This is not strictly true, it all 
depends on how far you overclock a component and how much performance you can gain in return, as well 
as the quality of the hardware itself. It's important to point out that it overclocking is not a simple or even 
beneficial procedure at all times. Despite everyone urging you to overclock your system you should weigh 
up the options rationally and either choose to avoid overclocking due to the additional expense and the 
potentially modest performance gains and/or the strong likelihood of instability/damage; or alternatively 
research the topic thoroughly and invest the time and money required to achieve a good balance of 
performance and stability. 
 
The bottom line is if you don't have much time or patience, or you can't afford to replace a vital system 
component should it get damaged, do not overclock. If your CPU or graphics card dies for example and you 
can't replace it, your entire computer becomes unusable, so it is not something to be taken lightly simply 
because people flippantly encourage you to do it. 
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 METHODOLOGY 

The precise details of how to overclock vary depending on your particular hardware configuration and BIOS 
options. The information below is only indicative and designed to give you a broad idea of the types of steps 
involved in overclocking; for more detailed information see the guides linked to at the end of this chapter. 
Importantly, before commencing any type of overclocking you must make sure you are totally familiar with 
the exact brand, model and default specifications of your major hardware components. If necessary refer to 
any packaging or manuals which came with your system, and more importantly see the System 
Specifications chapter for links to tools which can help you identify your components and their precise 
capabilities in detail. 
 
Also make sure that before changing any BIOS settings for the purposes of overclocking that you record 
your existing BIOS settings. This is because in some cases when overclocking beyond the point of stability, 
you will have to reset your BIOS (or it may reset automatically) back to its factory default settings, losing any 
customized settings you've put in. So make sure you document what the major BIOS settings are which 
you've altered through any general BIOS customization. 
 

CPU OVERCLOCKING 

 
 
Overclocking a CPU on most systems involves entering the BIOS and increasing the speed of the Front Side 
Bus (FSB) or QuickPath Interconnect (QPI) for Intel CPUs, or HyperTransport (HTT) for AMD CPUs. The 
FSB/QPI/HTT is the main pathway (Bus or Interconnect) between your major system components, and as its 
speed increases, information is transferred back and forth more rapidly between all your major components 
working off this bus speed. There are various settings in the BIOS which alter the speed of these buses or 
interconnects, however depending on the setting used, you may also be increasing the speed of other 
components, such as your system RAM. Check the relevant settings in your motherboard manual. 
 
Your CPU also has a Multiplier, which as the name suggests sets the overall CPU speed in MHz as a 
multiple of the main Bus/Interconnect speed. For example on a system with an effective Bus of 200MHz and 
a CPU that has a multiplier of 20 gives you a CPU speed of 20x200 = 4000MHz = 4GHz. Note that some CPUs 
have their multiplier locked at the hardware level, which means you can't actually change it. 
  

http://en.wikipedia.org/wiki/Front-side_bus�
http://en.wikipedia.org/wiki/Front-side_bus�
http://en.wikipedia.org/wiki/Front-side_bus�
http://en.wikipedia.org/wiki/Intel_QuickPath_Interconnect�
http://en.wikipedia.org/wiki/HyperTransport�
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RAM OVERCLOCKING 

Increasing the speed of your RAM is dependent on a number of factors. Overclocking refers to the process of 
increasing the clock speed of a component; in the case of system RAM this involves raising the main system 
Bus/Interconnect frequency and/or simply raising the RAM's Frequency directly to alter the RAM's speed in 
MHz - depending on your available BIOS options. However you can also alter the Timings (Latency) of a 
memory chip such that it refreshes faster between operations, meaning less waiting time between each 
operation and hence faster performance. 
 
Whether increasing RAM speed or lowering latency is the better option is not clear. There is no set answer - 
it all depends on your particular hardware and the applications you most commonly run as to the precise 
combination of RAM speed and RAM latency which will perform best and with greatest stability, so you will 
have to experiment. Generally speaking, applications or games which have large amounts of non-graphics 
information to transfer to the CPU and back will benefit more from greater RAM speed, which provides 
more bandwidth. On the other hand applications and particularly games which primarily require very 
complex calculations with repeated access to information in memory will benefit more from lower RAM 
latency. Obviously some applications and games require both, so again, there is no clear-cut answer. 
 
RAM overclocking also depends a great deal on how many sticks of RAM you have, their quality, and how 
similar they are. Because your RAM DIMMs (Dual Inline Memory Modules, also referred to as 'sticks') have 
to work together in your system, if you have two or more sticks of RAM in your system, you must try and 
ensure that firstly they are all equally matched in terms of rated speed and timings, and secondly that they 
should ideally be from the same brand and model of RAM. RAM chips can vary in quality and performance, 
so having mixed brands or types of RAM can lead to a variety of problems - even when running at default 
speeds. 
 

GRAPHICS CARD OVERCLOCKING 

 
 
The following is a modified summary from the overclocking section of the ATI Catalyst Tweak Guide and 
Nvidia Forceware Tweak Guide. It applies to all graphics cards regardless of brand, however if you are an 
ATI or Nvidia graphics card user please read through the relevant guide above for full details. 
  

http://www.tweakguides.com/ATICAT_1.html�
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The modern graphics card is a lot like a small computer by itself. It has a Graphics Processing Unit (GPU) 
which is the graphics equivalent of the CPU, it sits on a motherboard-like Printed Circuit Board (PCB), and 
has its own Video RAM (VRAM). And just like a computer system, the components on a video card can be 
overclocked to increase performance. Overclocking a graphics card involves increasing the frequency of the 
GPU (also called the Engine or Core) and/or the Video RAM (also called VRAM or Graphics Memory). You 
can overclock one or both of these components, with varying results based on a number of factors, but 
generally resulting in an increase in performance the higher you overclock each component. To overclock 
your video card, ideally you'll need a tool which allows you to change the clock speeds of the Core and the 
VRAM - you can use RivaTuner or ATI Tray Tools for these purposes. 
 
Overclocking your video card is similar to CPU overclocking and RAM overclocking combined - simply 
increase the clock speed of the Core/Engine, and/or the clock speed of the Graphics Memory, both of which 
are measured in MHz. The Core generates graphics data, and depending on your CPU and the rest of your 
system specifications, increasing the core speed can result in a small or large overall performance 
improvement. The Video Memory transfers information to/from the Core, and increasing its speed can once 
again improve performance either slightly or significantly, in conjunction with your Core speed and the 
speed of the rest of your system. 
 
All other things being equal, the higher the resolution being used for a 3D application or game and the 
higher the graphics settings, and the more recent the game, the greater the potential for graphics card 
overclocking to yield bigger improvements in performance. This is because newer and more graphically 
intensive games running at higher resolutions rely heavily on the GPU for their performance. 
 
Remember however that if you have an old or low-end graphics card then overclocking is unlikely to 
improve performance dramatically. The reason for this is that lower end graphics cards simply do not have 
hardware support for the advanced functionality demanded by recent games, such as the latest Pixel 
Shaders and Vertex Shaders. If your card does not have hardware support for a required advanced function, 
such as a DirectX 11 feature for example, then overclocking cannot surmount this handicap. 
 

VOLTAGE ADJUSTMENT 

As components are pushed outside specifications with overclocking, they will do more work. Often they can 
accommodate this extra work within their current voltage, however sometimes to gain stability and/or to 
push a component further, you will have to increase the voltage to these components. The three main 
components that can benefit from voltage tweaking are the CPU, the graphics card and RAM. The two main 
voltage adjustments you will find in almost any BIOS are CPU Voltage and RAM Voltage, and these are 
explained below.  
 
CPU Voltage: This is the amount of voltage applied to the CPU. The base voltage will vary depending on the 
CPU architecture, however make sure to note what your CPU's default voltage is before raising it. The only 
reason to alter the CPU voltage from its default is that when overclocking your CPU you may notice that you 
cannot overclock it beyond a certain point, or that you experience a lot of instability at higher clock speeds. 
Raising the CPU voltage by a small increment in your BIOS may allow the CPU to regain stability and/or 
allow you to push the CPU further. The theory behind raising the CPU voltage is more complex than just 
supplying more juice to the CPU, and you can read about it in this Wikipedia Article. The most important 
thing to understand is that upping the voltage beyond a certain point can result in permanent damage to 
your CPU, and strictly speaking any increase in the voltage can further shorten the life span of a CPU. 
However for the most part a small bump in voltage can help stabilize an overclocked CPU that is acting 
slightly unstable. Just remember that more voltage always equals more heat, which requires greater cooling 
to maintain safe temperatures. 
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RAM Voltage: Sometimes called DRAM Voltage, this is the amount of voltage for the RAM DIMMs. Just like 
CPU voltage, increasing RAM voltage can improve stability at higher clock speeds. This is particularly true if 
you're experiencing random reboots or sudden crashes to desktop, as these are almost always RAM related 
in some way. Once again, increasing the voltage to your RAM can result in permanent damage so do not 
overvolt by a substantial amount without first consulting with your motherboard manual to determine the 
maximum safe voltage level. Implement any increase in RAM voltage in very small increments, and provide 
additional cooling to prevent heat building in the area surrounding the RAM. 
 
You can view your existing system voltages in the BIOS, however if you want a utility to monitor system 
voltages from within Windows, use the free CPU-Z or HWMonitor utilities. See the System Specifications 
and BIOS & Hardware Management chapters for other utilities which may be useful. 
 
There may be additional voltage settings in your BIOS, and unless you have full knowledge of what they do, 
and what a safe adjustment is, do not alter them as you can permanently damage your components this way. 
 
 STABILITY 

Overclocking is pointless if it leads to instability or other problems. The Golden Rule for troubleshooting any 
problem on an overclocked system is: 
 

Always start by assuming your overclock is the primary source of any problem 
 
Begin the investigation of any problem or strange behavior on your PC by suspecting your overclock as the 
source of that problem. Reset your entire system to its default speeds and see if the problem persists or is as 
severe. If the problem goes away, or doesn't happen as often, you can be certain your overclocking is 
contributing in some way to it, or is the sole cause of it. You will have to lower or remove your overclock 
and/or increase your cooling. Details on how to correctly test your system for stability are covered in the 
Benchmarking & Stress Testing chapter, but bear in mind that even if your system can run every artificial 
test and benchmark there is for hours on end without a problem, the real test is having complete stability 
day-in, day-out, even when running stressful games and programs during hot summer days for example. If 
your system starts behaving strangely, or you are having crashes and problems, don't persist in maintaining 
your overclock. 
 
Electronic hardware components are highly accurate devices, and forcing them to run outside their normal 
operating speeds can increase the potential for small errors to creep into their operation. Manufacturers often 
push a particular component close to its limits by default from the factory, so even a small amount of 
overclocking can be enough to cause problems. If you're going to overclock, don't do it at the cost of system 
stability. At the first sign of strange behavior, don't be quick to blame everything else - suspect your 
overclock first and foremost. Make sure you have optimized and maintained your entire system as covered 
in this book. Then, and only then, if the problem persists to the same degree, and even after further online 
research, you still find no solution, you can consider the actual program or game to be buggy in some way. 
Unfortunately many people start this process the other way around. 
 

POWER SUPPLY UNIT 

Your Power Supply Unit (PSU) is an essential part of your system, and one that is often ignored. It is critical 
to system stability, and if after reading the information below you feel that there may be cause for doubting 
the quality or capability of your existing PSU to service your PC properly, you may wish to purchase a new 
and more adequate unit before investing too much time into optimizing your Windows installation. This is 
because no amount of customization or optimization can overcome the problems caused by a poor quality 
PSU, and it also jeopardizes your other components, potentially damaging them over time. A more efficient 
PSU can also save you money by using less electricity. 
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For basic details regarding PSUs see this PSU FAQ which talks about the common output specifications for 
PSUs and what they mean. In particular you should consider three key factors when determining the quality 
and adequacy of a PSU for your system: Wattage, PSU efficiency, and total amps delivered on the +12V rail. 
These figures should be readily available from the PSU's specifications.  
 
Wattage: To work out a rough estimate of the PSU Wattage which is sufficient for a particular system, use 
this Interactive PSU Calculator. It is fairly straightforward to use, however note that there are some traps 
you can easily fall into which will result in overestimating your power usage. For example under the 'System 
Type' box, you should always select 'Single Socket' unless you actually have multiple CPU sockets on your 
motherboard. A Core i7 CPU for example has four cores, but it is still a single socket CPU; virtually no 
desktop system has more than one CPU socket on the motherboard, so pay careful attention to the 
descriptions while going through the calculator. 
 
Efficiency: This doesn't represent how much of a PSU's power is usable - all good PSUs should provide up to 
their maximum rated wattage with stability if required. Furthermore, contrary to popular belief, whether a 
high or low wattage PSU, the PSU only provides the amount of power the system needs, so buying a larger 
PSU than you require won't result in extra power usage all by itself. PSU efficiency is the proportion of the 
power the PSU draws from your power socket that is relayed to your system. For example a PSU with 80% 
efficiency providing 400W of power to your system will actually draw 500W from the power socket on your 
wall while doing so. In practice efficiency will differ at different levels of load on different PSUs, and it's an 
important figure to look out for. Ideally you want 80% efficiency or higher at your expected load level on the 
PSU - the higher the efficiency, the more money you save in electricity bills. 
 
Amperage: The Amperage on the +12V rail, a key factor in system stability. For example if you look at the 
specifications of some graphics cards, they will say that they require a current of a certain number of amps 
on the +12V rail (e.g. 40A on +12V for an Nvidia GeForce GTX 285). You should refer to the specifications of 
the PSU to see if the +12V rail(s) provide that much amperage in total. Note that some PSUs may have 
multiple 12V rails - this is technically a safety requirement to prevent potential overload on a single 12V rail, 
but is not a necessity, and some even consider it undesirable. In practice as long as the amps and total 
wattage supplied along the 12V rail(s) are solid and sufficient for the job required, it shouldn't make a huge 
difference whether you have single or multiple 12V rails. 
 
The problem is that beyond trying to take note of the key factors above, an accurate review is required to tell 
you whether a PSU is genuinely good quality or not. As this article points out, specialized measurement 
instruments are necessary to determine this, not just measuring voltages with a multimeter. Hence most PSU 
reviews are inaccurate and effectively useless. Accurate PSU reviews can be found at sites like 
SilentPCReview and JonnyGuru, so start there if you want to know more about a particular PSU. 
 
As a final note, if you live in an area where the mains power supply is not stable or you can suffer periodic 
outages, I strongly recommend investing in a good quality Uninterruptible Power Supply. This will increase 
the life of your components, and is important in preventing potential data loss resulting from a power 
outage. 
 

COOLING 

One of the most common reasons for a range of problems in Windows has nothing to do with Windows or 
software; it is actually the hardware-related phenomenon of overheating. Overheating hardware can cause 
all sorts of strange errors, crashes and problems, and is often misdiagnosed as being a software or driver 
problem. Most computer hardware generates heat due to the power it consumes, and this heat needs to be 
dissipated somewhere. A typical computer case is designed such that it traps heat, and hence as heat builds 
up in a PC case, it will cause components to malfunction and even become permanently damaged over time. 
Overheating can occur in both stock systems and overclocked systems; it all depends on a range of factors 
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we look at below. Before spending time optimizing your Windows or considering overclocking, you must 
make sure your system is properly cooled. 
 
Measuring Temperatures: The first step in determining whether a component is running too hot is to measure 
its temperature. On modern PCs the CPU, graphics card and motherboard all have built-in diodes that 
measure the temperature for these components. The CPU temperature monitor is a reasonably accurate 
measure of the temperature at or near the core of the CPU; the graphics card temperature monitor provides 
an indication of the temperature near the GPU core; while the motherboard temperature monitor is a good 
measure of the general temperature within the PC case, otherwise known as the ambient temperature. Some 
other hardware components such as power supply units and hard drives may also come with temperature 
measurement devices you can access. 
 
To actually see the temperature readings from your components, you can check the key readings in your 
BIOS settings screens, typically under a Hardware Monitor section or similar. This gives you the CPU and 
motherboard temperatures, perhaps also the PSU temperatures as well. Clearly you need a more convenient 
method of checking temperatures under Windows, especially when running system intensive applications 
or games. Most motherboards already come with such software, so check your motherboard manual and 
driver CD, or the motherboard manufacturer's website for an appropriate monitoring utility. However for 
the most accurate and consistent temperature readings I recommend one of the following free utilities which 
work on almost any system: 
 

 
 
Real Temp - Primarily for measuring CPU temperatures, particularly across the individual cores of a multi-
core CPU. Also provides a basic GPU temperature reading. 
Core Temp - Similar to Real Temp, is designed to measure CPU temperatures. 
GPU-Z - Covered under the System Specifications chapter, GPU-Z has a range of GPU temperature 
monitoring capabilities found under its Sensors tab. It also has basic CPU and motherboard temperature 
monitoring. 
HWMonitor - Can monitor a range of system temperatures as well as system voltages and fan speeds. 
HD Tune - Covered under the System Specifications chapter, the free version of HD Tune provides a 
temperature readout towards the top of the HD Tune window, showing the current temperature of the 
selected drive. 
SpeedFan - A more general temperature monitoring utility which can provide CPU, motherboard and hard 
drive temperature readouts, as well as allowing manual fan speed adjustment. 
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Once you have the appropriate utilities, monitor your component temperatures at both idle and when your 
system is under heavy load. If particular components reach what appear to be very high temperatures when 
under load, then those components may malfunction while undertaking strenuous activities on your PC for 
a sustained period of time, such as playing games. However even when idle, your PC may begin to 
malfunction if heat steadily builds up in your PC case and is not cleared fast enough.  
 
Safe Temperatures: Most people will want to know what the 'safe' temperature is for a particular component 
in their system. Unfortunately there is no easy answer - safe temperatures differ based on different hardware 
architectures, as some are designed to run hotter than others. However you can ascertain a reasonably 
normal temperature range for your component by searching Google using the specific brand and model of 
the component along with the word 'temperature' to see if any user feedback or reviews of your hardware 
states what temperature ranges are normal. As a very general rule of thumb, at the time of writing, both the 
current generation of CPUs and GPUs should not exceed 90-100C under 100% load; and for hard drives, no 
more than 50-60C is normal when under maximum sustained load. 
 
The best way to tell if your component is overheating is to watch for potential symptoms: 
 
CPUs - An overheating CPU will usually throttle down its speed when under increasingly heavier loads, 
resulting in noticeably reduced performance. Use a utility like CPU-Z (See the System Specifications chapter) 
to monitor your CPU frequencies and run a CPU-intensive program such as Prime95 (See the Benchmarking 
& Stress Testing chapter). If under 90 - 100% load you find that the CPU is not reaching its full advertised 
frequency then there is a strong likelihood it is overheating, especially if temperature monitoring also reveals 
a very high temperature under full load. 
 
GPUs - An overheating GPU will result in graphical corruption and/or crashes, whether on the Windows 
Desktop or within graphically intensive applications like 3D games. Using GPU-Z, under the Sensors tab tick 
the 'Continue refreshing this screen while GPU-Z is in the background', then launch a modern game or 
stressful 3D application - see the Benchmarking & Stress Testing chapter for some free ones you can obtain. 
Watch for any noticeable anomalies in the graphics, such as flickering textures, dots, or strange colors, and 
then after a few minutes quit the game and click the 'GPU temperature' line of GPU-Z, select 'Show Highest 
Reading' to see what the highest temperature was. A moderately high temperature combined with signs of 
graphical anomalies or corruption is almost always a clear sign of an overheating graphics card. 
 
HDDs - An overheating hard drive is less common, and also harder to spot, however any strange noises 
from the drive, any signs of data corruption, or any problems or long delays in accessing the drive tend to 
indicate a problem which may be caused by overheating. Note that SSDs are not the same as HDDs and are 
unlikely to suffer from heat-related issues because they have no moving parts. 
 
If you believe you're experiencing any heat-related issues in your system, see the tips below. 
 
Cooling Tips: If you are experiencing problems with heat in your system, or more importantly if you want to 
prevent any heat-related problems from occurring in your system, the following basic cooling tips should be 
observed. This applies equally to overclocked and non-overclocked systems: 
 
 Remove any obstructions from around your case. For example don't obscure any of your case grills/air 

holes, such as having them pressed against a wall, blocked by dust etc. Insufficient flow of air into and 
out of the case is the number one cause of heat buildup and heat-related problems. No matter how much 
cooling you have inside a case, if air can't easily get into and out of the case then your system will 
overheat. 

 If you have few or no major case fans drawing in cool air and expelling hot air, remove the sides of your 
case so that the fans on the CPU, graphics card and Power Supply can get a fresh supply of cooler air, 
and can expel hot air outside the case. 

http://www.google.com/�
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 If you do have several case fans, arrange them so that some are to the front and low in the case, sucking 
air into the case (as the air near the floor is cooler) and some are to the rear and/or the top of the case, 
blowing hot air out of the case (where the hot air expelled will rise away from the case). In this situation 
make sure to keep the sides of your case closed so that the fans have more pressure to suck/blow air 
through the case's contents like a wind tunnel. 

 Don't position a sucking and a blowing fan too close together as they will 'short circuit' each other - that 
is they will pass air through the shortest line between the two, bypassing your components and hence 
not cooling them as efficiently. Again, fans sucking air into your case should be low and on the furthest 
side of the case from the blowing fans that expel heat from the case. 

 If one component is shedding a lot of heat, pay extra attention to perhaps providing greater cooling to 
the components immediately around it. Often the excess heat from one component can cause another 
nearby component to overheat. 

 Tidy the internal components of your case. This means all ribbon cables, power cables, etc. should be 
clipped or twisty-tied to be as neatly arranged as possible, primarily to avoid blocking the flow of free 
air around components, especially near the CPU and graphics card which are the two hottest 
components in most cases. Secured cabling and snug plug connections also means you can be sure 
nothing becomes accidentally unplugged or short-circuited over time and hence cause mysterious 
hardware-based errors that will confuse you in the future. 

 If using additional internal cooling like larger heatsinks or fans, make sure they are not too heavy for the 
surface they are mounted on. For example, using extremely large heatsinks on a graphics card can result 
in the card actually bending under the weight and hence becoming permanently damaged. Even a large 
heatsink mounted on a motherboard can cause it to warp or crack, once again damaging the 
motherboard PCB beyond repair. If you feel you require such hefty cooling you should consider instead 
buying a larger case that has better airflow properties. 

 Make sure your drive(s) are not smothered by cabling or crammed into a stuffy area of the case with no 
nearby cooling or fresh air. Higher speed hard drives in particular (i.e. 10,000 RPM or faster) can heat up 
quite a bit. Hard drives are often overlooked in cooling, and yet they are a vital system component, and 
as such you should make sure they aren't confined to an extremely hot section of your case. 

 Make sure that any heatsinks or heatpipes on the motherboard itself are not covered or blocked by other 
components or cables, or covered in dust. There is a reason why these heatsinks are there: because the 
chips on a motherboard often require cooling otherwise they can malfunction due to excessive heat just 
like any other major component. Don't assume a heatsink or heatpipe without a fan implies the 
component requires minimal cooling, as sometimes manufacturers skimp on putting a fan on these 
components, which simply means the heatsinks have to do more work, so keep them well exposed to 
cool air. You may even consider positioning a fan near them if you wish to aid in system stability. 

 
While non-overclocked components can overheat, overclocked components heat up much faster and are a 
very common cause of system instability and a range of problems. If experiencing problems on your system 
make absolutely certain that as part of your initial troubleshooting you return all your components to their 
default settings to see if this removes or reduces the severity of the problem. It should be noted that a 
common cause for component overheating is the incorrect application of thermal compound by the user. Too 
much or too little thermal compound can cause a component to overheat dramatically, so always follow the 
application instructions to the letter and don't improvise unless you are highly experienced. You may also 
wish to consider purchasing better quality thermal compound for use on your components. 
 
The most simple of all of these tips which anyone can undertake is to provide greater access to fresh cool air 
for the case's contents and regularly clean the case to remove dust buildup. Dust in particular can reduce 
airflow significantly, so keep your case and your components dust-free using a barely damp cloth, q-tip or 
compressed air. Furthermore the next time you go to upgrade your PC, consider buying a larger case with 
plenty of ventilation as the single best investment in cooling and hence general system stability. 
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COMPARING OVERCLOCKS 

One of the most common statements heard when people compare overclocks or are told that their overclock 
is unstable is: "But someone else who has the exact same system can overclock it much higher than me and 
their games don't crash - it must be a game bug!". A comment like that demonstrates a complete lack of 
understanding of some fundamental principles of overclocking: 
 
 No two components are exactly the same. Even if the two components being compared are an identical 

brand, model and speed, they may have very different tolerances to overclocking depending on which 
factory they were produced in and which revision they are; that is, how early/late into the production 
run they were produced - for CPUs this is called Stepping. 

 No two people have the exact same conditions for their overclocking. Your computer room may be 
hotter or cooler, your case may provide better or worse cooling, your combination of components may 
include a different PSU or different brand or speed of RAM, your system may be clogged with more 
dust, etc. 

 Your Windows settings and software environment will not be identical to anyone else's. You may have 
sub-optimal software settings, background programs that are the source of conflicts, or malware causing 
problems, or you may even have data corruption. 

 No two games are identical in the way they use resources and stress components on your machine, and 
hence if all of your other games work absolutely fine at a certain level of overclock, it may well be that 
the latest game you are playing has a completely different tolerance to your overclock and will crash 
most of the time. 

 
RESEARCHING OVERCLOCKING 

Having stressed the importance of researching overclocking before you dive into it, I recommend that you 
start by referring to the following guides as relevant for more details. This is obviously not a definitive list of 
places to research, nor have I personally tested out all the procedures in these guides - they are simply a 
good starting point, and provide an indication of the types of practical procedures involved in overclocking 
particular hardware: 
 
General Overclocking Guide 1 
General Overclocking Guide 2 
Core2Duo Overclocking Guide 
Core i7 Overclocking Guide 
Core i5 Overclocking Guide 
AMD CPU Overclocking Guide 
GeForce GTX 275 Overclocking Guide 
AMD HD 5750 Overclocking Guide 
 
 
This chapter has been just a taste of the information available on overclocking. Don't rush into overclocking, 
do it slowly and methodically, and take the time to search Google and various tech forums for peoples' 
experiences with overclocking hardware similar to your own. More often than not you will find someone 
who has a similar setup and who has overclocked it with reasonable success, so look out for such 
information as it can save you some time in your own experimentation. However be aware that people often 
have different definitions of 'stable' when it comes to overclocking, or may even outright lie when asked if 
their system is stable. Also as noted further above, no two systems are identical so don't just automatically 
assume you can reach the same results as someone else using similar hardware. Take the time to research, 
read and think about overclocking and make sure you have the right tools and knowledge to undertake it 
properly, and if in doubt, don't overclock. It is not a necessary procedure and in my opinion, carries more 
risks than benefits, especially if you value genuine stability and data integrity. 
 

http://en.wikipedia.org/wiki/Stepping_(version_numbers)�
http://www.deep-powder.net/OC_Guide/Mem_Mobo_CPU_Overclocking_Guide.htm�
http://www.tomshardware.com/reviews/overclocking-guide-part-1,1379.html�
http://forums.hexus.net/showthread.php?t=103676�
http://www.bit-tech.net/hardware/cpus/2008/11/06/overclocking-intel-core-i7-920/1�
http://www.evga.com/forumsarchive/tm.asp?m=100899331&mpage=1&key=&#100899331�
http://www.tomshardware.com/reviews/phenom-overclock-athlon,2161.html�
http://www.guru3d.com/article/geforce-gtx-275-overclock-guide/1�
http://www.legionhardware.com/articles_pages/ati_radeon_hd_5750_overclocking_guide,1.html�
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BENCHMARKING & STRESS TESTING 
 
 
If you change settings in Windows XP or your BIOS, or if you've applied a new tweak, or perhaps if you've 
overclocked a system component, it is often difficult to tell whether your overall performance or system 
stability has improved or decreased, and by how much. The best way to gauge performance changes and 
system stability is to Benchmark your system and Stress Test it. There are a range of utilities that are 
reasonably valid, objective benchmarking tools, and we will look at them in this chapter. We will also look at 
some reputable stress testing tools. 
 
It is important to understand that some benchmarking tools double as stress testing programs since they put 
your system through a series of relatively rigorous tests to produce their performance figures. These tests 
should assist in highlighting any latent instability in your system, so the simple act of benchmarking can also 
result in stress testing your system. Stress testing plays a critical part in troubleshooting and diagnosing the 
source of system problems. 
 
 
 BENCHMARKING 

To set the actual benchmark - or base level of performance - you should ideally run the benchmarking 
program(s) prior to the majority of performance tweaks or changes you make, and note the initial results 
they provide. That way once you've undertaken some tweaking you can run the benchmarks again to 
confirm that the tweaks are having the desired effect, i.e. improving performance. However, many 
benchmarking tools already provide some information on the comparative level of performance of your 
system; that is, whether or not your system is above or below an average level of performance given the type 
of hardware you are using. You can also compare results online with other users with similar systems for 
example. 
 
The main point is that for benchmarking to be successful you need a reference point; something to compare 
with down the track to determine whether your performance is going up or down with the changes you 
have made. 
 
Some important notes to keep in mind about benchmarking: 
 
 Benchmarking programs usually focus on testing the performance of particular components of your 

machine. You need to use the right benchmarking program to correctly measure the performance of the 
relevant area of your PC's performance. Using a graphics-based benchmark to test out CPU performance 
differences for example may not yield useful results. 

 All benchmarking (and stress testing) programs can result in sudden crashes and reboots, and on rare 
occasions data corruption, if used on unstable systems, so as a precaution always make sure any 
valuable data has been recently backed up before doing comprehensive benchmarking. 

 For optimal results make sure that you do not have any other programs or games running in the 
background when benchmarking, since these can lower your results and introduce significant 
variability. They can also cause a benchmark to crash prematurely, misleading you into believing your 
system is overly unstable. 

 On the other hand, for the purposes of using a benchmark as a stress test you may want to run other 
stress testing and/or benchmarking programs in conjunction with the benchmark, or other 
applications/games in the background, to really put the pressure on your machine. Of course this can 
still result in prematurely crashing a system, but it would be an extreme test of system stability. 

  

http://en.wikipedia.org/wiki/Benchmark_(computing)�
http://en.wikipedia.org/wiki/Stress_testing�
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Below are the more popular benchmarking programs available for free, and how to use them correctly - 
including details on the component(s) they primarily focus on testing: 
 

3DMARK  

 
 
3DMark is a popular and reasonably accurate Direct3D graphics benchmarking utility that has been around 
for several years. 3DMark 06 primarily utilizes your graphics card and to a lesser extent the CPU, with the 
memory subset a player as well. 3DMark results will give you a good indication of advanced 3D gaming 
performance on your machine, and broadly speaking the higher your results, the faster the performance of 
recent and upcoming games on your system. In very general terms if one system scores higher in the same 
version of 3DMark than another, then it should be better for gaming. Note that only 3DMark 06 or older will 
run on Windows XP; the newer versions of 3DMark are for Windows Vista and Windows 7. 
 
To use 3DMark start the program and click the 'Run 3DMark' button. You will see a series of tests running. 
These use various graphical techniques, some of which may not be supported by your graphics card, and 
some of which are only available in the purchased version of the benchmark. At the end of the run the 
benchmark will present a final score. You can then use this score to compare with other people who have 
run the benchmark and this will tell you whether your system is relatively faster or slower, and if compared 
with others who have virtually the same system specifications, it will tell you whether you have room to 
improve on your particular system. Note however that some systems with the same specifications may be 
heavily overclocked just to get a high 3DMark score and are not particularly stable for day-to-day use. 
 
One method of comparing results with others is to simply find an appropriate forum and post your results 
for comparison and discussion. A more reliable method is to use 3DMark's Online Result Browser (ORB) to 
compare results with others who have posted their 3DMarks. Using the ORB means you have a better chance 
of finding a precise match for your system specs since the ORB has many thousands of users. To enter the 
ORB at any time, click the 'Options' button under the Results section of the main 3DMark screen and then 
click the 'Online ResultBrowser' button. Keep in mind that the scores from newer or older versions of 
3DMark are non-comparable to the version you are using. 
  

http://www.futuremark.com/download/�
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UNIGINE 

 
 
Unigine has released several free benchmarks which can be used to measure graphics performance in both 
DirectX 9 and OpenGL. Heaven is a free DirectX 11 benchmark which also supports DirectX and OpenGL 
graphics functionality on Windows XP. To run the benchmark, launch Heaven and adjust the settings as 
desired, then click the Run button. The Heaven demo will begin, but to commence an actual benchmark run 
you will need to press the F9 key. Once completed you will see a result in both FPS and numerical Score - 
compare this with others who have run Heaven with the same settings as you to gauge your relative 
performance. There are also Tropics and a Sanctuary benchmarks available from the link above, which both 
support DirectX 9 and OpenGL. 
  

http://unigine.com/download/�
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LIGHTSMARK 

 
 
Many graphical benchmarking utilities are based on Direct3D, because this is the most common API used for 
developing games for Windows. However Lightsmark is an advanced OpenGL-based utility which is free 
and easy to use. Simply launch the program, select your screen resolution and then click the 'Start 
Benchmark' button to begin an automated benchmark sequence. At the end of the run you will be given an 
average framerate for the run which you can compare to other machines running Lightsmark at the same 
resolution. 
 

FURMARK 

 
 
FurMark is an intensive OpenGL-based benchmark, which also doubles as a stress tester. As with most 
benchmarks, installing and running the program results in a run through a series of tests, with results 
provided at the end. You can upload and compare these results online with other FurMark users. If you 
experience any graphical glitches or problems while running FurMark, this is a sign that your graphics card 
is not being cooled sufficiently and/or is overclocked too far. 

http://dee.cz/lightsmark/�
http://www.ozone3d.net/benchmarks/fur/�
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GAME BENCHMARKS 

 
 
The graphical benchmarks above are all very useful, however they are all entirely synthetic. The most 
realistic form of graphical benchmarking and stress testing is through the use of the benchmarking features 
recent games. Modern PC games are the most system intensive benchmarks you can use, because they stress 
almost all areas of your system - the CPU, the graphics card, your memory and your drive(s), as well as 
general Windows stability. 
 
If you can't find an automated or built-in benchmarking feature for a game, simply select the most strenuous 
game you have - that is, the one with the most graphical detail, best artificial intelligence and physics, and 
preferably the most recent - and use the FRAPS utility to measure performance over a set period of time. You 
can assign a key which starts and stops the benchmarking process in FRAPS, or you can tell FRAPS to stop 
benchmarking automatically after a period of time. You can specify the benchmarking stats to save, such as 
minimum, maximum and average frames per second. These results can then be compared with others to 
give you a general idea of your overall performance. 
 
To use any strenuous game as a stress tester, play it continuously for a sustained period of time at very high 
settings, such as two or three hours. If the game crashes at any point then this is usually a very good 
indication that your system is not completely stable. Contrary to popular belief, it is not normal for games to 
crash regularly, and you should not fall into the trap of blaming everything but your own system and its 
configuration for any problems. The vast majority of game-related problems are due to individual systems, 
not the game. 
  

http://www.fraps.com/�
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PCMARK 

 
 
PCMark is a general benchmarking utility from the makers of 3DMark that has been around for several 
years, and although not as reputable or as widely used as 3DMark, provides a reasonably good benchmark 
of your computer's general performance, not just in 3D gaming. It runs a series of tests based on such things 
as file encoding, disk reads/writes and basic graphics display. To use PCMark run the program and click the 
'Run PCMark' button on the main screen. After several tests it arrives at a score you can compare with others 
online, or again on the ORB. Note that PCMark results are recorded separately from 3DMark results and are 
not comparable. Note further that only PCMark 05 can be used on XP; newer versions are for Windows Vista 
and Windows 7 only. 
 

SANDRA 

 
 
Sandra is discussed under the System Specifications chapter, however in this chapter we look at the modules 
designed to test certain components of your system, such as the CPU, RAM, or drives. The free version of 
Sandra is limited in the particular modules you can access and hence the tests you can run, however there 
are sufficient benchmarks for our purposes in the free version. 
 
To see the modules of Sandra which have benchmarking functionality, click the Benchmarks tab and you 
will see modules such as Processor Arithmetic, Physical Disks and Cache and Memory. To run a benchmark, 
open the appropriate module and press F5 or click the blue arrows (Refresh) icon at the bottom of the 
module. This will begin a benchmarking run, after which you will eventually see the results displayed at the 
top of the module. You might want to record the score(s) somewhere. You can put the benchmarking results 

http://www.futuremark.com/download/�
http://www.sisoftware.co.uk/�
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in context by looking at the results for other reference systems also provided. You can also change the 
reference data to reflect a variety of hardware to compare against, by clicking the relevant drop down boxes. 
 
Sandra also has a role as a stress testing tool. To use it as a stress tester of specific components on your 
system, use the relevant modules under the Benchmarking tab. However instead of simply running them 
once, if you want to stress test the relevant component simply refresh the benchmark repeatedly (by pressing 
F5) whenever it completes each run. Alternatively, if you want to automate the process, Sandra has a Burn-in 
Computer module under the Tools tab which will undertake more thorough stress testing of your machine. 
Start the wizard, tick the components you want to continually stress test, set the number of times for them to 
loop, or the period over which you want to perform these test, make sure the 'Monitor your computer's 
health' and 'Terminate on overheat/failure' boxes are ticked to be safe, and then commence the stress testing. 
 

HDTACH 

 
 
HDTach is a free drive benchmarking utility that allows you to test your hard drive's speed. Launch the 
program, make sure all background programs and applications are closed, select 'Quick Test' then click the 
'Run Test' button and wait for the testing cycle to complete. You will be presented with a graph showing the 
drive speed over the course of the drive. In the right hand pane you can see the various speed statistics and 
CPU usage information for the tested drive. If you want to compare your results to users online, click the 
'Long Bench' option and then 'Run Test', and this time when the benchmarking run is completed you can 
click on the 'Upload Results' button to lodge your results to the database. 
  

http://www.simplisoftware.com/Public/index.php?request=HdTach�
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HD TUNE 

 
 
HD Tune is a drive information and benchmarking utility which has been covered in various chapters of this 
book, including the System Specifications chapter. You can run a drive benchmark in HD Tune by clicking 
the Start button on the main Benchmark tab. The test will run, providing a real-time mapping of drive 
performance, and the final results will be displayed for use in online comparisons. 
 

OPTI DRIVE CONTROL 

 
 
Opti Drive Control is a utility which is free for a trial period and provides the means to benchmark your 
optical drive with a range of tests which you can select and then click the Start button to run. You can share 
your results with others for comparative purposes. 
  

http://www.hdtune.com/�
http://www.cdspeed2000.com/download.html�
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 STRESS TESTING 

Stress testing has one primary purpose on a PC: to exaggerate and bring out any instabilities or sub-optimal 
settings as quickly as possible. The reason for this is that instability usually manifests itself at various times 
on your system and in various ways and thus its causes may not be clear. A stress tester accelerates the 
process by placing extreme stress on certain components of your system to quickly and accurately determine 
whether they are the likely cause of system instability. For example, running a program which almost solely 
stress-tests your CPU can give you a good indication of whether it is your CPU which is causing crashes, 
freezes, or Windows errors; or whether another component may be to blame. 
 
However specialized a stress tester may be, it will still not provide you with rock-solid evidence that a 
specific component is to blame. In the case of the CPU tester for example, it must be recognized that if the 
program indicates CPU instability, the causes can still vary. A CPU can appear to be unstable due to one or 
more of the following reasons: 
 
 A lack of sufficient CPU cooling 
 A lack of voltage to the CPU 
 A physical fault with the CPU chip 
 An incorrect CPU-related Windows or BIOS setting 
 A fault with the motherboard 
 A fault with your Power Supply Unit 
 
The best the stress tester can do is point you in a certain direction - it usually can't provide a precise solution 
for your problem. However often this is enough for you to rule out many other causes and hence save you a 
lot of time and trouble, and even prevent you from wasting money on repairing or replacing another 
component which is not the cause. This is typically the case when you are experiencing game-related 
problems, since it may not be clear which of the many components involved in running a game are the 
actual culprit. Often the graphics card, the drivers, or the game software itself is blamed when the cause may 
be anything from your power supply, to the RAM in your system, to general settings in Windows to dust 
buildup in your case. 
 
Below are the more popular stress testing programs available for free, and how to use them correctly, 
including details on the component(s) they primarily focus on stress testing: 
 

PRIME95  

 
 
Prime95 is a small mathematics program which will effectively stress test only your CPU and memory. Once 
you've downloaded the application, run Prime95.exe and click the 'Just Stress Testing' button. Next, you 
should automatically be prompted to select a test, but if not, under the Options menu select 'Torture Test' to 
start stress testing. Select the test type based on the particular components you want to focus on testing: 
  

http://www.mersenne.org/freesoft.htm�
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 Small FFTs - Select if you want to primarily test your CPU. 
 In-place Large FFTs - Select if you want to test your CPU for stability under high heat and voltage usage. 
 Blend - Select if you want a more general 'real word' test which tests both the CPU and plenty of RAM. 
 
Once you click OK the testing will begin and Prime95 will open multiple threads to ensure all your CPU 
cores are being fully utilized. If at any point you want to stop the test, go to the Test menu and select Stop. If 
the program aborts with an error at any time, this indicates system instability. In general if your PC can run 
the test for over one or two continuous hours it shows that the CPU and memory subset are quite stable. 
However Prime95 is still just a synthetic test which only stresses your CPU and RAM, and regardless of how 
long you can run it without errors, it is not indicative of a completely stable system. Only real-world 
applications and games running without problems indicate this. 
 

SUPER PI 

 
 
Super PI is a small utility similar to Prime95, in that it stress tests your CPU and memory subset by 
calculating the mathematical number PI to a certain number of places. Download it and run the 
super_pi_mod.exe file. Click the Calculate menu item at the top, and select the number of places to calculate PI 
to, ranking from 16 thousand (16k) to 32 million (32M) places - the larger the number of places, the longer it 
will take. 
 
For a speed test of your CPU, select the 1M option and once the calculation is done, note the time in seconds 
taken. You can then compare this figure to other people to see how fast your CPU is in raw calculation 
power relative to theirs. If you want to stress test your CPU, run the full 32M calculation which will take 
longer, and hence is a better stress test of your CPU. Once again you can also compare the time taken to 
complete this with other users. 
  

http://www.techpowerup.com/downloads/366/Super_PI_Mod_v1.5.html�
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MEMTEST 

 
 
MemTest is a Windows-based memory test which will help in stress testing your Windows memory 
configuration and RAM to detect any potential problems. Memory-related errors are one of the primary 
causes of system instability and data corruption, so a system memory tester is a necessity. To use MemTest 
simply launch the program, and I recommend manually entering the amount of RAM you wish to test - e.g. 
enter 512 to test 512MB of RAM, 1024 for 1GB of RAM or 2048 to test 2GB of RAM. You may need to run 
multiple instances of MemTest to use up all your system RAM. Click the 'Start Testing' button to begin RAM 
testing and allow the test to run until it has reached 100%. Ideally you should run the test for at least an hour 
or more. If running the test triggers any errors, Windows-related warnings or prompts, then you have 
potentially faulty RAM and/or misconfigured BIOS or Windows memory settings, which can lead to many 
types of system problems. 
 

MEMTEST86+ 

 
 
Memtest86+ tests your memory before Windows loads into memory. This is a much more accurate way to 
test your physical RAM and memory subset free of any memory spaces taken up by the operating system. 
The version of Memtest86+ you download is based on which device you use at bootup, whether CD, Floppy 
or USB flash drive. Once booted on this device, your system will launch Memtest86+ and test your RAM. 
Any errors indicate BIOS or physical RAM problems. 
  

http://www.hcidesign.com/memtest/�
http://www.memtest.org/�
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RTHDRIBL 

 
 
RTHDribl (Real Time High Dynamic Range Image-Based Lighting) is an older DirectX 9 tech demo and not 
specifically designed as a benchmark or stress tester. It does not have a series of tests to run, so simply start 
up the program and observe your framerates in the top left corner. You can turn off the text shown on the 
screen at any time by pressing F1 and F3. You can also cycle through a range of object shown (Press O), the 
materials used on their surfaces (Press M), and the backgrounds used (Press L). You can change the display 
resolution or increase the size of the program's window, either of which will increase the load on your 
graphics card. 
 
To use it as a stress tester, go to the File menu and select 'Config Display'. In the Direct3D Settings window 
which opens, select the 'Fullscreen' option, then select the highest available resolution. You don't need to 
alter any of the other options on this screen unless you know what you're doing. Click Ok and the changes 
will be implemented. Now start the Auto Demo mode by pressing F5, or select Enter Planet Demo' under the 
Demo menu, and let the program run for a while. Any graphics instabilities will soon become apparent 
through crashes, artifacts or glitches. You can put further stress on the graphics card by changing the 
Multisample setting under the Options menu to progressively higher values. 
 
 
Remember, you can also use any of the benchmarks listed earlier in this chapter as stress testers simply by 
running them at their highest settings repeatedly for an extended period of time. 
 

http://www.daionet.gr.jp/~masa/rthdribl/index.html�
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WINDOWS ERRORS 
 
 
The information throughout this book is already aimed at helping you configure your system for optimal 
error-free performance. As such the whole book must be read to allow you to correctly troubleshoot any 
problems you may have. However this chapter contains some specific details on common Windows errors, 
and what they may mean. It is by no means a comprehensive listing of procedures to follow in 
troubleshooting problems, and again, it must be used in conjunction with the information in the rest of this 
book. 
 

 
 
 
 IDENTIFYING WINDOWS ERRORS 

It is import to understand that most Windows and program errors are not easy to diagnose, and often what 
the error message indicates as the source of a problem is not the actual source of the problem. For example, a 
DRIVER_IRQL_NOT_LESS_OR_EQUAL error is supposed to occur due to faulty drivers. However most 
commonly it actually occurs due to excess heat and/or overclocking on the graphics card, which then 
generates driver errors due to system instability, which Windows then reports as a driver error since it is the 
driver software which appears to be failing to perform its task. As you can see, if heat is the source of your 
problems for example, uninstalling and reinstalling new graphics drivers will do nothing to resolve this 
issue. So you need to make sure you follow the steps under the Diagnosing Problems area further below to 
correctly diagnose a problem. 
  



 
THE TWEAKGUIDES TWEAKING COMPANION 

 

 

 254 Copyright © 2010 Koroush Ghazi 

 

W
indow

s Errors 

SUDDEN REBOOTS ON ERRORS 

If you find that your system suddenly reboots when you experience an error, and hence you can't see the full 
details of an error, then you will need to disable the automatic reboot on error function in Windows. To do 
this, follow these steps: 
 
1. Go to Control Panel>System>Advanced>Startup & Recovery Settings. 
2. Under the 'System Failure' section untick the 'Automatically Restart' option, as well as the 'Send an 

Administrative Alert'. 
3. When next you receive an error, your system will freeze at the error screen and show the error message. 

Write down the error type and number exactly as shown for future reference. 
4. Manually reboot your system using the restart button on your PC, or by pressing CTRL+ALT+DELETE, 

or by holding down the Shutdown button on your PC for 5 seconds. 
 
If your system still suddenly reboots, then this is a sign of memory-related issues - see the Memory 
Optimization and Overclocking chapters, as this is related to your RAM settings or hardware, virtual 
memory or CPU Caches, especially when overclocked. Important system information held in memory is 
suddenly corrupted and must be dumped, and the system either aborts the program responsible for the 
corruption - causing an instant Crash To Desktop (CTD) with no error - or reboots your entire system 
instantly to reset memory and clear the error. 
 

EVENT VIEWER 

 
 
Another place to view error codes and error listings is in the Event Viewer, accessible under Control 
Panel>Administrative Tools, or by going to Start>Run, typing Eventvwr.msc and pressing Enter. There are 
three categories of event logs to view: Application, Security and System. Click on each of these in the left 
pane, and a list of events and errors (shown as red X's) will display in the right pane. The first thing to do is 
not panic if you see Red X's; this is normal on all systems. What is important is the details of the error - for 
example, under System there are commonly lots of DCOM errors if you've disabled any services. This is 
because an application will call for a service to start; if the service has been manually disabled, the 
application reports an error and continues loading. This is not a genuine error or something to worry about, 
unless of course it is the application with which you are having a problem in the first place - in which case 
re-enable the relevant service. 
 
To correctly diagnose an Event Viewer error, read the error log text and enter its details into this Microsoft 
Events & Errors Message Center form, and it should provide you with more details and links to help resolve 
your problem. Alternatively you can try this Event ID Site for further research. 

http://support.microsoft.com/kb/308427�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.eventid.net/�
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 SOLUTIONS TO WINDOWS ERRORS 

I cannot cover all the error numbers and error types in this section, therefore it is necessary that you take the 
initiative and research the particular error code using one of the following trustworthy sources: 
 
Microsoft Knowledgebase 
Microsoft TechNet 
Windows XP Solution Center 
Microsoft Events & Errors Message Center 
Troubleshooting Windows Stop Errors 
Troubleshooting Miscellaneous Windows Errors 
 
Use the search functionality in the sites above and enter your exact error code as shown on screen. To make 
things easier, below are some common Windows error codes, an excerpt from the relevant Microsoft 
document describing the error and a potential fix for the error. Remember, none of these errors has a single 
definite cause or specific fix, sometimes a range of unrelated issues can cause Windows to generate a certain 
error. The description and solution provided is the most generic and most common one for each error: 
 

IRQL_NOT_LESS_OR_EQUAL 

A Stop 0xA message might occur after installing a faulty device driver, system service, or firmware. If a Stop 
message lists a driver by name, disable, remove, or roll back the driver to correct the problem. If disabling or 
removing drivers resolves the issues, contact the manufacturer about a possible update. Using updated software is 
especially important for multimedia applications, antivirus scanners, and CD mastering tools. 
 
A Stop 0xA message might also be due to failing or defective hardware. If a Stop message points to a category of 
devices (video or disk adapters, for example), try removing or replacing the hardware to determine if it is causing 
the problem. 
 
If you encounter a Stop 0xA message while upgrading to Windows XP Professional, the problem might be due to an 
incompatible driver, system service, virus scanner, or backup. To avoid problems while upgrading, simplify your 
hardware configuration and remove all third-party device drivers and system services (including virus scanners) 
prior to running setup. After you have successfully installed Windows XP Professional, contact the hardware 
manufacturer to obtain compatible updates. 

 
Suggested Solution: Install the latest drivers for your components, or if already using the latest drivers, do a 
full driver uninstall in Safe Mode and go back one version. If this doesn't work, run through a range of 
benchmarks and stress tests to determine whether a hardware component is faulty. 
 

DRIVER_IRQL_NOT_LESS_OR_EQUAL 

Stop 0xD1 messages can occur after installing faulty drivers or system services. If a driver is listed by name, disable, 
remove, or roll back that driver to confirm that this resolves the error. If so, contact the manufacturer about a 
possible update. Using updated software is especially important for backup programs, multimedia applications, 
antivirus scanners, DVD playback, and CD mastering tools. 

 
Suggested Solution: Install the latest drivers for your components, or if already using the latest drivers, do a 
full driver uninstall in Safe Mode and go back one version. In particular if this occurs in relation to your 
graphics driver, make absolutely certain your system is not overclocked and is being cooled properly. 
  

http://support.microsoft.com/search/�
http://technet.microsoft.com/en-us/windows/default.aspx�
http://support.microsoft.com/ph/1173�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://aumha.org/a/stop.htm�
http://aumha.org/win5/kberrmsg.htm�
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PAGE_FAULT_IN_NONPAGED_AREA 

If you added new hardware recently, remove and replace the hardware to determine if it is causing or contributing 
to the problem. Run diagnostics software supplied by the hardware manufacturer to determine if the component 
has failed. 
 
Stop 0x50 messages can also occur after installing faulty drivers or system services. If the file name is listed, you 
need to disable, remove, or roll back that driver. If not, disable the recently installed service or application to 
determine if this resolves the error. If this does not resolve the problem, contact the hardware manufacturer for 
updates. Using updated drivers and software is especially important for network interface cards, video adapters, 
backup programs, multimedia applications, antivirus scanners, and CD mastering tools. If an updated driver is not 
available, attempt to use a driver from a similar device in the same family. For example, if printing to a Model 1100C 
printer causes Stop 0x50 errors, using a printer driver meant for a Model 1100A or Model 1000 might temporarily 
resolve the problem. 

 
Suggested Solution: Aside from trying driver updates, test your CPU and RAM in particular, though it may 
even be an issue with your motherboard. 
 

UNMOUNTABLE_BOOT_VOLUME 

This behavior can occur if either of the following conditions is true: 
 Your computer uses an Ultra Direct Memory Access (UDMA) hard disk controller, and the following 

conditions are true: 
 You use a standard 40-wire connector cable to connect the UDMA drive to the controller instead 

of the required 80-wire, 40-pin cable. 
 The basic input/output system (BIOS) settings are configured to force the faster UDMA modes. 

 The file system is damaged and cannot be mounted. 
 
Suggested Solution: See the Backup & Recovery chapter for use of the CHKDSK /R and possibly also the 
FIXBOOT commands in the Windows Recovery Console to repair this issue. If these fail, do a full reformat 
and reinstall, and if that fails, your drive may be physically faulty. 
 

BLACK SCREEN ON BOOTUP 

The master boot record (MBR), partition tables, boot sector, or NTLDR file is corrupted. 
 
Solution: See the Backup & Recovery chapter for use of the FIXMBR command in the Windows Recovery 
Console to repair this issue. 
 

DEVICE MANAGER ERROR CODES 

For an explanation of the various error codes you might see for certain devices in Device Manager, read this  
Microsoft Article. 
 

WINDOWS FIREWALL ISSUES 

If you're having problems with the Windows XP Firewall, see this Microsoft Article. 
 

WINDOWS STARTUP PROBLEMS 

For a range of solutions to general Windows XP startup issues, see the following: 
 
Microsoft Article 1 
Microsoft Article 2 
Microsoft Article 3 
  

http://support.microsoft.com/kb/310123�
http://support.microsoft.com/kb/875357�
http://support.microsoft.com/kb/310353�
http://support.microsoft.com/kb/307545�
http://support.microsoft.com/kb/317277�
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WINDOWS SHUTDOWN PROBLEMS 

For solutions to general Windows XP shutdown issues, see the following: 
 
Shutdown & Restart Troubleshooting Article 
User Profile Hive Cleanup Service 
 
 
That is just a brief list of the more common errors and possible solutions. As always your specific problems 
may be much more difficult to resolve, therefore I urge you to see the reference sources listed further above 
in this section to research and find the solution to your problem, as well as trying the methods covered 
below to diagnose your problem. 
 
 DIAGNOSING PROBLEMS 

I've noticed that whenever a problem occurs on a PC, new users tend to think everything that's going wrong  
is due to faulty hardware, and that they've just damaged their machine or screwed up thousands of dollars 
worth of equipment by editing their registry or changing a setting in a game. More experienced users go to 
the opposite extreme: they are always convinced that every fault they see on their PC lies with the software, 
despite their overclocking for example, or the fact that they've physically modified their graphics card or 
flashed it with a modified BIOS. The truth lies somewhere in between, and requires that you have some 
patience and try some common steps to diagnose your particular problem.  
 

TROUBLESHOOTING CHECKLIST 

I suggest you follow these general steps, preferably in the order shown: 
 
Remove any overclocking: I cannot stress this point enough - many of the problems which I see reported on 
Internet forums and in emails to me are based at least in some part on some form of overclocking. Crashes, 
memory errors, freezing, sudden reboots, garbled graphics or unusual colors or dots on the screen - these are 
all the classic signs of a system which is operating outside its specifications and being over-stressed by a 
particular game or application. Before blaming any software of being at fault, you must first change all your 
hardware back to their default speeds, including such things as RAM timings. Even if every single other 
game or program on your system runs fine at a particular level of overclock, but one game or program 
doesn't, that does not mean the program is at fault; you should still make sure your overclock is not the issue 
by running at stock speeds for a while. If the problem is reduced or completely eradicated by running at 
stock speed then the issue is without a doubt related to your overclock. Note that if you have heavily 
overclocked and/or modified your components in the past you may have already caused them permanent 
damage, so keep this in mind as you try to find the source of the problem. For example, if you have heavily 
overclocked your graphics card for some time it is quite likely that you have permanently damaged the 
Video RAM and this is the cause of any video artifacts you may see in games, even at stock speeds. 
 
Check for Heat Issues: A major cause of many system problems is heat buildup. Even if none of your 
components are overclocked, under certain conditions components such as your CPU and graphics card in 
particular will generate a large amount of heat. This can build up in your case, but even with good case 
cooling the heat may buildup locally near the particular component and cause it to malfunction. The most 
obvious signs of this are random errors, graphical glitches in games, and crashes to desktop. Check the 
Cooling tips in the Overclocking chapter, and as a temporary solution open up your case and clean the dust 
out, then leave the sides of your case open and if possible also place a desk fan pointing into the case, or 
some other method of additional cooling for the internal components. If this helps reduce the frequency of 
errors or problems, then heat is a major cause. 
  

http://aumha.org/win5/a/shtdwnxp.htm�
http://www.microsoft.com/downloads/details.aspx?FamilyID=1b286e6d-8912-4e18-b570-42470e2f3582&DisplayLang=en�
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Optimize your System: In order to rule out a software-based problem you must make sure your general 
system settings are correctly configured. Clearly that is what this book is designed to do, so follow it in full 
and also make sure to check for application or game-specific tweak guides to make sure the software's 
settings are configured correctly. Sub-optimal Windows and/or software settings and/or out-of-date drivers 
are a major cause of problems on many systems, and even if they are not the primary cause they can 
certainly exacerbate any existing issues. 
 
Optimize your BIOS: Along with any software optimization you must make sure your BIOS settings are 
correct otherwise no amount of software optimization or reduction in overclocking will help. This is another 
important area that is almost always overlooked because it is not easy to do. See the BIOS Optimization 
chapter for details. 
 
Read the Manual & ReadMe Files: There are times when particular programs have a known issue with a 
particular hardware component or hardware/software combination. Usually these issues are addressed in 
patches for the program, or by new driver releases for the relevant hardware. However you need to be 
aware of these problems, and the best way to do that is to read the Readme.txt or any similar help files which 
come with the program. These are usually located somewhere in the program's directories and a link is 
typically found for them under the program's install folder. You may even find mention of known issues in 
the program's manual or on their website, so make absolutely certain you read these. 
 
The Problem Occurs During Bootup or in the BIOS: If the problem you are experiencing occurs during your PC's 
initial bootup and/or in the BIOS screen then this clearly indicates that it is completely unrelated to your 
Windows settings, drivers or programs, since none of these have even loaded while the BIOS is loading. 
Problems which occur during initial bootup or when you are in the BIOS are always and unequivocally 
either hardware-related faults (including heat and/or overclocking) and/or a BIOS setting which is incorrect. 
 
Benchmark and Stress Test: It is imperative that if you don't know which component(s) are causing a problem, 
that you use several benchmarking and stress testing tools (covered in the Benchmarking & Stress Testing 
chapter) to narrow down the cause. For example if your system is freezing during the playing of games, it 
could be the graphics card, CPU, RAM or even the sound card which are at fault. Using several 
benchmarking or stress testing programs that are specialized in stressing particular components more than 
others will tell you which component is the likely candidate for further investigation. There is no easy way 
for anyone to know what the cause is on your system unless you specifically test for it yourself. 
 
Check your Cabling and Components: If you feel comfortable in doing so, turn off your system at the power 
switch (but don't unplug it) and open up your case. Check the Hardware Handling Tips section below first, 
then: 
 Check to ensure that your component fans are not covered with dust or debris. 
 Check to ensure all the cables to and from your components are firmly plugged in and not damaged 

along their length. 
 Check your motherboard manual to make sure all the switches on the motherboard are set correctly, and 

that all plugs are going into the right source. 
 Check for signs of extreme heat such as scorch marks or a burnt smell: these indicate heat damage to 

particular components. 
 Check to make sure metallic surfaces are not in contact with each other as this can short-circuit 

components. 
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HARDWARE HANDLING TIPS 

If you have to physically handle the hardware components in your system at any time, such as removing or 
installing a component, checking component connections, or cleaning components, you should make sure to 
follow these tips to prevent any permanent damage to the components through mishandling: 
 
 Before opening your case and/or handling any of your components, always shut down your PC and turn 

off the power directly at the wall socket - the electricity in your PC can kill or injure you, especially the 
dangerous voltages contained in your Power Supply. Even when switched off at the wall, the PSU can 
retain a lethal charge for quite some time, so on no account should you ever open your PSU or insert any 
metal objects into its casing. 

 Once you've turned off your system at the wall, press and hold the PC power button for several seconds 
to discharge any residual charge in the motherboard's capacitors. 

 While handling computer components, make sure you regularly discharge any static electricity in your 
body by touching any 'earthed' object - that is any object that can harmlessly dissipate static electricity. 
Typically if you leave your Power Supply Unit plugged into the wall socket (but switched off) then 
periodically touching the side of the metal PSU case will harmlessly discharge any static electricity. You 
can also purchase an anti-static wrist strap if you handle components regularly. If you are going to 
handle components try to minimize how much artificial fabrics and materials you are wearing as these 
can help to build up a significant electrostatic charge in your body. An electrostatic discharge from your 
body can damage or kill an electronic component, so do not take this lightly as it can actually happen.  

 Do not use a vacuum cleaner to clean the inside of your computer and its components, precisely because 
vacuum cleaner nozzles can discharge static electricity and zap your components. Use a clean barely 
damp lint-free cloth or barely damp q-tips to wipe dust from most surfaces, making sure you don't 
scrape the Printed Circuit Board (PCB). Don't use any detergents and most certainly don't spray 
anything onto the components. Ideally if it is available to you, use a can of compressed air (or an air 
compressor) to blow dust from hard-to-reach or sensitive surfaces as this is much safer and far more 
effective. 

 If blowing dust from a fan, especially if using a high pressure source like compressed air, insert and hold 
something like a pen in the fan's spokes to prevent it from suddenly spinning rapidly as this can damage 
the fan's bearings 

 Do not force any plugs, cables or components into sockets that do not appear to be accepting them. Even 
if the two ends appear to be matched, the pin arrangements may be slightly different or out of alignment 
and hence forcing a fit may actually bend or break some of the pins and make the connection useless or 
permanently damaged. Computer hardware interfaces are designed to fit together with firm but not 
excessive force. This includes components like the CPU chip which fits into the appropriate socket on the 
motherboard - align all the pins perfectly and press evenly but not too hard and they will mate safely. 
Force the fit and you may just end up making your CPU unusable. 

 Most devices in your PC require a source of power, however the voltage they require is very specific. If 
you connect the wrong plug to the component (which is hard to do), or forget to attach a necessary 
power connector (which is quite common), then the component will appear to be dead or may 
malfunction. You will have to check your component documentation and especially the motherboard 
manual to ensure that all components are plugged in correctly and firmly to receive sufficient power. 

 Most hardware components are sensitive to physical impact and strong vibrations. Avoid situations 
which result in the bumping or banging of these components, or for example mounting heavy fans onto 
them insecurely which can pass vibrations to these components or warp them under the weight. 

 Do not handle liquids around electronic components. Any spillage can result in disastrous short-
circuiting. 

 Do not place excessive weights on PCBs as this can crack or warp them such that they will be 
permanently damaged. Don't even rest a large object temporarily on the motherboard or a component 
for example, put them on another surface until you need to use them. 

 

http://en.wikipedia.org/wiki/Electrostatic_discharge�
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Finally, make sure you invest in a good quality Surge Protector for your PC and all your other sensitive 
electronic devices. Aside from typically letting you plug in multiple devices into one outlet, surge protectors 
serve an important function: they prevent spikes in voltage - which can occur for a range of reasons - from 
harming your components. Voltage surges needn't be sudden or catastrophic; even minor increases in 
voltage can reduce your component's lifespan over a period of time. Note that most surge protectors will not 
protect your equipment from the surge generated by a direct lightning strike on or near your house, so 
during heavy thunderstorms it is recommended that you turn off your PC and any other expensive 
electronic equipment and disconnect their power plugs from the wall socket to provide foolproof protection 
against any surge. This also includes any phone lines used for DSL for example. 
 
Electronic components these days are quite hardy, and can withstand some abuse, but given how valuable 
they are I suggest that you don't take any risks when handling them and in their general usage, so the tips 
above are best observed if you want to maintain your PC and your electronic components in good condition. 
 
 
In the end, if you really can't find a solution to your problem, try contacting Microsoft Technical Support, or 
the tech support for the particular game, application or hardware you are having issues with. Their contact 
details are listed on the product box, in the manual or on their website. Make sure to provide them with your 
correct system specifications - as covered in the System Specifications chapter of this book - as well as full 
details of the error. You can also post your specifications and error code(s) along with the things you have 
already tried on an Internet forum. Usually however, the person best suited to solving a problem is you - all 
you need is some patience and some knowledge, and with the use of Google in the long run you will save 
yourself a great deal of time, and indeed come to be able to prevent a great many problems, if you make the 
effort to become proficient in identifying and diagnosing PC problems yourself instead of relying on others. 
 

http://en.wikipedia.org/wiki/Surge_protector�
http://support.microsoft.com/contactussupport/?ws=support�
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REGULAR MAINTENANCE 
 
 
Keeping Windows and your PC in optimal working order requires regular system maintenance. Any 
operating system will degrade over time if not properly maintained, particularly as you install and uninstall 
a range of programs and drivers. You must arrive at some regular method of undertaking such maintenance 
using the tools and methods in this book. It also cannot be done on a rigid schedule; it depends on your 
usage patterns, how often you install patches and updates, install new software and move files around, etc. 
 
Below is a list of the actual things I regularly do to maintain my PC, the rough order they are done in, and 
the frequency with which I do them. You may consider some steps or their frequency as overkill, but I've 
found that by doing these procedures at least once a week I not only keep Windows as fresh as the day it 
was installed, I also weed out any undetected malware or unnecessary programs, keep my drive space 
optimal and quickly get wind of any potential problems before they ruin my data or destabilize the system. 
 
This is only an example, and you will need to customize it to suit your particular circumstances, but it is a 
good starting point for the average PC user: 
 
 

STEP 1 - MAINTAIN SECURITY 

Action: Run Windows Update, then update malware scanners and run a full manual scan of all drives. 
Frequency: Once a week at least, and also scan individual downloaded files before use with MSE. 
 
See the PC Security chapter for details. 
 

STEP 2 - CHECK STARTUP PROGRAMS & SERVICES 

Action: Use MSConfig to quickly check under the Startup and Services tabs for any newly installed startup 
programs or non-Microsoft services. Identify any new or unfamiliar entries and disable unnecessary ones as 
required, first by checking the program's own options, then using Registry Editor or Autoruns as necessary. 
Frequency: After every new program or game install. 
 
See the Startup Programs and Services chapters for details. 
 

STEP 3 - BACKUP IMPORTANT FILES 

Action: Create a System Restore point. Backup the Registry using Erunt. Do a full manual backup of 
important files and folders to rewriteable DVDs. Also backup extremely important files again to ISP 
webspace via FTP as an added precaution. 
Frequency: Once a week at least. If working on something extremely important, backup every couple of days 
both to ensure it's not lost, and also to have several versions in case current version is corrupted or 
accidentally deleted. 
 
See the Backup & Recovery chapter for details. 
 

STEP 4 - CLEAN WINDOWS 

Action: Run the Disk Cleanup utility, then CCleaner. Do a manual clean out of remaining unnecessary files. 
Frequency: Once a week at least, and also after major updates or program uninstalls. 
  
See the Cleaning Windows chapter for details. 
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STEP 5 - RUN A DISK CHECK 

Action: Use the Disk Check utility to do a full disk scan/repair of the drive - right click on your drive letter in 
Windows Explorer, select Properties>Tools>Check Now, tick 'Automatically fix file system errors', then click 
Start and reboot to implement. 
Frequency: Once every month at least. 
 
See the Drive Optimization chapter for details. 
 

STEP 6 - DEFRAGMENT 

Action: Use the Windows Disk Defragmenter to run a full defragmentation of the drive. 
Frequency: Once a week at least. Also after every major program or game install/uninstall, or any manual 
game or Windows patching, such as after Windows Update or driver installation. 
 
See the Drive Optimization chapter for details. 
 
 
Some of the steps above may seem somewhat tedious to run through on a frequent basis, but in practice it is 
precisely what has ensured that my system always remains problem-free. Proper maintenance is important 
in ensuring that your data remains secure, your system remains as responsive as when you first installed 
Windows XP, and you don't keep running into 'mysterious' crashes and problems. Of course proper system 
knowledge and prevention are also two key aspects of system maintenance. 
 
A critical part of proper maintenance is prevention, and this involves making sure that you do not constantly 
install a range of unnecessary programs on your system. Codec packs, various dubious tweaking utilities, 
piracy tools and pirated software, constant upgrades/downgrades of leaked drivers, etc. are one of the major 
reasons why many systems are so unstable and insecure, beyond Windows XP's capabilities of managing the 
mess of program conflicts and detritus that such systems have accumulated. Treat your PC as a complex and 
finely-tuned electronic machine, not a dumping ground for everything you find on the Internet, and you will 
find that it remains stable and performs well for a very long time. 
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That brings The TweakGuides Tweaking Companion for Windows XP to a close. I hope you've found the 
information in this book useful, and thanks again for your support in purchasing this Deluxe Edition.  
 
Cheers, 
Koroush 
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